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About this manual

This training manual is prepared for geo-scientists who want to learn how to use
OpendTect seismic interpretation software. The OpendTect suite of software
tools consists of two parts: a free (open source) part and a commercial (closed
source) part that is protected by license managing software. The free part con-
sists of a base system called OpendTect that can be optionally extended with free
plugins. The commercial software consists of a software layer on top of
OpendTect called OpendTect Pro that offers extra functionality for professional
seismic interpreters.

OpendTect Pro can be further extended with a range of commercial plug-ins for
special work flows. This manual teaches both parts. Theory and background of
some of the more advanced work flows are given but the focus is on hands-on
exercises that are executed on “F3 Demo”, a 3D seismic data set from offshore
the Netherlands. Manual and data set are released free-of-charge for self-train-
ing. The same material is used by dGB Earth Sciences, the company behind
OpendTect, in commercial training classes.

To follow the free exercises in Part 1 of this manual you need to install OpendTect
and download F3 Demo. To follow the commercial exercises in Part 2 you need to
install OpendTect Pro and all of the commercial plug-ins. For details, please fol-
low the instructions for F3 Demo Training on the website.




OpendTect is supported on Linux (64 bits), macOS 12 (Monterey), 13 (Ventura)
and 14 (Sonoma), and Windows 10 & 11 (64 bits). The latest version of
OpendTect + plug-ins can be downloaded from the Download page. The full
instructions for installation can be found via the Install page, the Installation_
Instructions on dgbes.com and in the Administrator's Manual:

* Installing OpendTect on Windows
* Installing OpendTect on Linux

¢ Installing OpendTect on macOS

T
| — —

OpendTect itself runs without license keys but the commercial plug-ins are pro-
tected by FlexNet license managing software. Entitlement is stored in FlexNet
license keys that are checked whenever you run one of the commercial plug-ins.
A warning message is given in case you are not entitled to run the software (e.g.
when a colleague grabbed the last license before you). F3 Demo is a special data
set. No license checks are made if you work on this data set. In other words all
exercises in this manual can be performed without license keys.

The training manual consists of two parts:
Part | — Free Software

e OpendTect
e Setup a survey & data loading
» Basic interaction
 Attribute analysis & cross-plots
» Well to Seismic Tie
« Interpretation of horizons & faults
o Time-Depth conversion



https://dgbes.com/software/installation-instructions
https://dgbes.com/software/installation-instructions

Part Il - Commercial Software*

OpendTect Pro
» Setup a survey and get data from Petrel
» Basemap interaction
» Grab and share 3D pdfimages
» Seismic facies tracking (Thalweg tracker)
» AVO attributes & Angle stacks
Attributes & filters
 Structurally oriented filters & attributes (Dip-Steering)
» Frequency enhancement (Spectral Bluing)
» Flat spot enhancement (Fluid Contact Finder)
» Object detection (Neural Networks)
HorizonCube & sequence stratigraphy
» Global Interpretation (HorizonCube, Well Correlation Panel)
» Sequence stratigraphic interpretation (SSIS)
Seismic Predictions
» Band-limited inversion (Colored Inversion)
 Full-bandwidth inversion (Deterministic Inversion)
» Stochastic inversion (MPSI)**
Machine Learning
» Log-to-Log Prediction for Density
« Lithology Classification using Well Log data
» Seismic Bodies using Supervised 3D Models
» Fault Locations using the Unet 3D Fault Predictor
» Rock Properties using a combination of Seismic Data & Well Logs

Seismic Features using a Seismic Image-to-Image Workflow
Fill blank traces in Seismic Data using a Seismic Image Regression
Workflow

*Not all commercial extensions are introduced in this manual. For training of Syn-
thRock (stochastic pseudo-well modeling & HitCube inversion) and Velocity
Model Building (pre-stack NMO & RMO picking) please contact dGB. For XField
(potential field — gravity & EM - modeling) please contact the developers ARK
CLS.

**Multi-Point-Stochastic-Inversion is introduced in this manual. For a more com-
plete (commercial) training class please contact dGB.




Licenses

The OpendTect suite of software products is released under a triple licensing
policy:

» GNU /GPL license — grants access to the free (open source) part only.

» OpendTect Pro license — grants access to both parts free (open source)
and commercial (closed source).

» Academic license — grants access to both parts to Universities for education
and R&D only.

Under the GNU / GPL license, OpendTect is completely free-of-charge, including
for commercial use.

The OpendTect Pro license gives access to OpendTect Pro and the (closed
source) plug-ins. Licenses can either be bought (permanent license) or rented on
a monthly or annual basis. The closed source parts of OpendTect are protected
by FlexNet license keys.

Feature Description Access Support Access Support

* Data visualization
* Horizon tracking
e Fault interpretation
* Basic Attributes
OpendTect * Spectral Decomposition V x V V
* RGBA

* Time-Depth conversion
... etc

Colop
* AVOAttrib.
Free . LTFAttAri b. V x V x
R e MLV filter
Plugins ¢ RSpecAttrib.
* ExternalAttrib.
... etc Not developed by dGB Not developed by dGB

PetrelDirect

* Basemap
* PDF3D

OpendtectPro | .- x x V V
¢ Thalweg tracker
coo BT

Dip Steering
Neural Networks

Commercial : ;‘SOI;IZOnCube x x V V
Plugins +  Colored Inversion

* CLAS

... etc

Under the academic license agreement Universities can obtain free licenses for
OpendTect Pro and the commercial plug-ins for R&D and educational purposes.

For more information please visit the website at the Download page.




About F3 Demo dataset
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Google maps showing the location of the
F3 Demo dataset (brown-filled rectangle)

F3 is a block in the Dutch sector of the North Sea. The block is covered by 3D
seismic that was acquired to explore for oil and gas in the Upper-Jurassic — Lower
Cretaceous strata, which are found below the interval selected for this demo set.
The upper 1200ms of the demo set consists of reflectors belonging to the Mio-
cene, Pliocene, and Pleistocene. The large-scale sigmoidal bedding is readily
apparent, and consists of the deposits of a large fluviodeltaic system that drained
large parts of the Baltic Sea region (Sgrensen et al, 1997; Overeem et al, 2001).

The deltaic package consists of sand and shale, with an overall high porosity (20-
33%). Some carbonate-cemented streaks are present. A number of interesting
features can be observed in this package. The most striking feature is the large-
scale sigmoidal bedding, with text-book quality downlap, toplap, onlap, and trun-
cation structures. Bright spots are also clearly visible, and are caused by biogenic
gas pockets. They are not uncommon in this part of the North Sea. Several seis-
mic facies can be distinguished: transparent, chaotic, linear, shingles. Well logs
show the transparent facies to consist of a rather uniform lithology, which can be
either sand or shale. The chaotic facies likely represents slumped deposits. The
shingles at the base of the clinoforms have been shown to consist of sandy tur-
bidites.

The original F3 dataset is rather noisy, to remove the noise, a dip-steered median
filter with a radius of two traces was applied to the data. The median filtered data




(exercise 2.3.1 Dip-Steering) was subsequently inverted to acoustic impedance
using the industry standard Strata software. A number of horizons were mapped
on a loose grid to study the sigmoidal shaped structures. Continuous horizons
were created from these coarse grid interpretations by interpolation with an
inverse distance interpolation algorithm. Within the survey, four vertical wells are
present. All wells had sonic and gamma ray logs. Only two wells (F2-1 and F3-2)
had density logs. These logs were used to train a neural network that was then
applied to the other two wells (F3-4 and F6-1) to predict density from sonic and
gamma-ray logs. Porosity in all cases was calculated from density using the for-
mula: Porosity = (2.65 — Density) / (2.65 — 1.05).

The F3 Block is available, along with other datasets, via the Open Seismic Repos-
itory on the TerraNubis website.

References

Overeem, |, G. J. Weltje, C. Bishop-Kay, and S. B. Kroonenberg (2001) The Late
Cenozoic Eridanos delta system in the Southern North Sea basin: a climate sig-
nal in sediment supply? Basin Research, 13, 293-312.

Sarensen, J.C., Gregersen, U, Breiner, M and Michelsen, O. (1997) High fre-
quency sequence stratigraphy of upper Cenozoic deposits. Mar. Petrol. Geol.,
14, 99-123.
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Support Options

There are several ways of getting help with OpendTect’s interactions and work-
flows.

User Mailing List

There is an active User Community. The users mailing list is for sharing inform-
ation relevant to OpendTect users. Anyone on this list can send e- mails to all
OpendTect users e.g. to pose or answer questions, suggest workflows,
announce innovations etc. Please do not use this mailing list for support ques-
tions.

Support

For support questions please contact OpendTect's support team at: sup-
port@dgbes.com

Social Media

flin

There are OpendTect user groups and communities on Facebook, Linkedln and
Discord.

|"-._

Documentation

All user-documentations can be accessed online as either HTML or PDF, or via
Help menu in the UI.

Via the software

-11-



Help

Documentation 4 OpendTect F1
How-To Instructions dGB Plugins Fz
Aftributes I : -, %

Cnline Suppart
Keyboard shortcuts ?
About

Legal ..

The help menu

The Help Button in each window will automatically pop-up the most appropriate
(sub-)chapter of the user manual.

User Documentation

—

The user documentation is structured in the same way as OpendTect itself. There
are separate documents for OpendTect and the plug-ins.

Plugins Documentation

A documentation for all commercial plugins in OpendTect.

How-to Manual

-12 -


https://doc.opendtect.org/7.0.0/doc/od_userdoc/Default.htm
https://doc.opendtect.org/7.0.0/doc/dgb_userdoc/Default.htm

This document describes various workflows in OpendTect + plug-ins. We
describe the purpose, what software is needed (OpendTect only, or OpendTect +
one or more plug-ins), and how to do it.

Tutorial videos

At the OpendTect YouTube Channel and thedgbes.com resources Videos the
user can find different demo, training workflow and webinar videos like: Survey
Setup & Load SEG-Y, Horizon tracking, Machine Learning webinars, Fault
planes, SSIS interpretation, Dip steered median filter, Chimney Cube etc...

-13-


https://doc.opendtect.org/7.0.0/doc/HTML_WF/Default.htm
https://www.youtube.com/channel/UCiaLX2p5rCcovOK_NAwpaOQ
https://www.youtube.com/channel/UCiaLX2p5rCcovOK_NAwpaOQ
https://dgbes.com/resources/videos

1 Part I: Free Software
1.1 About OpendTect

What is supported?

OpendTect version 7.0 supports all tools you expect to find in a seismic inter-
pretation system. Key features include:

o 2D, 3D Post-stack & Pre-stack seismic data
o 2D & 3D viewers

» Volume rendering & RGB(A) blending
e Seismic attributes & cross-plots

» Spectral decomposition

» Movie-style parameter testing
 Distributed computing

» Rock-physics library

» Horizon trackers

e Faults

o Well-tie

e Depth Conversion

» Geobodies and ... alot more ...

“ OpendTect Pro V6.2.0/win6: F3_Demo_2016_training_v6 - [Scene 1] - O
) Sunvey Analsis Processing Scene View Utiies Help Estimages RE
Giadw{E A T-Anna SEXFeD
BRET Z 10 4 Flemmp o7 I [oos |m simiany
[ Tree scene 1 & .
b} it
Elements Color
® | scenen -
v W Inine
é v 425 ]
r Continuous_. )
- [ 4Dipsteere_. E1 i
& |~ @ Crossine 1:-“
v (AT
@ d Continuous _.. ®
4Dipsteere_. E1 d -
v @ Zsiice i
f v [ 108 i
- Steered Simi... I -
0 - @ voume &
~ ~ RandomLing "
(7] + [ Random Line 1
~ 7aAlCubeStd I
® - [ 4Dipsteere... B
2DLine
3D Horizon
e 20 Horzon
B Fault
FaultStickSet
® Boay
v A well
FO3-4
F03-2
Fo2-1
# Pointset
[ Polygon

% Shapefils
S Prestack Events
Annotations

As stated before all functionality listed above is available free-of-charge when
OpendTect is run under the open source GNU/GPL license. This system can be
extended with other free software systems and several open source plugins.
Several open source plugins developed by others are available via the
OpendTect website at Free 3rd Party Plugins.
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1.2 Set up a Survey & Load Data

In this Chapter you will learn how to set up a new survey (a project) and how to
load seismic data, horizons and well data using industry-standard file formats
such as SEGY, LAS and ASCII.

In many oil companies setting up surveys and loading data is done by specialists.
OpendTect Pro users who want to use OpendTect in combination with Petrel*
can simply copy the Petrel project information to setup the OpendTect survey
(Exercise 2.1.1a). They can then either work directly on the Petrel data store, or
they can copy data from Petrel into OpendTect and back to Petrel when they are
finished. The first option saves disk space but ties the Petrel license. The second
option saves money as it allows you to work with many OpendTect interpreters on
a project without tying the Petrel license. In addition to the PetrelDirect link in
OpendTect Pro there are also several commercial plug-ins that support easy pro-
ject setup and data 10 to and from SeisWorks/OpenWorks**, GeoFrame-IESX***
data stores.

Since not everybody needs (or wants) to know how to do this it is possible to skip
this entire Chapter. F3 Demo is already set up for OpendTect, hence there is no
need to start from scratch. Simply go to the next Chapter to start your training.

The raw data for our new survey are located in a folder called Raw_Data in the F3
Demo directory.

*Is a mark of Schlumberger.
** Registered Trademark of Landmark Graphics Corporation.
*** Registered Trademark of Schlumberger.

-15-



1.2.1 Survey Definition

What you should know about OpendTect surveys

A survey is defined by a 3D grid of Inline, Cross-line numbers and Z sample
rate in time, or depth.

Inline, Cross-line numbers are linked to X,Y rectangular coordinates via a
single linear transformation.

Surveys can be set-up for 3D seismic only, for 2D seismic only and for 2D
and 3D seismic data.

The Z dimension (time or depth) as defined in the survey setup determines
the primary display axis in OpendTect. Data in the other dimension can be
visualized in new (3D visualization) scenes in which the data is transformed
on-the-fly using a given velocity field.

3D seismic must fall inside the defined survey boundaries.

Itis possible to load 3D seismic data sets with varying orientations and
sample rates inside one survey. All data sets are mapped onto the defined
grid.

2D seismic lines can stick outside the defined survey boundaries. The grid
dimensions as defined in the survey setup are used in gridding operations,
e.g. when creating a 3D horizon from a 2D horizon.

Surveys can be set up in different ways

1.

B w

Manually: You enter the required information such as the specification of
the 3D grid and the inline, cross-line to X, Y co-ordinate transformation by
hand. The latter is specified:

a. Either in the form of two linear functions.

b. Or, as three points (usually the corner points of the survey outline).
Two of the points must lie on the same inline. OpendTect derives the
linear transformation functions from the specified points.

SEGY Scan: SEGY data usually contains inline, cross-line and X,Y co-
ordinate information in the trace headers. As not all SEGY data adheres to
the standard (SEGY Revision1) OpendTect supports tools to help you ana-
lyze and where needed correct SEGY files.

Copy from another survey..

Set up for 2D only: For 2D seismic surveys OpendTect only requires X, Y
co-ordinates to be correct. You can set it up with a fake inline, cross-line
grid.

Using Commercial Tools: There are commercial links to SeisWork-
s/OpenWorks, GeoFrame-IESX and Petrel.

-16 -



1.2.2 SEG-Y Scan Setup & Load

What you should know about SEG-Y

SEG-Y is the industry standard seismic data format that was defined ori-
ginally as a tape format.

It consists of a EBCIDIC Header with general information like data format,
trace length and sample rate, followed by a binary Header (descriptive data
typed in by the seismic processor — not very trustworthy) and seismic
traces. Each trace consists of two parts: a trace header followed by trace
data.

Not all SEG-Y files (especially older files) adhere to the standard definition,
which is called SEG-Y — Rev. 1 (Revision 1).

Before loading SEG-Y data you must verify that the information OpendTect
needs (inline, cross-line and X,Y co-ordinates) is stored in the trace head-
ers where OpendTect expect these.

If not, you specify where the information is located. If the information is not
present at all you can create the information using OpendTect’s trace
header manipulation tools.

If you run into problems, please check this page from the user doc with pos-
sible solutions: UserDoc.

What you should know about SEG-Y in OpendTect

OpendTect can work directly on SEG-Y data files.

The advantage is that there is no data duplication.

To use this option OpendTect must scan the SEG-Y file to construct a table
with inline, cross-line information from the trace headers.

-17 -



1.2.2a Survey Setup & Load SEG-Y

Required licenses: OpendTect.

Exercise objective:

Set up a new OpendTect survey and load 3D seismic data from SEGY using the SEGY scan wizard.

| SelectSetup .|
Session 4

Workflow:

List of all Surveys in this Survey Data Root
> o
1. Go to Survey > Select/Setup... e
or click on the Survey Setup icon £ . °m 13

e LT s oo amo t“-~"'
;LL:MO,S:UZ‘UJ:: = . 7534280 -

2. Click on the New Survey icon g . -t AL “ G

%

1] 100730 10011250

When starting OpendTect for the first time, you
arrive directly in the Survey Setup & Selection
window.

1; Toral: §51
: 0 - I84E - 4; Total: 463
25.00 / 25.00 (m/line)
Projaction: [EFSG'23031] EDSO / UTH zone 31N
286,93 (sq km)
Survey t Both 2D and 30
In-line Orisntar £5.40 Degrees trom N
Location : C:\Surveys\F3_Demo_2020

[Bscet]| Bonee @ @

Workflow cont’d:

& Create New Survey - a X
Specify new survey parameters

3. Specify a Survey name and Survey name [My New Survey|
Available data [ 3D 2D O wells

Initial setup | Scan Navigation Data “
4 Copy from other survey
" T Read from Survey Setup file

(a) select Scan SEG-Y file(s), s Scan VDS file
™ Scan ZGY file
2 Scan SEG-Y file(s)
B Scan LAS Well Data

Get from Petrel

i Enter by hand

(b) set Time for Z Domain, *

z Damain O Depth

(c) Press Next.

€ Cancel 0

OpendTect display scenes are in Time or Depth. Transformation is done on-the-fly using a given

velocity model. In the Survey Setup you choose the primary Z Domain. In the case of depth
survey, Z Domain should be Depth.
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Workflow cont’d:

4. Go to the Rawdata directory of F3 Demo and Select the Input SEG-Y file: \Raw

data\Seismic_data.sgy.

c]
Input file *=wildcard O Select ... E
Data type (30 selsmic Data ~
Coordinate System | Unlocated XY O Select
Quick scan result Source Actually use 2> =
SEG-Y rovision User defined = @
Data format From file header
Number of samples From header - |1 = (1000 3
Zrange From header  Start |0 Step (1 -
In-line range From header
Cross-line range From header
X-coordinate range From header
Y-coordinate range From header
- v 1 1 = F3Demo2023 > Rawdata - O
Organise > New folder 1 F = =
o 0.1% =
4 Downloads S Mam & N
N - O Zeres
& Music
Surtoce_dota
= Pictures Wiell data
& vidoos Selsmic_datasgy v
. Windows (C) v o< >
file name: [Seismic_data.sgy | |SEG-Y files (=sgy .56V “seqy) ~

Open

Cancel

(5 end @

Workflow cont’d:

5. The import wizard makes a quick scan of the SEG-Y volume and automatically fills-in
relevant parameters for survey set-up and import.

If needed, the parameters
required for SEG-Y import
(under the Actually Use column)
can be changed manually.

The bottom part shows the
extracted geometry of the
survey and the histogram of
seismic amplitudes from the
quick scan of the input SEG-Y
volume.

@ Bxtract Survey Setup from SEG-Y

Tnput fle * =wildeard | C:\Surveys\F3_Demn_2023\Rawdala\Selsmic_dala.soy

Data type | 3D Seismic Data

- o *

O Select | |# Edit

Coordinate System | Projection: [EPSG:23031] EDS0 / UTM zone 31N O Select ...
Full scan result Source Actually use = [

SEGYravision |1 Revision 1 . E‘%
Data format 3 - Integer (16 bits) From file header " O\
Number of sampies 462 (500515 traces) From hoader v | 162 Nron =
2 range 0.004 - 1.848 - 0.004 (s or m) From header ~ Start | 0.004 Step | 0.004 e
In-line range 100 - 750 From heacder | Inlina (byte 189) - "Infine numt ~ 4 bytes ~
Cross line rerge 300 - 1250 From header  |Crossline (byte 193) - "Crosslin - 4 bytes
X-coordinate range 60541670 - 629576,30 From header | Xedp (byte 181) - "X coordinate + 4 bytes v
¥-coordinate range 6073556.50 - 609046330 From heacder | Yedp (byte 185) - Y coordinate - 4 bytes ~

Resultmgég;;ﬂe! setup 75071250

100500 071250

-10000
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Workflow cont’d:

6. Optionally, click on the icon to scan the entire input SEG-Y file.

7. Click on the Q icon to examine in detall, first ‘1000’ traces (changeable) of the file.

f& Extract Survey Setup fram SEG-Y - o x
Input file *=wildcard | C:\Surveys\I3_Demo_2023\Rawdata\Seismic_data.sqy O Select ...
Data type B30 Seismic Data -
Edit option can be used if the SEG-Y Coordinate System | Projection: [EPSG:23031] EDS0 / UTM zone 31N © Selact ...
file needs to be moadified. You can I Full scan resut source Actually use -
update binary headers and trace | SOV ! SEEDE - |
u - Data format 3 - Integer (16 bits) From file header ~
headers using mathematical formulae 4 >
) ) Number of samples 462 (600515 traces) From header 462 - w0 =
and information from other headers. 2 range T | (0000 S (2008 | e
In-line range 100 - 750 from header | Inline (byte 189) - "Inline numt - 4 bytes ~ :
Cross-line range 300 - 1250 From header  Crossline (byte 193) - "Crosslin - 4 bytes ~
X-coordinate range 505416.70 - 629576.30 From header | Xodp (byte 181) - "X coordinate ~ 4 bytes
Y-coordinate range 6073556.50 - 6090463.30 From header  Yodp (byte 185) - "Y coordinate ~ 4 bytes v

Scanning the entire SEG-Y file
is useful when the survey

Resulting survey setup 7501250
geometry extracted from the 0
quick scan looks doubtful.
100/300 100/ 1250 10000 4" 00 al SC 0
S0k _| (@ cancel 0
Workflow cont’d: )
X
. . ‘-,.
8. Examiner window: @ secvean® | . - o x
Use this to find out Fi.emwi,.;x' .
what is inside the file. [z wn 5 1or 750 xrs 1250 [@ oo nonses— 0 |
co9 Cori o 00 7 IL: 750 XL: 300
c10 Bin 0000
9. Check the Inline, o owos Coarmaen eettoey G0 S S
. €13  In-line: 100-750 inf: 1 Dump of EBCIDIC and
Crossline and X/Y Cl4 cCross-line: 300-1250  inf: 1 . g
§ ! €15 2 (ms): 4-1848 int: ¢ | Binary headers vahe
coordinates : find the |ci¢ ---io-- - i [ I
. n lxr\e_byte. 7489 1p2 [aa7s0 | (2381.8057

corresponding byte |5t FEELI ;zi:ili M

and observe the . ot e S Vo s waeres 4 .

aSSOCiated p|0t Trace header informaltiotraces | 1000 Ci E tracl (trace sequence number within line)

1 2 3 G
10. Optionally, check Zltrzcl] L Z 2 800
. . . 5 [tracr] 1 2 3

S_e|sm|c viewer and o ] o o

histogram windows. 13 [tracf] 0 0 0
17 [ep] 0 0 0 400
21 [adp] 300 301 302 200

Trace header name + 25 [cdpt] 0 0 0 Trace header Plot i

byte position. 39 ftric] ! ! ! -~ 200 400 600 800 1000
Trace / Step |1 2l :dm Range: [1,951] (N=1000)
| First 1000 Trace header Nos. (2
Total traces: 600515 C:\Surveys\F3_Demo_2023\Rawdata\Seismic_data.sgy
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Workflow cont’d:

11. Click on OK. Optionally, click on the i) icon to save the import set-up parameters.

a
Input file *=wildcard | C:\Surveys\F3_Demo_2023\Rawdeta\Seismic_data.sgy O Select ...| [ Edit ...
Data type (B30 Seismic Data ~

Coordinate System | Projection: (EPSG:23031] ED50 / UTM zone 31N

Full scan result: Source Actually use

SEG-Y revision 1 Revision 1
Data format 3 - Intager (16 bits) From fila haader
Number of samples 462 (600515 traces) From header v 462
Z range 0.004 - 1.848 - 0.004 (s or m) From header ~ Start | 0.004 Step | 0.004 WF
In-line range 100 - 750 From header  Inline (byte 189) - "Inline numt - 4 bytes
Cross-line range 300 - 1250 From header  Crossline (byte 193) - "Crosslin ~ 4 bytes -
X-coordinate range 605416.70 - 629576.30 From header  Xcdp (byte 181) - "X coordinate ~ 4 bytes -
Y-coordinate range 6073556.50 - 6090463.30 From beader  Yadp (byte 185) - Y coordinate ~ 4 bytes -
Resulting survey setup 70 1250* 0.1% %

o O Zeres

100/358 T00]1250 10000 5000 0 5000

Workflow cont’d:

12. Survey definition is set now. Click on OK to proceed further.

@ Edit Survey Parameters = [m]
Survey name 'My new Survey
Location on disk C:\Surveys
Survey type Both2Dand3D
Ranges/coordinate settings Enter below v

=~ Survey ranges @ Coordinate settings 2 I/C to X/¥ transformation <% Coordinate System

In-line range 100 5750 3| Step |1 < Nr. In-lines: 651
Cross-line range |300 <] :1250 :: Step :1 :: Nr. Cross-lines: 951
Z range [4 |[1848 | step[a | | millisecond v

Display depths in ® Meter (O Feet

Seismic Reference Datum (m) |0

= Apply

cancel @

Free space on disk: 52.56 GB
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Workflow cont’d:

13. Go inside the newly created survey by either double-clicking on it or clicking on Select.

14. Press Yes when asked to import the
SEG-Y file used to set-up the survey.

™~ .
ﬂsurveyDataRoot... C:\Surveys o @
F3_Dema_2020 &)
_Demo_ o -
F3_Demo_2020_20jul21 - My New Survey
F3_Dema_2020_old .
X 750¢ "
My_New_Survey =]
My_survey_AL
S
2
@ Specify
& 100500 1001250
0 Import the SEG-Y data used for survey setup now?
Ono @ Information = Notes @ Log
[ In-line range : 100 - 750 - 1; Total: €51
Cross-line range : 300 - 1250 - 1; Total: 951
Z range (ms) : 4 - 1848 - 4; Total: 462
Inl/crl bin size : 25.00 / 25.00 (m/line)
CRS : Unlocated XY
Area : 386.93 (sq km)
Survey type : Both 2D and 3D
Tn-line Orientation : 88.40 Degrees from N
Location : C:\Surveys\My_New_Survey
[

Qcancel @ &

Workflow cont’d:

15. Keep the default Yes (import) toggled on, in front of Copy data. Optionally, it is possible to
make a link to the input SEG-Y file in OpendTect.

16. Specify an Output Cube name (by default name of the input file is copied here).

17. Press Import.

a Import 3D Volume = O X

Importing C:\Surveys\F3_Demo_2023\Rawdata\Seismic_data.sgy

Import as|® OpendTect CBVS (copy&import)| O SEGYDirect (scangdink)

Volume subselection |- O Select ...
Null traces @ Discard O Pass

[ Scale values:  Shift/Factor

Qutput Cube |Seismic_data | © select ...| | cBYS ~ [ Depth

(] Execute in Batch Options ...

ErTpo @
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Workflow cont’d:

18. Once the import is finished, press OK on the notification window. Next, OpendTect will

automatically open the option to change the Z-scaling of the newly created survey. Move
the slider to set an appropriate Z scaling factor and press OK.

.
b ]
U 158 P2
e ol | B i 1
~ —rﬂ A0, L! A ol
S ] 7 i Ay
= Information o N\ f 7 -~ H,
I 1 7 r— |
@ Treceis avaiabie orwork ™ S A / o &
= A
The cube has varying cross-line ranges koo » E
| i
In-ine range: 100 - 750 (step 1) ~| 1
X-line range: 300 - 1250 (step 1). et 2 scaling fackor |
Z start:0.004 step: 0.004 | = =]
Number of samples: 462 N TR R 1o scone] @ o Home | L
= | [ELE— T
Gaps: Gaps present cE=1e
J —
e / \ 7\T\‘\_
i / \ SN
/ \ ™
(o 301408 [
3 .
Workflow cont’d:
. . B anage 3D Seismics - a X
19. Check in the seismic manager the
. . O~ Filter |* 5]
newly imported cube; Survey >
. . [ > Seismic_data < ¢
Manage > Seismic > 3D. =
1 (Windows) =UPDATE AVAILABLE a
Survey Analysis Precessing Scene View Utilities TerraNubis Help OpendTect automatically W
47 Select/Setup ... L - 35 5 . A A
Session . St @ marks the imported seismic
. Z Step0 S
& Import ’ 2 volume as the default data. =
£ Export )
| Manage 4 . Attribute Sets ’ =]
|_ Pre-load 3 Color Tables ...
© Restart &, Cross-plot Data... L
16y Bt | Faults A
0 U, FaultStickSets .. &
Faultset ... SEG-Y
~ ) CEnis 1i 100 - 750 [1]
Tn-1line range: - 1
[ M . GEG_r"E“"ZD o cross-line range: 300 - 1250 [1]
P " Horizons ’ Area: 375.31 (sg km)
%, Layer Properties ... [Time range(ms): 4 - 1848 [4]
%, PointSets/Pol storage: 16 bit signed
A W Faultset Pr:l‘mbim_{m::;;‘;mmms File name: Seismic_data.cbvs
— FaultSti.. [Location: C:\Surveys\My New_Survey\Seismics
] @ Geobody ___Random Lines.... size: 540.64 MB
] A well ¥, Seismic Data 4 20 ... Last modified: Fri 20 Aug 2021, 17:01:53
pointset & Prestack Seismic Data » ) — X
d N created by: assia
® D Polygon Sl created at: Fri 20 Aug 2021, 17:00:39
] @ Shapefile I, Stratigraphy ...
& Prestac... A, Wavelets __ = [=]
M |2 Amnotati - 2 g 2 .
é rootations | AsRWeleE Check info on seismic volume; e.g.
%, Machine Leaming v T .
B _ inline/crossline ranges, storage etc.
STL files ...
Mistie Corrections
€ Hozoncue ; o
©° SSIS Interpretations. » Free space on disk: 52.51 GB
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Workflow cont’d:

Tips:

+ Changing the default Z-scale setting manually at any time
+ Saving color settings with the loaded data set

* Manually making a seismic cube the default data set

Changing the Z-scale at any time:

1. Add aninline:

+ Right-click in the tree on Inline > Add and Select Data.

' |In-line!
W Cro¢  Add Default Data

bl Add and Select Data

® vou Add at Well Location

Add Color Blended

« Left-click on the selected seismic data or press OK in

the window that pops-up after step 1.
2. Go to View > Z-scale.

3. Use the slider to change Z. Toggle on Save as default and

press OK.
 25csing oo es
Utilities  Help Set scaling factor
Work Area ...
Apparent velocity (m/s) [} [17378.007
Viewer 2D ... I—I
Fi To H:
Stereo Viewing * 3 Fitto scene | To Home
Toolbars 3

Workflow cont’d:

Saving color settings with stored volumes:

1. Select a color bar.

2. Right-click on the color-bar and select Ranges/Clipping.

3. Change the Percentage clipped and Apply a few times.
When satisfied Press Close.

4. By default, clipping is used meaning every line will be scaled
slightly different. To set the extreme values: manually
overwrite the values next to the color bar and press Enter.

5. Right-click on an attribute in the tree and select Save Color

(& scaling) Settings to save it as default for this attribute.

V475
v

Cross-line Select Attribute r

Z-slice Save Color Settings

Volume Displa v

Random Line > y

2D Line = Remove

-s005 ([ s1ee |1 maegic

= Matteo terrain cube

=1 Mattec ferrain cube red
= Matteo terrain linear

¥ 1 Pastel

=1 Porosity

11 Pressure

w1 Rainbow

1 Rainbow Plus
H'f Red-White-Black
-
Flipped
|_Ranges/Clipping ... |
Manage ...
Set as default

> <

<

-5095

1= RangesrCipring =3 1]
Auio-set scale ranges & Yes Mo

Percertage clipped 05 05

Auto detect symmetry O Yes @ No

Setsymmetical © Yes @ No

Save as Default

9900 | J 000
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Workflow cont’d:

This is just for information purpose and
is not part of the current exercise.

2D Seismics

Manually setting a default data set :

1. Press the Manage Seismic icon and Select
3D Seismics or go to Survey > Manage >

Seismics > 3D.

2. Select a Seismic data set from the list and
click on the Default | [ icon. The default

file is marked by the >< symbol.

The advantage of having a default data set is that it
saves many clicks to select data in various places in
OpendTect. For example in this exercise we used
option “Add and Select " to see the data. We then had
to select the data. From now on we can use “Add
default data” for in-lines, crosslines and Z-slices.

.
2D Prestack Seismics <

3D Seismics ||l

3D Prestack Seismics

@ Manage 30 Seismics

m Filter [+ &

2 > Seismic_data < | 1@
=)
[ ]
o]

- L]
=
L=
)
&
A
o=
e
@ |in-line zange: 100 - 750 (1] 0

Cross-line range: 300 - 1250 [1]

are: 5.31 (sq km)

Time range(ms): 4 - 1948 (4]

e: 16 bit signed
ame: Seismic_data.chvs

Location: C:\Surveys\My_New_Survey\Seismics

Size: 540.64 MB

Last modifisd: Fri 20 Aug 2021, 17:01:53

Created by: assia

Created at: Fri 20 Aug 2021, 17:00:39 v

Dciose | @

Free space on disk: 52.50 GB
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1.2.2b Load SEG-Y

Required licenses: OpendTect.

Exercise objective:

Load a seismic SEG-Y volume in OpendTect.

Workflow:

1. Go to Survey > Import

Seismic > SEG-Y > 3D

>

or click on the SEG-Y import
icon &% in the OpendTect

main toolbar.

7 Survey Analysis Processing Scene View Utilities TerraMubis Help

47 Select/Setup ...
Session
"% Import &
% Export r
I Manage L
ﬂ_ Pre-load 4
@ Restart
O Exit
n— ™I ZSICE
] @ Volume
= Random.
2D Line
N - @ 3D Horl
< 4 2D Horl...
Fault
,’. # FaultSet
mm .| [ Faultst..
® Geobody
e & & well
[ = PointSet
@ - [ Polygon
] [] @ Shapefile

(] B Prestac...
Annotations

s B[]

Attribute Set

Color Table ...

Cross-plot Data

Faults

Faultsticksets

FaultSet

Geobody

Horizons

Mute Functions

Navigation Data / 2D Geometry
PointSets/Polygons
Probability Density Functions
Seismic Data

Velocity Functions

Wavelets

Wells

Pre-Trained Model ...
Shapefile ...

HorizonCube Data ...
Prestack Events ...

= SEG-Y
Open VDS ...
Open ZGY ...

= CBVS
Simple File
Petrel ..

@ GPR: DZT ...

[JRey
L= 1) I
T Prestack 2D ...
& ..

' BR Prestack 3D ...

v

Workflow cont’d:

2. Go to the Rawdata directory of F3 Demo and Select the Input SEG-Y file: \Raw

data\Seismic_data.sgy.

Input file *=wildeard |

Import 3D Seismic Dato

@ Select (one of) the SEG-Y filels)

-

SEG-Y revision

Data format

Number of samples

Z range

Inling range

Cross-line range
X-coordinate range |

Y-coordinate range

Organize ¥ New folder

B Desctop ~  Non

= Dotuments

¥ Downloads

b Music

& Pictures

B videos

L 05(C)

~- Gocgle Drive

= d29 (\192.16

- d25 (W102.16

=x d34 (\192.16

¢ 46 (119216

~x 39 (\192.16

s d52 0N192.16

= users (11921

= dota (NIS2.10
v <

Flle name:

. £3Dem.. > Rawdato > -

Faults

Suriace data
Well_ data
Seismic_data sgy

Seismic_aatasqy

SEG-Y files (*sgy SGY “segy) ~

Open || Cancel

€3 Close

[oam =
[ zeros

(2}
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Workflow cont’d:

3. The import wizard makes a quick scan of part of the seismic volume and automatically fills
in relevant parameters required for import.

Tmport 3D Selsmic Data

Input file *=wildcard | C: vs\F3_Demo_2023\ \Seismic_dato.sqy © Select ... | [#Edlt ...
Coordinate System Projection: [EPSG f?]ﬂ!i] EDS0 / UTM 2one 31N Oselect ..
If needed, the parameters ‘Quick scan result Source Actually use 2
N . SV 1 — il =
required for SEG-Y import SEG Y redsion |1 Eeviiont
Dela format 3 - Integer (16 Lils From file hecder -
(under the Actually Use column) pelio i) ‘ =
Number of samples 462 (600515 traces) From header ~ 462 - oo 3
can be changed manually. R =
7 1ange 0,004 - 1.848 - 0.004 (s or m) From header ~ Start 0.004 Step [ 0.004 b Use I/C
In-line range 100 - 750 From header  Inline (byte 189) - "Inline ~ 4 bytes 5 6 e iy
Cross-line range 300 - 1250 From header  Crossling (byte 193) - “Cr ~ 4 bytes o
X-coordinate range 605835.52 - 629122.55 Calaulated Xedp (byte 181) - "X coor - 4 bytes
Y-coordinate range 6073556.50 - 6090463.28 Calculated Yedp (byte 185) - "Y coo ~ 4 bytes
0.1% 2
[ zeros

In the bottom part, histogram of
seismic amplitudes of traces
used for the quick scan can be

~10000 =5000 o 5000 10000
seen. Vale

®next >>| | QClose 0

Workflow cont’d:

4. Optionally, click on the icon to scan the entire input SEG-Y file.

5. Click on the q icon to examine in detalil, first ‘1000’ traces (changeable) of the file.

@ Impon SEG-Y Data
Import 3D Seismic Data
Input file *=wildzard | C:\Surveys\F3_Demo_2023\Rawdata\Seismic_data say B Select ...

Coordinate System | Projection: [EPSG:23031] EDSO0 / UTM zone 31N

Quick scan result Source Actually use
SEG-Y revision 1 Revision 1 7
Data format 3 - Integer (16 bits) From file header >
Number of samples 462 (600515 traces) From header ~ 462 =
Z range 0.004 - 1.848 - 0.004 (s or m) From header ~ Start |0.004 Step (0.004
In-line range 100 - 750 From header  Inline (byte 189) - "Inline ~ 4 bytes v
Cross-line range 300 - 1250 From header Crossline (byte 193) - "Cr ~ 4 bytes 5
X-coordinate range 605835.52 - 629122.55 Calculated Xcdp (byte 181) - "X coor ~ 4 bytes
Y-coordinate range 6073556.50 - 6090463.28 Calculated Yedp (byte 185) - Y coor ~ 4 bytes
Now in the bottom part, 1% 5
[ Zeros

histogram of seismic amplitudes
of all the traces in the input
SEG-Y volume can be seen.

-10000 -5000 o 5000 B 10000

Ehet>>) (B0 | @

-27 -



Workflow cont’d:

6. Examiner window: e
Use this to find out @seoveant D x
what is inside the file. Fi.ehea.,e,m;;”
cog corl 8 IL; 750 xL; 1250
. . . co9 Corl * 000 7 IL: 750 XL: 300
7. Examiner window: Gl0  Bin s
Use this to find out 5 ST ey T G0 G S
hat is inside the file. |57 ooinsi.. o0, o 1| Dump of EBCIDIC and :
—iine: = 1] i1 ” 70000 F0000
wnat IS Inside the Tile. €15 2z (ms): 4-1848 inf: 4 [ Binary headers Vel
e 1T S —— -—— valug range (29840 | (26623
) c17 In—linerbyte: 189-1p2 Moan/Std devistion [4.17%0 || 2581.6054
8. Check the Inline, G5 eceord byeer T doiabs Wi ==
Crossline and X/Y D SEemibge i o et 26322078 /1
COOI’dinateS N flrld the Trace header informdtiotraces [1000 E tracl (trace sequence number within line)
corresponding byte 1 2 3 c
and observe the ‘[“'“;1 L 2 ) 800 |
. 5 [tracr 1 2 3 ) ‘
associated plot. o 18] FPPS PP Fp o |-
13 [tracf] 0 0 0 .- |
9. Optionally, check 17 [ep] 0 0 0 400 )
Seismic viewer and 21 [edp] L E U 200 '
hist ind 25 [cdpt] 0 0 0 . Trace header Plot
Istogram winaows. 29 (id] ' N . . - P
s EEaEr FEmD & = o 200 400 600 800 1000,
byte position. Trace / Step |1 Sl Z 4 Range: [1,951] (N=1000)
| First 1000 Trace header Nos. (2]
Total traces: 600515 C:\Surveys\F3_Demo_2023\Rawdata\Seismic_data.sgy
Workflow cont’d:
10. Click on Next in the Import SEG-Y Data window.
Input file *=wildcard  C:\Surveys\F3_Demo_2023\Rawdasta\Seismic_date.sqy O Select ... | | Edit ...
Data type (23D Seismic Data
Coordinote System | Projection: [EPSG:23031] ED50 / UTM zone 31N O Select ...
Full scan result Source Actually use <>
SEG-Y revision 1 Revision 1 v ?Sfl
Data format 3 - Integer (16 bits) From filke header v Q
Number of samples 462 (600515 braces) From header ~ 452 > | oo B
2 range 0.004 - 1.848 - 0.004 (s or m) From header » Start | 0.004 Step |0.004 T
In-line range 100 - 750 From header Inline (byte 189) - "Inline numt ~ |4 bytes -~
Cross-line range 300 - 1250 From header  Crossline (byte 193) - "Crosslin ~ |4 byte: ~
X-coordinate range 605416.70 - 629576.30 From header  Xcdp (byte 181) - "X coordinate ~ 4 bytes -
Y-coordinale range 6073556.50 - 6090463.30 From header  Yadp (byte 185) - Y coordinate ~ |4 bytes ~
Hesmting?g‘gﬂﬁy setup 750, 1250‘

100350 10071250 10000 5000 0 5000
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Workflow cont’d:

11. Keep the default Yes (import) toggled on, in front of Copy data. Optionally, it is possible to
make a link to the input SEG-Y file in OpendTect.

12. Specify an Output Cube name (by default name of the input file is copied here).

13. Press Import.

4 @ Import 3D Volume — 0 ¥

Volume subselection |-

Importing C:\Surveys\F3_Demo_2023\Rawdata\Seismic_data.sgy

| | Import as ® OpendTect CBVS (copy&import) IO SEGYDirect (scan&link)

© Select ...

Null traces @ Discard O Pass

[] Scale values:  shift/Factor | [
utput Cu ismic_da v ™) ep
Output Cube | Seismic_data © Select CBVS [] Depth
[ Execute in Batch | Options ... |
port || €3 Cancel e
Workflow cont’d:
@ Manage 3D Seismics = [m] X
14. Close the Import SEG-Y Data O- Fiter [+ 7
window. > Setsmic_data < ¢
(=)
15. Check in the seismic manager the ]
newly imported cube; Survey > W
Manage > Seismic > 3D. L -
=
m Analysis Processing Scenes View Utiities Help k‘
{{2 Select/Setup . LE 2 Th - = - Y] ,%"1} _
Session 2 = = ®
Import 3 =
Export » ;&a
, Attribute Sets . )
{ Preload " | ® Bodies ... @ |in-line range: 100 - 750 (1) &
| e Golor Tables .. CromsLine cange: 3001-11250/(1)
u:—ﬁ_ffgnﬁﬁ‘['-"_ Cross-plot Data -r;en: tanqe:ms)fqi - 1848 (4]
ine s : 16 bi i d
@ | © 30 Honzor PN i fros Eoflertie e
- éD :onzor + Fault Stick Set Location: C:\Surveys\My_New_Survey\Seismics
- aul =, Geometry 2D . s, : 540.64 MB
!q o Saog,;sﬁck = Ho"zon” ) L::i modified: Fri 20 Aug 2021, 17:01:53
: 5 Well ", Layer Properties . Created by: assia
# Pickset |, PickSets/Palygons . Created at: Fri 20 Aug 2021, 17:00:39 v|
3~ gg:’gglgz'“"". Probability Density Functions ... — =
o Ani Random Li - o o q a
s paakne & = Check info on seismic volume; e.g.
@ - & Seismics Prestack ’ E_—’ inline/crossline ranges, storage etc.
o

Free space on disk: 64.88 GB
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1.2.3 Import Horizon

What you should know about OpendTect horizons

e There are two kinds:
e 2D horizons (from 2D seismic)
» 3D horizons (from 3D seismic)
» Each kind has two types:
» Geometric grids
 Attribute grids
« Attribute grids are stored as “Surface Data” with the geometric grid to which
they belong.
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1.2.3a Horizon

Required licenses: OpendTect.

Exercise objective:
Import horizons from ASCI| files.

Workflow:

1. Go to Survey>Import>Horizons>ASCI| 3D

> Single 3D Horizon.

2. In the Import window, select the horizon

©F Survey Amalysis Processing Scene View Utilities TerraNubis Help

as Input Ascii file: \Rawdata\Surface_data\ ..

F3-Horizon- FS6.xyt for example.

A7 selecySelup .. P @
Session v ‘{ B
1% Import ¥ Ausitue set = & "B
2 Bpot »  Color Table
i Manage Cross plot Data '
g2 preoad Faults ,
FaultStickSets
Jregres Faultset .
Hw T Seobody
D@ Volume | Honzons YT Ascn |
& Random.| [k Functions + [T ASCi 3D Single 3D Horizon ...
@5 2DUne | Navigation Data f 2D Geomelry *  From ZMap ... Bulk 30 Horizon ...
| 3% 3pm PointSets/Patygons * T Horizon Data 30 ... —
9 2 30Hon,,  1opabilty Density Funcions  * potrel ..
D Fat " selsmicData ,
ey F::“H Velocity Functions
D Fauitsr,, et
< T Wells
) @ Goobody
S A we Pre-Trained Model ...
1) 2 PointSet Shapefile ...
& | @D Pohgen Prestack Events ...
.’IT @ shapefile HorizonCube Data ..
- Sy Prestac.
HH | > Annotations
[ N
# Import Horizon = E é

Input ASCII File \Rawdata\Surface_data\F3-Horizon-FS6 .t ]e Select ... | Q Examine

Atribute(s) to import

I

Workflow cont’d:

3. Examine the file to determine the
header contents and to check details
for the Format Definition.

Keep this window open to fill in the
Format Definition.

4. Specify the header size (number of
lines): here, set it to No header.

Optionally define attribute(s) to be
loaded as Horizon Data in the same time
as the geometry : use the g icon.

You can add as many attribute as you
need. They will be listed and you can
decide to select them for loading.

Attributes can also be imported and
added to an already existing horizon by
choosing: Survey > Import > Horizon >
Attribute 3D...

File

9 CAODData\F3_Demo_trsining\Rawdata\Surface_data\F3-Horizon-FS6yt - o x

4 # Reload

) Import Horizon

ey

Input ASCII File \Rawdata\Surface_datalF 3-Horizon-FS6.t| | ©) Select... | | Q) Examine

—
.

Adtribute(s) to import

=
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Workflow cont’d:

5. To set the Format Definition, click on Define : assign to each quantity the corresponding
column in the file.

6. Optionally, click on Scan Input File to test the loading parameters.

7. Close the scan report

Specify Necessary Information
Format definition | <Incomplete>

Undefined Value | 1e30

[scan Input File

Position [col:1 5 |col:2  [3] X/Y ™
Coordinate System | Projection: [EPSG:23031] EDS0 / UTM zone = | O Select ...
Area subselection |= Select
Time [col:3 %] Unit s (Seconds) -
@ CASurveys\My Now SumepiProciscon_borzontd o X L stop reading at
o (@ox) Gl @
()van.\:
Workflow cont’d:
8. Specify if the undefined parts should be RS - B
filled: select No. Input ASCII file | Surface_data\F3-Horizon-FS6.txt | |© Select ...| 4 Examine
O
Attribute(s) to import [ o
9. Name the Output Horizon and select a —
%

color for display.

Horizon is in ® Time O Depth

File header |No header v| |-

10. To automatically load the horizon in the 3D Format defnition (RIS e

scene, toggle on the “Display after

. ,’ : Scan Input File

import” option.

Area subselection |- © Select
1 1 . PI'ESS |mp0l’t. Fill undefined parts Yes No
Output Horizon [F3-Horizon-F56__| -] (@ select ...
Tied to Level - ~

Base color | [l | ™ DarkSlateBlue

] 0o @ ©
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1.2.4 Import Well Data

What you should know about well data:

Wells are defined by a well name and a well track.
Optionally the following information can be added:

e Time-Depth Curves.

o Markers.

e Logs.
Time-Depth curves can be modified (stretched and squeezed) in the Well-
tie module (synthetic-to-seismic matching module).
New logs can be created in the Well manager using OpendTect’'s Rock-
physics library and math & logic manipulations.
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1.2.4a Well Data

Required licenses: OpendTect.

Exercise objective:

example.

If you select
Directional or Vertical
Well, you can manually
add the well head
coordinates.

7 Survey Analysis Processing Scene View Utilities TerraNubis Help

e Import Well Track

Input type 'Well Track file (XYZ) -

. L7 Select/Setup ... e e
To load well data from ASCIl and LAS files. docson Bl -1 =
% Import ¥ Attribute Set . ] [Roy |
% Export 3 Color Table ...
| Manage » Cross-plot Data J
42 pedad Fauits '
FaultStickSets r
et FaultSet '
. ') Exit Geobody 5
Workflow: BT 230 o :
> !é ;:T:(:; Mute Functions >
. . e 1 Navigation Data [ 2D Geomets 4
1. First import the well track by  g- 252U  icimmons o
choosing Survey > Import > Wells > g)| Gzom i A S
] aul -
ASCII > Track. Ao | @ Fauset :ZT;Z:“MW '
- E.m Wells » T asci 0 Track ... i
- Ye- Viell locations ... Logs ...
2. Select the Well track file: /Rawdata/ W DA e Bk N
®-| B Prestack Events ... 12 VSR (SEGY) ..
Well_data/F02-01_welltrack.txt  for z ZE;?;;;'IE P e

= a X

Well Track file ell_data\F02-01_DT_TVDSS.txt| © Select ... |\ Examine

File header | No header M &

Format definition | <Incomplete> [£) Define ...

Workflow cont’d:

3. Click on the Examine button.

File header No header

Format definition | <Defined>
First Coordinate (m)
[ Reference Datum Elevation [KB] (m) 0

[] Total Depth [TD] ( m )

‘a
Input type Well Track file (XYZ) ~
Well Track file 1'\Well_data\F02-01_welltrack.bxt
File header No header v| |-
-
[606554 6080126 0 30

606554 6080126 523.6 553.6
606554 6080126 582.9 612.9
606554 6080126 €53.3 683.31

=)

@ Fermat Definition

05“"“'

4, Define the Format Definition for the well track: col-1: X, col-2: Y, col-3: Z and col-4: MD.
The default units are in meters, but can be modified from the drop-down menu.

Spedify Necessary Information

Position [col:1 15| [col:2 2] XJY

|2 Define ... | ————__, Coontinate System (Picfecion [EPSG:230511 D50/ TH zon J (© Sekcr...

[2 [TVD5S]] col:3 % Unit ms (Milliseconds) ~

[MD] [col ] %] unit m (Meter)

[ stop reading at

o

(Eo) (@cos @
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Workflow cont’d:

5. Select the Depth to time model
file: !Rawdata/WeII_data/FOZ- [¥] Depth to Time model file Uen_,data\mz—m;rn.m

01_TD.ixt.

6. Examine the file.

File header Noheader  » | <

7. Define the Format Definition for RS SLShon | sincompisle>
the Depth to time model; col-1:
Depth in m, col-2: TWT in sec.

@ Format Definition

Specify Necessary Information

Undefined Value 1e30

Depth col:1 =) MD ~ Unit \m (Meter) i
Time col:2 = TWT ~ | Unit s (Seconds) ~
[ stop reading at
d -l-oon ||@cancal 0

If you uncheck the
model for this well.

Depth to Time model file, you will be able to add a constant velocity

Workflow cont’d:

8. Is this checkshot data? Tick yes.

Advanced options are optional

9. Provide an output name.

10. Once done, press the Import button.

Depth to Time model file _Nell_data\FOZ—Oi_DT_TVDSS.txt: © select ... O\ Examine

File header No header = B
Format definition | <Defined> Define ...
[T this chedehot da? @ ¥es] O o
Advanced/Optional ...
Output Well |F02-01] | © select ...
[ Display after import Qcose @ ®

-35-




Workflow cont’d:

11. Display the well in the survey:
right click on Well = Load and
select your well.

FaultStickSet

@ Body Select Input Wells

A well =T Filter

* Poin Add ... T =
[ poly A5 Tie Well to Seismic ... =

¥ Shap  Pick New Trajectory ... B B
S\ Prestack Events T = o]
Annotations

e =

..ys\My_New_Survey\Welllnfo\F02-01. well

12. To import the logs files: click on @ Manage Vel - o x
the Manage Well Data icon O« Filter [+ o 0- Log
/#, and click on Import. o201 i
Alternatively, follow Survey > P (=)
Import > Wells > ASCII > Logs. ]
3 &
t
L J
J Tk 5," i ){ 7Y G A Import ... | Create ...
Workflow cont'd:
13. Press the Import button, then select las file: /Rawdata/Well_data/F02-01_logs.las.
14. Toggle MD.
15. Highlight all logs needed to import
16. Select Curve in the name after log
-] Import Well Logs = o X

17. Click on Import.

Input (pseudo-)LAS logs file kdata\Well_data\F02-01_logs.las Q, Examine

Depth interval to load (empty=all) 30 [Bso | (m
Depth values are O TVDSS
Undefined value in logs -999.25

Curve Unit Description -~
1 [+ cALL in Caliper_1 (Caliper)
2 [¥] RHOB g/cc Density_1 (Density)
3 M GR API Gamma Ray_math (Gamma Ray)
4 40T us/ft P-wave_1 (P-wave)

Name log after ® Curve |O Description

Add to Well | F02-01

~| € select ...

et @
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Workflow cont’d:

18. In the well manager, click the Edit
Markers icon.

In this exercise, we will import markers
from an existing file. It is also possible to

add markers manually.

@ Manage Wells - (u] b3
O~ Filter * € 0O~ Log
(] Fo2-01 o |Decau B
[ RHOB
= Dor =)
W Dot 1]
[ UNKNOWN
2
)
< &
t
+
| | [EF % b Gl A Import... Create...
= Edit Well Markers ojl@|a
Name MD(m} TVD(m) TVDSS{(m) Color Regional marker
Marker 1
Marker 2
Marker 3
Marker 4
Marker 5
|update display Export . Z in Feet

Set as regional markers ... [

i

Ocan:ell 9 Help

Workflow cont’d:

 Import Markers = [m] x
19. Select the input file: /RawData/ Well Input ASCII file ‘[a\F()zfmimarkerg._ Q, Examine
_data/F02-01_markers.txt. File header |No header | =

20. Define the Format Definition:

Format definition ‘<lncomplete> | Deﬂne I

Existing markers (if any) @ Replace O Keep

[ Assign random colors tomarkers

@@ Qcancel @

/= Format Definition fo @ ]

Specify Necessary Information

MD E| Depth col:1 = Unit m (Meter) z|
Marker name col2 <

Stop reading at

H QoK |[© cancel| [ @Hep |
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Workflow cont’d:

21. Select / Modify a color for each marker by double-clicking on the appropriate row in

the Color column.

22. Press OK.

23. Once done, close the dialogs and return to OpendTect scene.

‘= Edit Well Markers

Name MD(m) TVD(m)
Marker 1 Seasurface 30 30
Marker 2 MFS11 553.6 5536
Marker 3 FS11 576.02276611 576.02276611
Marker 4 MFS510 683.31 683.31
Marker 5 MFS9 716.65002441 71665002441
Marker 6 MFS8 748.49 748.49
Marker 7 FS8 795.00915527 795.00915527
Marker 8 Name 869.93859863 869.93859863
Marker 9 FS7 942 27575684 942 27575684

Marker 10 Truncation 1051.41040039 1051.41040039

Marker 12 FS6
[Updme dlsptay” Import ... ][ Export ...

Set as regional markers ... [ |

1106 93835449 1106 93835449

TVDSS(m)
0
5236
546.02276611
653.31
68665002441
718.49
765.00915527
839.93859863
91227575684
1021.41040039

Marker 11 Top Foresets 1094.07200030 1094.07200030 1064.97200030 [N

1076 93835449

[&ox ] (@ cancel| [ @ten |

Color legional marke *

-

MEFEEEMEEEEEIE]

<
1

1 Zin Feet

Workflow cont’d:

24.In the scene, display the log and/or
markers on the well : right click on the
well in the tree and follow Display
>Properties.

25. In the left- | center- or right-log tab, select
the log to display and the properties.

a Display properties of: F02-1

Iml Center Log  RightLog Markers  Track
| select log (Gamma Ray y|
Specify data range v [Fp
Log range (min/max) ,07 th [J Logarithmic

26. Open the Markers tab: toggle on the
desired markers and set the marker size
etc.

£ wel
4] F02-01]
& PiokSet
Q goiygon 1 CLAS LogPlot 2D Log Viewer ...
s Prestack [0 1 el 1o Seismic ... Show ’

= Annotations

Create Aftribute Log ...

Franta | an Coke

@ Display properties of: F02-1

Show Amplitude Spectrum »
———————————

LeftLog  Center Log
Marker size |15 -

H =cie

Right Log Track

Marker color [[J use single color
Shape  Cylinder v Height|1 3]
Name size @:l Normal ~ | [ Dynamic
Name color (|| [C3White same as markers
-

Display markers

[ save as Default

W MFS11
W Fs11
MFS10

Apply Current to all wells

ol Save

Reset all

- e
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1.2.5 Multi-Well Import

Different options are available to import multiple wells in OpendTect

(-] OpendTect Pro V6.6.4 (Windows) : tst2del - [Scene 1]

Zf Survey Analysis Processing

Scene  View Utilities TerraMubis Help

. {7 Select/Setup ... 4 == sé’i}f
Session L4
ameon WE _
< Import 3 Attribute Set 3
% Export » Color Table ...
4 I Manage 4 Cross-plot Data L4
.. Pre-load 4 Faults 4
1 R FaultStickSets 4
-
v FaultSet 4
D Bt
— i 3
7 W Volume Horizons
: .;-; random Li Mute Functions L4
. - < 2D Line Navigation Data / 2D Geometry L4
G 3D Horizor PointSets/Polygons 3
- 2D Horizor Probability Density Functions L4
A Fault Seismic Data ’ _@_Qg
. - # FaultSet Velacity Functions »
ick<
ﬁ FaultSticks Wavelets >
1 Bod
® Body Wells v T asco
D | B4 wl Well locati
i PointSet Pre-Trained Model ... el locations ...
Bulk * Track ...
[ Polygon Shapefile ... -
|‘ @ Shapefile R 12 vsP(SEGY) ... Directional wells ...
1 —
: L
& Prestack E Prestack Events ... [ 098
E‘ Annotations Markers ...
Depth/Time Model ...

e Import > Wells > Bulk...

» Track: if the track information of more than one well is in the same file,
use this option. The names of the wells need to be in a column.

» Directional wells: allows for the import of multiple well tracks following
the same principle as for Bulk Well track. In this case, after reading
the file, the well tracks are listed in a table that can be QC-ed and
edited prior to actual import.

» Logs: allows for the simultaneous loading of several LAS files.

» Markers: as for well track.

o Time/Depth Model: as for well track.

Important notice: when you have finished with this Chapter do NOT continue in
the survey you have just created but return to the original F3 Demo data set as
this data set is much richer.

-39-



1.3 Basic Interaction

This Chapter deals with basic interactions. You will learn how to display seismic
data on in-lines and cross-lines, how to move lines in the 3D scene, how to zoom
in and rotate a scene and how to create random lines.

What you should know about the user interface

OpendTect supports multiple 3D scenes.
Each scene has its own Z-axis (time, depth, flattened on a single horizon,
Wheeler-transformed).
There are three interaction modes for 3D scenes, each has its own cursor:
1. Position mode for positioning & moving display elements (arrow
cursor)
2. View mode for zoom, rotate and pan (hand cursor)
3. Interpretation mode for picking and editing data points (cross
cursor).
Each Scene has its own tree from which data objects are added to the
scene and from where they can be manipulated.
The tree does NOT show the entire data base of all stored data in the
survey as in some other software systems. The tree shows which ele-
ments have been loaded or processed on-the fly. These elements reside in
memory and are available for visualization and further manipulations.
Most display elements (lines, horizons, slices) have multiple layers for com-
paring and co-rendering information.
Data for display can be loaded from stored files, or processed on-the-fly.
If you have the memory: use it! Pre-load seismic data to speed up visu-
alization and on-the-fly processing.
Display elements can be manipulated in the 3D scene (right-click menu) or
from the tree (right-click menu).
Seismic sections displayed in the 3D scene also be displayed in separate
2D (flat) viewers.
If you have an OpendTect Pro license: use the basemapto interact with the
system.
Functionality can be accessed via Menus, lcons and short-keys.

Short-keys and Mouse-controls

OpendTect supports a range of short-keys to speed up various interactions.
Mouse controls and a number of short-keys can be modified from the Utilities
menu, option Settings --> Keyboard shortcuts. The default settings of the most
important short-keys and mouse-controls are given in the table below. This table
is also available from the menu Help with the option "Keyboard shortcuts.
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View Mode
Pan Middle Click+ Drag

Rotate Shift + Middle Click + Drag Interpretation Mode
Scroll Wheel

Zoom infout Pick seed Left Click
Ctrl+ MiddleClick + Drag Remove seed/pick Ctrl + Left Click onseed/pick
Activate Polygon Selection |y
Multi Selection v + Ctrl + Left Click
Move Single Selection Left Click+Drag
MNew Shift + Left Click
Finish Double Left Click

Ctrl + Left Click onexisting faultstick (cutside seeds)

Position Mode
Activate element Left Click
De-activate element Left Click outside active element
Draggers —applied to Active Inline, Crossline, Z-slice or Random Line
Browse,/Resize Volume perpendicular-to-plane | Left Click + Drag in Active Volume Faultstick
Resize Left Click+Drag (green) Anchors Select (to edit)
Rotate (if possible) Ctrl + Left Click+Drag
perpendicular-to-plane Left Click+Drag

parallel-to-plane Shift + Left Click+ Drag

orizon Tracking
Tracking menu Ctrl + Right Click
Autotrack k

Retrack Ctrl +k

Lock / Unlock Ifu

Clear Selection E]

Basemap

Inline
Crossline

Random line

Delete Selection d

Show all Shortkeys Shift+?

Save selected object Ctrl+ s

Save as selected object Shift+ Ctrl +5
Undo /Redo Ctrl+ z f Ctrl +y
Toggle / Print 3D graphics stats g/G

Pop up Command Controller Ctrli+r

Toggle between “infull”/ “at section” selected item display

inline/crossline/z-slice HHH“__& o um n ﬂ— l—lm_n.ﬂ ﬂ —\l O
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1.3.1 Tree, Scene & Elements

Each 3D scene has a tree and each tree controls a set of display elements: In-
lines, Cross-lines, Horizons, Wells etc. Via the tree a user controls what is dis-
played in the 3D scene. (OpendTect Pro users can also do this via the basemap.)
Display elements can be toggled on and off and display parameters can be
changed from the tree menu, which is opened by right-clicking on the element.

Section elements such as In-line, Cross-line can be filled up to 8 layers deep with
data for co-rendering. The layers can be moved up and down in the tree. For co-
rendering the user can change the layer's transparency and / or change the opa-
city curve of the chosen color bar.

Display elements can be filled with stored data and data that is calculated on-the-
fly. The latter option is used to test attributes and to evaluate their parameters
before (optionally) computing an attribute volume in batch mode. This way of
working improves efficiency.

Elements Color
Scene 1 Tree g x
--ly In-line
= 425
4Dipste... Il
# Crosstline
w» Z-slice
® voumt Display
- 2p Linl €lement
@ 3D Holtzom
@ 2D Horizon
Fault
Fault Stick Set

@ Body
~ Well

= Prestack Events
+- Annotations
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1.3.1a Display An Inline

Required licenses: OpendTect.

Exercise objective:
Display an inline in the 3D scene.

Workflow:

and Select Data.

1. Right-click on Inline in the tree and select Add

2. In the pop up window, select 4 Dip steered

Scene 1

& in-fine.

¥ Cross-  Add Default Data

P4 Add and Select Data |
@ Volum¢  Add at Well Location ...
7/ Randc  Add Color Blended

median filter.

3. Click OK to display data in the scene.

! Select

Select first layer

@ stored

Steering

1 Original Seismics -
3D UVQ 6 biased Texture+Energy+SystemsTracts E
3D UVQ Texture+HC attribs+ Energy disk

[[‘é} Filter *

4 Dip steered median filter

5 ChimneyCube

7a Al Cube Std

7b Al Cube from HorizonCube

||Q OK ”0 Cancell ( @ Hep ]

Visualization and processing goes faster when you load the relevant data set(s)
into memory. If you do not have sufficient memory to load an entire volume load
only the part you intend to work on. Another way to reduce memory consumption

is to re-scale data to 8-bit during pre-load.
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1.3.1b Pre-load Data

Required licenses: OpendTect.

Exercise objective:

Pre-load data

In the lower-right corner of the
main window you can see how
much memory is free.

2. Click on Add Cube.

[emmzwroy
Workflow: N
. . . SR Avalysis Processing Scene  View
1. Use it only if you have sufficient memory. To Pre- g Soevsanp | pui o
H . ession | S el Al
load a stored seismic cube go to Survey > Pre- iw : =
load > Seismic. Bgon b | Color |
{ Manage v |
T
Exit «4 Horizons
w | W Crossini ® HorizonCube
= Seismic Data Pre-load Manager =R |

5 Add 20 Dataset....

o Unload Checked

2 =

@) @]

Workflow cont’d:

3. Select 4 Dip steered median filter as input cube.

Optionally, specify a volume subselection and the
loading format. Press OK.

To reduce memory consumption:
1) load in a smaller volume range
2) load in a different format e.g. as 8-bit

/= Position [r=el-@ @
" e Specify Position
- | Select | Nr Traces 1000 Scan
(O select .. vﬁume subselection Range E lg.
In-line Range 100 > (750 < Step [1
o oo

E: Cross-line Range | 300 S 1250 = Step 1

2 1 Time Range (ms) 0 < 1848 = Step |4
v

[ G (oot @ )
=
Data format on disk: 16 bit signed. Estimated memory usage: 546,73 MB

= Sami Data Pra-Joad Minager

(===~

401p steered medkan filter

B raacuce..
i ndz0 omaset .
P r—

-44 -




1.3.2 View, Position and Interpretation Mode

OpendTect distinguishes three possible modes of operation for the 3D scene:

» Position Mode for (re-)positioning, moving and resizing display elements.
The cursor in this mode is an arrow.

» View Mode for rotating, panning and zooming. The cursor in this mode
cursor is a hand.

 Interpretation Mode for picking and editing data points. The cursor in this
mode is a cross.

e Ih
Use . or {é j icons to toggle between Position and View modes.

o]

Use oricon to toggle between Interpretation and View modes.
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1.3.2a Position, Zoom, Pan, Rotate

Required licenses: OpendTect.

Exercise objective:

Workflow:

1. Click on shift + the mouse wheel and drag
to rotate your display. To pan the scene
(i.e. move the scene horizontally &
vertically) press the scroll wheel (keep it
pressed on) and move the mouse.

2. Zoom in and out by scrolling the mouse
wheel. Or press Ctrl + the mouse wheel

(keep it pressed on) and move the mouse
back and forth.

Learn how to zoom, pan, & rotate a 3D scene and how to move a seismic line.

Workflow cont’d:

Positioning elements

| Elements
Scene 1

Colot

3. Click on In-line in the tree > Add Default
Data.

4. Select the inline in the tree by clicking on

~ Rand  adq Color Blended
I LB I e ———

iy |In-line,

@ Cross IR

& Z-slict Add and Select Data

@ Volum  Add at Well Location b
7 Survey Analysis Processing Sce

& Il oWy e bn 2T

Exit «4 Horizons
,ﬂ.—l T ‘;llf_s‘-?'“"e #{ HorizonCube .

, fizoo bt 4mmp
the line number 425. |Tres dkens 1 .
L]
- Colo
5. Fill in 250 (the new inline position) line l;
number in the Slice Position toolbar. R | gormine
Use available memory: pre-load 2D, 3D, pre-stack seismic, W e e b L
Horizon and HorizonCube for quicker access. s Tt
Survey > Pre-load > Seismics —
m Analysis Processing Scene Vie =@
&7 SelectSetup L
| Session L3 - ‘ Q b
Import 3
Export r
| Manage
Pre-load o © cione] [ @ Heie |
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Workflow cont’d:

Positioning elements

6. Rotate the view so you see the inline
such that it is displayed from its side' or
'end on' as much as possible in the

scene.

7. Left click (keep the button pressed) on
the inline in the scene and drag it to the

desired location and let it go.

8. Toundo press Ctrl + Z.

style.

If the seismic is pre-loaded the display
is uploaded instantaneously, movie-

Workflow cont’d:

Positioning elements

9. From the tree, right-click on the
updated inline number and select
Display > Position option in the

pop-up menu list.

10. Position the inline at 195 and

click OK.

Scene 1
N Indine
= 05
7 Add
@ Cros IR

= @ Zslic  pyplicate

o™ 92 pocet Man pulation

5 @ Volur  Display Prestack Data »

V| 34 Correlate with Wells ...
| @ Lock Treeitem
~ Ranc

L™ Remove from Tr(_ee

ks Histogram ...

it Positioning

Specify the element's positioj

In-line nr

Cross-line Range 300

| Scroll...

1250 <

Resolution

Z Range (ms) 0 1848 =

\ + Apply |

| QoK ”OCanceI” & Help ]
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Workflow cont’d:

Positioning elements @) Positioning =1 ER %
Specify the element's position
11. Scrolling: Right-click on an In-line e o T
number and select Display > Position.
Press Scroll. Elements are moved either Cross-line Range 300 =) 1250 (=
manually (select Control Manual) or Z Range (ms) [FRAIR oele-

Control scrolling through In-line

automatically (select Control Auto).

Scroll step 1

[@ox (¢

[<< Step Back Auto

© Close | | @Help
12. Default keyboard short cuts to move a Help
slice backwards/forwards are x and z. To Look and Feel
change this go to Utilities > Settings > o e
» ance: »
Keyboard shortcuts. Show Log File ... | Language ,

Workflow cont’d:

Positioning elements
Z-slice

13. In the element tree right-click on Volume - [Volume!
and select Add. This will insert an empty element in the tree. T

\

Add Color Blended
-

Randurmrmre

14. Select a stored volume: right-click on <right-click> and go to Select Attribute
> Stored Cubes > 4 Dip steered median filter.

=-[v] 425
| <right-click> ©u
# Cross-line
& Z-slice
= @ Volume
= [v] 343-506 / 656..

4] <right-clich—c_ "
~ Random Line Select Atribute » 1 Original Seismics
. 2D Line Di Altributes 4 Dip steered median filter

“ 3D Horizon ? Steering Cube * | 5 ChimneyCube

# 2D Horizon 7a Al Cube Std

E:zgsﬁcksgl 7bAl Cul.)e from HorizonCube

@ Body 8a PorosityCube from HC-NN

L Well 8b Gamma from HorizonCube
“ PickSet 9-1 Similarity on FEF seismic
D Polygon 9-2 Dip-steered diffusion filter
S Prestack Events 9-3 Fault enhancement filter

2 Annntatinne

15. Left-click and drag an in-line/cross-line/z-slice, you can then go quickly
through the entire volume.
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Workflow cont’d:

Look at what you have from all sides. Note that the data values are read out and displayed
in both methods (view mode and position mode), these values are displayed at the bottom
of the screen.

Show crossline 1000 in a similar manner.

S OpenalTact 510 VS0 Opre? 2011034 /winba: £3,Demo_2015 - [Scaes 1] = ror x|
sis Processing Scene View Wiities Help -

AT > 53N

[wess (510 50Z) Value = -1970 rea mem) 3.2/7.9.G8 5

Workflow cont’d:

Show a part of a Z-slice at 700 ms TWT

16. Right-click on Z-slice > Add Default Dat fi ]
- - > & (7 eli==L
. Right-click on Z-slice efault Data. -oéoi T
5 ¥ < Add and Select Data
17. Rotate the view so you see the Z slice from s =

above. Shift + Middle Click + Drag. @ Z-slice
] 924]
v 4
18. Make the frame smaller by dragging the green .yogjg T
H d uplicate Docition
handle points of the frame. (If the handles are B4 R e IG“:M;;:S
not apparent click on the relevant slice to  Randc & Lock Treeitem & Properties .
‘activate’ them). @ 3D Ho= Remove flom Tree | pogoiution >

) Positioning o | B[R

19. Right-click on the Z-slice number > Display >
Position. Change Z (ms) to 700 and press OK.

Specify the element's position

In-line Range 100 = 472

Cross-line Range 300 < 900 5

Z (ms) 700 = |[ Scrol .

¥ Apply |

‘OCancel_‘ @ Help |
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1.3.3 Random lines

What you need to know about random lines

* Random lines can me moved (left-click + drag) and rotated (Ctrl left-click
+ drag) through a volume.

» For movie-style inspection of the data it is recommended to load the data
into memory (pre-load exercise 1.3.1b)

» Random lines can be created in different ways:

Easiest: Add default data to get a line positioned in the center of the
volume and start moving rotating

Drawn on time-slices or horizons (OpendTect Pro users can do this in
the basemap).

Through wells: A random line can be created by connecting the
selected wells. By right clicking on the random line in the tree, and
selecting Create from wells, a dialog box appears with a list of wells
that can be selected in order to set up the random line path. This
option is useful for the Well Correlation Panel.

From Existing: This option allows the generation of a random line
from an existing random line. There is an option available to generate
a random line at some distance away from an existing random geo-
metry and store itin a new random line geometry.

From Polygons: allows creating a random line definition from pre-
viously created polygons.

From Table: allows creating a random line in defining its nodes in a
table. Each node is defined by its x/y coordinates and Inline/Crossline
information.
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 Random lines can be optionally saved in the data base.

~ iRandnm_| Tal-¥ |

2D LI Add Default Data
“ 3DH  Add Stored ___
Add Color Blended »
e

[ Polygon
=% Prestack Events

Interactive ..

From Existing ...
From Polygon ..

From Table __.
From Wells ...
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1.3.3a Random Line

Required licenses: OpendTect.

Exercise objective:
Add a random line and move & rotate this through a 3D seismic volume.

~ iRandom. | inpi

Workflow: & ggﬂ Add Default Data
1. Pre-load the stored 4 Dip = e ::j 2‘?'9‘18'-- s
. . 0lor Blende:
steered median filter cube (see Fault

. Fault| New g
exercise 1.3.1b). -

2. Add a random line: right-click
on the tree item (OpendTect
Pro users can also do this from
the basemap).

3. Resize the display element:
left-click + drag on the green
anchors (this is optional but for
the sake of this exercise let's
doit).

Workflow cont’d:

4. Push the line through the
seismic volume: left-click +
drag.

5. Rotate the line: Ctrl left-click +
drag.

6. Push the line through the
volume in the new direction:
left-click + drag.
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Workflow cont’d:

7.

Insert a node: right-click on
the element in the scene, or the
entry in the tree and Select
Display < Insert Node < On
clicked panel

Use the green anchors to
position the node: left-click +
drag.

As before, now push and rotate
the crooked line through the
volume using left-click + drag
and Ctrl left-click + drag,
respectively.

B | Custe20Gid
ﬂ B Saveas.
-—— Save 35 20
m‘ﬁ Correlate with Wells:

S g Lock Tresitem

Hide

=~ (5 Exportto Google KML

== Remore fiom Tree

before clicked parel | 43
a7~ o clicked panel

ater clicked pane!

-53-




1.3.3b Random Line Through Wells

Required licenses: OpendTect.

Exercise objective: @ Zslce
Create a random line through existing wells. "f‘”'fm —

vJ op| Add Default Data
& 3p| Add Stored .
4 20| Add Color Blended *

Workflow: s R
’ Body From Polygon ..
1. Right-click on Random line > ;:f:sa
New > From Wells. ) D Polygon
' Create Random line F]@
2. Select all four available wells and S DX DG
change the well's order = Wl Name
accordingly: F03-4, F03-2, FO2-1, [rezt saect 1 Grarge
FO06-1, using Change order | Foxs =] j 0
arrows. |,
5

3. Press the Preview button to see
the updated geometry in the

Use only wells’ tep position (@) Yes Ne

+| Extend outward (m) 2500

scene.
| =
4. Give a hame to the newly created Outout Random Ling =] © select |
Random line and click OK. 7| Display Random Line on creation

j Ocancel\l @ Help \
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1.3.4 Save & Restore Session

Use Survey > Session > Save.../Restore.../Auto load... to restart your inter-
pretation at a later moment. The graphic scene(s), elements in the tree(s), current
attribute set and neural network are all saved and restored.

When clicking Auto load, choose Enable and then Use one for this survey. Select
one session amongst the available ones. The session will restore itself auto-
matically the next time you start OpendTect.

Elements that contain attributes that were calculated on the fly can only be
restored if the attribute definition is still valid at the time of saving the session. If
not, you will get a warning message stating that the attribute cannot be restored.

Attribute calculations take time. A Session restore will go much faster if you
retrieve the data from disk instead of recalculating it on the fly. So, before you
save a session think whether you can retrieve the data from disk (e.g. a horizon
attribute can be saved as Horizon data with the parent horizon. The same display
can thus be restored much faster if you save the attribute first and then select it
from Horizon data before saving the session).
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1.4 Seismic Interpretation

In this Chapter you will learn basic interpretation tasks such as tying wells, track-
ing horizons and interpreting faults.
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1.4.1 Well-to-Seismic Tie

Tying a seismic volume to well data is a major task in interpretation projects. It is
typically done at the start of a project to determine which seismic events cor-
respond to which geologic markers.

We will assume that all data (inputs for the tie) have been prepared already. The
inputs are:

e 3D seismic Volume

» Aninitial wavelet (if there is none, you can create either synthetic or
stochastic wavelets, in OpendTect)

» Well data (either sonic and density logs, or an impedance log, and geologic
markers)

» (Seismic horizons are optional)
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1.4.1a Well Tie

Required licenses: OpendTect.

Exercise objective:
Tie a well to the seismic and extract a deterministic wavelet.

Workflow: “ Well
# Pick  Add ...
. . ) ) - [ Poly| 45 Tie Well to Seismic ..
. - > <
1. Right-click on Well in the tree > Tie Well to Seismic NPreS  NowWellrack .

Annotatr

Tip:

Well to seismic tie module can be also launched via:

- Analysis > Wells > Tie Well to Seismic...

- Right-click on a well name in the tree > Tie Well To Seismic...

2, Thalweg Tracker
1 Velocity Model Building 4
Well Correlation Panel ...

g Lock Treeitem
== Remove from Tree

“ Survey | Analysis | Processing Scene View Utilities CLAS Help a A Weu'
&7 4L 44 Atributes g @ e B Lk v F06-1
[vl|F03-4
oD i 4z -
- e; = e . . v F02-1 CLAS LogPlot
B : A< EditLogs... ¥ PickSet 4 Tie Wellto Seismic ...
& | W& Layer Modeling ' |4 Tie Well to Seismic ...
° . . > Polygon Create Attribute Log ...
C1 4 ;Iuld Clisnt:vcl ilnder. k i\\\ Pfre?ad‘ Create Log Cube ...
@ | 4 NeualNetworks nnotations g it Welitrack
A8 ssIS v =
w- Save
&
I‘.

Workflow cont’d:

2. In the Tie Well to Seismic window: choose F03-4 well, check the options to be as
shown below and click Run.

@ Tie Well To Seismic - (m] X

Select Data to tie Well to Seismic

well B [Fo3-4 v | (© select ...
Seismic 3D Volume 2
Input Cube *g&3, |4 Dip steered median fiter || @ select ...
Density Density v | lgfec a E
Sonic  Sonic v | lus/ft £ Sonic a E

Use existing depth/time model

Synthetic type Zero Offset Stack ~
Reference wavelet stat 120 | | A, Manage Wavelets ...| |JuExtract ...

Synthetic generation parameters ...

[ save as default

€ Close 0 =)
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Workflow cont’d:

@ Tic F03.4 to 4 Dip steered median filter

Seismic

Synthetic
A
" gi;lg
|| 23332
-
e

NS

T,
ik
o
(;;‘p‘pg -
i
i
2235

Sonic Al
120 140 160 12000 14000 16000 18000
Top Top >
700 00 700 =g 700
750 50 750
= .
500 00 -:— 800 E
g <
E
850 50 850
MFS e MFS;
900 00 900
0.05-0.025 0 0.025 0.05
Reflectiity

Synthetic seismic

Wavelet stat 120 ~ | Polarity @ SEG Positive ) SEG Negative (North Sea) Track Peak or trough
Extracted logs Computed logs NrTreces[s ]
OK/Save info ... Help

Extracted seismic

v [Apply Changes | Undo | IClear picks Clear last pick

Quality Control ... Match markers and horizons

Cancel

Markers are loaded by default.

2

Workflow cont’d:

3. Click on q icon to load already mapped horizons to be displayed on the extracted
seismic traces: Check horizons from Demo 1 to Demo 7 and click OK.

- Tie F03-4 to 4 Dip steered median filter - B “
Some i 08 Ty 15 10 ns 2
A G0 S0 s s a0 sosge || g - i I\..-r
L) Load 3D Horizonts) - © HEM w
Selectinput 3D Horizon (s) a
-  Filter|* 100
(=] ilter Q
Demo 1= MFS4 ~ +
Demo 2 —>FS6 4
Demo 3 —= Top Foresets Il
IE’; [¥] Demo 4 —= Truncation o X
Demo 4 —= Truncation trim & fill X o
Demo 5-=FS7
Demo 6~ F53 E
|[¥] Demo 7 — shallow v
14001 ‘
< >
8/51 chosen
414 Track |Peakortrough ~ | Apply Change I
Display additional -] [Match marke
OK/Save info Help Cancel
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Workflow cont’d:

4. Zoom in using middle-mouse scroll button and pan by pressing middle-mouse button:
hold and drag up/down until you have a display to pick matching events.

- Tie FO3-4 to 4 Dip steered median filter - olEN
Al Synthetics >Seismics i
1 3 3344863 4500000 604 0 ; 10 125 14 =T
i S || 4deh ___i??g?s 495,67 (=]
MFS] MF g} === ig==pe= o = - - L
601 00 6001 600 IR Q
_ _EFEFEE CFRTTE |
: runcalidy femoft > Tuncatiol) 5 Y Q
i oo || 748 700 Fodse: Bno2r op Foresrs 2
os
80 00 8001 800 2 ??2’? \
ii.i {: ezj: ;;;ii “
Mg soo || Mbg - s00 900 '."f."%\?%' q RS e \? o
Moz 2w 202¥n? || Gkmn o ooz ooered | YTSZITWT (ms) Seismic+
Density Refectiity
42 in time Track [Peakortiough =) ApplyChanges Undo  Clearpicks Clear [ast pick
Display additional information ... Match markers and horizons.
OK/Save info . Help Cancel

Al:1e30m/s x kgim3 Reflectivity: 1230 MD:495.46m TVD:495.42m TVDSS:461.32m TWT.484.79ms

Workflow cont’d:

5. Activate pick mode with the icon ©g®

Synthetics< Seismics z

6. Pick matching events on the 59] < e
extracted seismic then synthetic % % % % i s
traces (or synthetic then extracted IO m” |
seismic). ﬁ—?—?—%—?—% o
Tuncap ?% catofy 79N ]

7. Optionally, to change your picks: o0 fior-Forein = Ddhe L =ep Forescs ‘
click Clear picks or Clear last pick if % % % % % % % E
needed. 800} e e e :

= < . Pl

9007

ST5.2ITWT (ms)

Seismic™

Track Peakortrough ~ ApplyChanges Undo Clear last pickg

Display additional information

info ... Help
VD:554.18m TVDSS:520.08m TWT.545.42ms

Match markers and honzons:

Cancel
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Workflow cont’d:

8. After picking the events, click Apply

Changes to reflect the changes. Synthetics< " >Selsr1"éc§ y

0,
4956

9. If not satisfied with the result, click
Undo to revert the most recent step.

ol Y-

.

600 DeRG S > FS/ % % % % %, g

%%??%Tﬁ S T s

As only the previous step can be reverted [ e 5 x
using Undo button, it is recommended to %%% % % % % %% =
save intermediate T/D (Time/Depth) curves 800 :
by clicking on the ij icon and exporting to e ety
a text file. ) )
Saved T/D curves can be (re-)imported at b -
any time via the same window or via Well
Manager. TS ZITWT ms) Seismic+

Track Peakortrough ~ Clear picks  Clear last pick

Display additional information ... Match markers and horizons

info Help
VD:554.18m TVDSS:520.08m TWT 545 42ms

Cancel

Workflow cont’d:

10. Click on Display Additional Information to check the Cross-Correlation Coefficient.

L) Tie F03-4 to 4 Dip steered median filter -0
Synthelics: >Seismics z
3 5965157 0 1=
49561 754195 6 49561 H
MFS [
FSTT 5 '!)
600] 600 Q
@
-
Tapr= 700f *®
E E ...
=
= =1 =
= . 800 =
f % De 02 5FS6 3 3 3 by
- -
MESE fm s e MESE===== I g e T 7=t S-S~ == e
5001 — 00 o 3 900 900 WS S
i e feee ! I I ;A o i- t- =T
— =t
ZF| = == ?
o 210 223501 || SHhanz 0 o025 oosder || ITOZATWT (ms) Seismic—
Density I Reflectmty |
[+ Z intime Track |Peakortrough  -| Apply Changes = Undo | Clearpicks Clear pick
| Display additional information ... | Match markers and horizons
OK/Save

info ... Help
Sonic:458.79837036us/m Density:2165.28588867kg/m3 MD:684.35m TVD:684.31m TVDSS:650.21m TWT.682.92ms

Cancel
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Workflow cont’d:

11. Choose Compute Data between

Markers and select top and bottom
markers, for example FS11 and FS3,
to define a window of interest.
Note that Cross-Correlation
Coefficient, the graph and the
Estimated wavelet are immediately
updated.

12. Optionally, switch to Estimated
(deterministic) wavelet option: see
that the synthetic traces change in
the main Tie Well to Seismic window.
The scaler applied to the seismic has
also changed and should be close to
1.

- Fsa - |

Cross-checking parameters

Compute Data between Markers - Fs11

Setactive Wavelet | Cross-Conelation C oefficient 0.5960489 |

® Initial - stat 120

Estimated

0,69,
0

o J i Iy

. I AMW\

H HU i' u Lt

8
ora o0ra 0 L
Synthetic to seismic scaler: 2836 92285156 0.597

“hoo -100 [ 100 200
Estimated wavelet length (ms) 120 = Lags (ms)
© Close| @) Help
- Cross-checking parameters - olEl
Compute Data between Markers -| |[FS§11 ~||FS3 -

Set active Wavelet :

) Initial : stat 120|® Estimated |

Cross-Comelation Coefficient: 0.6532883

[ Esimared ] .
0
|,
z 0
- DWﬂﬂn M
S ka1 |
ora Onra . H
Synthetic to seismic scaler. 0.98019022 051
00 100 0 100 200
Estimated wavelet length (ms) 120 = Lags (ms)

[Eo] @

Workflow cont’d:

Click on icon to save:

Acoustic Impedance, Reflectivity and Synthetic as well logs or as seismic cubes.
The initial (loaded) and/or estimated wavelet.

Sonic

a Save current data

Check the items to be saved

Tie F03-4 to 4 Dip steered median filter

Log(s) [ Al Reflectivity (] Synthetic

Save as O Log @ Seismic cube
Duplicate trace around the track |1 =

Output Name [~] with suffix | log cube

Wavelet :

Sample interval (ms) 1

Initial wavelet | stat 120

| Deterministic wavelet | Deterministic wavelet from well F03-4

Smhetlcs " Sewsl:‘néc; y %
—
rrrRlC
Lol =
v
1t
(] with well name 2 > o> =
$idd
E
TETT
v‘ GSelect ISmic
v | Bty TR e

atch markers and horizons

) Close e

Cancel

Sonic:458.79837036us/m Density:2165.28588867kg/m3 MD:684.35m TVD:684.31m TVDSS:650.21m TWT.682.92ms
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Workflow cont’d:

13. Click on OK/Save button to save the T/D curve as an active T/D model of the tied well.

" Tie F03-4 to 4 Dip steered median filter - O s
Al Synthetics: >Seismics 2
0 =
7
4354 S0 | 4956 e
MFS| s
FST ‘)
600 500 600 Q
A
2
ol 700 7007 X
-
ve
800 800 800
MES
LI
o 2100 z9s5ry? || a0z 0 0025 00634 975 2UTWT (ms) Seismic
Density I Reflectmity |
[¥ Z in time Track |Peakortrough ~| Apply Changes = Undo | Clearpicks Clear last pick

Display additional information ... | Match markers and horizons

0OK/Save info ... Help Cancel

Sonic:458 79837036us/m Density' 2165 28588867kg/m3 MD:684 35m TVD:684.31m TVDSS:65021m TWT 682 92ms
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1.4.2 Horizon Tracking

What you should know about horizon tracking in OpendTect

There are several horizon trackers in OpendTect to support a variety of work
flows using 2D and 3D viewers. The following trackers exist:

« 3D auto-tracker. This interactive tracker is the primary tool for tracking hori-
zons in OpendTect. It operates in the 3D scene and tracks amplitude dif-
ferences along maxima, minima or zero-crossings. Optionally, the tracker
also tracks using similarity or correlations and using seismic dip (only if you
have a Dip-Steering license). The tracker supports two methods: comparing
with (picked) seed traces and comparing with parents (neighbors). The
seed trace option is used in a work flow in which the user continuously
points additional seeds and QC's the tracked results. First areas with the
largest confidence are tracked before the constraints are relaxed and the
exercise is repeated. Typically multiple passes are made through the entire
data set. Any remaining holes are filled in later stage using a gridding
algorithm (e.g. OpendTect dip-steered gridder, see below). The advantage
of this work flow is that the horizon is QC-ed while you are interpreting and
that you save time on editing. In cases where the event is easy to track the
parent method in which positions are compared against neighbors is pre-
ferred. The tracker extends the horizon further out from the starting pos-
itions but the risk of loop-skipping increases.

» 2D auto-tracker. This interactive tracker is similar to the 3D tracker. The
main difference is that it operates only along seismic sections. The lines are
either displayed in the 3D scene, or in a flat (2D) viewer. Use this tracker to
interpret 2D seismic data and/or to interpret 3D seismic lines in a grid, e.g.
to interpret every 10th inline and crossline.

» 2D line drawing. This option is used to manually pick horizons in areas
where auto-tracking is not feasible.
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» 3D dip-steered tracker. This tracker requires a dip-steering license. It cre-
ates a single horizon from multiple picked seed positions by inverting the
dip field (given in the form of a Steering Cube). This tracker can be used
e.g. to create a quick geologic model with minimal input from the interpreter.

» 3D dip-steered gridding. This tool requires a dip-steering license. This
gridder interpolates holes in a horizon using a inverse-distance solution that
honors the dip field (given in the form of a Steering Cube). The gridder is typ-
ically used to fill in holes left by the 3D auto-tracker and to fill in areas that
were not interpreted (2D auto-tracker).

» Thalweg Tracker. This tracker requires an OpendTect Pro license. It tracks
bodies and horizons either by adding one single position at the time (fol-
lowing the Thalweg: the path of least resistance) or by adding positions to
the edges (margin tracking). It is used for seismic facies tracking, e.g. for
mapping channels, see exercise 2.1.4 in Part 2.
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1.4.2a 3D Auto-track

Required licenses: OpendTect.

Exercise objective:

Interpret a horizon using 3D auto tracking

Workflow:
Survey > Pre-Load > Seismic...

For details on pre-loading see Exercise 1.3.1b.

1. Pre-load 4 Dip steered median filter.

2. Right-click on Random Line > Add Default ~ Random Line

. . . . 2D Line Add Default Data
Data. The data displayed is 4 Dip steered @ 3D Horizon T
median filter in the middle of the survey. 20 orzon Add Color Blanded >
aul
FaultStickSet New 2|

3. Right-click on 3D Horizon in the tree > New >
Auto and Manual Tracking.

@ 3D Horizon
* 2D Horizor Add

. . Fault Add at Sections Only .
4. The Horizon Tracking Setup control center § e forp——
. ody
pops up (next slide).  wel New » || Auto and Manuai Tracking
& PickSet Track Unconformity
[ Polygon Thalweg Tracker

S Prestack Events

Annotations With Constant 2

You can interpret on inlines, crosslines and random lines, in the 3D scene and 2D viewer.

Workflow cont’d:

5. Choose the tracking mode: Section Auto-track (from seeds) and Select Seed Trace as
tracking method.

# Horizon Tracking Settings - <New Horizon1> ol[8=

Mode | Event | Correlation | Properties | DipSteer

- @ Section Auto-track

Manual Draw

o
o Moo i)
) Close| ._Q'_)Help ‘
Method:
+ Seed trace: compares amplitudes against the seed reference (recommended for most
horizons)

» Adjacent parent: compares amplitudes against the last tracked position (increased risk of
loop-skips; recommended for easy horizons).
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Workflow cont’d:

6. Click on the Event tab.

7. Select event type Peak and leave the search window as default for now.

Display after picking a seed

=
Mode | Event | Correlation  Properties  DipSteer

iy |Event type Peak ~| Fwva [vp
- Threshold type Relative difference ~ ( ( ( (
d Allowed difference (%) | 25 E 1
g Search window (ms) |-8 = 8 | [ symmetric
- r 9

Data Display window (ms) |-16 < |16 sl [J Symmetric

Nr Traces |5 & < g g K

Picked on: 4 Dip steered median filter

(=@ ®

+ Use the green lines in the waveform display to change the search window

« |tis possible to change the event type during the interpretation

Workflow cont’d:

8. Click on the Correlation tab.
9. Set the use Correlation toggle to Yes.

10. Set the Correlation threshold to 60%.

Display after picking a seed

) Horizon Tracking Settings - <New Horizon 1> @)=
Mode | Event Properties | DipSteer
) - e rrr
Compare window (ms) -40 T 40 : Symmetric ’ . \’ ’ ’
= ¢ C C (
Correlation threshold (%) 60.0 2] [¥! $nap to Event %
e | | IR

¥ Data Display window (ms) -48 a8 = Symmetric ,W
NrTraces S . Ci < q a

© Close| | @ Help

Tracking with correlation is more accurate, but it takes more time to compute.

-67 -




Workflow cont’d:

11. Set the selection of Steering to No.

= Horizon Tracking Settings - <New Horizon 1> =
o Mode | Event | Correlation ‘ Properties
ot Use Steering ) Yes @ No
m
(474
s
| Close| | @ Help

This option is only available if you have a dip-steering license.

It ensures that the correlation window follows the seismic reflectors by steering the window
along the pre-calculated dip. This option lowers the risk of loop-skips, especially in areas with
steep dips.

Workflow cont’d:

12. Optionally edit the display properties.

) Horizon Tracking Settings - <New Horizon 1>

Mode | Event Correladon DipSteer

Horizon Color

-
Line Width 3
Seed Shape/Color Cube > ‘
Seed Size [ 2
Parents Selections

Locked

© Close| | @ Help

We recommend the Horizon Tracking setup window to stay open during the entire
interpretation session. Parameters can thus be adjust at all times. To re-open the window,
use the $¥. icon in the toolbar in the upper section of OpendTect main window.
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Workflow cont’d:

13. Pick a seed on a Max event (as selected earlier) on the displayed random line.

14. Click on the €% Auto-Track icon in the Horizon Tracking Setup window.

In horizon picking mode, the cursor is a cross. You need to have the horizon active in order to
interpret. You can make it active by clicking on it in the 3D scene or on its name in the tree.

Workflow cont’d:

15. QC the auto-tracked horizon patch:
a. Select the new horizon in the tree.
b. Set the display of the horizon to “sections only”: press the shortcut v/V key.
¢. Move the random line through the patch: click and drag the line.

16. If the horizon patch looks OK but is rather small: change the amplitude correlation

parameters and redo.
In this case, change the correlate window to [-20, 20] ms.

17. Click on the Retrack-All icon €22 in the Horizon Tracking Setup window.

Correlation window [-40;40]ms Correlation window [-20;20]ms
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Workflow cont’d:

18. When satisfied with a patch, right-click on it > Tracking > Lock, so that it can no longer
be changed. Alternatively, Ctrl + right-click on it > Lock.

19. To continue, pick another seed in an empty area and repeat the exercise.

Add L4

Display *

Tracking > Start Tracking
Tools ¥ % Change Settings
Workflows * | v Enable Tracking
Save Lock

Save as Unlock
Lock Treeitem Seeds L
Hide Select Parents

Remove from Tree Show Parents Path
Select Children

Delete Selected Children

Workflow cont’d:

20. Click on the auto-track icon €% to track more from the new seed (previously auto-
tracked horizon patch remains untouched).

Two seeds
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Workflow cont’d:

21. Repeat this workflow (add seeds, auto-track, QC, lock) until you have filled the entire
area with horizon patches of good confidence.

22. Now lower the constraints in the amplitude and correlation tabs.

23. Repeat steps 21 and 22 until the tracker cannot fill in holes any further without
making mistakes.

What to do when something went wrong?
There are three ways to change the results:
* UseUndo ™ and Redo ™ icons, or CTRL-Z / CRTL-Y shortcuts.

» Select the area to remove with the selection & icon and press the % delete icon.

» Use the tracking history to remove all positions (children) following the last good position

(parent). How to do this is explained next.

Workflow cont’d:

How to see the tracking history

24. Right-click in the 3D scene on a bad position on the auto-tracked horizon and Go to
Tracking > Show Parents Path.

25. position on the auto-tracked horizon and select Show Parents Path. Alternatively,
ctrl + right-click on the bad

=% Start Auto Tracking

@ Retrack From Seeds

@ Select With Polygon
Select Parents

s Show Parents Path

Select Children
. Clear Selection

Add
Display

>

Start Tracking ...

Tools * % Change Settings ...

Workflows P Enablge Trackir?g f 8::::3 Selected
& Save Lock Redo
&l Save as Unlock & Lock
o Lock Treeitem Seeds r a Unlock

Hide Select Parents Show Locked

= Remove from Tree Show Parents Path o Save

3 Select Children @ SaveAs ...
I.‘h"

Delete Selected Children = Display Only at Sections
. Show Settings ...
TE

Ctrl + right-click pops up the dedicated menu containing all the tools required for 3D
horizon tracking. This menu minimizes the need to use the horizon tracking set-up window,

e.g. for auto-tracking or re-tracking from seeds.
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Workflow cont’d:

26. The nodes of the random line that appears in the 3D scene shows the tracking path
to the selected position (Parents Path).

BN
“:

Add 4
| Display »
L Tracking 4 Start Tracking
Tools ' | % Change Settings
Waorkflows ' | ¥ Enable Tracking
= Save Lock
# Saveas Unlock
o Lock Treeitem Seeds »
Hide Select Parents
Remove from Tree Show Parents Path -
Select Children
Delete Selected Children

e

Each node (in Green) of the random line, corresponds to a parent seed.

Each parent path is added in the tree under the Random line item and can be saved.

Workflow cont’d:

27. Additionally, the Parents Path random line is automatically displayed in a 2D viewer.
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Workflow cont’d:

28. Locate the parent position where the interpretation went off-track: Ctrl + right-click on
this position on the horizon patch (or in the 2D viewer) and select Select Children.

29. The samples tracked from this bad parent position are highlighted in the scene.
Either, right-click on them > Tracking > Delete Selected Children
or Ctrl + right-click on them > Delete Selected.

4 Display - .

i Start Tracking ...
Tocls * % Change Settings ...
Workflows * v Enable Tracking

wl Save Lock
& Save as Unlock
o Lock Treeitem Seeds
= : — = o — = Hide Select Parents
048 —— - = Remove from Tree Show Parents Path
Select Children

Delete Selected Children

Workflow for “fast” auto-tracking using “Adjacent Parent” tracking method

1. Select Adjacent Parent method in the Mode tab. | Mode | Event | Correlation
@ Section Auto-track

2. Go to the Event tab and Select Relative difference as
Threshold type.

© Manual Draw

Method |Adjacent Parent  ~

3. Define the allowed differences value (in %)

) Horizon Tracking Settings -0 “
. . Mode Event | Corelation | Properties | DipSteer
@ Horizon Tracking Settings - <New Horizon 1> 5 Event type |Max 1 ZFWVA VD
Py Mode Event  Correlation  Properties  DipSteer g Threshold type [Relative difference N \\\]
A Event type Peak v & wva i\
@ i | @3 Allowed diffg
n m » - " o .
o [Theeshold type [Rekative difteranica ~ | senhit Patches tracked with the Adjacent
Allowed difference (%) [5__] _< oaeoipaywl Parent method tend to be much

€ cchwindowms)[8 BB )0 symmetric larger than with the Seed Trace

Data Display window (ms) -16 3| |16 | OJ symmetric mEthOd. espemally ‘If you use
~ — multiple steps (next slide)

Nr Traces |5 B m
Picked on: 4 Dip steered median filter
* >Ja!
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Workflow cont’d:

4. Specify the allowed differences (in %) as shown on the picture. In this example any
sample of the horizon is tracked in at-most 5 steps.

In the first step only 1% difference between neighbors is allowed. If the program is able to
find a new sample in the neighborhood with less than 1% amplitude difference, that sample
is included in the horizon and tracking moves on. Otherwise, the amplitude difference
criteria of next steps are utilized.

Be aware that loosening the constraints too much may result in loop-skips.

Eve.nt type |Peak ™
Threshold type [Relative difference ~ Adjust the amplitude and correlation
Allowad difference (% parameters in case the tracker stops tracking
too soon.
Search window (ms) -20 7 20 <[] Symmetric

5. Follow steps 8-29 of the previous workflow based on the Seed Trace method.
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1.4.2b Tracking In 2D Viewer

Exercise objective:

Interpret a 2D horizon using a 2D viewer

~ Random Line

Workflow: ' 2D Line
@ 3D Hori|  Add... .
1. Add a 2D line to the 3D scene: right-click on 12D Hori|  Create 2D Grid from 3D ...
2D line and go Add Fault Extract from 3D ...
. FanltStickSa
2. Select the Well correlation - Line and change
the action to Load default data. = seeazotines  — 0 NS
LId Fitter *
3. Once the 2D line is loaded, right-click on the | Well correlation-Line |~
attribute name (i.e. Seis) in the tree and go '?
Display = 2D viewer. =
2D Line =
4 [v] Well corr... =
v| Seis =
@ 3D Horizl Select Attribute »
1 20 Horizi Save Color Settings
Fault Display ' |l Histogram .
FaultSticl Remove & Amplitude Spectrum
i° Body T F-K Spectrum
gl i Change Transparency " .
i PickSet = In a 2D viewer, you can interpret
O Palygon = 2D Viewer
S Prestack E T 2D Viewer - Wiggle 2D and 3D seismic.

Worll(flow cont’'d:

2D viewer

20 Viewer - Unetwell correlaton Line - oEm

c eGP -

3D scene

NEEE R

s Distance™

TRHTOB (621012 6096319, 200) VA O (Soe)k  RotSP-1030
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Workflow cont’d:

Elements Calo
4. In the 2D viewer, right-click on 2D horizon and select [ 7 wiggle
Track new. =VD i
~4 2D Horizon!
. . . i Add
5. In the Horizon tracking settings, leave the parameters as FaultStich ’
default @ HorizonC~ Track New ...

% Svstems Tr

6. Optionally, close the Horizon tracking setting window

(=) Horizon Tracking Settings - olEl
'Muda Event | Correlation | Properties | DipSteer

-

(®) Section Auto-frack - . : :
() = Horizon Tracking Settings -0
H O Manual Drew Mode Event Correlation Properties | DipSteer
- Event type Max - wlwWvA_C1vn
Ay it |Alecont Rareni s (] =) Forizon Tracking Settings - oEH|
Threshold type Relative difference - 8 —
- H Mode \ Event = Carrelation | Properties | DipSteer
o~ & Allowed difference (%) 20 o Use Correlation ® Yes (O No Mwva [JvD
- Search window (ms) -8 * 8 = [ sy 8 Compare window (ms) -40 3 40 2 ] Symmetric
¥ Data Display window (ms) 16 216 [2/(]Sy| cum Correlation threshold (%) 80.0 =
Nr Traces |5 S W Data Display window (ms) -48 3 48 |3/ (] Symmetric
Picked on: Seis o Nr Traces 5 8
@ Close || @ Hep

Workflow cont’'d:

7. Pick a seed on a Max event (as selected earlier) on the line.

8. Interpret the full line.
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Workflow cont’d:

9. In some areas the horizon does not propagate well and you may want to switch to the
manual drawing mode.

Workflow cont’d:

10. Re-open the horizon tracking settings: right-click on the <New 2D Horizon> and
select Change setup.

11. Change the tracking mode to Manual Draw and select the Snap to event option. The
event type is defined as previously.

4 420 Horizon || =
I[= —r— -
YD s
au ICKoe!
5 Save as : A = -
& HorizonCube - Horizon Tracking Settings - a8 “
F Systems Tr Change setup ... Mod
ol St
Remove o o~ e . Event Correlation Properties DipSteer
RO (_) Section Auto-track Between Seeds (coming soon)
O |--ju Manual Draw [v] Snap to Evenl]
P Method Adjacent Parent -
-
—

@ Ciose | @Help
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Workflow cont’d:

12. Draw the line where you want to interpret.

Workflow cont'd:

13. Once you are done, release the left-click button from your mouse: the line will be
automatically converted into the horizon and snapped to the Max event.
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Workflow cont’d:

14. When satisfied of the interpretation, 4 ~4 2D Horizon | ==
save the 2D horizon: right-click on <New2D.[ g o ]
the <New 2D Horizon> in the 2D FaukStickSel e
. € HorizonCube ave as
viewer tree and select Save as (at S c
- ! | Systems Tr hange setup ...
this point Save and Save as are Remove ,
equivalent) and specify an output " T
name. ' Qutput selection =5 F=E <

. Qutput 2D Horizon 20 _Horizon| - O Select
15. Close the 2D viewer.

The 2D line and the newly
interpreted 2D horizon  are (@ 0K | [© cancel [ @ Hep |
displayed in the 3D scene.

7| Replace in tree

Note: A 3D horizon as well as Fault stick sets can also be interpreted in the 2D viewer.

Workflow cont’d:

3D horizon interpretation using a 2D viewer
1. The horizon type you are interpreting is 3D horizon.

2. The tracking modes are similar but on the contrary to the 2D tracking, the auto-tracking
option is ON while tracking a 3D horizon in a 2D viewer.

3. For auto-tracking the horizon, recommendation is to use the Seed trace method in
combination with the section auto-track option (see previous exercise 1.4.2a for more
details).

4. In the 2D viewer, while tracking a 3D horizon, you can switch inline/crossline by either
typing the line number or using the arrows and the step to interpret a grid like you would
do in the 3D scene.
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1.4.3 Fault Interpretation

What you should know about faults in OpendTect

We distinguish between fault sticks and fault planes.

Fault planes can be mapped directly from line to line (only advisable for
large faults that can be recognized easily).

Alternatively, faults sticks are picked and stored in a fault stick set from
which fault planes are created by manually grouping the sticks.

In the current version (5.0) you can pick horizontal and vertical fault sticks
but you cannot combine sticks from different orientations.
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1.4.3a Fault Planes

Required licenses: OpendTect.

Exercise objective:
Pick a major fault plane.

Workflow:

steered median filter.

toolbar.

1. Right-click on In-line in the tree > Add Default Data; 4 Dip

Change In-line position and step: enter manually 250 and 10
in the Inline and Step fields, respectively, of the navigation

|
re%l  Add Default Data

& Z-slice Addand Select Data

® Volum  Add at Well Location ...

~ Rand
< 2D Lit Add Color Blended

In-line 250 = Step 10 ]ﬁ >

Click on . to have
an In-line view.

or
ﬂf ' View Cross-line

7' ® ViewZ

==y View North
7@ View North Z

A major fault (highlighted |
with black arrows) is present |-

throughout almost the entire |
| geologic section.

L

In-line 250: 4 Dip 'j‘ -
steered median filter. L

Workflow cont’d:

Display > toggle on Only

5 ¥ Fault ‘
= ) ERENEE — =
[¥] <right-clic

FaultStickSet
® Body =)
L Wel e
= PickSet i Saveas ..
> Polygon o Lock Treeitem

S Prestack Even . Remove from Tree
# Annotations

4. Right-click on Fault in the tree > New.

Add L
Display 4l la Histogram ...

|Faultj

Fault{_Add.
© Body IITETIN
A Well

[ —_—
R <New Fault 1> 8.

at Sections.

4 Properties ...
Only at Horizons

v Fault Planes

v Fault Sticks

v Use Single Color

(¥ <right-clicks ~ Add L
. . FaultStickSet Display L4
5. Right-click on the newly added Fault > Save  ® Bods & Save
as... : pase T
[ Polygon o Lock Treeitem
% Prestack Events| . pemave from Tree
# Annotations
6. Enter an Output Fault name and click OK. -~ Output selection - olEH|
Output Faulll 143a_Fault V| © Select ...
. R vl Replace in tree
7. Right-click on the saved Fault name >

) Cancel | @ Help
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Workflow cont’d:

8. Pick the fault on the first In-line: either Left-click + drag or Left-click to pick and double-
click to end a stick.

9. Edit as needed: Left-click + drag seeds, Ctrl + Left-click to remove seeds, S ‘or Ctrl + Z
to undo the last action, 79 or Ctrl + Y to redo.

il NE - = e
L — To be able to pick faults make sure that:
< | 1) Position mode § is selected.

= e | 2) The fault is selected in the tree.

. 3) E| St|cs icon .« is toggled on.

In-line 250: 4 Dip
steered median filter

Workflow cont’d:

10. Move the In-line to a new location (for example 240): Click on «» in the navigation
toolbar or use short keys (Z and X by default) to move the In-line backward and forward.

11. Repeat steps 8, 9 and 10 for every 10" inline in the range 100-250.

In-line 240: 4 Dip
steered median filter.

G
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Workflow cont’d:

12. Right-click on the fault name in the tree > Display > toggle off Only at Sections, to see the
fault plane in 3D. (Shortcut key: v)

Faurr
-
¥ <right-clic  Add

FaultStickSet -EE_ & Histogram .

® EV?:Y = Save 2 Properties ..
+ PickSet B Saveas v Orl,-atSet:ﬁons
> Polygon a Lock Treeitem nly at Horizons

v Faun F'Ianes
v Fault Sticks

v Use Single Color

& Prestack Even — - Remove from Tree
+ Annotations

13. Optionally display the seismic data along the fault. Right-click > Select Attribute > Stored
Cubes > 4 Dip steered median filter.

Fault
4 1433 Fault

ght-click>

o E‘:':“S“c 1 Original Seismics
Wel\y Display * | Attributes 3D UVQ 6 biased Texture+Energy+SystemsTracts
 PickSet — Remove Sieermg Cube * 3D UVQ Texture+HC attribs+ Energy disk

[') Eu\ygoq N 4 Dip steered median filter

Workflow cont’d:
Fault
Wil 143a_Faull M-
¥ <right-clic ~ Add
14. Don't forget to Save your work regularly. A Eig’;mkw Display
Well
“ PickSet & Saveas..

15. To delete sticks from a fault plane, use Select and Remove O Polygon g Lock Treeitem

. S Prestack Even
icons as shown below. = Annotations Remove from Tree

- o Inid250 SSep1  C4mmp

o | 0Honzn
20 Morizon

Select sticks @and
Remove Selected

to select and remove
fault sticks.

i [=]Fa ~[Croata Singta tow 7] ~] Soeat

In-line 240: 4 Dip
steered median filter.

PR [
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1.4.3b Fault Sticks

Required licenses: OpendTect.

Exercise objective:

Workflow:
1. Right-click on In-line in the tree >
Add Default Data; 4 Dip steered
median filter.

2. Drag inline position to 110 in the
Position mode g .

3. Clickon iy ' to have an inline view.

4. Reduce the displayed area to the

faulted part as shown in the picture:
Left-click + drag the green square
in the upper right corner.

Pick a set of fault sticks and group these into fault planes.

Add Default Data

]
& Zslice Addand Select Data
@ Volum  Add at Well Location ..

~ Rand
< 2D Lit. Add Color Blended

400

Cross-ine —A00

[~~200

In-ling22

M| 9 View In-line

% W& View Cross-line
i ® ViewZ
“=~ b View North
“ 7@ View North Z

N

Workflow cont’d:

5. Right-click on FaultStickSet in the tree
and select New.

6. Right-click on the newly added
FaultStickSet > Save as. ..

7. Enter an Output Fault Stick Set name
and click OK.

8. Right-click on the saved FaultStickSet
name > Display > Only at Sections.

@ Body
L Well
“ PickSet

FaultStickSet
<New FaultStickSet 1>l
@ Body
Lo well
= PickSet
> Polygon
= Prestack Events
= Annotations

Display
= Save
» Saveas..
g Lock Treeitem
== Remove from Tree

3

Output selection

]

Output FaultStickSet | FautStickSet_01

®dGB

| © Select

“l Replace intree

FaultStickSet
o3| FaultStickSet 01]
@ Body
L Well W Save
# PickSet &
0 Palygon il Saveas...

& Prestack Events d Lock Treeitem

# Annotations

ckSet 01 —
& Properties _.

== Remove from Tree

@ Cancel | 3 Help

Only at Sections
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Workflow cont’d:

9. Pick the first fault stick: either Left-click + drag or Left-click to pick and double-click
to end a stick.

10. Edit as needed: Left-click + drag seeds, Ctrl + Left-click to remove seeds, Y or
Ctrl + Z to undo the last action, 7% or Ctrl + Y to redo.

@'Trccsc&\c" ] 5 e ]
Elements Color — . .
: _3435“9"; —| To be able to pick fault sticks make sure that: g
= |G —— ,,[5:;:/:;_”-“'—"-‘#/ 1) Position mode R is selected. |
- | S _ = | 2) The fault stick set is selected in the tree. [
W @158 P - 1
= ¥ 9.1 Similant... ) 5 (]
@ Voume =
~ Random Lire =
M| 2D Line
3 -| = 30 Honzon <
< 2D Horizon
[ ] Fault
®| P e
| ¥ Pickse
E 3;?&%&&%5
@ Arnofations
"‘a‘;‘\ =
inline 110: 4 Dip
- = . steered median filter.
E@ Copy Selectonto - [Faut Create Single New seet. MKW &= ~|

Workflow cont’d:

& FaultStickSet |
-
® Body Display
A Well -
11. Save your work regularly. e " ave
. L S Prestack Events OcK Ireeitem
12. Interpret several fault sticks on inline 110. @ Annotations = Remove from Tree
Tips:
NI - The fault stick closest to the mouse cursor is highlighted with a
8| oo “I thick line. Press Ctrl to make it active and editable.
= @ Inel . . . . .
&1 %% ... .|- Click on a seed of any stick to make it active and editable.
| 2z Press Shift to end a stick (altemative to double-click).
L o L. 19-1 Similant... = P —— — — =
X : :

i

B

® %

we®| &7 [CopySeectionto - [Faut

@ Voume

~ Random Lire

= 2D Line

< 30 Horizon

“ 2D Horizon
Fault
FauliStickSat
[l  auitstickS et 01 ]

@ Body

A well

# PickSel

> Palyaon

35 Preslack Evenis

@ Arnotations
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Workflow cont’d:

13. Move to inline 120: Click on ﬁ» in the navigation toolbar or use short keys (Z and X
by default) to move the inline backward and forward. Continue the interpretation for
several inlines, e.g. with a step of 10.

P

‘

@
<

mm &

A Tl b A TY ¥

Tree scene 1 &
Elements Colof

Scene 1
¥ In-line
¥ 130

¥ 4 Dip steere... 11
@ Cross-line
® Z-slice
¥ 1516
[ 9-1 Similarit... ==
@ Volume
~ Random Line
20 Line
“ 3D Honzon
@ 20 Honizen
Faut
FauttStickSet
C -
Body

Well
& PickSet
[ Palygon
& Prestack Ev
@ Annotations

Select sticks (&7and
Remove Selected
Sticks [ icons allow
to select and remove
fault sticks.

(&7 | Copy Selection to |~|Fault v Create Single New |+

steered median filter.

-Se\ea..xom*—

Workflow cont’d:

We have finished picking sticks. In the
14. Add an empty Z-slice* to the scene and next phase sticks will be grouped into
Drag it to 1500 ms. Click on ﬁ) to have a planes. To facilitate this process we will
North oriented top view and resize with the display a fault discontinuity attribute on
green anchors to cover more or less the a time-slice through the sticks.

area you interpreted.

2 4 1516

3 zisisseps = 4mmp (065 I (095 |w Similarity v = #91Si.. =
Tree scene 1 g~ W ViewlIn-ine
i Elements % | View Cross-line
-.‘ .Stﬁum:nl ® ViewZ
- :E_r;;irme Erasssine—800 | : “'mh View North
| cEm BN View North Z
e- t\if?c;;?:mune B |7 Body
> 20 Line
v @ 3D Horizon
:- - Ezu:onzm — -
B ) osae *Positioning an empty
o IRy slice is faster than
A %5}’%?2&“ positioning a slice with
m | = \nnotations .
B data. With pre-loaded
data the speed
difference is negligible.
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Workflow cont’d:
15. Add 9-1 Similarity on FEF seismic from Stored attribute list.

w\/

BT ——

Observe that separately interpreted fault
sticks can be easily grouped into fault
planes when co-rendered with a similarity
attrlbute on a Z-slice.

Workflow cont’d:

16. Select sticks located along the same lineament by clicking on & icon and:
- Ctrl + Left-click to select/de-select sticks one by one;
- Left-click + drag to select/de-select a group of sticks;
- Ctrl + Left-click + drag around several groups of sticks for multi-group selection.

Draw a polygon
to group fault
sticks located
along the same
lineament.

| Sticks that are

not currently
selected
remain violet.

ve E Copy Selectionto v|Fault v|Create Single New v v| Select .. . x ° |-
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Workflow cont’d:

17. Choose Copy Selection to > Fault > Create Single New and type in a new name in the
toolbar. Optionally choose a fault color. Then click [&.

e’ G?|Copy Selectionto | v|Fault v|Create Single New vIFaurt_mA vl Select El}{‘ TR NG

18. Repeat previous two
steps to create more
fault planes.
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1.4.4 Velocity Gridding & Time-Depth Con-
version

What you should know about Velocity Gridding and TD conversion

» Time-Depth conversion is performed on-the-fly by transforming the Z-axis
of the scene using a given velocity field.
» Velocities are given in the form of:
» Velocity volume.
» The TD curve of the specified well.
» A user-defined linear velocity function.
3D velocity volumes can be created in the Volume Builder.

What you will learn in this Chapter

How to load a stacking velocity function.

How to grid stacking velocities and create a 3D velocity volume.
How to display the volume on the fly and batch processing.
How to batch-process cubes for depth survey.

How to batch-process horizons for a depth survey.

How to set-up a new depth survey.
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1.4.4a Stacking Velocities

Required licenses: OpendTect.

Exercise objective:
Import stacking velocity functions.

Workflow:
1. Go to Survey > Import > Analysis Processing Scenes View Utilities Help
Velocity Functions > ASCII... ——— = - —
Yy {7 Select/Setup ... | =4 "’:_ e g = 0. M > llg, |

to import a velocity function.

Session »
Step 0 : |
Attribute »
Export * | ColorTable ...
Manage * | Cross-plot Data ’
Pre-load * | Fault b
_ Exit Fau_rtStickSets 4
=T"% Zaice | Horizon ' v
- ® Vvolume Mute Functions 4
+| -~ Random Li PickSets/Polygons »
! 2D Line Probability Density Functions *»
o % 3D Horizor Seismic >
B e IZ:EU'I;'O”ZUT Velocity Functions » [e¥ Ascl
:- Faultticks ' ovelets '
. ‘ Body Well »
> gels . HorizonCube surface data ...
v ¥ - PickSef
Prestack Event ...
"> Polvaon :

Workflow cont’'d:
2. Locate the file Velocity_functions.txt in the Rawdata directory and Examine the input file.

3. Select the velocity type: Vrms.

- Import Velocity Function - o IEN
Input ASCII File lawdata\Velocity_functions txt € Select ...

Has statics O Yes ® No

File header No header = |-

Format definition | <incomplete=> Define ...
Output Velocity v © Select ...

@ Import| € Cancel @ Help
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Workflow cont’d:
4. Set File header to Fixed size consisting of 2 lines.

5. Define the format as X-Y-Time-Vrms respectively in column 1, 2, 3, 4.

e Import Velocity Function - a “
Input ASCII File :awdata'Welocity_functions.txt| € Select .| QG Examine

Velocity type Vims -

Has statics © Yes ® No

= Format Definition = (m] x
Specify Necessary Information
Position |col:1 5| col:2 |5 X/Y ~
Coordinate System | Projection: [EPSG:23031] EDSO / UTM zone = | O Select ...

File header | Fixed size =| e
Time |col:3 <] Unit ms (Milliseconds)
Header size (number of Iines) vims |col:4 1=

Format definition ' <Incomplete> [ stop reading at

o [(Sok ocac @

Output Velocity v| O Senn....

@ Import € Cancel | Help

Workflow cont’d:

6. Specify an Output Velocity name as it would appear in OpendTect, e.g. Vrms_function,
and click Import.

o Import Velocity Function - g “
Input ASCII File :awdata\Welocity_functions.txt| € Select .| & Examine

Velocity type Vims -

Has statics O Yes ® No

File header Fixed size | =

Header size (number of lines) 2

Format definition <Defined> Define ...

Output Velocity I Vrms_function "I © Select ...

© Cancel @ Help
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1.4.4b Grid Stacking Velocities

Required licenses: OpendTect.

Exercise objective:

Specify the gridding workflow to grid the stacking velocity functions.

Workflow:
1. Launch the volume builder module accessible from the icon “‘.

2. Select the Velocity gridder step and add it to the Used steps list with the middle arrow.

@ Volume Builder: Setup

= [m] X
Available steps Used steps D
.Geobodv shape painter A [ t
Lateral Smoother H
Smoother ‘
Horizon-based painter - Simple M

Horizon-based painter - Advanced

Velocity gridder

Input Volume »
Voxel Connectivity Filter

WellLog Interpolator

M-GS Destriping

Recursive Gaussian Filter

Sinc Interpolator
| Local Smoothing Filter v

On OK, store As | v | [© select ...

Process on OK €3 Cancel 0

Workflow cont’d:

@ Edit step - m| X
Velocity gridder
Interpolate along Z-slices v
3. In the following window, choose alaolithy
Triangulation as an algorithm type.
Velocity sources
. Add ...
4. Add velocity source.
Remove
Properties ...

Name for this step

© Cancel e
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Workflow cont’d:

5. Choose Type: Stored Functions and select the input function Virms_function that
was imported in the previous exercise.

6. Click OK to proceed.

@ Add velocity function source = O X

Type |Stored Functions | ~ |

Input [Vms_function | | select ...

Ocna | @

Workflow cont’d:

@ Edit step - m} X
Velocity gridder
Interpolate along Z-slices ~

Algorithm | Triangulation ~

Velocity sources

[Vms_function | "Add...
Remove
7. Name this step (e.g. Triangulation of Broperties ...
Vrms function).
Name for this step | Triangulation of Vms function l
8. Click OK. [Ceox J|ocace @
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Workflow cont’d:

9. Store the setup as Grid velocity function.

10. Toggle off Process on OK and press OK.

@ Volume Builder: Setup

Available steps

Geobody shape painter ~
Lateral Smoother

Smoother

Horizon-based painter - Simple

Horizon-based painter - Advanced

Velocity gridder

Input Volume

Voxel Connectivity Filter

WellLog Interpolator

M-GS Destriping

Recursive Gaussian Filter

Sinc Interpolator

Local Smoothing Filter v

Used steps

Triangulation of Vms function

[ Se=
ZL %

On OK, store AslGrid velocity function

| ~](©select...

[[] Process on OK

Eaoow @

Workflow cont’d:

11. Add default inline to the scene.

12. Right-click on it > Add >
Volume Builder Attribute.

13. Select Grid velocity function and press OK
to display the attribute on-the fly.

Elements Color
Scene 1
& [In-line]
DY Add Defaull Data |

& Z-slice Add and Select Data
© Volume  Add at Well Location

~ Rando  agq Color Blended
20 1 in,

Elements Color
Scene1
4 @ In-line
+ (¥)[azs]
B Add Al Attribute
B cros | R ' 9 volume Builder Attribute
;i;;:f; ?:‘ffrf_ti_mrm“. € HorizonCube Display
~ Rando  pisplay prestackData  * BN L
20LIn 4 correlate with Wells ..
@ 1D Ho

41 2DHo B Lock Treeitem

Fault == Remove fromTree

elect Volume Pre

Select Input Volume Processing Setup

Filter
@ Grid velocity function

...3\Misc\Grid_velocity_function.vpsetup
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Workflow cont’d:

The result should be similar to the one shown below

~-400
In-link

Workflow cont’d:

Scenes View Utilities Help
Create Seismic Output » Attributes »

14. Go to Processing > Create Seismic Output > Creale Horizon Output » | 2D <=> 3D v |
3
. (Re-)Start Balch Job Angle Mute Function
Volume Builder. ~ Dip Steering , | P2 Bayesian Classification ...

= GMT Mapping Tool From Well Logs ...

€ HorizonGube o Prestack Processing »
Madagascar VCCRY, M

Volume Builder

y  SSIS C
& T Re-sort Scanned SEG-Y ...

15. In the pop up window, select Grid Velocity function for Volume Builder setup and specify
an output name, e.g. Vrms, and press OK to start batch processing.

@
Volume Builder setupl Grid velocity function v ” © Select | R Create ...
Volume subselection | - © Select ...
Output Cube|| vrms || © select ...| |@ cavs v
Batch execution Single Process ~ |4+ Options ...

S| @
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1.4.4c TD Conversion On-the-fly

Required licenses: OpendTect.

Exercise objective:

Workflow:
1. Go to Scenes > New [Depth].

Create a depth scene and perform velocity conversion.

Vwew Utilities  Help

New
New Map View

|

New [Depth]

New [Horizon Flattened] *
¢ New [Wheeler]

Cascade
Tile r
Properties ...

Save scene to 3D PDF  +
v Scene 1

2. Awindow pops-up asking you to select or create a velocity model. Click on Edit...

0 Velocity model

Select velocity model to base scene on

Z transform  Velocity volume

-

Velocity model (m/s) ié " | Velocity model (INT)

Depth Range (m) [0

|10 Jsep[d ] &

S[EE=

) Cancel | | (g Help

Workflow cont’d:

= Specify velocity information [o & e
Velocity cube [y i) Velocity model (RMS) v
Velocity type Vims 1=
Has statics Yes 9 No

© Cencel| | @ Hep |

5. Press OK in the Velocity Model window and a new depth scene will appear.

@ Velocity model -

Select velocity model to base scene on

Z transform  Velocity volume -
Velocity model (mvs) k! [ [ Velocity model (INT) -] |© select
Oept Rang () 0 ]
[E] o~

3. Select the velocity cube i.e. Velocity model (RMS) and specify the velocity type (RMS).

4. Press OK and OpendTect will scan the file to compute the depth range for the new scene.

Edit

@ Help
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Workflow cont’d:

6. In the depth scene, display any stored volume on the inline 425. You will notice that the

scene now shows data in depth, which has been converted from time data using the

interval velocity you, selected. This is done on-the-fly.

QHeNEEEES ,
iy &7 on Pl o B nEoHQEBENY A nna SERY

h Tree scene |

2 | Seone 1 =
Blements [

24| & Depth (using VeloatyT20')
a0

T Smnel

ks

e £ 4 Dip stoered median filer 11
@ s o

A Deiae
=@ volume

N 37 ransomine

§| Friowe

@@ 30 Horizon

I. q »

~

NN - | Tree scens 3 L)

Eloments
s Depth (sing VelodhyT20')
@~ @0 hie
v 345

34 Dip stocred modian fier 11
} @ Crossoe

M@ Zsice
E @ Vohume:

= =]

[ Random Lne:
5 20 Lne

M 30 Horizm

[free mem) 20.0/314 G5 ‘
'

Workflow cont’d:

Conversion of Vrms to Vint

7. Go to Processing > Create Seismic output > Velocity > Velocity conversion...

NS scene View Utiities Help
| Creale Seismic Output » Aftributes

Creale Horizon Output * 2D <=> 3D

| A Wells v Angle Mute Function ...
(Re-)Start Batch Job ... Pt Bayesian Classification ...
+ Dip Steering , From Well Logs ...
! e GMT Mapping Tool .. Pres1ck Processing v
'@ HorizonCube E rsm" :
5 = [ Velocity Comersion -__|
= I\S.:jsagascar ) Re-sort Scanned SEG-Y ... - =

8. Fill the fields as shown below and click OK.

| Execution Options ...|

 Velocity conversion =N EoR =]
Velocity conversion
Input velocity model i) [ Velocity model (RMS) | [& Select -] | Edit... |
Area subselection - © Select .|
Output velocity type
Output Cube [ Vin ] [© sewct .| @ cavs
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Workflow cont’d:

- - . . . Elsments Color
9. Right-click on an inline in the scene > Add and Select Data. Scone 1
r. I(?;S:S\ Add Defaut Data
. . © Zsice
10. Select the new converted interval velocity. @ olume - dd al Wl Localon
20 Line MderB\end_sd
= Select L) [t “ 3D Horizon
Select first layor d ﬁgﬂnmzoﬂ
e[ fo g Soiy
Steering _jux_fotest_DELME b
e Ty
AIDUtoS Welocity model (RMS)
Vit
\ug . Nozel Test
Firer *
| QoK | @ cancel | @rep
11. Right-click on an inline 425 in the scene > Add > Attribute.
12. Select the rms velocity to compare.
i Select L) ] ‘I:TB;:ZI
Selact first layer L IJ"E‘E% —
gp e ]
@ Stored 2:\?,:[);:07‘::[&” T :;".““j play by Volume Processing Atrbue
Steoring m:f;!} w‘:\i‘_’DElME ."}T\‘,:: = o H;:::T:;::::m
s IR — 2 Dt Prosck O »
T \ model (RMS: @ 3p i Correlate with Wals ..
= el ¥ ' s tom o
Fiker * e

| QoK | ©@cancel | @rep

Workflow cont’d:

Velocity model (RMS) |

Velocity model (INT) |
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1.4.4d TD Volume Conversion In Batch

Required licenses: OpendTect.

Exercise objective:

Workflow:
1. Launch the time-depth conversion dialog.

|Prncessing Scenes View  Utiities Help

Create Seismic Output 3

Atftributes

Create Horizon Output L4 2D <=> 3D

(Re-)Start Batch Job ... Angle Mute Function ...

% Bayesian Classification ...

Dip Steering »
Fault Extraction ... FromWellLogs ...
@  GMT Mapping Tool ... Prestack Processing
@  HorizonCube > Velocity
§ Madagascar .. Volume Builder ...

Use the velocity volume to time-depth convert volumes in batch mode.

o | e A4
o 30 ‘L_- =
LT =

I 1 Seismics

Time - Depth Conversion ...

Velocity Conversion ...

In general, the depth volume does not change laterally from the original cube
(thus InL/XL step stays the same) but the depth Z range can be larger.

Workflow cont’d:

3. Define the depth range and the step

4. Select the Time volume to be converted

2. Select the Velocity Model (in this case, Velocity Model (INT)).

# Time to depth volume conversion

Time/Depth conversion

Direction @ Time to Depth O Depth to Time

Z transform Velocity volume -

Velocity model (m/s) lé B, | Velocity model (INT)

Depth Range (m) | 0 [2100 | step [4] |

Input Time Volume -é} *bl 4 Dip steered median filter

Area subselection ‘

Qutput Depth Volume ‘

.+ Execution Options ...

- a X
~| © setect | | Edit
vl © Select ...
‘ ) Select ...
~| © Select ...| @i cBVS -
@ Cancel | | (g Help
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Workflow cont’d:

5. Specify the new output depth volume (e.g. D-4_DSMF).

6. Click on Run. The volume will be saved in depth and stored in the time survey

=
Direction ® Time to Depth O Depth to Time
Z transform | Velocity volume ~

Velocity model (m/s) “‘g |Ve|ocity model (INT) v \ |© Select ...| | Edit... |

Depth Range (m) |0 2100 Step |5

Input Time Volume ‘E} |4 Dip steered median filter v ‘ | © Select ...
Area subselection | - © Select ...
Output Depth Volume [D4_DSMF ~ |i0 Select ...| 5 CBVS v

.+ Execution Options ... |

(G 0o @

Workflow cont’d:

7. To display the new depth volume, go to the depth scene. Click on the scenes,
Select New [Depth].

8. Anew window will pop up, Make sure all inputs are correct, and then Press Ok.

@ Velocity model — O x

Select velocity model to base scene on

Z transform  Velocity volume v
Velocity model (m/s) *g& |Velocity madel (INT) v |(© select ...| [ Edit ...
Depth Range (m) |0 2100 Step | 5|

[E oo @
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Workflow cont’d:

Elements Color

9. Right click on inline > Add and Select data

Add Default Data

Add and Select Data

@ Volu  Add atWell Location ..
~ Ran  agd Color Blended

W Cro;
& Z-sli

10. In the pop-up dialog, Select the depth volume.

11. Hit Ok, and a new depth volume will be displayed 2D Larrgepp
5 Deptn (wsing Neloay 2Dy . e @ select = m| X

Select first layer

O stored D-4 DSMF

O Steering

Attributes

|9CanceI: o
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1.4.4e TD Horizon Conversion In Batch

Exercise objective:
Use the velocity volume to time-depth convert horizons in batch mode.

In order to display the horizons in depth survey we will need to first export them
from time survey using velocity model.

Workflow:

1. Go to Survey > Export > Horizons > ASCII 3D.

L‘;Jm Analysis Processing Scene View Utilities Help

|4z selectiSetup .. 'y e EEE, g
perd ) SEG-Y

Session L
p— vt Elammp o e Jrases
[ Bt + [ N
Manage L FaultStickSets 4
Pre-load g Geometry 2D
it T T scio .
i »
g Mlute Functions ASCII 3D ...
N 425 PickSets/Polygons 4 PetrelDirect  *
= ~k [] |  Probavility Density Functions » |
W Cross-lin  Seismics »
-a ,

¥ Zslice | Wavelets

Workflow cont’d:

2. Select an input Demo 0 --> FS4.

@ Export Horizon - (m] bd
3' Set the OUtpUt type to XN Input Horizonlmi v||© Select ...
o -
Horizon Data
Area subselection  100/300-750/1250 (463 samples) O Select ...
Coordinate System | Projection: [EPSG:23031] ED50 / UTM zone 31N © Select ...

Write Z ® Yes O No Apply Time-Depth conversion O Yes ® No

Z Unit ms (Milliseconds) v
Header No ~
Output ASCII file © Select ...
oo @
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Workflow cont’d:

4. Set Write Z "Yes’ and Apply Time-
Depth Conversion ‘Yes’

5. Select Depth conversion: Velocity
volume.

6. Select Velocity model (m/s): Velocity
Model (INT)

7. Z-units: set them to meter.

8. Give a name to the Output ASCII file
and Export (by default
it will be store in the survey main
directory).

Note that if you have already calculated
attributes in time survey, you select
some or all to be exported in the white
rectangle.

@ Expont Horizon - (m]
Input Horizon | Demo 0 --> FS4 v || O Select ...
Horizon Data
Area subselection | 100/300-750/1250 (463 samples) O Select ...

PN i —

Coordinate System | Projection: [EPSG:23031] EDS0 / UTM zene 31N

Write Z @ Yes O No |£p_ply Time-Depth conversion ® Yes | ONo
Dot comersion| ERRETEEN S
Velocity model (m/s) ‘E>|Ve\ucity model (INT) ] (©Select ... [ Edit...
Z Unit m (Meter) v
Header Mo i
Output ASCII file | Demo 0_FS4 |(©select ..
€ Close 0

O Select ...
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1.4.4f Setup Survey For Depth Converted Data

Exercise objective:

Workflow:

Icon.

1. Go to Survey > Select/Setup...> or click on this Q Import

B Analysis Pr
Select/Setup ...
Session r

»
Export 4
Manage 4
Pre-load 4

Exit

5 Survey Setup and Selection
) Survey Data Rool .| K vicloria'surveys

F3_Uemo_2015_training_course

Set up a new depth survey to work with depth converted data (e.g. seismic, horizons etc.).

ymem

6. Click Next.

F3_Demo_Depth.

4. Choose Copy from other survey.

5. Select Depth for Z Domain and Meter for units.

Specify new survey parameters

Survey name ([F3_Demo_Depth|

Available data [+ 3D 2D [J wells

Initial setup ! Scan Navigation Data

|% Copy from other survey |
T Read from Survey Setup file
ves Scan VDS file

%Y Scan ZGY file

i Scan SEG-Y file(s)

B Scan LAS Well Data

Get from Petrel
J Enter by hand

Z Domain O Time
Depth unit O Feet

G
2. Clickon g iconin the Survey Setup and
Selection window.
[ select| [ Concel [ g st
Workflow cont’d:
3. Give a name to the new depth survey: @ Create New Survey - 0o X

-I €3 Cancel o
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Workflow cont’d:

7. Choose the time survey and click OK.

s N
) Survey @M
Select Survey
Filter | *
F3_Demo_training -

m

@ cancel || @@ Help

Workflow cont’d:

8. Change the Z range: 0-2100,
step 5 in meters.
9. Click OK to create the survey.

@ Edit Survey Parameters

Survey name | F3_Demo_Depth
Location on disk | C:\Surveys
Survey type Both2Dand 3D
Ranges/coordinate settings Enter below .
2 1/C to X/Y transformation <% Coordinate System

-\ Survey ranges '@ Coordinate settings

In-line range :100 3: 750 < Step 1 + Nr. In-lines: 651
Cross-line range 300 11250 |7 Step 1 + Nr. Cross-lines: 951
Z range [0 2100 Step |5 ] meter ~
Display depths in Meter Feet
Seismic Reference Datum (m) |0
= Apply

Free space on disk: 17.91 GB
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1.4.4g Import TD
zons

Converted Volumes And Hori-

Exercise objective:

Workflow:

Import the newly time-depth converted volumes and horizons into the new depth survey.

Here we assume that the time-depth converted seismic volume is saved in OpendTect’s
native CBVS format, in the time survey. We are working now in the depth survey.

1. Survey > Import > Seismic > CBVS > from file....

127 Select/Setup ...
Session >

Manage >
Pre-load U

1
{  Exit
[T~ Random[C
= < 2D Line
“ 3D Horizor
- @ 2D Horizor
- Fault
Fault Stick
¢ ® Body

b Well
= Pickset
[> Polygon

3 = PrestackE
- | Annotations

'j-,' Analysis Processing Scenes View Utilities Help

f‘;;;“_-@:«-;‘«e.___..“.,.Ga% L & oo 9
Attribute L
ColorTable ...
Cross-plot Data »
Fault L
FaultStickSets »
Horizon »
Mute Functions L
PickSets/Polygons »
Probability Density Functions *
T Simple File > |
Velcky Functions >
Wavelets > |[& PetrelDirect » M’
e * | @ GPR: DZT..
HorizonCube surface data ... = SEG-Y
Prestack Event ... 7 SEG-Y Data Link ...

Workflow cont’d:

4. Keep the default Use in

2. Click on Select and browse to the location of F3-Demo (Depth survey).

3. Select the depth volume that was created in the exercise 7.4.4.e (D-4_DSMF.cvbs).

place option (which means the physical location of the stored

volume will remain in the time survey).

= Import CBVS cube - olEN|
(First) CBVS file name|W:\F3_Demtheismics\D-4_DSMF.cbvs | © Select ..
Cube type Input data cube v

Import mode © Copy the data [® Use in-place

Output Cube [D-4 DSMF |+ © Select... [ Depth

</ Run | 8 Close | @ Help
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Workflow cont’d:

Similarly, import horizons: Survey > Import > Horizons > ASCI| > Geometry 3D...

[ZJEMAE Analysis Processing Scenes View Utiities Help
T - N N
{7 Select/Setup ... P| = ""; 5 = g o Q M > % ll{‘ n. it | crl
] Session 4 I
Attribute »
| Export * | ColorTable ..
Manage ' | Cross-plot Data »
{ Pre-oad ’ Fault 3
| Exit FaultStickSets %
-~ ~ Random L . ASCII 4|  Geometry 2D ...
/2D Line | MuteFunctions * [ PetreiDirect * LR
- : 3D Horizor  PickSets/Polygons YT Attributes 3D _
9- '%I;)ul;orlzor Probability Density Functions + Bulk 2D
Fault Stick| Seismic 4
<4 ® Body Velocity Functions 4
n A Well Wavelets v
* Pickset Well »
: - O Polygon
= Prestack B HorizonCube surface data ...
@@ | Annotations Prestack Event ...

Workflow cont’d:

XY = | Position col:1 2 col2 %

Z col3 1 Unit |m (Meter)

5. Click on Select and browse to
the location of FS4 horizon.

6. Press on Define to specify
the necessary information for import,
relating columns with XY and Z.

7. Give the output horizon a name and
press import.

#® Import Horizon [
InputASCII File YF3_Demo_2015\Demo 0_§S4 | =) salau...l Q, Examine|
Attribute(s) to import [
=)
© 1
File header | Noheader | | <&
Format definition <Defined> | Define ... |
|Scan InputFile|
Arsa subselecion O sl
Fill undefined parts ) Yes @ No
output HorizonIDemo 0_Fs4 v [© seleat I [ asB -
Tiedto Level | — .
Base color [N [ M Crimson -
| Display after import
| EE Irnpod][ ) Close Lo Help
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Workflow cont’d:

8. Right-click on 3D Horizon > Add.

j Survey Analysis Processing Scene View Utilities Hel

™ Ly o gy
Q Adl = ‘ L\. L
Cross-ine 0 Step o
Tree scene 1 [
Q Elements Color
< Scene 1
W In-line
a4 # Cross-line
@ Z-slice
= | ® Volume
~ Random Line
& 20 Li
@ 3D H
O | 2oron
Fault Add at Sections Only
v ° EE‘Q“ST‘C' Add Color Blended
ody
Qg Track New
" PickSet Create with Constant Z

n . D Palygon

ﬁ #- Annotations

=y Prestack Events

¥

Workflow cont’d:

9. Select the just imported
FS4 Horizon.

10. Press OK.

r
9 Select Input Horizon (s)

{G\Elﬁ‘

v Filter *

[[#) Demo 0_Fs4

=S

Area subselection 425/300-425/1250 (421 samples)

...F3_Demo_Depth\Surfaces\Demo_0_FS4.hor

()
)
[ @ o« ][O cance| [ @ Hen |
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Workflow cont’d:

11. FS4 Horizon is displayed
in full in the Depth survey.
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1.5 Attribute Analysis & Cross-plots

What are seismic attributes?

Seismic attributes are all the measured, computed or implied quantities obtained
from the seismic data. The two main reasons for using seismic attributes:

1.

2.

Visualization (qualitative)
» Toremove extraneous information in the hope of revealing trends or
patterns not visible in the original data.
Data integration (quantitative)
» To obtain information carriers from different sources that can be integ-
rated by statistical methods.

What you should know about Attributes in OpendTect

1.

2.

B w

oo

Attributes can be computed from post-stack 2D and 3D data and from pre-
stack data.
Attribute definition and computation are two separate steps:

» Step 1: Define how to compute the (2D or 3D) attribute in the cor-
responding “Attribute Set” window (input > algorithm > parameters >
output).

» Step 2: Compute the algorithm either on-the-fly on the display ele-
ment of choice (inline, crossline, Z-slice, horizon, sub-volume, point-
sets, fault plane, 3D geobody), or in batch mode to create an attribute
volume (via the Processing menu).

Attributes can be chained (output attribute 1 is input to attribute 2).

You can create your own attributes using chaining, mathematics and logical
manipulations.

Attribute parameters can be tested in a movie-style manner.

Attribute time gates (vertical window) and step outs (lateral step in multi-
trace attributes) are specified relative to any evaluation point (x, y, z) where
the attribute is to be computed (Step 2, see above).

A time-gate of 30ms that is defined as [-10, 20] means the software will
extract data from a time-gate between 10ms above the evaluation point to
20ms below the evaluation point. The extracted data is resampled to
sample rate defined in the survey.

Filters are a just another group of attributes, hence are treated as attributes.
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What attributes are supported?

Since it is possible to create one’s own attributes using chaining, math & logic the
number of attributes supported in OpendTect is without limit. To put order in the
attribute maze, dGB supports an Attribute Table on their website. The table maps
attributes versus application domains and is ordered in attribute classes.

Please note that will find both free and commercial attributes described in the
table. OS (Open Source) labels attributes offered in the free functionality.

Amplitude-based

Attributes Information
Energy « Description: sum of Amplitudes Squared in a time-gate
« Plugin: 0S, 0D

« Stratigraphic: highlights packages with different reflection strengths
« Siliciclastics: energy may correlate with lithology & porosity

« Fluids: enhances Bright Spots

« Other: use Sqrt output option to control output dynamic range

» References

Scaling « Description: various functions to correct amplitudes vs. time

= Plugin: 0S, 0D

« Structural: scaling can be tuned to facilitate structural interpretation

« Fluids: AGC time-gates smaller than 500ms should be avoided in quantitative interpretation
« Other. do not apply in workflows that require preservation of original amplitudes

« References

Event « Description: quantifies the shape of an event or relative distance between events
« Plugin: 0S, 0D

« Structural: useful to determine horizon quality

« Stratigraphic: useful inputs for 3D NN facies classifications

« References

Strata « Description: returns statistical property (min, max, sum etc.) of an attribute in an interval defined along one horizon or between two horizons
Amplitude « Plugin: 0S, OD

« Stratigraphic: useful to characterize intervals

» References

Frequency-based
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The application domains (organized in columns) are:

Structural
Stratigraphic
Siliciclastic
Carbonates
Fluids

Noise
Others

The attribute classes (rows) are:

Amplitude based
Frequency based
Multi-trace based
Impedance based
Dip & azimuth based
Processing & Filters
Meta-attributes
HorizonCube & SSIS
Pre-stack attributes
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The following list shows which attributes are useful for a specific task.

* Noise reduction:Dip Steered Median Filter, Frequency Filter, Gap Decon-
volution

» Frequency enhancement (spectral balancing):Seismic Spectral Blueing

» Fault detection:Similarity, Fault Enhancement Filter, Ridge Enhancement
Filter, Curvature, Dip, Variance, Fault Extraction

» Fracture prediction:Curvature, Azimuthal AVO, Fracture, Inversion to
Anisotropic Parameters

» Layer thickness estimation:Spectral Decomposition, Instantaneous
Attributes

» Porosity estimation:Deterministic Inversion, NN Rock Properties Pre-
diction

» Net-pay:Seismic Coloured Inversion, Stratal Amplitude, Net-pay

» HC presence detection:AVO Attributes, Frequency Attenuation, Energy
((far-near) x far), Sweetness, Fluid Contact Finder, Seismic Feature
Enhancement

» HC saturation estimation:Gas Chimneys, Three Term Inversion?

» Oil vs. Gas prediction:Gas Chimneys, Three Term Inversion, NN Clas-
sification, Spectral Decomposition

» Predicting Clastic Lithofacies (sand-silt-shale):

» Simple:Energy ((far-near) x far), Frequency, Phase
» Advanced:Waveform Segmentation, Volumetric Segmentation,
Fingerprint, Deterministic Inversion, NN Rock Properties Prediction

» Predicting Carbonate Lithofacies:Waveform Segmentation, Volumetric
Segmentation, Fingerprint, Deterministic Inversion, NN Classification

» Mapping seismic geomorphology: Lithology (see above): Similarity
(indicates erosional incision), Dip Attributes, Spectral Decomposition
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1.5.1 Bright Spot Detection and Visualization

What you should know about bright spot detection OpendTect

Bright spots are seismic anomalies that are often related to hydrocarbons. How
the seismic response varies as a result of a change in fluid-content depends on
the geologic setting and rock-physics / fluid properties. Forward modeling helps
to increase the understanding of the seismic behavior as a function of changes in
rock and fluid properties. such understanding is important for selecting the
optimal attributes and tools for qualitative and quantitative analysis of bright
spots.

OpendTect offers a range of pre- and post-stack analysis tools to investigate
bright spots, especially in the domain of commercial plugins. Examples are seis-
mic inversion plugins and hydrocarbon anomaly enhancement techniques such
as Fluid Contact Finder and Seismic Feature Enhancement.

Seismic attribute analysis is a simple and effective tool to enhance bright spots
and to study their areal extent in 3 dimensions. In the exercise a gas-related
bright spot is visualized in 3D using volume rendering of the energy attribute. The
volume rendered object can be saved as a 3D object for further study, e.g. to com-
pute the body's volume.
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1.5.1a Bright Spot

Required licenses: OpendTect.

Exercise objective:

Isolate an amplitude anomaly (bright-spot) using attribute analysis and visualize the
anomaly in 3D using volume rendering

Workflow:

1. Launch the attribute set window: click on the Attribute 3D icon « /and select 3D.

2. Define the Energy attribute with default parameters.

Attribute Set 3D
File

2 LT TLY R

Altribute set | <not saved>

- oEN

Besic v| Energy

Energy [-28,728]

Irm_1l3m|4 Dip steered median fiker

ITwne gete (ms) -20 28 I

Computo gradiont O Yos @ No

~||© sokxt...

Oulpud |Energy

I e

Atribute Name |Energy [-23,+28]

Add es new| il
) Savo on Closo

@ Close | @ Hep
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Workflow cont’d:

3. Provide an attribute name as Energy [-28,+28] and press Add as new.

~

- Atribute Set 3D ToEN
File
CPL R A (R -
Anribute set <not saved> Basic ~| Enargy v ?
Energy [-28,+28] Input Data 4 Dip steered median filter ~| © Soloct ...
Time gata (ms) 25 20
Computo grediont () Yos ~ ® No.
Output Energy B
Defined
attribute(s)
appears t
here. %
!
=
IA!tnhute Name | Energy [-28, +28) | |Acus new ||-‘

¥ Sawo on Closo

D Ciose | @ Hep

There are no restrictions on the length of the name: it may contain spaces. It is
recommended to use a name that contains all essential information of the attribute. It

helps you remember what this attribute does, and prevents having to go back to this
attribute window to see the exact definition of the attribute.

Workflow cont’d:

4. Tick the Save on Close box and press Close.
Alternatively, press the Save as icon &l and press Close.

5. Provide a (new) name for the attribute set like my first attribute set and press OK.

Aftribute Mame | Energy |28, +28] Add o5 now| (il
(S Save Attributeas — O [IESM
P Select output Attribute
File Fitter *
P VR A - =
=
a5 now. [l <
@+

© Cancel @ Help
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Workflow cont’d:

6.

In the tree, right-click on In-line and
select Add Default Data.

Change the inline position to 250: select
the inline in the tree and type the position
using the position toolbar.

Add an extra attribute layer to inline 250:
right-click on the inline number in the tree
and go Add > Attribute.

The attributes available are organized in
three categories: Stored, Steering and
Attributes (from the active attribute set and
calculated on-the-fly).

Go to the Attributes section, select your
attribute Energy [-28,+28] and click Ok.

Scene 1

= W n-lins
Sp3| Add Default Data
v] Add and Select Data

@ Cret Add af

EZsll g, lor Bl
- @ Volu id Color Blanded

EZREEE-LTy)

t Well Location ...

Inl 250] % tep 1 %_ﬁﬁ‘ 4s00 1

Ny’ In-line

S4cal 2507
gl Ak [§ Atribute

& Cross-
& Z-slice
® Volumy
~ Randc
1 2D Lir
@ 3D He =
420 Hc g
Faull e

= Correlate with Wels ...

Display
Duplicate
Reset Manipulation

* 4 Volume Builder Attribute
@ HorizonCube Display

. Systems Tracts Disy
Display Prestack Data » ¥ piay

Lock Treeitem
Remove from Tree

FaultSu
- Select —_olEN
Select Layer 2
Stored
Steering
s
Y
Scums O

Workflow cont’d:

Results should look like this.
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Workflow cont’d:

Color-bar

a new color-scheme.

Visualizing the results is almost as important as the results themselves. Therefore, try
different color-bars for your attribute. Each attribute layer has its own color-bar.
The color-bar is displayed by default above the 3D scene and can be edited by selecting

1. Click on the attribute from the tree and change the color-bar.

Try: Chimney, Faults and Grey scales.

FQ

= iy In-line
& 250
Energy [-28,+28] i& ]
4 Dip steered ... 11

>0
>
v - -

soess7)]  J343010/11 seismics 5

Dip2

1 Double Rainbow
111 Double Tasty

W Energy

i Experimental

I 1 Extremes

1 Faults

E Flames
2 Grey scales

1 Greyn

Workflow cont’d:

2. Right-click on the color bar: select Manage. ..

Edit color markers
from the main window
The color can be edited by double clicking on

32373 M24a73l1 aSeismics
Flipped
Ranges/Clipping ..
Manage ..
Set as default

one black marker below the histogram. To add
a new marker, double click at the position you
want, select the appropriate color and click Ok.
Drag the marker to change its position. Right-
click on a marker and chose Remove color to
delete it.

From the table

Right-click in the white section of the color-bar
displayed under the histogram and chose Edit
markers... In the table that pops up, the colors
and position of every marker can be edited: for
a specific marker, you can type in a new

Color table
Matteo ter
Matteo ter
Pastel
Porosity
Pressure
Rainbow
Rainbow
Red-Whit
Red-Whit
SandShale
Seismics
Similarity
SunRise
Tasty
UVQs Ex

Remove

Status
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default

Import

Manage ColorTable - oEd

Add, remove, change color tables

v

"
Segmentation None v
Undefined color Transp 0% =
Marker color [N
Flip Save as

@OK | ©Cancel @Help

position and change the color by double-
clicking on the used color. When right-clicking
on a marker, you can either delete the selected
marker or add a new one above or below.
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Workflow cont’d:

Segmented vs Continuous
The color-bar can be continuous or

segmented. When changing the Segmentation | _
from None to fixed, you define the number of | | =

particular used when displaying a discrete Color table
attribute, for example a Neural Network result: | | tateoter

Pastel

one color corresponding to one class. Porosity
P
ey
Rainbow ..

Transparency Red Wit
Red-Whit

The red line in the histogram represents the SandShao

transparency: changing the transparency line Similarity
alters the parts of the spectrum that are i{s"g::
displayed. Drag the seeds up to modify the

transparency. You need to have a seed at each

extremity of the histogram: add new seeds by

Remove

Stalus

Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default

Import

Manage ColorTable - olEN

the segment. Segmented color-bars are in | | A% remove. change colorizties

A

v

1 I

ISegmenlatlcn None v |

Undefined color

Marker color [N

Flip Save as

Q OK ©) Cancel @ Help

double-clicking on the red line and drag the
seed laterally and vertically. To remove a seed,
do ctrl+click on the seed.

Workflow cont’d:

3. Press Cancel to close the color-bar manager.

=

The undefined color is the color that will be
used for undefined values. You can adjust its
transparency. Color table

Matteo ter.
The changes you are making are applied in the | | pa
same time in your scene: you can actually QC | | P
the color-bar edition. Rainoow
Red-Whit

Once you are done with the color-bar editing, | | Redwhr.
you can save it with another name or overwrite | | 325
the color-bar you were using (not SunRise
recommended) by just clicking OK and | & W&
Continue. If you do not wish to save the | """
modifications, click on Cancel.

Stalus

Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default
Default

Import

Manage ColorTable - olEN

Add, remove, change color tables

v

— _—
Segmentation None v

Undefined color Transp 0% &

Marker color [

Flip Save as

-119-




Workflow cont’d:

4. Right-click on the color-bar and select Set as default: it will set the specific color bar

by default for all the attributes to be displayed that do not h
attached to them.

309857' r Flipped

Ranges/Clipping ...
Manage ...
Set as default

Color Settings to save the color-bar and the color range: it wi
this specific attribute again.

Scene 1
N In-line
= [v] 250

[¥] Energy [-28,+28] m

] 4 Dip steered . g k2]
i Cross-line Select Attribute  »
& Z-slice Save Color Settings
@ Volume Move 5
~ QRDanliiurn Line Display D
X ine
% 3D Horizon Remove

ave a specific color bar

Optionally, right-click on a stored attribute (volume) in the tree and select Save

Il be used when loading

The color-bar right-click menu allows you to flip the c

bar, Set as default.

Ranges/Clipping (to set the scaling values symmetrical around zero), Manage the color

olor bar, change the

Workflow cont’d:

Evaluate attribute parameters

interactively (movie-style) evaluating its parameter settings:

Now we are going to evaluate the Time gate parameter of the energy attribute by

1. Open the Attribute Set window: click on the Attribute i I.: -ggg
seticon , | and select 3D. Energy [-28,+28) R
2. Activate the Energy [-28,+28] attribute displayed on 4 Dip steered ... 11
inline 250 in the tree.
3. In the Attribute Set window, select the Ene

again and press the Evaluate attribute icon

r?%:ttribute

Allribute Set 3D
Fia

o LLLT TR

Aliribute st | <not Saved> Basic vl

~| Energy

—_—

Energy [-28,+28] Input Deta 4 Dip stoorad modian fiker

Time gate (ms) -28 28

Compute gradient C) Yes @) No

Output Energy

o

- olEN

Evaluate attribute

Set parameters
Evaluale Time gale v

Initial value -28 28

Increment -4 4

Nr of steps 2 + Calculato

@ Accept| @ Help
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Workflow cont’d:

- |

= Evaluate attribute

4. Select the parameter to evaluate: Time gate Set parameters

(in this case, there is only one type of

parameter to evaluate so it is selected by Evaluate Time gate %
default). Initial value |-4 4
Provide the parameters for the time gate as Increment -4 4

shown in the image on the right.

Nr of steps 10 + | Calculate

6. Press the Calculate button. Slice

7. The slider becomes active once the on-the- Store slices on ‘Accept

fly processing is finished.

Move the slider to see the results for a
certain slider position, corresponding to a
time gate in this case: observe the changes
in the 3D scene (see the following slides, for
instance).

@ e

Slice | U

If an attribute is defined using a time gate and/or
a step out, these parameters can be evaluated
the same way.

Store slices on 'Accept’

Time gate [-16,16]

Workflow cont’d:

8. Evaluate the attribute by moving the slider position.

Time gate [-8,+8]ms

= Evaluate attribute

Sel parameters.

Evaluate Time gate
Initial value -4 4

Increment -4 4

Nr of steps 10 = | Calculate

peel0 |

Store slices on 'Accept’

Time gate [-8,8]

o Accept| @ Help
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Workflow cont’d:

Time gate [-20,+20]ms

@ Evaluate attribute

Set parameters.
Evaluate Time gate
Initial value -4 4

Increment -4 4

Nr of steps 10 % | Calculate

Store slices on 'Accept’

Time gate [-20,20;

QAccepl @ Help

Workflow cont’'d:

Time gate [-36,+36]ms

= Evaluate attribute

Set parameters.

Evaluate Time gate

Initial value -4 4

Increment -4 4

Nr of steps 10 < | Calculate

Store slices on ‘Accept’
Time gate [-36,36)
OAccepl @ Help Y
_—— T F i

If you Accept at this point, [-36,36]ms will become the time gate of the attribute that you
were evaluating. In this manner, you decide the optimum time gate.

You may also say that this might be a too large time gate for this feature when compared
with a narrow time gate e.g. [-16,16]ms.
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Workflow cont’d:

- Evaluate attribute -0 “

9. Once the best time gate has been decided, press
Accept to update the attribute with the selected time

Set parameters

Evaluate Time gate M
gate.
Initial value -4 4
10. Update the attribute name according to the selected frcrement |4 4
time gate Nrofsteps 10 |2 | Calculate
Slice U
11. Optionally, click on the i icon to save the attribute set SR
window or tick the Save on close box, and close the Time gate [-20,20]

window.

0 Accept| @ Help

Workflow cont’d:

Create a seismic output

So far, everything was done in memory. We are now going to calculate and store the
Energy attribute on disk as an OpendTect volume.

1. Click on the Create Seismic Output icon 4= and select 3D or go to Processing >

Create Seismic Qutput > Attribute > Single Attribute > 3D

is Scene View Utilities Help
‘ Create Seismic Output » Adttributes » [ Single Attribute »

2D ...
Create Horizon Output » = " .
= . P 2D ==>3D _ ' Mutti Attribute . mL
| A Wols ' Angle Mute Function ... MuliCube DataStore ... [ |
= (Re-)Start Batch Job ... | P4 Bayesian Classification ... > Along Horizon ’
~+ Dip Steering 3 From Well Logs .. =y, Between Horizons v

= GMT Mapping Tool . Prestgck Processing 4

e @ HorizonCube ’ NEEEL ) '

0 Ve Volume Builder ...

E o o Re-sort Scanned SEG-Y ...
SSIS

4 L
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Workflow cont’d:

2. Select Energy as the Quantity to output.
3. Select a volume sub-selection:

Inline range: 100 — 300, Crossline range: 900 - | = Position - olEN|
1150, Time range: 432 - 600 ms Specify Position
Press OK. i

Volume subselection Range = E

4. Press Run to start the processing. incine Range [100 (300 Elsep[i B

) Create Volume Attribute Cross-line Range (900 % (1150 T Step 1 :

| Quantity to output Energy [-16,+16] | v| © Select ... Time Range (ms) 432 |5 600 |* Step 4

Volume subselection  100/900-300/1150 (43 samples) © Select ...

@OoK | @ Cancel (@ Help

Null traces ® Discard () Pass

[[] Scale values:  Shift/Factor

| Output Cube_Energy [-16,+16] | v| © Select .| @ CBVS v

Batch execution Single Process v| 4.4 Options ...

@ Cancel | @ Help

By default the processing is single-machine, To speed up, you can use the multi-
machine processing (requires plugin).

Workflow cont’d:

Volume Rendering

The objective of the last step of this exercise is to fully visualize the bright-spot in 3D.

1. Right-click on Volume and Add. It will insert an empty volume in the tree which is
centrally positioned in the scene.

2. Position the volume: Right-click on <343-506 / 656-893 / 692-1156> and go to
Display > Position.

¥/4 Dip ... 11

Y o T
=~ Ra
=] F Add Color Blended + @ Volume

M¥0p.. 4 [¥]/343-506 / 656-893 / 692-1154!
) <right-click> Add r
~ Random Line Display * [ Histogram .
“ 2D Line Duplicate 3 Properi
i perties ..
¢ gg nor!zon Reset Manipulation & Position
< orizon
Fault g Lock Treeitem
FaultStickSet == Remove from Tree
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Workflow cont’d:

3. It will launch a position dialog: fill in the ranges:

Inline range: 100 — 300, Crossline range 900 — 1150, Time range: 432 — 600ms.
Press OK.

4. Select Energy from the window in the Stored category and Press OK again.

e Positioning - B n

Specify the element’s position

In-line Range 100 |3 300 S &%

, =] Select - olEd|
Cross-line Range 900 = 1150 =

-

Select Layer 1

9-1 Similarity on FEF seismic A
9-2 Dip-steered diffusion filter

€) Cancel @ Help Steering 9-3 Fault enhancement filter

9-7 Thickness UVQ6 segment slice520

Aftributes 9-8 UVQ6 Hor 4-8 seament
energy [-28,+28

S < >
s~
I=? Filter |*

Z Range (ms) 432 &= (600 =

) Cancel @) Help

Workflow cont’d:

5. Change the color-bar to Chimney and optionally adjust the color range.

280000LI 810000C = Chimney v

6. In Position modeh , left-click (keep pressed) and drag to re-position the surfaces of
the volume or just scroll through in this manner to view the contents.

Attributes calculated on the fly can
be displayed using the volume
rendering. For large volumes, it is
recommended to store them prior
displaying to save time.
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1.5.2 Spectral Decomposition

What you should know about spectral decomposition

Spectral decomposition is used to study seismic data at a sub-seismic resolution
or to study attenuation effects caused by hydrocarbons. The method produces a
continuous time-frequency spectrum of a seismic trace. It can be done either by
using Fast Fourier Transformation (FFT) or by using Continuous Wavelet Trans-
formation (CWT). The details on both methods have been extensively described
in literature. In general, the technique separates the time series into its amplitude
and frequency components. The FFT involves explicit use of windows, which can
be a disadvantage in some cases. The CWT uses a mother wavelet which is
extended and compressed for computing the time-frequency spectra. It is equi-
valent to a temporal narrow band filtering. Depending upon the purpose, one of
the algorithms can be selected.

o FFT is used to delineate the stratigraphic/structural information along an
interpreted horizon.

o CWT is preferably used to delineate hydrocarbon attenuations and thick-
ness changes along an interpreted horizon.

- 126 -



1.5.2a Spectral Decomposition

Required licenses: OpendTect.

Exercise objective:

color stacking.

Workflow:

-

" Select Input Horizon ()

Filter *

Demo 0 --> FS4

=

‘=

| Demo 1 —> MFS4.

2 Demo 3 -
= Demo 4 --
Demo 4 --
Demo 5 -
Demo 6 -
Demo 7 --

Area subselaction

Demo 2 --> FS6

-> Top Foresets
> Truncation

> Truncation trim & fill

= FST
>Fs8
> shallow

100/300-750/1250 (463 samples)

emo_2015\Surfaces\Demo_1_--__MFS4 hor

X2

Bt
) Cancel| | @ Help

1. Right-click on 3D Horizon in the tree and click on Add
color blended...

Choose horizon Demo 1->MFS4 from the list of horizons.

Study paleo-geomorphological features by displaying 3 iso-frequencies simultaneously with

2D Ling
20 Honzor Load ..

Add at Sections Only ..

[T Add Color Blanded ...
s\?:“y Track New .
_ PickSet Create with pnnsiant z

Optionally, to speed up the exercise, click Select for area sub-selection and set
inline range to 200-650; crossline range to 500-1000.
Press OK to apply the changes and then click OK to display the horizon.

™ Position

Specify Position

Area subselection Range
In-line Range 200

Cross-line Range 500 <

© Cancel | @ Help

< 650

ORI

gy
+ Step 1

1000 = Step 1

Workflow cont’d:

In the tree, the horizon appears with 4 separate attribute layers. The three lowest attribute

layers represent the RGB channels (see color flags next to each layer). Three attributes can
thus be blended into a single display.

Survey Analysis Processing Sceno View

Gros:

= OpendTect Pro V6 00pre7-20151016/win64: F3 Demo_2015 - [Scene 11

Utiities. Holp

s-dine

Iroe mem] 437.9 6B 3.,
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Workflow cont’d:

3. To define 3 different attributes that will be loaded to the RGB channels of the horizon,

open an attribute set 3D: click on the , ;' icon.

4. Select Spectral Decomposition as attribute and set the time gate to [-8,24]ms.

Set 3D

d LA T TEY 138
=] [© Sekct

nput Det 4 Diip steerad medien fiter

Transform type @ FFT

Display Time/Frequency panel|

cwt

Output frequency (Hz 50 = Step 50 =

Altribute Neme: Add as new| [l

¥ Save on Close

[@cwse || @Hep

When the extraction of an

1| attribute is done on a horizon,

choosing the right time gate

is critical. The time gate
represents the interval of
investigation. If a

symmetrical time gate is
chosen (e.g. [-28, +28ms])
the attribute will highlight
geological features above

and below the horizon. When
an asymmetrical time gate is

chosen (e.g. [-8, 24ms] or
[-24, 8ms]) the attribute
response will highlight
geological features below or
above the horizon.

Workflow cont’d:

5. Right-click on Inline in the tree > Add Default Data

Inline 425 will be added to the scene.

Tree scene 1 L

Elements
Scene 1
! [In-lin

g Cros|
& Z-slic

Color

Add and Select Data

@ Volur  Add at Well Location ...
~ Ran( Add Color Blended

6. Reduce Z ranges of the section, so that it just covers the horizon interval: select the

inline and drag the green anchor vertically.

7. Right-click on the 4 Dip Steered Median Filter attribute and select Display > Amplitude

Spectrum...
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Workflow cont’d:

8. Within the amplitude spectrum, identify the frequencies to be used as the low, middle
and high frequencies: the low frequency can be selected as being the first peak (e.g.
24Hz), while the high frequency as the last peak (e.g. 64 Hz).

After choosing the frequencies, close Amplitude spectrum window.

&) Amplitude Spectrum for 4 Dip steered median filter

o @ =]

0 =

Power (dB)

0 25 50 75 100 125
Frequency (Hz)

Display between frequencies 0 125 Gridline step 25

Value(frequency, power) 23.7025¢ -5.38955 [/ Normalize V| dB scale

\Dlsnlay cepstrum ...| | Export ..

Workflow cont’d:

9. Back to the attribute set window: create the first Spectral Decomposition attribute and
set the input data to 4 Dip Steered Median Filter.

10. Set output frequency to 24Hz with a step of 4Hz.

11. Give a name to a new attribute, e.g. SD_24Hz[-8,24ms], and press Add as new.

" Attribute Set 3D

oy |
Fils
=T T
od AR N T T 150

Airioute 5ot | <not saved> Frequeney =] ‘Spectral Decomposton =2
0 a8 28w) B T —

Transform type @ FFT ) GWT

Timo gato (ms) -8 24

[Display Time/Frequency panel

Outout frequency (Hz|24.0 - Slep 40 °©

Altribute Na:v[ﬁh;mr[-ﬁ_?:u ] ] |Md a5 nn] [

¥ Save on Close

[@cwse [ @ Hep
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Workflow cont’d:

12. In the same manner, create the other two attributes for middle (44Hz) and high (64Hz)
frequencies: change the output frequency value and the attribute name respectively.
Click Add as new every time when a new attribute was defined.

13. Click on Close.

Optionally, give a name to the new attribute set, e.g.: Spectral Decomposition (if Save

on Close is toggled on).

3 Attribute Set 3D ol i3
[ P2
Tl KB 2T LT 155
Attribute set | <not saved> Frequency =] Spectral Decomposiion =2
Input Date |4 Dip steered median fiker BIEETS
Transform type @ FFT ) CWT
Timo gato (ms) |- 2
[Display Time/Frequency panel
Outout frequency (Hz 240 = Step 4.0
+
z4
—
Atribute Nerme [SD_24R218 24ms] || e
EE T

Workflow cont’d:

14. To convert your attributes into Horizon Data.
go to Processing > Create Horizon Output >
Attributes > 3D.

[GEEEETT) Scene View Utiities Help

Create Seismic Output * e = qyon g - h‘ .@ =
%

(Re-)Start Batch Job Horizon Curvature ... | [JESYIN
Stratal Amplitude .
Isochron

== Dip Steering »

= GMT Mapping Tool ...

@ HorizonCube 4
Madagascar

F. ssIS

15. Select the SD_24Hz_[-8,24]ms attribute to output and the Demo71->MSF4 horizon on

which it will be output and press Run.

16. Process the two other attributes in similar way.

= Calculate Horizon Dats from 3D [o & =)
Quantity to output |SD_24Hz[-8 24ms] - I@
Altribute Neme SD_24Hz|[-8 24ms]
Fill undefined parts © Yes © No
Calculate on Horizon I,J:) [Demo 1> MFS4 ~] © Select..|
Batch execution Single Process z £*, Options ...
[ oo (0w

0]
4
4

= Select
Select Quantity to output

Stored iz
. SD_44Hz[-8,24ms]
@ Attributes | SD_64Hz[-8,24ms]

=
=

© Cancel| | @Hep |

Saving as Horizon Data is faster than calculating on the fly along a horizon. Moreover, the
process is done in batch, so can be preferred simultaneously for other Horizon Data.
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Workflow cont’d:

¥/ Demo 1 ->M
¥ <right-click> B
V| <right-click> =

17. Display the three new Horizon Data ¢ gicico
on Demo1-> MFS4. right-click the text 20 Host S
. . } | Aftributes 3|
adjacent to the red channel > Select attribute > @ Fousick  Dipy +| Steering Cube >
. o Save as Horizon Data
Horizon Data and select SD_24Hz_[-8,24]ms. Wl 1 R
) Polygan |= Remove E
= Prestack Events T
o Annotations.
St B goR=|
e
on the honzon. After lading, use Page Up'
and ‘Page Down’ butlons to scrol.
Make sura the atiribute trogitom is schocied
and that the mousa pointer i in the scena,
SD_24Hz(-8 24)ms
SD_42Hz( -8 24
SD_BaH 8 24)ms
(oK [T concet
18. In the same manner, select SD_44Hz_[-,24]Jms : '_g_DbHor R
data for the green channel and select JeT['gm-_g ick> _m
SD_64Hz_[-8,24]ms for the blue channel. /1SD_64Hz |-... =

V1 SD_44Hz_[-... m
V] SD 24Hz [-... =
@ 2D Horizon

Workflow cont’d:

19. When blending the three inputs, the results should be similar to the one shown on the
figure.

Some extra steps:

» Try to flip the green channel : right-click on the color bar, a menu pops up which allows you
to flip the color bar).

M 36337.0/11¢

Ranges/Clipping

+ What do you notice? Do you see one feature better than the other ones? Which paleo-
geomorphological features can you interpret? What can you conclude in terms of
depositional environments, water depth, litho-facies, and direction of currents?
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Workflow cont’d:

We normally create RGB with three channels; Red, Green and Blue. A fourth attribute (called
Alpha channel) can be optionally added to highlight structural features like faults/fractures.

20. To define ‘Similarity’ attribute and add it to the fourth layer, open the Attribute set 3D

window with the , | icon and select Similarity.

21. Select Extension: All Directions.,
22. Select Min for Output statistics.

23. Give it a name (Min_Similarity)
and click Add as new.

24, Close the Attribute set window.

fo Arribate Set 30

s R IR Y
Altribute set | <not saved>

¥ Sava on Close

EI

P =] simiarty B2
[Linoue Data 4 D stsered mactian ier [ & seect
Time gate (ms) -28 28
Oty stalistic Min =]
=T =] i

[Sse=] oo

Workflow cont’d:

25. Right-click on the fourth element on Demo1--> MFS4 > Select attribute > Attributes 3D

and select Min_Similarity.

© 3D Horizan
v/Demo1->M... =
¥

[<right-clck> M
CEDXCTENE  Select Afiribute |

Jll Atributes 3D
SteeringCubes
Stored 2D Data  »

Altribute

¥ 8D_44Hz_[-  Move

¥ 8D_24Hz_[-

@ 2D Horizon . Di?mey
Fault .
FaultStickSet

@ Body # Remove
Wel

¥ PickSet

™\ Pohmon

Steering 2D Data *
Horizon Data (3)
Z values

& SD_24Hz_[-8,24)ms
* | SD_d44Hz_[-8,24)ms

What do you notice? Do you see any structural features (faults, fractures)?
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1.5.3 Cross-plots

What you should know about cross-plots in OpendTect

The cross-plot tool in OpendTect creates 2D cross-plots for analyzing rela-
tionships between seismic data and well data. Two types of cross-plots are typ-
ically analyzed: seismic attributes vs. seismic attributes and seismic attributes vs.
well logs. The data points are extracted in a given volume or in a region of interest
e.g. by drawing a polygon. The extracted data is displayed in a spreadsheet. The
spreadsheet is then used to manipulate and plot the data.

| Well attribute data [aol®] = |

B2 XY, ¥ [x qmmp b = Show100.0% =[EE[Z)T Show nicrl 2 I
Well data:F02-1,F03-2 F03-4,F06-1 / Attributes

X-Coord Y-Coord Z (ms) “MD (m) Porosity [1 original Seismics *
FO3-4 623255.82555338 6082552.10243577 565.45 568.57357178 0.32620955 2683
F03-4 623255.82544775 6082592.10682858 570.45 569.97357178 0.34664613 2854.14648438
FO3-4 623255.82533617 6082552.11121738 571.45 570.57357178 0.35052142 2755.22412109
F03-4 623255.82522554 6082592.1156061% 572.45 571.97357178 0.35206923 3122
F03-4 623255.82911396 6082592.12 573.45 572.97357178 0.35128462 2031.60766602
FO3-4 623255.82500334 6082552.12428381 574.45 5723.57357178 0.35052854 718.10595702

F03-4 623255.828859176 ©082592.1287731 575.45 574.97357178 0.34973079 —653.72827148 -

The cross-plotting tool has several functionalities. These include the following:

» Scattered plots

 Density plots (useful when larger number of data points are selected)
» Regression fit

» Multi-data selection

* Interactive on-the-fly Geo-body extraction

» Creating Probability Density Functions for rock property predictions

» Vertical variograms analysis

» Extracting pointsets for Neural Network prediction

» ASCII file output

* Quick cross-plot snapshots
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1.5.3a Attributes - Attributes

Required licenses: OpendTect.

Exercise objective:

the iso-frequency attributes

Workflow:

color blended...

2. Launch the Attribute Set 3D ==

Analyze the attribute response of the bright-spot amplitude anomaly by cross-plotting

2D Line

1. Right-click on 3D Horizon in the tree and click on Add

Load
Fault Add at Sections Only ...
_ ) . il A Color Blonded |
Choose horizon Demo-6 -> FS8 from the list of horizons.  Dody | Track Hew
_ PickSet Create with Constant Z ..

ol )
window: click on the | "®EfSEamaE. -
Al icon. o S o
Semple velug
Time gate (ms) ‘;;;‘W
ey —
Stepout '?..\-::r-:“ Tt
3. Choose Spectral g oS- Ot
Decomposition from the list
of attributes. .
24
Ouiput stalishic Average =
Attnbute Name Add o5 now| [l
7] Save on Close [ @ chose | | @ Heo
Workflow cont’d:
4. Change the time gate to [-12,12]ms.
5. Change output frequency to 24Hz with a step of 4Hz.
6. Giveitaname, e.g. FFT [-12,12]ms 24Hz, and press Add as new.
= Altribute Set 30 te-laEs
Fie
ol B N RE ¥ LS
Altribute set <not saved> <Al =] |spoetral Docomposition =l ?
[FFT [-12,12]ms 24Hz Input Data 4 Dip steered median fiter =] |© Sekct
Transform type @ FFT GWT
Time gete (m:,)m
:D isplay Time/Froquoncy penot:
‘Output frequency (Hz
t
8
FAd
Attribute Name |FFT [-12,12]ms 24Hz Jrod as nev| i
|Save on Close| [OTuse‘ @ Help. ]
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Workflow cont’d:

7. In similar way define two more Spectral Decomposition attributes of 44Hz and 64Hz.

8. Give them appropriate names, e.g. FFT [-12,12]ms 44Hz and FFT [-12,12]ms 64Hz,
each time pressing Add as new.

9. Uncheck Save on Close and press Close.

= Anribure Set 3D [E=RECE <"
File

PR Ak
Alfribute set | <nol saved> <Al =| Spectral Decomposition A ?

12)ms 24Hz Input Deta 4 Dip steered median fiter [=] & Sohct ...
12]ms 44Hz

Transform type @ FFT CWT
Time gate (ms) -12 12

|Display Tima/Frequency panol

ovouenuency cufoso & Sep w0 _F1] Optionally save the
Y attribute set. In this
8 case “Save on close”
2+ should be checked.
[Petrioute ame FFTI-12,12)ms 640z | nml-‘
o

Workflow cont’d:

10. Apply these three attributes on the - bems>rss

7| <right-click> m

horizon (red-24Hz, green-44Hz, and frchegs
blue-64Hz):

v
< 2D Horizon Select Aftribute 8 Stored Cubes  »
[ Atributes 30+ [FrT 12,121 24tz

right-click on the red channel and go = fau e
) . FaultStickSet Display » SteeringCubes » FFT [-12,12]ms 44Hz
Select attribute > Attributes 3D > FFT [- $8 Sovo s Horzon Ocka | Sired 2D Dala | _FFT-12.124ms 4tz
oo * | Afributes 2D
12, 12]ms 24Hz. bsﬁ:;ﬁ # Remove Steering 2D Data *
S Prestack Events Horizon Data (0)
Annotations Z values

11. In the same manner select for the green (44Hz) and blue (64Hz) channels.

12. Click on the View icon iy * and select View North Z to observe the result.

E. View In-line
< | g View Cross-line

® View Z
-

-~ I View North

|+ View North 7

- 136 -




Workflow cont’d:

13. Right-click on the Polygon in the tree > New.

14. Type in the name Shallow bright spot and Press OK.

A Well
2 PickSet
v

= Prestacl Add .
) Annotations

= Create New Polygon

Name for new Polygon |Shallow bright spot
Color | | ™ Magenta

O Cancel | @ Help

|E=5 FoE =)

H

Workflow cont’d:

15. Use left mouse button to outline a polygon.

L5
L |

-
o o |
S Prestack Event  Display ’
. . . . # Annotations Calculate Volume ...
16. When finished, right-click on this newly added polygon
i I Save
in the Tree and select Close Polygon. s
Create Body ...
& Lock
(G Export to Google KML ...
Delete from Database
# Remove from Tree
ots— |
& Prestack Event  Display v
& Annotations Calculate Volume
R . . -
17. Right-click again on the polygon name and Save. - as
Create Body
& Lock

(G Export to Google KML ...
Delete from Database
# Remove from Tree

e
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Workflow cont’d:

18. Go to the menu Analysis > Cross-plot Data

> Attributes Vs Attributes. ..
or click on the cross-plot :

| icon.

19. Select the three attributes just created.

/% OpendTect Pro V6.0.0pre7-20151016/win64: F3_Demo_2015 - (Scene 1]
& Survey Processing Scene View Utilities Help

b il A Aftributes ’

|Tr5 “&§ Volume Builder ...

Cross-ling 0

Y | Cross-pht Data 3. Welllogs vs Aftributes ..
f L Wells [l B Attributes vs Altributes ...
> | Layer Modeling ’ Open Gross-plot ...

@ Attribute cross-plotting —

(m] x
Select attributes and locations for cross-plot
(=] Attribute
FFT[-12,12]ms 24Hz ~
(] FFT(-12,12]ms 44Hz
(] FFT[-12,12]ms 64Hz
TT1 Original Seismics)
[J [4 Dip steered median filter]
([ [5 ChimneyCube] .
O rom ar ~te ca
Select locations by Range v n = d
In-line range |100 <] 748 < Step |9 =
Cross-line range (300 =| 1245 2| Step |9 s
Time range (ms) lo :: [1600 :: Step :4()() 3:
Sampling Mode O Random ® Regular
Location filters |- © Select ...
(2o @cancel @

Workflow cont’d:

20. Select location by — Polygon.
21. Select Shallow Bright Spot polygon.

22. Change Inline & Cross line steps to
1 and time step to 4ms.

23. Click Select for Location filter.

@ Attribute cross-plotting = (m] x
Select attributes and locations for cross-plot

=] Attribute

FFT[-12,12]ms 24Hz -
FFT[-12,12]ms 44Hz
FFT[-12,12]ms 64Hz

[ [1 Original Seismics]

[J [4 Dip steered median filter]
[J [5 ChimneyCube]

Select locations by | Polygon v

Polygon | Shallow Bright Spot v || © Select ...
In-line/Cross-line Steps
Time range (ms) :U <l[1600 = Ste
Use Positions @ Inside O Outside
Location filters |- O Select ...
(Box ) @cnca) @
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Workflow cont’d:

24. Check the Horizon option.
25. Select the horizon Demo6 -> FS8.

26. Click OK in both windows to proceed.

a Filters

Specify Filters
® -
O well ~
[ Polygon
[ PointSet
[ Horizon ]
[ Body
[[] Seismic Cube Positions

M

Horizon | Demo 6 --> FS8 v | |© Select ...

Sele - O To a 2nd Horizon

Z step (ms) 40 2:

Extra Z (ms) |0 sl ::

[Exoms @

Workflow cont’d:

27. In the pop-up spreadsheet, select FFT [-12,12]ms 24Hz to be displayed along X-axis:
click on FFT [-12,12Jms 24Hz column and then click on Xiicon.

28. Assign FFT [-12,12]ms 44Hz to Y-axis: click on FFT [-12,12]Jms 44Hz column and then
click on Y4 icon.

4 Attribute data [E=8 EGE =%
B Y. [% q@mmp |4 o = show250% : | show Invcd =7 i

area 100/945-286/1134 (401 samples) / On 'Demo 6 --> FS8'

X-Coord Y-Coord Z (ms) X FFT 12,12 ¥ FFT [-12,12| FFT [-12,12]ms *
170/1030 624029.5406... 6075815.513... 529.19 236431713867 [iklil:Eriisil] 8064.92333984

172/1029 624003.1544... 6075864.794... 530.11 3204.86523438 [LECNOMNETIN 5500.46044922
267/993 623037.1936... 6078213.668... 52591 3726.45654207 [ TITN 12006.81542...
267/997 623137.1546... 6078216.461.. 526.07 512243806484 [LETIREPI 12621.10839. .
2661983 622787.9801... 6078181.694... 526.76 5549.01123047 [EUGIECEALIEAA 11063.40527...
|267/962 £22262.4957... 6078192.016... 524.34 5601.13818350 EULfr kIl el 11131.1875 - |

@Heb |
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Workflow cont’d:

29. Optionally add more attributes to the Y-axis by selecting a column and pressing Y.+icon. Or
remove the selection by pressing Unselect icon.Y_

30. Click on the Save icon g5 to save the crossplot data and provide a name and click OK.

31. Press Cross-plot icon L to plot the selected data.

/= Attribute data

4‘ X Y. Y. [ q@mmp -4 o = snow2s,0% [2

area 100/945-286/1134 (401 samples) / On 'Demo 6 --> FS8'

f=! Create Qutput ‘ =l-a &S
Spacity Qutput
OQuiputto © Test ke @ Ogendlioct obect

Fiter *

=
1<

name [erosspiol_SO_24Hz 4drz |

<

'z

| Show InUCrl ;‘{

@'Qunnu:j @Hop |

oo =7

Y-Coord

6075815.513...
6075864.794...
6078213.668...
6078216.461. ..
6078181.694...
6078192.016...

Z (ms)
529.19
530.11
525.91
526.07
526.76

152434

[X] FFT [-12,12] | [¥] FFT [-12,42] FFT [-12,12)ms *

2364.31713867
3294.86523438
3726.45654297
5122.43896484
5549.01123047
5601.13818359

620377832031 8064 92333084
4638 68017578 5500.46044922
6094.88916016 12096.81542 .
6856.9453125
450534326172 11063.40527 ..

13499 75439453 11131.1875  ~

12621.10839...

(Do) @1 |

Workflow cont’d:

32. To have a better feel of the data's behavior
toggle the density plot @ button in the
scattered cross-plot window.

5 area 102/332-281/1133 (D1 samples) / On "Demo 6 --> FS8 Cross-plot | . ﬂ
Show 50,00% m; Selectony V1 [~| % & K@ 8= 8 b
@ o
A =094
rw
v
£
ot
? WleomEe 0 "%
¥ Salocted: O
1% ares 102/532- 9171133 (401 samples) £ b Dema 6 -~ F58' Cross-plat =N N =" |
Snowi0000% < [EZ] ¥: | [feectonfvi F] &k R MR R D
1 [l e Ranbow =|
P
g r=0.94
;(IJ
5
¢ Tz, rams S0 b 1000
¥ Soloctos: 0
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Workflow cont’d:

Show(100,00%) = 3] Y2 | [Sewect onty Y1 [+]

1 [l |mRainbow
_ _ _ D

33. Click on [ | icon to reverse the selection : oo

tool. w-

34. Using the selection tool (& 7 draw
a free-hand polygon, as shown
in green color on the figure.

35. Click Show points in 3D scene :+ button

0 20000

20000 100000

40000 60000
FFT [-12,12)ms 24Hz
Y Selocled. 8257

= Diley Propertes (o]
36. In the pop-up window choose an option sy S SetcidPonts = Alponiswin ite
Selected Points to display the selected
scattered data and Press OK.

e [T

Workflow cont’d:

37. In the scene, right-click on the green colored
displayed picks > Save as PointSet. ..

Properties ...
Save as PointSet ...
Remove points inside polygon

) Create New Pickset =8N =5

Selection Group [l No 1 q

38. Give it a name, e.g. High amplitudes, and press OK. | for now Pk g ]
Color - m Crimson =

| QoK I“Qcanoei” @Hep |
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Workflow cont’d: i mo6 > - o X
39. In the Cross-plot window click on % ‘icon swfuos 2| Y2 seonn ¥ [El@ e = G 5
to remove the previous selection. @ e

FSg'

P(x) 100000

40. Draw a new polygon as shown Ei
on the figure. 75000
!
:: 50000
41. Click Show points in 3D scene :: button E
| 25000
OU 20000 40000 60000 E0000 10000¢
FFT[-12,12]ms 24Hz
Y Selected: 7569
= Display Properties ([E=8on =
. . . Display @ Selected Point All points with atfribut
42. Choose an option Selected Points to display i T
the selected scattered data > Press OK.
[E5<](0 Gorel
Workflow cont'd:
43. In the scene, right-click on the green colored
displayed picks > Save as PointSet. ..
Properties ...
Save as PointSet ...
15 Create New PiciSet [E=5 HoH =
i i i Selection Group [lINo 1 q
44. Give it a name, e.g. Low amplitudes and press OK. W for nw rose{ Tow mpais] ]
Coor ) = BlusViolet =
| QOK I‘OCancei” @Hep |
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Workflow cont’d:

Some extra steps:
+ The scattered data selected in the previous figure can be displayed as pick sets. Note that the
separation of frequency highlights two different regions of the bright spot.

+ The cross-plot has helped to identify the changes in the gas pocket that are possibly due to
differences in saturation/thicknesses. Optionally, you can repeat the exercise to cross-plot all
three attributes together FFT 24Hz, 44Hz and 64Hz.
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1.5.3b Attributes - Wells

Required licenses: OpendTect.

Exercise objective:

Analyze relationships between seismic attributes and well logs using cross-plots.
Workflow: |
1. Launch the Attribute Set window A= > 3D or follow Analysis > Attributes > 3D.

2. Define Instantaneous Amplitude attribute: Select Instantaneous from the list of attributes
and keep all the default parameters for this exercise.

3. Typein a name, e.g. Inst_Amplitude, and Add as new, so that the attribute appears in the
list of defined attributes on the left-hand side.

[ | P e =5 |
Flle
it K N°N T 150
s st s ET S o e—
Input Dala |4 Dip steerad medion fiter 7] (© sower..|
Ouiput Amgiituce =
+
+
z¥
[Aaribue Home | insi_ampituce | |0 a5 now i
Savo on Closo [Dcrse | [ @tep

Workflow cont’d:

4. In similar way define two more attributes: Energy and Dominant Frequency (Listed
under “Frequency” option in the attribute list), using all the default parameters.

5. Close the window.

<Al Akdl -
] (@ sdect ..
Smooth Spectium O Yo @ N
Culput Dominant frequency
+
) J
2
—
Attribuite Narme [ominant_Froquency | e

4 Save on Closa @ Close | M)

If the Save on Close box is ticked, the attribute set will be automatically stored when closing.
When closing an unsaved attribute set, you will have the option to store it.
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Workflow cont’d:

6. Go to the menu Analysis > Cross-plot Data >
Attributes Vs Well logs...
or click on the cross-plot Lﬁl\\ icon.

7. Select the three defined attributes
Attribute section.

in the ":\‘Mhuneiwwlctms—nlulﬁng

‘= OpendTect Pro V6.0.0pre7-20151016/win64: F3_Demo_2015 - [Scene 1)
5 Survey Processing Scene View Utilities Help
Q (| <l Aftributes 2
AL
Tre ‘% Volume Builder
L Qi Crossplot Data » [ Welllogs vs Aftributes
- A Wells * i Aftributes vs Aftributes
- & Layer Modeling » Open Cross-plot

Cross-line 0 Step

[RESIEER =]

- Adtribut

Log
| Donsay
! Sonic
W Gamma Ray

] Poros;
! P-impedanca

! P-Impedanca_rel
4l vp

¢l Densty_odied

Extract Betwaen | Markers (] [ Extractin time  Step (m) 1

[ Fsa =

Distanco abova/below (M) |0 0

Sekctad 200 | Truncaton

Log resampling method | Take Nearest Sample [v]

Redius around wells (m) 25

Fiser pasiton - [© 5okt
| @0k | ©cancel| @tep
Workflow cont’d:
[ r— Lo il
8. Select all available wells and logs. s e
 Domipant_Frequency
Use Ctrl+A shortcut to select all items from the list or
tick the box on top of the item list.
. 7T
9. Extract between the Truncation and FS4 markers. Jrst
10. Press OK button to proceed. Extnc Bawoer oo [¢] £ Exctn i St (3 1
Soloctod 2on0 fTruncaton = PS4 =]
Distance abovo/boiow (m) O 0

Log resemgling method Take Nearest Semple [v]
Redius around wells (m) 25

Fiter posticn - [© sekeat.

E ) Cancel| | ) Help
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Workflow cont’d:

11. In the pop-up spreadsheet, select GR log to be displayed along X-axis: click on GR log
column and then on X button.

12. Assign Dominant frequency attribute to Y-axis: click on Dominant Frequency column
and then on Y.icon.

13. Press Cross-plot button L to plot the selected data.

| Well attribute data e |
s v_ i qmmp 4 o = showtonon: ] Show InlCrl =7 E
Well data:F02-1,F03-2,F03-4,F06-1 / Attributes.
X-Coord Y-Coord Z(ms) “MD(m) Density Sonic Farosrty P-Impe¢: P-Imped: Vp Densty_ Inst_Amp Energy

FO3-4 623239, 608299, 146.9 66253 2111.7... 489.19.. 51.85 0.3363.. 4312050 -78652... 2044.2.. 2124.6.. 2280.5.. 670482
FO3-4 623265.. 608257 . 146.9 66253 . 2111.7... 489.19... 51.85 0.3363 .. 4312050 -T8652... 2044.2.. 21246.. 376.86.. 499611
FO3-4 623255 600250, . 146.9 66253 . 2111.7.. 48019.. 51.05 0.2363... 4312050 -70652.. 2044.2.. 21246.. 1600.4.. 123512
FO3-4 623255... 608259.. 147.13  66353.. 20926.. 500.03.. 57.806... 0.3483.. 4204080 -53108.. 1999.8.. 2126.0.. 1611.9.. 123451
FO3-4 623265 B082ST 14713 BB35K3 20026 50003 57 806 03483 4204080 53108 10008 21260 . 35673 502202
F03-4 623230, B08250.. 147.13 66353, 20926.. 500.03.. 57.806... 0.3483 .. 4204080 -53108.. 1999.8.. 2126.0.. 22928 . 662454
FO3-4 623255... B0B259.. 147.37 66453, 21377.. 47442 56.085.. 0.3201. 4500510 -21256.. 2107.8.. 2127.9.. 15436 . 123395
FO3-4 623265 608257 14737 66453 = 21377 47442 56085 . 03201 4500510 -21256... 2107.8.. 21279 . 33653 . 504850
FO3-4 623230 . 608250, . 147.37 66453 . 21377 47442 56085 03201 . 4500510 -21256.. 2107.8.. 21270 23012 . 654806.5 pRliciE

HEEBEBEEEE
SHEHEHHE

F03-4 623265 608257 1476 66553 . 21504 46720 58785 03121 . 4626120 14698 . 21407 21207 31647 . 507516.  RERGEES
FO3-4 623255... 608250.. 147.6  66553.. 21504.. 467.20.. 58.785... 0.3121. 4626120 14698... 2140.7.. 2129.7.. 1475.7.. 123343
FO3-4 623230... 608250.. 147.6  66553.. 21504.. 467.20.. 58.785... 0.3121.. 4626120 145698... 2140.7.. 2129.7.. 2305.5. 647528 m
FO3-4 623230, BOB250. . 147.83 66653 217789, 45161, 62.35 0.2950... 4824330 52805.. 22142, 21315, 2306.0.. 640624, m
FO3-4 623255... §0B8259... 147.83 ©6653.. 21779.. 45161.. 62.3% 0.2950... 4824330 52805... 2214.2.. 2131.5... 1408.5.. 12329%. m
FO3-4 G23265.. 000257.. 147.03 ©G6653. . 21779.. 45161 62.35 0.2950 .. 4024330 52005, 22142 21315, 20679 510159 m
F03-4 623230 808250 14807  B6753 21503 46221 60020 03066 4670120 91507 21635 21334 21800 603416 PRI

(o) (0 ]

wel: F03-4

Workflow cont’d:

14. By default, it will plot scattered points of all mm mv“.. I TR EEE)

wells vs. selected attribute(s). Select one s
well from the combo-box to cross-plot an 2 Bt e et
individual well. =

£

;

§ 20

“ﬂ 40 60 80 100
Gamma Ray (APTY
Additionally:

Repeat the steps 12 to 14 by selecting exclusively logs for the X axis and for the Y
axis. Optionally select consecutively two logs to be displayed on the Y axis. The
second log will be displayed as Y2.

When selecting different X and Y quantities in the table, the crossplot display window
will be automatically updated. Use the = and s arrows to change the Y column to
the next (or previous) column.
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1.5.3c Bayesian Inversion

Exercise objective:

Perform a Bayesian inversion to predict whether a similar bright spot as the one we have
studied exist elsewhere along the same horizon.

Workflow:

1. Open the cross-plot data saved in the exercise 1.4.3: Analysis > Cross-plot Data > Open
Cross-plot.

2. Select the cross-plot data and click OK.

‘) OpendTect Pro V6.0.0pre7-20151016/win64: F3_Demo_2015 - [Scene 1]

! Load Positioned Vector Data |- |- &)
& Survey Processing Scene View Utilities Help

Select input Positioned Vector Data

Q X L ail Attributes * | Cross-ine 0 - Ste|
‘Tre “& Volume Builder . Fitter |*
b | ST . Wel logs vs Atributes
A Wells v | Affributes vs Aftributes _ Xplot-Well-Seismic-from-Import
f |& Layer Modeling 12 Open Cross-plot ... —_— [;

| = Fluid Contact Finder ... \Z
h = | ¢+ Neural Networks e
£ ssIs e [:

-4 |2y Thalweg Tracker
Al 1 Velocity Model Building *»

IW © Cancel || @ Help

\Features\crossplot_SD_24Hz_44Hz pvds

Workflow cont’d:

3. In the spreadsheet, select FFT [-12,12]ms 24Hz to be displayed along X-axis: click on
FFT [-12,12]ms 24Hz column and then on X button.

4. Click on FFT [-12,12]Jms 44Hz column and then on Y icon.
5. Press Cross-plot button L to plot the selected data.

) crossplot_SD_24Hz_44Hz [
H > Y_ \5 -- H 1 = Show25,0% |l Show InlCrl =7

area 100/945-286/1134 (401 samples) / On 'Demo 6 —> FS8'

[X] FFT [-12,12]ms 24 | [¥] FFT [-12,12]ms 4«( FFT [-12,12]ms 64Hz *
170/1030 624029 54069026  6075815.5136924  529.19 236431713867 6293 77832031 8064 92333984

172/1029 624003.15440207 6075864.79457039  530.11 3294 86523438 5500.46044922

267/993 623037.19363058 6078213.66824719  525.91 3726.45654297 88916016 12096.81542969
267/997 623137.15464542 6078216.46197656  526.07 5122.43896484 19453125 12621.10839844
266/983 622787.98911072 6078181.69426859  526.76 5549.01123047 11063.40527344
267/962 622262.49576557 6078192.01684455  524.34 5601.13818359 3499.75439453 11131.1875

X-Coord Y-Coord Z (ms)

158/1034 624137.877912 6075518.43155973  529.79 5839.96044922 12116.49609375 15774.79492188
266/987 622887.95012556 6078184.48799796  527.04 6591.56591797 11367.41992188
266/979 622688.02809588 6078178.90053921 526.85 6729.35253906 296875 10554.22949219
203/1014 623606.66206194 6076628.99739551 539.08 6751.89648438 10471.64355469 9672.45410156
269/1005 623335.68064061 6078272.02874565  526.38 717866894531 522617773438 9048.19921875
14525.93554688

S 32 'S s
SHEEEEHEEHE
= NN =] ~
g 2 3 3

267/1001 623237.11566026 6078219.25570593  525.22 7191.24316406

e |
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Workflow cont’d:

6. To have a better feel of the data's behavior toggle the density plot ]ﬁ button in the

scattered cross-plot window.

/= area 102/932-291/1133 (401 samples) / On ‘Demo 6 --> FS8' Cross-plot. E=n os =<~ = area 102/932-291/1133 (401 samples) / On ‘Demo 6 --> FS8' Crass-plot E=n ol =<~
Show 50,00% :IE'V; Selectony Y1 -] @ F IR B $ B Show(i00,00% = (5] Y2 | [Seectony Y1 -] & K1 @ M FR 8 B
| 12500 1 JI 1 | Rainbow
s =094 -/ 125000
;m & r=0.94
100000 ;’m
100000
i
\;, 75000 § 5000
; 50000 § 50000
25000 25000
0
0 20000 40000 60000 80000 100000 0 20000 40000 60000 80000 100000
FFT [-12,12]ms 24Hz FFT [-12,12]ms 24Hz
Y Selected: 0 Y Selected: 0
Scattered cross-plot Density cross-plot
N
Workflow cont’d:
7. Click on icon to reverse the selection tool.
8. Using the selection tool (& draw a free-hand polygon, as shown in green color on the
figure. K
9. Click on Create Probablhty Densi‘ty @ area 102/932-291/1133 (401 samples) / On 'Demo 6 --> FS8ross-plot [a@]=]
Function (PDF)icon P(x). Showff0000% = (B3] Y2 | [Selectony Y1 -] & # [@ @ @ = & &
1 [Tl | Rainbow =]
- 125000
: r=0.94
P(x)
100000
g 75000
2
i 50000
-
n
25000
0
0 20000 40000 60000 80000 100000
FFT [-12,12]ms 24Hz

Y Selected: 8257
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Workflow cont’d:

10. In the pop-up window choose an option Selected Region.

11. Select Spectral Decomposition attribute 24Hz and 44Hz.

12. Provide an output name, e.g. pdf_bright_amplitudes, and click OK.

/) Create Probability Density Function

Create PDF from [Selected region +
Attribute Range 0
Attrlbute Range 0

E=8 Ho8 =X

100000 Nr of Bins |25 -

125000 Nr of Bins |25 <

<- Less

Output PDF [ pdf_bright_amplitudes

[] |© select ...

|_00K ”OCancelH @ Help \

b

Workflow cont’d:

13. In the Cross-plot window click on ﬂ to remove the points inside the selected area.

14. Draw a new polygon as shown on the figure (left mouse button down and drag).

15. Click on Create Probability Density

Function (PDF) iCOI'] P(X) . @) area 102/932-291/1133 (401 samples) / On "Demo 6 --> FS8 Cross-plot B
Show/100,00% = [E] Y2 Selectony V1 1] & ¥ @ R[W = & &
1 [i .1 wa Rainbow ﬂ
125000
(]
r=0.94
= 100000
L 75000
3
®
£
~
N
<. 50000
.
i
i
25000
o
0 20000 80000 100000

40000 60000
FFT [-12,12]ms 24Hz
Y Selected: 6056
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Workflow cont’d:

16. In the pop-up window choose an option Selected Region.

17. Provide an output name, e.g. pdf_low_amplitudes, and click OK.

18. Close the cross-plot windows.

"‘" Create Probability Density Function o |el=) @

Create PDF from [Selected region -]
Attribute FFT [-12,12]ms 24sz| Range 0 100000 Nr of Bins |25 —
Attribute |FFT [-12,12]ms 44HZZ| Range 0 125000 Nr of Bins |25 S

e =
Output PDF [pdf_low_amplitudes || © select ...

LOOK ”OCancelH @ Help ]

Workflow cont’d:

’-‘, Analysis Processing Scene View Ulilities Hel

19. Go to Survey > Manage > Probability & Seectseue -

3 pea /o ¥ »| Cross-ine 0

ession 4
Density Functions. Import , -
Export > Color
‘ !, Attribute Sets _..
Pre-load ' | & Bodies ...

Exit Color Tables
) 7 Rand L"*, Cross-plot Data ...
andom
~ 9D Line , Faults .
@ 3D Horizg |+ FaultStickSets ..
4 2D Horiza #, Geometry 2D ...
Fault

B “® Horizons »
® BZ:y e "3, Layer Properties ...
L Well £, PickSets/Polygons ..

EBLCLSEM « Probability Density Functions .
Q gmy%mm Random Lines
restacl .y
= Annolations | T Seismics :

20 There you can brOWSEIEdit PDFS ) Manage Probability Density Function
click on using the icon ¥ or double | - Fitlr |- )
CliCk on the PDF crossplot exercise 3.3.3 10a

crossplot exercise 3.3.3 10a smoothed
crossplot exercise 3.3.3 10b

crossplot exercise 3.3.3 10b smoothed
Density vs. Sonic
pdf_bright_amplitudes
pdf_low_amplitudes

SRR

23

=
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Workflow cont’d:

21. View the PDF distribution by clicking the ##, icon
in the Values tab.

22. Smooth the function using the icon AF.

23. Press Ok and save the smoothed PDF
with a new name or overwrite the existing file.

24. In the same way smooth the second PDF and
close the Probability Density Function manager

% Edit Probability Density Function |- |- &) (st
Edit 'crossplot exercise 3.3.3 10a' at SD44 = 3000
Names Values
2500 7500 12500 | -~ —
147000 0 ] 0 0
141000 O 0 0 0
135000 0 ] 0 0
129000 0 0 0 0
123000 0 0 0 0 -
4 1 »

I QoK ] OCanceIH @ Help |

window.
@) Probability Density F.. [ o | B | &
0 25000 50000 /75000 1000Q
100000
P
' sD44Hz SD24Hz ~ |
Workflow cont’d:

Scene View Utilities Help

Create Horizon Output »

25. Go to Processing > Create
(Re-)Start Batch Job ...

Seismic Output > Attributes >

R R ~+ Dip Steering
Slngle Attribute > 3D... = GMT Mapping Tool ...
{9 HorizonCube »
Madagascar ...
| ES ssIs 4

mrome

| Creaie Seismic Ouiput > - Single Aftibute

» | P& Bayesian Classification ...

D) ...

2D <=>3D 4
Angle Mute Function

Multi Attribute
MultiCube DataStore ...
= Along Horizon »
=y, Between Horizons 3

From Well Logs ...
Prestack Processing
Velocity »
Volume Builder ..

Re-sort Scanned SEG-Y ...

26. Select Spectral Decomposition attribute of 24Hz and limit the processing range to in-
line 530 — 750, cross-line 660 — 1040 and Z range 500 — 700ms to save processing

time. Click OK to start batch processing.

Output Cube FFT [-12,12]ms 24Hz

E] i Options ...

] [© select | @ cBYS Fl

Batch execution Single Process

! Create Volume Attribute :Uﬁ
Quantity to output FFT [-12,12]ms 24Hz ] [© setect ]
Volume subselection 530/660-750/1040 (51 samples) I
Null traces @ Discard Pass
Scale values:  Shift/Factor

Qo | (@ cancel] [ @Hebp |

[F=8 Eo =)

= Position

Specify Position

Volume subselection Range

H @

In-line Range (530 < 750 < Step 1 =

Cross-line Range 660 < 1040 < Step |1 =

Time Range (ms) 500 = 700 = Step 4 —

QoK | (@ cancel| [ @ Help

27. In the same way process Spectral Decomposition attribute of 44Hz.
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Workflow cont’d:

[T scene View Utilties Help

28. Go to Processing > Create seismic output > s ;
Bayesian classification to launch the Bayesian @ Create Horizon Output » | 2D <=> 3D ,
inversion (Re-)Start Batch Job ... Angle Mute Function ...

. ~+ Dip Steering Ml Bayesian Classification ...
= GMT Mapping Tool . From Well Logs ...
@ HorizonCube 5 Prestack Processing »
| 5
Madagascar ... Velocity >
59 SSIS R Volume Builder ...
Re-sort Scanned SEG-Y .

!I'Dne—'_
29. Select both previously created and smoothed PDF (to add additional PDF click on

More).
@) Bayesian classification - PDFs o | =B &8 = Bayesian classification - PDFs (| =E
[1] Specify PDF input [1] Specify PDF input
Input PDF 1 pdf_bright_amplitudes | Input PDF 1 pdf_bright_amplitudes E] e Select,,.‘
| More -> Input PDF 2 | pdf_low_amplitudes B
[ More > [ <Less |
|OCanceIH @ Next H @ Help J \OCancelH @ Next ” @ Help_|
S
Workflow cont’d:

30. Provide a weight for each: 1 for the first and 0.8 for the second. Then press Next.

@) Bayesian classification - Scaling o || &8 &

[2] Normalization/Scaling

Normalize Input PDFs @ Yes No
A priori weights @ Constant Variable
For "pdf_bright_amplitudes’ |:|
For 'pdf_low_amplitudes’

Normalize output @ Yes No

iO<Back”_ONexl ]” @ Help ‘

The weight functions can be constant as well as variable that
can be input in form of volumes. For instance the weight could
be a function of the well distance, or the vertical distance to
the target.
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Workflow cont’d:

31. Select input volumes corresponding to each attribute.

*“* Bayesian classification- Seismics

[3] Specify Seismic input

[E=1 Nos =5

~] | © select .

Input for 'FFT [-12,12]ms 24HZ' |FFT [-12,12]ms 24Hz

Input for 'FFT [-12,12]ms 44HZ [FFT [12,12]ms 44Hz

| | © Select ...

[Q<Back”_QNext I[ @) Help }

Workflow cont’d:

32. Check the outputs you want to generate, provide the desired names and hit Go.

N Bayesian classification- Output

[4] Select and specify output

7| P: *pdf_bright_amplitudes' | Probability_bright

E] [@ Select ] @ CBVS

v| P: 'pdf_low_amplitudes' |Probability_low

~]|© select | @ cBvs

v| Classification: Class |C[ass

|| © Select .| & CBVS

|v] Classification: Confidence |Confidence

][0 ses. | vces

[¥] Determination strength |Determination_strength

[ [ [ ]

~||© select | @ cBVS

Volume subselection -

0<Back| 2560 | @ Help
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Workflow cont’d:

33. Right-click on 3D Horizon in the tree > Load > Select Demo6 --> FS8 hotizon to
display.

34. Right-click on the Demo6 --> FS8 horizon in the tree > Add > Attribute and select one
of probability attributes from the list.

& Z-slice
@® Volume
~ Random Line
% 2D Line
4 @ 3D Horizon
4 [v] Demo 6 -
v Z v Add Y || Attribute
1 2D Hori: Display L Contour Display
Fault Tracking > Horizon Data
FaultStic Tools »
® Body Workflows »
Well Reload
& PointSef & |Save
[ Polygon ' R

@ Shapefil & Save as .
N Prestact @ Lock Treeitem
Annotations == Remove from Tree

35. One by one display all five attributes that were output.
See if other similar bright spots can be recognized.
Change the color bars if need be.

Workflow cont’d:

The “Classification: Class” returns

The “P” is the probability volume associated an integer corresponding to the
to each PDF distribution. most| likely PDF at each sample
location.

The “Classification: Confidence” returns the The determination strength gives a number
distance between the most related to the relative position in
likely and second most likely PDF distribution. the most likely position (Histogram count).
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2 Part Il:
Commercial Software

Under a commercial, or academic license agreement OpendTect, the open
source seismic interpretation platform, can be extended with a range of closed
source extensions. These extensions are protected by FlexNet license keys. All
extensions, also the ones developed by other vendors are licensed through dGB.

For purchase/maintenance fees please contact dGB via inffo@dgbes.com.
As stated before the exercises in this manual can be executed without license

keys as OpendTect does not check license keys when the survey you work on is
F3 Demo.
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2.1 OpendTect Pro

What you should know about OpendTect Pro

OpendTect Pro is a commercial layer (closed source, FlexNet license key pro-
tected) that extends the free OpendTect software with extra functionality. All com-
mercial plugins require an OpendTect Pro license to run.

Among others OpendTect Pro offers:

» PetrelDirect, a two-way seamless connection to Petrel,

An interactive basemap with mapping functionality;

PDF3D plugin for sharing 3D images (see below);

A Thalweg tracker for tracking seismic facies;

An accurate ray-tracer for AVO attributes and Angle Stacks.
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2.1.1 PetrelDirect

What you should know about PetrelDirect

PetrelDirect is a two-way data connectivity solution that enables OpendTect to
work directly on a Petrel data store. Data can either be linked (no data duplic-
ation) or copied. The advantage of copying data is that usage of the Petrel license
is restricted to a minimum. Apart from linking / copying data PetrelDirect can also
be used to set up an OpendTect survey.

The following features are supported with full two-way access:

3D seismic volumes

3D horizons and horizon attributes
2D seismic lines

Fault stick sets

Wavelets

One-way access: Petrel > OpendTect is supported for:

» Wells: tracks, logs, markers (time/depth curves and/or checkshot data is
automatically transferred with the track if present)
» 3D Seismic pre-stack data.
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2.1.1a Set up PetrelDirect Plugin

Required licenses: OpendTect Pro.

Exercise objective:

To check the setup and verify that the PetrelDirect plugin is installed in OpendTect and Petrel*.

The PetrelDirect plugin allows OpendTect Pro users to seamlessly exchange data with the Petrel* data store of a
running Petrel* project. The data exchange exercise between Petrel and OpendTect can be replicated only if the
PetrelDirect Plugin is installed and OpendTect Pro and Petrel licenses are available.

ataacon 0 e
Shaw Log File Autorspdate Fobey .

OpendTect:

& pphes Sesngs
Connection Settiogs .

1. The PetrelDirect plugin is a part of OpendTect
Pro. Once OpendTect Pro is installed, Start
OpendTect

~| Flugn name [Petrebrect (sase)

Froduct [OpendTect Fro

2. Verify that the PetrelDirect plugin is installed
and license is active: OpendTect > Utilities > g
Installation > Plugins > OpendTect Pro. Select Pk
PetrelDirect h

Lirary name | dGePetrelnccess Al

Information |Dizect daza access from and 5o Fesrel ().

st

FeveDrec (G
PetréDirect Tooks] (6U)

Load 3 pugn .

* Petrel is a mark of Schlumberger ]

Petrel*:

To be able to use PetrelDirect functionality in Opendtect Pro, Data access for OpendTect (dGB) plugin must be installed
in Petrel*. Installation can be done either via Windows installer (.msi file) or Plugin Installer Package (PIP file).

Via Windows installer (.msi file):

The Windows installer does both the first-time plugin installation and an update of already
installed plugin to a newer version without any extra actions.

1. Download the .msi file from the dGB's download page in the OpendTect Pro plugin for Petrel*
2. Run the .msi file and follow the instructions.

3. Start Petrel*

4. Go to the Seismic Interpretation tab and observe that OpendTect toolbar is present:

Seismic Interpretation

S s e
o5 o

s |
Cemo0-o» 5t - @ | v ia - 4 Well
setvp 2| Seimmic-wel calbraton

8| Seisemic (g

Managers

*Petre.’ is a mark of Schlumberger
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Petrel*:

To be able to use the PetrelDirect functionality in Opendtect Pro, Data access for OpendTect (dGB) plugin must be installed
in Petrel*. Installation can be done either via Windows installer (.msi file) or Plugin Installer Package (PIP file).

Via Plugin Installer Package (PIP file):

For the plugin to update to a newer version, any old version must be EEFFCEEDT T
uninstalled first:

1. Start Petrel”
2. In Petrel* main window: go fo File > Options > Plugin Manager:
3. In Ocean Plugin Manager window: uninstall the old version

of Data access for OpendTect (dGB) plugin by selecting it and
clicking the Uninstall button.

4, Close Petrel*

© Ocean Plug-in Manages

0 @ &

Plugins Store  Securty

‘Ynur installed plug-ns (1)

o

*Petfei is a mark of Schiumberger

Petrel*:

To be able to use PetrelDirect functionality in Opendtect Pro, Data access for OpendTect (dGB) plugin must be installed in
Petrel*. Installation can be done either via Windows installer (.msi file) or Plugin Installer Package (PIP file).

Via Plugin Installer Package (PIP file):
For a first-time installation, or once the plugin version is uninstalled:

1. Download the PIP file from the dGB's download page in the
OpendTect Pro plugin for Petrel*.

2. Start Petrel*

3. In Petrel* main window: go to File > Options > Plugin Manager:

In Ocean Plugin Manager window:

Click on Install plugin button

5. Locate the PIP file and click Open

6. Once the installation is finished, click Close in both windows
7

8

&

Restart Petrel*

Go to Seismic Interpretation tab and check that the OpendTect toolbar is present

eling

& & & Wavelet toolbox E‘»’ ‘ B surface attributes | @
i R Log condiioning e el & S
Sessmic - - Insart Sei Mesh Volume  Mixer _ ) et Geobody Make FPolygon

@O welitie - @ Welltie editing - editing | attibutes 4 Meunslnet - interpretstion - =} B | sudfsce editing @

Setup o| Seismic-well cabration = | 2D/3Dimerpretation % | Mesh Amibutes Volime interpsetation Structore | Swructunal fr...| Depth Utiities

B | Seismic (defavt) -
s

Managers

*Petrei is a mark of Schlumberger
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Link OpendTect and Petrel* projects

PetrelDirect status button - helps monitor the status of the connection to Petrel*. Clicking the button will open the settings
window. The drop-down menu next to it allows to directly control the status of the connection:

. - disabled (drop-down menu next to it allows to Enable connection)

* @] - uninitialized (connection is enabled, i.e. will be activated once PetrelDirect is used; drop-down menu next to it allows to
either Disable connection or Initialize now)

+ [94 - active (drop-down menu next to it allows to Disable connection)

If the connection is enabled and left initialized, the PetrelDirect status will become active once Petrel is used

1. Start Petrel* and Select the Project of interest.

2. Start OpendTect. At startup, the Petrel connection [¥] is disabled (in the
lower right corner of the main OpendTect window). Select Enable from the
drop-down menu. When the connection is enabled, the PetrelDirect status
icon becomes active [

E?

57

Disable

3. Select /nitialize. The icon turns pgindicating that the connection has been

established between Petrel and OpendTect.

* Petrel is a mark of Schlumberger

Choosing the preferred Communication Port (TCP/IP)

Petrel:

By default the plugin should use the TCP/IP port 57375; if this port is not available or accessible,
it can be changed in two ways:

1. From the Petrel plugin user interface, which is available under the 'Seismic interpretation' tab in
the Petrel* ribbon.

Seismic Interpretation o Propedty Modeling

%{E e Wavele - @ £ U Porteditg % = EJ L)
F& og conditioning - B ) ke polygons e =
s Ingert e insert . Make  Pobgan G Settings  Run
B Well tie editing M tion eaing B o Manager By Map-based Wmes | sumce  eatng G Surtece editing ~ L: OpendTect
Selsmicanell caloration 2050 interpretation = | Mesh G- Volume interpretation = | Structre | Structural ramework Deotn utaities Gur OpendTect
5 setings for OpendTect comnecten - @ x
1P Commanication Port Fr37s
| GpendTect instaitation directory |C1Pragram FresiOpendTects 60 Select ..
o

2. By adding an environment variable DTECT_PETREL PORT, and setting the value to the
preferred port number which is available for access.

OpendTect:

The Petrel* connection setting can be set and modified in the PetrelDirect status window. The
TCP port number must be the same as the port number specified on the Petrel* side. The default
value of 57375 should work in most cases. s

Link status 5] (Aciwe)

TGP porttouse] sTaT5 b
Disatle connection oneror & Yes O No
Enstie comecion ststanup & Yes O No

* Q Al Q Cose @) Hep
Petrel is a mark of Schlumberger

- 160 -




2.1.1b Set up Survey using PetrelDirect

Required licenses: OpendTect Pro.

Exercise objective:

To show how an OpendTect survey can be quickly set up from an existing Petrel* project
using PetrelDirect.

Workflow:

1. Choose Select/Setup option under the Survey menu
or click on the Survey Setup icon Q .

Import 4
2. Click on the Create New Survey icon ¢ in the 1 f;;"’;’;e :
Survey Setup and Selection window. Pre-load ,

Exit

P} Survey Setup and Selection = (m] X
&]Survey Data Root ... [C:\Surveys =
AusNW_Shallow-Demo_2018_PdC E F3 Demo 20 G
AusNW_Shallow-Demo_PdG & P
F3_Demo_2018_PdG By § 2
F3_Demo_2020 L‘:’ 75y e | G
F3_Demo_2020_20jul21 »
F3_Demo_Fault_Extraction_2018_ |5
Groningen_Petrel_model_depth_m
Groningen_Petrel_model_depth_m @
My_Mew_Survey
Survey_from_Petrel 100300 100/125C
*Petfei is a mark of Schlumberger
Workflow cont’d:
3. Specify a Survey name; select Use i@ Create New Survey - b0 X
PetrelDirect; Set Time for Z Domain and Specify new survey parameters
press NEXt' Survey name ||Survey From Petrel ”
Available data [] 3D D
4. Select a seismic data set from the Initial setup E::e ”s:;'g‘fr_fc(t )
. = Scan -Y file(s
Petrel project to set up the OpendTect 2 Set for 2D only
survey (% Scan Navigation Data
K Copy from other survey
5. Press OK. T Read from Survey Setup file
) Enter by hand
@ Get survey setup from Petrel = m] X Z Domain @ Time | O Depth
Base the OpendTect survey on
v [ seismic
Input Seismic Survey F3 Demo QCanceI 0
F3 Demo ~  In |Seismic bl
| Ok | Ocanel @
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Workflow cont’d:

6. You would see the survey
information filled-in
automatically from the selected
Petrel” project set-up. Press
OK to set-up the survey.

7. Apop-up message asking if you
want to proceed with the data
import. Select No, if you don't
want to proceed with bulk data
import from Petrel.

@

o Proceed to import all listed data?

ove

@ Edit Survey Parameters

Survey name Survey From Petrel

Location on disk C

\Surveys
Survey type Both 2D and 3D~
Ranges/coordinate settings Enter below e

== Survey ranges @ Coordinate settings B I/C to X/Y transformation % Coordinate System

In-line range (100 /(750  [2] step [1 2| Nr.In-lines: 651

Cross-line range \300 * \1250 +| Step |1 +| Nr. Cross-lines: 951
Zrange 0 (1848 |step s millisecond v
Display depths in ® Meter O Feet
Seismic Reference Datum (m) |0 ]
¥ Apply

[Go ] Ocel @

Free space on disk: 35.97 GB
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2.1.1c Import data from Petrel using PetrelDirect

Required licenses: OpendTect Pro.

Exercise objective:
Import data from Petrel* to OpendTect using PetrelDirect.

Introduction
PetrelDirect is an OpendTect Pro feature for direct data transfer between CigandTect and Petrel* projects. Reading data from a
Petrel* project is available in various OpendTect workflows via insert icon , which allows to either access data directly from a

Petrel* data store via links or physically data copy to an OpendTect project:
Link to Petrel*:
« no data duplication;
« data is available only when the Petrel* project is running and PetrelDirect connection is active (i.e. Petrel* license is tied).
OpendTect copy:
« physical copy data in OpendTect format;
« no restrictions on data access (i.e. Petrel* license is not tied and data is accessible to all users).
Either method gives full potential for manfpuia@n, interpretation and processing. Writing data to a Petrel* project is also available
in various OpendTect workflows by choosing PetrelDirect output format.

PetrelDirect support the following objects:

» Full two-way access (Petrel* <> OpendTect):

Faults and FaultStickSets, 3D horizons, 2D and 3D seismic, Wavelets, Wells (tracks, time-depth models and logs)
» One way access (Petrel* > OpendTect):

2D horizons, 3D prestack seismic, Wells (markers)

Batch processing for importing objects is now available for Faults, FaultSticks, Horizons and Seismic Cubes.

A check box to use the original name is provided which should be checked in case the same needs to remain identical to the
object in the Petrel project. Any name entered into the field adjacent to this will be used as the 'base name' for the objects.

The following exercises will cover some examples of data exchange between Petrel and Opendtect .

Exercise objective:

Use PetrelDirect to import all data in one go from Petrel* to OpendTect at Survey creation.

Workflow: o Proceed ta import all listed data?
o

1. Perform the same steps as in Exercise 2.1.1b to set g
up an OpendTect survey using PetrelDirect, except s ouspe moneas

the last step. At the pop-up message asking if you i —L
want to proceed with the data import, Select Yes, to :mzzml
proceed with bulk data import from Petrel. 24 me
v (@l F6 Block
[ A ros-1
2. Select All Objects in the Datatypes and Hit OK. For a T e
large amount of data you can use the ‘Execute in §5°°°;¢§5‘“:£;.| "
Batch’ option. e

[ % Demo 0 > F54 Petrel

[ 8¢ Demo 1 > MF54 Petrel

(1484 Demo 2 > F56 Petrel

[Z1%& Demo 3 > Tep Foresets Petrel
[ ¥ Demo 4 —> Truncation Petrel

[ 8¢ Demo § --> F57 Petrel

[ 8¢ Derno 6 > Fs8 Petrel

Note that ‘Datatypes’ and ‘Filter’ can be used to list ﬁgiﬁi,,iﬂﬁiﬁiﬁfw
. [ ¢ tst2del_Inter_Demo 0 —> FS4
and select only the data of interest to be loaded. 2 st a0 > P
[ Execute in Batch Options ...
Qcort| @

*Petfei is a mark of Schlumberger
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Exercise objective:
Use PetrelDirect to import 3D seismic from Petrel* to OpendTect.

Petrel* 3D seismic cube can be accessed in OpendTect by clicking on PetrelDirect insert icon & in the following places:

» Manage 3D Seismics window (Survey > Manage > Seismics > 3D... or click on ¥, icon in the Manage Data toolbar)

+ Select window when adding a seismic attribute display at In-line/Cross-line/Z-slice/3D Horizon in the 3D scene

« Other workflows, including attribute definition and processing, etc.

Petrel* seismic data must have compatible geometry with OpendTect survey set up. The easiest way to achieve this is to get survey
set up from Petrel* when setting up a survey and choose an appropriate Petrel* seismic survey folder as the geometry source.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set
up an OpendTect project using PetrelDirect.

2. Select Survey < Import < Seismic Data < PetrelDirect
< Cube. Select the Seismic cube from the Import
Petrel Seismic Cube window.

3. Create either Link to Petrel* or OpendTect Copy. Note S—— = ==
that the Link to Petrel option, requires Petrel License 8 ot e
to be able to use the seismic in OpendTect. 13 oo st e s 1
Volume subselection | 100/300-750/ 1250 (463 samples) O Select

Ml traces ® Discard O Poss

4. Keep the default parameters. Tick Use Original Name = o

Create ) Link to Petrel ® OpendTect Copy

Output Cube and Hit Run. e e e 0 e s e T
Eelew o

*
Petrel Is a mark of Schlumberger A by GBS Pelrel{DpendTect eopevsction

Exercise objective:
Use PetrelDirect to import Faults from Petrel* to OpendTect.

Petrel* fault interpretation can be accessed in OpendTect as Faults by clicking on PetrelDirect insert icon i the following places:
*Manage Fault window (Survey > Manage > Faults... or click on _ icon in the Manage Data toolbar)

*Select Input Fault(s) window when adding Fault(s) to the 3D scelw; 2D viewer or Basemap by right click on Fault in the tree > Add)
This workflow is similar to import FaultStickSets from Petrel to OpendTect.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set S oo sen S
up an OpendTect project using PetrelDirect. s ?‘AA;:;:;E. |

2. Select Survey < Import < Faults < PetrelDirect. Select (2% o™ .
the Fault from the Import Fault window. r— S— -

- =] Filter —

3. Create either Link to Petrel* or OpendTect Copy. Note | - = e v .
that the Link to Petrel option, requires Petrel Licenseto . :
be able to use the Fault in OpendTect. 1 Use il N Pk 1 AL 26 Oseect.

O Execute in Batch - Options
4. Keep the default parameters. Tick Use Original Name oL

Output Cube and Hit Run.

Note that OpendTect does not support crossing fault sticks (a fault plane cannot cross itself). If faults were picked on inlines,
crosslines and horizontal slices, only the largest subset of the three will be used to import the faults. Manual editing (removing
unwanted sticks) is possible after import and might be required in some cases.

* Petrel is a mark of Schlumberger
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Exercise objective:
Use PetrelDirect to import 3D Surfaces from Petrel* to OpendTect.

Petrel 3D horizons and surfaces can be accessed in OpendTect by clicking on PetrelDirect inserticon & in the following places:

* Manage 3D Herizons window (Survey > Manage > Horizons > 3D... or clickon & icon in the Manage Data toolbar)

- Select Input Horizon(s) window when adding 3D Horizon to the 3D scene, 2D viewer or Basemap by right click on 3D Horizon in the tree > Add)
= Other workflows, including 3D Horizon gridding and filtering, creating flattened scene, etc.

This workflow is similar to import 2D Horizon from Petrel to OpendTect.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set
up an OpendTect project using PetrelDirect.

2. Select Survey < Import < Horizon < PetrelDirect< 3D
Horizons. Select the Horizon (s) from the Import Petrel
Horizon window.

3. Create either Link to Petrel* or OpendTect Copy. Note
that the Link to Petrel option, requires Petrel License to
be able to use the Horizon in OpendTect.

Hortzon proporties/dtrdes:

Create O Lk to Petrel  OpendTect Copy.
1 U Oviginal Hame. Hextzon @ sect.

4. Keep the default parameters. Tick Use Original Name Beascee
Horizon and Hit Run.

OpendTect project is based on a particular 3D survey set up. Petrel* 3D horizons associated with 3D seismic surveys which
geometries are different and Petrel* surfaces based on grids which are different are snapped to an OpendTect grid during import.

[Ern ] @ @

*
Petrel is a mark of Schiumberger

Exercise objective:

Use PetrelDirect to import Wells from Petrel* to OpendTect.

Petrel well data (deviation survey, time-depth model, logs and well tops) can be accessed in OpendTect by clicking on PetrelDirect
insert icon [ in the following places:

* Manage Well window (Survey > Manage > Wells... or click on 4, icon in the Manage Data toolbar)

* Load Well(s) window when adding well(s) to the 3D scene or Basemap by right click on Wellin the tree > Add)

+ Other workflows, including well-to-seismic tie, Log attribute definition and processing, etc.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set

up an OpendTect project using PetrelDirect. “ M
2. Select Survey < Import < Wells < PetrelDirect. Select o oam )
the Wells(s) from the Import Petrel Well window. :mmmmmn: v
3. Create either Link to Petrel* or OpendTect Copy. Note T R e e
that the Link to Petrel option, requires Petrel License to §
be able to use the Wells in OpendTect. . ::::‘:.‘?: .

o Scasurface

4. Keep the default parameters and Hit OK.

Selection of well logs and markers can be done using the Filters, Show only
common logs/markers switch, then Select buttons.

Create ©) Link to Petrel @ OpendTect Copy

Dcancel | @

* Petrel is a mark of Schiumberger
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Exercise objective:

Use PetrelDirect to import Wavelet from Petrel* to OpendTect.

Petrel* wavelets can be accessed in OpendTect by clicking on PetrelDirect insert icon in the following places:
» Manage Wavelets window (Survey > Manage > Wavelets or click on @ icon in the Manage Data toolbar)

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set
up an OpendTect project using PetrelDirect.

2. Select Survey < Import < Wavelets < PetrelDirect.
Select the Wavelets (s) from the Import Petrel Wavelet

W|ndOW_ @ Import Petrel Wavelet
- —&
~ [ seismic
3. Create either Link to Petrel* or OpendTect Copy. Note s
that the Link to Petrel option, requires Petrel License to ::LT;;.,P.W e
be able to use the Wavelet(s) in OpendTect. e e
ooe @
4. Keep the default parameters and Hit Run. Addad by 58’ PerelopandTact contacton

*Perref is & mark of Schiumberger

Exercise objective:
Use PetrelDirect to import Pointsets and Polygons from Petrel* to OpendTect.

Petrel pointsets and polygons can be accessed in OpendTect by clicking on PetrelDirect insert icon & in the following places:

» Manage Pointset/Polygons Windows (Survey = Manage > Pointsets/Polygons... or click on the ¥, icon in the Manage

Data toolbar). When adding from PointSet/Polygon manager, user will have a selection box to choose which kind of object they
want to import from Petrel*

* Load Pointsets (Polygons) window when adding pointsets (polygons) to the 3D scene or Basemap by right clicking on Pointsets
(Polygons) in the tree > Add). The relevant dialog box pops up.

Workflow:

1. Perform the same steps as in Exercise 2.1.1b to set
up an OpendTect project using PetrelDirect.

2. Select Survey < Import < Pointsets/Polygons < @ impa e Fiaes
PetrelDirect < Polygons (or Pointsets). Select the T =15
Polygons (s) from the Import Petrel Polygons window. 9 et rondsate rtoce_Domo 0 -> £
. . s F4 use Original Hame FickSet Group 2 ce_Dem S © Select ...
3. Create either Link to Petrel* or OpendTect Copy. Note [E] 0o ©

that the Link to Petrel option, requires Petrel License to
be able to use the Polygons/Poinsets in OpendTect.

4. Keep the default parameters, Use Original Name and
Hit Run.

*Perref is & mark of Schiumberger
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2.1.2 Basemap

What you should know about the basemap

The basemap utility in OpendTect Pro is a new module for interacting with the
data while presenting a clear overview of the interpretation exercise at hand.
From the basemap the user populates a 3D scene with data elements (inlines,
cross-lines, random lines, 2D seismic lines, Z-slices, horizons, wells, etc.) and / or
pops up 2D viewers. The module also features options for gridding / contouring
and for creating final maps. As the module is brand new in version 6.0 some func-
tionality will evolve as the product matures over time.
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2.1.2a Basemap

Required licenses: OpendTect Pro.

Exercise objective:
Use the Basemap to populate/manipulate the 3D scene.

1. Pre-load 4. Dip steered median filter (optional, see
Exercise 1.3.1b for details).

can be done in 3 ways:

:F3_Demo_2015 - [Scene 1]
Utilities Help

Work Area

Z-Scale

Viewer 2D

Stereo Viewing *

I Step 0

Toolbars >

2. To open the basemap, click on the @‘ icon or go to
View > Basemap.
3. Add aninline to the basemap and the 3D scene®. This

Add Cross-ine
Add In-iine and Cross-iine.

a) Press (once) keyboard | and drag the line to the
correct position : the line humber is shown in the - b 0 oo 4o00m
tree and in the lower left corner. ,
Basemap Tree g
b) Move the cursor in the basemap to the correct Elemen: Coor |
position; right-click and Add Inline. Seftings
V| gin-
¢) Right-click in the basemap tree > Add. 7) @ Cross
V| & Z-Slice

v| @ Seismic Outline

L R I

The basemap can be used: 1) to populate a 3D scene; 2) to pop up
2D viewers; and 3) as standalone utility, e.g. when creating output
maps. All options are controlled from the Synchronization menu.

= Basemap - Scent
Basemap Processing | Synchronization | Hi
o= I 2D Viewers ¢

v | 3D Scene f
. Basemap Tree sy

Workflow cont’d:

4. Move the inline to a new position: hover over the
inline until it shows up in bold; left-click and drag to
the new position®.

Add a crossline with pressing (once) keyboard C.

Add a random line pressing keyboard R; Left-click
to add corner points and double-click to end the line.

To insert a new node after the random line is drawn:

Hover over the random line until it shows up in bold and
then shift + click.

To delete a node ctrl + click on it.

0 000 8000m
e —

] 4000 8000m
2"

*If the basemap is synchronized with the 3D scene (as in this exercise) you can also re-

position elements using all options supported in the 3D scene, e.g. nis2 >sept - ) .
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Workflow cont’d:

% Add
7. Right-click on Well in the basemap tree Z
and select Create Group. o & | Propeties..

=] Remove All

8. Add F02-1 and FO3-2 to the group.

) Select Basemap parameters [o-e=]
9. nght-Clle on the Group and select Well symbols |!oilwe|| |+] size |5 | [7] Display Projection
Properties.
For the sake of the exercise let's assume

these wells are oil wells: select the

corresponding Well symbol and change
size to 5.

10. Repeatthe exercise for F03-4 and F06-1: 562
Give another well symbol to these two, say
oil and gas.

--507

0 4000 8000m
D e —

[

Workflow cont’d:

11. Add other elements (horizon, contour, shapefiles, ...)
and change the basemap settings (right-click on

Settings). Basemap Tree a8
12. To create final maps you can process your horizon Sl Color
before printing: under the Processing menu you will find ‘
options for filtering or gridding. Basemap Synchroniz @ In-line
e Fitering .. [ 07 i Cross-line

_|_Gridding .. & Z-slice

@ Cube Outline
~ Random Line
17 2D Line

% 3D Horizon
< Contour

~4 2D Horizon
FaultStickSet
A Well

i PointSet

[> Polygon

¥ Shapefile

[&] Image

FE Annotation

] F3_Demo o,
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2.1.3 PDF3D

What you should know about PDF3D

The PDF3D plug-in supports the capture of a 3D scene in OpendTect and to save
the captured information in PDF format. The 3D PDF file can then be viewed,
rotated, zoomed, and manipulated in Adobe’s free Acrobat Reader software that
is installed on most computers. PDF3D thus greatly improves communication of
complex seismic interpretations. The PDF3D plug-in to OpendTect allows volume
sections, horizons, wells and interpretation features to be embedded within a
secure technical report.
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2.1.3a PDF3D

Required licenses: OpendTect Pro.

Exercise objective:
Grab a 3D scene with PDF-3D for sharing via Acrobat Reader

| || <
- SEG-Y
Workflow: “* Save scene
‘g4 Save scene as...

1. Prepare the scene you wish to capture and
press the drop down sign adjacentto PDF-
3D icon 1. Select Save scene as...

2. Specify the Output PDF file name (e.qg.
Example_pdf3d) and select Half the
resolution for the horizons.

- Save scene as - oIEN
Output PDF file name [\Example_pdf3d.pdf O Select ...

Select horizon resolution | Half v

[T] set password for open exported PDF3D

@ok | @ cancel| ) Help

Workflow cont’d:
Preferences
Categories: 3D and Multimedia Options
. . . Commenting ~ Renderer Options

3. Open the file in Acrobat Reader v8 (or higher). Decumers Prefered Rendere

g*f‘efs' ‘ [ Enable hardware rendering for
) o age Dislay _

4. Ensure that double-sided rendering is enabled. EIERHE dosh et e

Accessibility Preferred 3D &‘!l Rendering Mode:

5. Use the left mosticon on the toolbar to zoom, pan, rotate
etc.

6. Use the tree to toggle elements on and off.

- e
D [Views v -0 &
B model - > 8 oy » @
[} (£ OpendTect Scene -- dGB

5 [ Well: F03-2
7 ¢ Log: F03-21
% TrackF03-2
% (o In-Line: 425
@ [¢# Survey box
5 (¢ Horizon: Demo 0 --> FS4
& Horizon: Demo > F!
« PDF3D-SDK Lights From File
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2.1.4 Thalweg tracker

What you should know about the Thalweg tracker

A Thalweg is a geologic term to describe the path of a river as it flows through a
valley (Thalweg is a German word; Thal means valley and Weg is path). A Thal-
weg tracker operates in a similar way: it follows the path of least resistance. It
does this by adding only the best matching position per iteration. The tracker can
be used to track 3D bodies and / or horizons and is typically used for detailed seis-
mic facies mapping e.g. for tracking channels.

The Thalweg tracker tracks samples in an input seismic cube based on certain
user-specified constraints. Initially the user points a single seed position. The
seed is considered to be a cube of unit size and the next sample to be tracked is
chosen from all available samples along the faces’ of the seeds. In the first iter-
ation, all six neighboring samples along the six faces of the initial seed act as can-
didates for tracking. Only the best matching position is added. In the next
iteration, all samples neighboring the two currently accepted positions now act as
candidates and again only the best matching position is added. This process con-
tinues until it is no longer possible to add candidates that meet the tracking con-
straints.

A Thalweg tracker adds only one position per iteration. If you choose to accept
more than one position per iteration, the Thalweg tracker becomes a margin
tracker. Thalweg and margin trackers are typically used sequentially. For
example in the exercise hereafter we first use the Thalweg tracker to track a chan-
nel. Once the channel is found we change the settings to track the channel mar-
gins.

The output of a Thalweg tracker is a Point Set that is typically converted into a
"snapped" horizon. All tracking attributes can be saved with the horizon tracked in
this way. The tracking attributes can also be used for further analysis in the Cross-
plot tool.
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2.1.4a Thalweg Tracker

Required licenses: OpendTect Pro.

Exercise objective:
Track a channel (and its associated margins) using the Thalweg tracker.
Elements Color
Workflow: Scene 1
.,lcn,!_
Lo ) ) & 25| Add and Select Data
1. Add an inline with default data in the @ Vo Add 3t Wel Location
~ Ra__Add Color Blended
scene.
= Thalweg Tracker =8 gon ==
2 LaunCh the ThalWeg tra.Cker from the Input cube @A 4 Dip steered median fitter [] | © select..
Ana|y5|5 menu (Ana|y5|5 > Tha|Weg Area subselection | 100/300-750/1250 (463 samples) [© seeect.|
tracker) or click onll icon. siart Possion (nICr) Z(me) [R] vae
Event to track ® Minima Maxima
3. The default data volume for this Vi Treshot HaxTesteld
survey will appear automatically in e seeett
R Amplitude Sum Scaler 1 Amplitude Sum Step (ms) 1
the Input Cube field. i AT R T ———T—
1/1000 o0 S [Not Appiicable 0.000 |=
The Thalweg tracker is not a conventional S
tracker: it is using a weighted voxel FAED et
> ) A Output horizon [-] [© setect..| @acs [l
approach to track seismic facies. I R
Hence it is not limited to map channels. (Gromionoreor)
© Close|
Workflow cont’d:
4. Move the inline to 365: click on the inline 425 and type in Inj425 [+istep1_[=] 4 mp | |4500
365 in the Slice Position toolbar, or use the basemap and \ Lm"
drag the inline to the wanted position. & | scene
= Inine
‘
. . . . =4 TDIb steered me...
5. Pick an event: press % icon and pick a seed at crossline _ | @ crssine
647 at 1024ms.
Intne 365 Step 1 | dmmp| (¥ = < Bg @ - B1 2y 4 0 4| {4500 1 4500 [1aScismcs &l
of P———— - ————— —  ———— .
— - ==y
2w %k
= input cube [ [&] 4 Dip steered median fiter ~][© select
Avea subselection 100/300-750/1250 (463 samples) © select |
Start Position (WCr) 365 641 2(ms) 1024 | & P Value: 5220
= Z Min Thiphete®™ 0478 Max Threshold O
e e Scalr 1
C—— lf'% Ampitude Sum Scaler |1 Ampitude Sum Siep (ms) 1
—— ——— 5 Schedule Ma Nr Cells Cells per teration Cuteoff criteria Cuottvave | (]
e e e  Show Poits
SR e e *‘*”':'.'-_ o Bl | T —
The software will snap to the nearest event (Minima or £ i, e
Maxima, as chosen by the user) automatically for the | =)
picked position and fill the corresponding fields. — T
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Workflow cont’d:

' Thalweg Tracker =R
od RN
Input cube 4 Dip steered median filter B
Area subselection | 100/300-750/1250 (463 samples) e Select ..
Start Position (Inl/Crl) | 365 647 Z(ms) 1024 m Value: -5239
Event to track @ Minima Maxima
6. Keep default values for I — -
. . in reshol =t ax reshol
Amplitude Scaler, Amplitude
. Amplitude Scaler |1
Sum Scaler and Amplitude
Amplitude Sum Scaler 1 Amplitude Sum Step (ms) 1
Sum Step (ms). :
Schedule Max Nr Cells Cells per iteration Cut-off criteria Cut-off value | @

11000 =1

0.000

“Nothppiicable

Schedule: set the values as
shown in this screenshot.

| Track View Log

] (@ 5ok oo

Press the Track button to
start reading the input

V| Show Points  Display Settings

Output horizon

VOlume and traCkIng v] Snap to event; Search gate (ms) -4 4
%‘;@

The first row of the schedule table represents the thalweg settings e.g. Max Nr Cells = 1000
and Cells per iteration = 1.

Workflow cont’d:

9. Once the processing is finished, it will display the result as color-coded points.

) Thaiweg Tracker |E=5Eon ===
%k
input cube (&) (5] (4 Dip steered median fiter [][© setect..|
Area subselection [100/300-750/1250 (463 samples) © select .|
Start Position (IniCrl) (365 647 Z(ms) (1024 | [ ] Value: 5229
Event to track @ Minima Maxima
Min Threshold |-10478 Max Threshold [0
Amplitude Scaler |1
Ampltude Sum Scaler 1 Amplitude Sum Step (ms) |1
Schedule Max Nr Cells Cells per iteration Cut-off criteria Cut-off value ‘ Z
1/1000 =0 | Not Appiicable 0.000 I=
[ Track | [ViewLog_..]
¥ Show Points [Display Settings .|
Output horizon [*][© select .| @dcB [

71 Snap to event Search gate (ms) -4 4

B,

Greate horizon]

© Close:

Finished Tracking

Output of the extracted channel.
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Workflow cont’d:

10. If you are satisfied with the results, specify the Output horizon name. Optionally, toggle
on Snap to event, to output a horizon snapped to the nearest Minima or Maxima in a user

11. Press the Create horizon button.

W e ———
— N

e = Thalweg Tracker =3 o8~
= %k
input cube iS5 5] (4 Dip steered median fiter ] [© setect..|
Area subselection | 100/300-75011250 (463 samples) © select .|
Start Position (Crl) (365 647 2(ms)[1024 | [R] value: 5239
Eventto track @ Minima Maxima
Min Threshold |-10478 Max Threshold |0
Amplitude Scaler 1
Amplitude Sum Scaler |1 Ampiitude Sum Step (ms) |1
Schedule Max Nr Cells Gells per iteration Cut-off criteria Cutoftvaie | (i)
1/1000 =0 = INot Apy 0000 1=
[ Track | [viewLog .
7] Show Points [Display Settings _.|
Cl = —-
] Snap to event; Search gate (ms) -4 4
[crete norcon |
%J @ Close
Finished Tracking
1] .
Workflow cont’d:
=% 3D Horizon
=[] Channel-1 -
V] Amplitude 3 |
. . . . v| Amplitude Sum 3 |
12. The horizon will appear in the tree as well as in the scene. 7] Thickness 1
v Cell Number 2 |
vl lteration n
. . 7| Schedule r
13. Turn off the Show points display. =i .
e — — N
1 Thalweg Tracker (=8 Eo8 ===
> - |
"
input cube (&) (] (4 Dip steered median fiter ] [© sekect..|
Area subselection | 100/300-7501250 (463 samples) © select .|
Start Position (In/Crl) (365 647 2(ms) (1024 | [R] Value: 6239
Event to track @ Minima Maxima
Min Threshold |-10478 Max Threshold |0
Amplitude Scaler |1
Amplitude Sum Scaler 1 Amplitude Sum Step (ms) |1
Schedule Max Nr Cells Cells per iteration Cut-off criteria Cutoftvaie | (i
1/1000 =0 |not Appiicabie 0.000 =
[ Track | [ViewLog .|
Output horizon | Channel.-1 [+] [© select .| @dcB [
9] Snap to event Search gate (ms) -4 4
[Greate horizon| ‘
B,
@ Close
Finished Tracking
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Workflow cont’d:

14. To track the margins of the channel, add a second schedule step and set the
parameters as shown in the figure. Turn on Show points and press the Track button

to obtain the T

— — -
/7_2,2 Start Position (InliCrl) 365 647

g and its associated margins.

= Thalweg Tracker (o e
B %k
Input cube (5] () 4 Dip steered median fiter [][© select.]
Area subselection | 100/300-750/1250 (463 samples) [© sekect..|
2Z(ms) 1024 (%] Value: -5220
Event to track @ Minima Maxima
Min Threshold 10478 Max Threshold [0
Ampltude Scaler 1
| Amplitude Sum Scaler |1 Amplitude Sum Step (ms) | 1
= Schedule Max Nr Cells Cells per iteration Cut-off criteria Cut-off value
[1] 1000 <1 | ot Appiicable 0.000 =]
Iﬁua =12000 = Percentage [~[5000 T
[ Track J]view Log..]
Output horizon | Channel-1 [*]|© select .| @dcB =l <
7/ Snap to event Search gate (ms) [-4 4

[Create horizon]

Finished Tracking

© Close

Workflow cont’d:

and merged into a single horizon.

Several horizons can be created |

1 Thalweg Tracker

Crossplot is a utility to
perform analysis on the

extracted dataset (e.g. if
you use an acoustic
impedance (Al) volume,
you can analyze
iterations with Al data).

Display Settings control the
display and color coding of
the points of  various
extracted attributes along the
Thalweg.

/! Display Properties N =2

Attribute to display |Iteration =

o .: ] 1015

i Rainbow =

Q close

~a{E]

Input cube @ 4 Dip steered median filter

Aréa subselection | 100/300-750/1250 (463 samples)

Start Position (In/Crl) 365 647 Z(ms)

Event to track @ Minima Maxima
Min Threshold -10478
Amplitude Scaler 1

Amplitude Sum Scaler |1

[-]|© select....

1024 | [R] value: 5239

Max Threshold 0

Amplitude Sum Step (ms) 1

Schedule Max Nr Cells Cells per iteration Cut-off criteria Cut-off value H—‘
1/ 1000 =1 | Not Applicable 0.000 E
22000 = 2000 <|Percentage E] 5.000 .
[ Track | [View Log ..
| Show Points- Display Settings

Output horizon  Chapr€l-1

v Snap to event;

Finished Tracking

[+] |© select .| @ dcB [+

Search gate (ms) -4 4

i iﬁ_g lose
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2.1.5 Raytracer

What you should know about the Raytracer

OpendTect Pro's ray-tracer is a 1D ray-tracer that computes the angle of incid-
ence at various interfaces in an elastic, horizontally-layered earth model. The ray-
tracer is used among others by the SynthRock plug-in to compute pre-stack syn-
thetics (P, S, and multiples). OpendTect Pro users do not need a SynthRock
license to make good use of the ray-tracer. Ray-tracing is used in the conversion
from offsets to angles e.g. when computing mute functions, angle stacks and
AVA attributes.

-177 -



2.2 Commercial Plug-ins

OpendTect supports free and commercial plug-ins. The latter are only available
under the OpendTect Pro license. Commercial plug- ins are used for specialized
and advanced tasks. dGB and 3rd party vendors ARK CLS, Estimages, Geo 5,
LTrace and Stark Reality provide commercial plug-ins for OpendTect.

Unless you are working on the F3 Demo training data set commercial plug-in
require FlexNet license-keys. You may wish to contact info@dgbes.com to
request an evaluation license.

Users can create their own commercial OpendTect Pro system by picking and
choosing the plug-ins they need. Logical sets of plug-ins have been combined
into bundles for typical G&G tasks. These bundles are licensed at discounted
prices. The following bundles are available:

» Geoscience.This bundle contains OpendTect Pro and the following plug-
ins: Dip Steering, HorizonCube, SSIS, Well Correlation Panel, Machine
Learning, Faults & Fractures, Fluid Contact Finder, SynthRock.

* Machine Learning. This bundle contains OpendTect Pro and the following
plug-ins: Machine Learning, Dip Steering, Faults & Fractures, SynthRock.

This manual follows a similar sub-division for training the commercial parts of the
software:

 Attributes & Filters.
» HorizonCube & Sequence Stratigraphy.
» Seismic Predictions.

Before starting the training exercises let’s first give short descriptions of the com-
mercial plug-ins per software vendor.
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2.2.1 dGB Plug-ins

As well as creating the open-source OpendTect software itself, dGB Earth
Sciences also develops closed-source plug-ins for OpendTect. See: dGB

website.

Dip-Steering

HorizonCube

The dip-steering plug-in allows the user to create a (dip-)
SteeringCube which contains local dip and azimuth inform-
ation of seismic events at every sample location. The cube is
essential for structure-oriented filtering (aka dip-steered fil-
tering), and improves resolution of numerous multi-trace
attributes (e.g. Similarity) by honoring and following dipping
reflectors. It also features unique attributes like Curvature
and Dip. Finally, a SteeringCube is an essential input to the
HorizonCube

HorizonCubes impact all levels of seismic interpretation.
They are used for:

» Detailed geologic model building,

» Low frequency model building for seismic inversions
» Well correlation

» Sequence stratigraphic interpretation system (SSIS).

A HorizonCube consists of a dense set of correlated 3D
stratigraphic surfaces. Each horizon represents a (relative)
geologic time line. Horizons are created either in a model-
driven way (stratal / proportional slicing, parallel to upper /
lower), or in a data-driven way via a unique dip-steered
multi-horizon auto-tracker.
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The Well Correlation Panel plug-in is used for picking well
markers and correlating markers guided by seismic evid-
ence. In combination with the HorizonCube, the interpreter
can use the slider for detailed seismic-steered correlations.

Well Correlation
Panel

The Machine Learning plug-in is for both operational geo-sci-

entists, experimental geo-scientists and research geo-sci-

entists. Links OpendTect Pro to the research world of

Python, TensorFlow, Keras, PyTorch & Scikit Learn. Is the

successor of our popular Neural Networks plugin, which has
Machine Learning peen fully integrated into the new plugin.

Machine Learning offers workflows for: seismic, wells, and
8 seismic-to-wells applications.

+

Train on real data extracted from multiple surveys, or on syn-
thetic data generated by SynthRock, OpendTect's stochastic
simulator.

Includes trained models for off-the-shelf applications such as
fault prediction by a U-Net.

The Faults & Fractures plug-in supports special attributes, fil-
ters and tools for analyzing faults and fractures. Included are
among others: Thinned Fault Likelihood, Smoothed Seismic,
Un-faulting, automatic fault-plane extraction, fracture density
and fracture proximity. In combination with dip-steering also:
dip-steered attributes and filters (SOF), and curvature attrib-
utes.

Faults & Fractures

Sequence Strati- The SS/S plug-in (Sequence Stratigraphic Interpretation Sys-

graphic Inter-  tem) is an add-on to the HorizonCube. SSIS supports full

pretation System sequence stratigraphic analysis, including automated

(SSIS) wheeler transforms, systems tracts interpretation and
annotations.

FCF is a seismic hydrocarbon detection technique where the
Fluid Contact  sejsmic traces are stacked with respect to the depth of a
Finder mapped surface (common contour binning). The objective is
to detect subtle hydrocarbon related seismic anomalies and
to pin-point gas-water, gas-oil, oil-water contacts.
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Velocity Model
Building

SynthRock

The VMB plug-in is used to pick up RMO velocities from pre-
stack Common Image Gathers. RMO velocities are used to
update the 3D velocity model in PSDM workflows. VMB sup-
ports picking on semblance gathers and picking of pre-stack
events for input to the PSDM- Tomography plug-in. Two
VMB modules are supported: Vertical update and Horizon
update. Models are constructed from combinations of grid-
ded/smoothed RMO velocities, interval velocities and 3D
body velocities (e.g. Salt body velocity).

The SynthRock plug-in is a forward pseudo-well modeling
and probabilistic inversion package supporting wedge mod-
els, stochastic models, pre- and post-stack synthetic seis-
mograms and cross-matching (HitCube) inversion.
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2.2.2 ARK CLS & Earthworks Plug-ins

ARK CLS make the following commercial plug-ins for OpendTect. See: ARK CLS

website.

Workstation
Access

B

Seismic Spectral
Blueing

Seismic Colored
Inversion

MPSI Determin-
istic Inversion

The Workstation Access plug-in is used for direct data
access to and from OpenWorks/SeisWorks and GeoFrame-
IESX.

The Seismic Spectral Blueing plug-in is a technique that
uses well log data (sonic and density) to shape the seismic
spectrum in order to optimize the resolution without boosting
noise to an unacceptable level.

Seismic Colored Inversion enables rapid band-limited inver-
sion of seismic data. SClI is rapid, easy to use, inexpensive,
robust and does not require expert users.

Deterministic inversion (by Earthworks and ARK CLS)
includes a 3D model builder for constructing a priory imped-
ance models using well log and seismic horizon data; a 2D
error grid generation module for providing spatial inversion
constraints and a model-based deterministic inversion mod-
ule. Even better deterministic inversion results can be
obtained if the low frequency model is built in OpendTect’s
volume builder using HorizonCube input.
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MPSI Stochastic
Inversion

Seismic Net Pay

4

Seismic Feature
Enhancement

Frequency Shap-
ing

\

Spotlight

©

-

Stochastic inversion includes the MPSI (Multi- Point
Stochastic Inversion) ultra- fast stochastic inversion module
for generating multiple geo-statistical realizations and the util-
ities for processing the multiple realizations to represent the
inversion uncertainty for lithology, porosity, saturation or
other attributes as probability cubes. This plug-in group also
requires the purchase of the deterministic inversion plug-in

group.

The Net Pay plug-in is an add-on to Seismic Coloured Inver-
sion to compute net pay and net-to-gross from thin and not
so thin reservoirs. Net Pay is based on BP technology.

The Seismic Feature Enhancement plug-in is a flat-spot util-
ity that enhances the signal of consistent flat events and
reduces the "noise" of the channel reflections.

Frequency Shaping is an innovative technique that integ-
rates well data into your seismic analysis. Two operators are
simultaneously derived using acoustic impedance logs and
reflectivity, once applied to the seismic data they effectively
broaden the amplitude spectrum of the seismic data at both
ends, low and high.

Spotlight adds quantitative interpretation capabilities to the
standard SCI workflow by rapidly combining up to 4 different
coloured seismic datasets into a single cube that resembles
the behaviour of a given elastic attribute. The relationship
between the input data and the desired output is established
from prior well log analysis.
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2.3 Attributes & Filters

OpendTect’s attribute engine can be extended with various plug-ins that allow
computation of advanced attributes and filters. As OpendTect’s user interface is
built dynamically, information about plug-ins (and certain attribute options in the
user interface) is only visible if the plug-in is installed and a valid license key is
available. (As stated before this is no issue when working on F3 Demo).

In this Chapter you will learn how to:

Remove random noise (Dip-Steering).

Sharpen edges (Faults & Fractures, Dip-Steering).

Visualize faults (Faults & Fractures, Dip-Steering).

Extract fault bodies (Faults & Fractures)

Extract Fault planes (Faults & Fractures)

Enhance the vertical resolution (Spectral Blueing).

Enhance amplitude anomalies (Optical Stacking (free), Fluid Contact
Finder, Seismic Feature Enhancement).

Visualize seismic patterns (Neural Networks).

Create a Chimney Cube (Neural Networks).
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2.3.1 Dip-Steering

What you should know about Dip-Steering

The dip-steering plug-in allows you to create and use a (Dip-) SteeringCube. A
SteeringCube contains at every sample position the dip in the inline- and cross-
line directions of the seismic events. These dips can be displayed as overlays on
seismic sections. Please note that you should display the cross-line dip on an
inline and the inline dip on a cross-line (right-click menu in the tree). In 2D, the
SteeringCube contains the apparent dip in the line direction.

The SteeringCube is used for:

Structurally-oriented filtering (e.g. dip-steered median filter)

Improving multi-trace attributes by extracting attribute input along reflectors
(e.g. dip-steered similarity)

Calculating some unique attributes (e.g. 3D-curvature, and variance of the
dip).

Dip-Steered auto-tracking of single horizons or multi-horizons as is done by
the algorithm that creates HorizonCube.

o ==

From a SteeringCube several valuable attributes can be computed. Most of these
attributes, which require SteeringCube are grouped under type Dip inside
OpendTect’s attribute set.
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Wyl B -
|Dip = | | Curvature = |?
Curvature =
Inl/Crl stepout | Curvature Gradient
D

Constant velocity | Dip Angle
FaultDip
Fracture Attributes

Velocity (m/'s)

Qutput | Mean curvature b

Steering Data IT]E |"E§ 2 Steering BG Detalled - E:i Select |

For example, OpendTect supports computation of a whole family of volume
curvature attributes. These attributes are useful in the interpretations of frac-
tures, geo-morphological features and drainage patterns. Other attributes that
can be computed from a SteeringCube are:

» The polar dip or true dip: the dip is measured from the horizontal and the
range of the dip is always positive and given in usec/m or mm/m.

» The Azimuth of the dip direction is measured in degrees ranging from -180°
to +180°. Positive azimuth is defined from the inline in the direction of
increasing crossline numbers. Azimuth = 0 indicates that the dip is dipping
in the direction of increasing cross-line numbers. Azimuth = 90 indicates
that the dip is dipping in the direction of increasing in-line numbers.

Detailed vs Background SteeringCube

In this training, you will be creating several SteeringCubes. The differences
between these cubes are in the algorithms used to calculate them and the use of
filtering. SteeringCubes called 'Detailed' are unfiltered or gently filtered, while
those named 'Background' are heavily filtered. Detailed SteeringCubes contain
details such as dip associated faults or sedimentary structures. Background
SteeringCubes contain only the structural dip.
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Examples of (Ieft to r/ght) Or/g/nal Se/sm/c (Full stack), Detailed Steering and
Background Steering

These Steering Cubes have distinct applications:
Detailed SteeringCube

e Dip & Azimuth attributes

» Curvature attributes

o Guide multi trace attributes (Similarity)
Background SteeringCube

» Dip Steered Median Filter

e Diffusion and Fault Enhancement Filter
e Ridge Enhancement Filter

[ Original Seismic Data ]

l
[ Detailed Steering ] [ Background Steerlng]
i Dip Steered Median
1 e e Flltel'
1 | Similarity |
________________ | ———— [ Dip Steered Diffusion ]
| Detailed Attributes | ! Fllter
( Analysis / i
———————————————— 1 Fault Enhancement
L l B Filter
ST T N Din. Azimuth )T o———— N Fault enhanced seismic
i Dip-steered | i an: Curvature i : Other I P— | S
l\ Similarity J '\__Ett[i_b_“'_tf-f'__/' Il\ Attributes ,' |L Improved Similarity |
________________________________ pass——
Ridge Enhancement
Filter
Sharp faults
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In OpendTect there are two different algorithms available for creating Steer-
ingCubes (e.g. BG Fast Steering and FFT). Coming few exercises will be carried
out using the BG Fast Steering algorithm (based on the phase of seismic signal).
More information about the SteeringCube can be found in the dGB Plug-ins Docu-
mentation: UserDoc.
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2.3.1a Steering Cube

Required licenses: OpendTect Pro, Dip Steering.

Exercise objective:
Compute a Steer'ngcube. Processing | Scene View Utilities CLAS l:(zlp
Create Ssismic Output & - = ., O o
Create Horizon Output~ » = = LB Sy
b Wells g
Workflow: (Re-Stat Bateh Job
Dip Steering »
- . . . . = GMT Mapping Tool Filter
1. Bring up the Create Steering Seismics window: @ Horzoncuve | oo 5
Processing > Dip Steering > Create > 3D. e V| oo smmacise.
2. Select 1 Original Seismics as input. : :
ginal celsmics P With a calculation stepout of
. 1,1,1; the dip is computed within
3. SKtZZﬁr:heafieJﬁmx?lﬁu:at'on stepout for the PCA a small cube of 3x3x3 samples
galg R around each sample in
consideration.
¥ Create Steering Cube - (m] b4
Input Cube L:“l “E} 1 Original Seismics = | © select | Steering algorithm PCA < |
Volume subselection |100/300-750/1250 (463 samples) © Select ... Filter size (sample) |inl:1 |2 jerl:1 (2 |Z:1 :|
Use fault dips O Yes ® No Maximum dip (us/m) 800
With planarity O Yes @ No
Qutput Steering «| | © select ... [ Filter result  Median
Batch execution  Single Process ~ |4+ Options ...
€ Close eHeIp
Workflowcont'd:
4. Specify a stepout of 2,2,5 to apply a median filter on the raw dips.
¥ Create Steering Cube - a X
Input Cube L:L "&} 1 Original Seismics | 6 select ... Steering algorithm PCA -
Volume subselection [100/300-750/1250 (463 samples) | |© select ... Filter size (sample) (inl:1 |3 |crl:1 3] |Z:1 :
Use fault dips O Yes @ No Rdnupldpl(isiplljano
With planarity O Yes @® No
Output Steering .| @ select ... [ Filter result  Median -
Batch execution Single Process 7] [ options .. Filter stepout (sample) |inl:2 |3 |crl:2 2] |Z:5 =
Qcose @ Hep

When adding Planarity, the output steering cube contains an additional Planarity
component along with the Inline Dip and Crossline Dip. The Planarity attribute
returns the quality of the steering cube and is used by Unconformity Tracker,
Inversion + tracker and for HorizonCube creation.
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Workflowcont'd:

time run this process.

6. Give the output SteeringCube a name (e.g. PCA111_MF225) and click OK.

# Create Steering Cube - o x
Input Cube Lﬂ ‘& 1 Original Seismics ~ 6 Select ... Steering algorithm PCA =
Volume subselection | 100/300-750/1250 (463 samples) 6 select ... Filter size (sample) linl:1 3 :crlzl 3 |Z:1 ::
T Use fault dips O Yes @ No Iodmidpiusm ) 800 |
Tip: It's recommended to T @E | O
use the SteeringCube output steeing [FRTTETTI T sl {2 Fitr result. Median .
par:meterstrlln Its namel Batch execution IR <] [ options .. Filter stepout (sample) |inl:2 3| |erl:2 2 |Z:5 =
as done in this exercise.
oclose eHelp
# Positions. - o X
Specify Positions
Volume subselection Range Bl e ]
Indine Range 420 3 [430 2| Step |1 1
Cross-line Range 300 5 1250 5| Step [t e
Time Range (ms) 0 21848 2| Step |4 &
@ok | @Dcancel @ Help
Workflowcont'd:
7. Add default data (i.e. 4 Dip e
o g ; Yors| Add Defautt Data_ |
- W Cro;
stt_a'er(_ed mea_f.'an filter) by right & ol Add and Select Data
clicking on inline 425. @ Volu  Add at Well Location ...
~ Rar - adq Color Blended
2D L
¥ In-line
8. Once again right-click on o o400 AN ‘
. . N ross-line y i i
inline 425 to display the @ Zsice Duplicate : :°"{me§”:)‘de|;f°‘“:'b“‘e
Detailed SteeringCube (SEIECt ® Voume . Reset Manipulation - orizon-ube lsp.ay
~ Random Lir “ . Systems Tracts Display
PCA111_MF225 from 2D Line t Correlate with Wells ... 'y
Steering tab).
# Select - a X
Select Layer 2
Filter |*
O stored 2 Steering BG Detailed
F n 3 Steering BG Background
©® Steerind || 3, Steering FFT225 MF113
- ; _ Attributes PCA111_MF225
Tip: It's recommended to display B
the Crossline dip component of the &
SteeringCube on an inline and vice-
versa. | Component Crossline Dip 'l
QOK | Qcanoe\ OHelp
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Workflowcont'd:

9. Use the Pastel color-bar.

10. To co-visualize seismic and cross-line component of dip, right-click on the
PCA111_MF225 in the tree > Display > Change Transparency and set the transparency
to 50%.

= | § i B @ B 2y b I

v 425
[ PCALL1 MF225.. E3
4Dips  Select Attribute

@ Cross-line Save Color Settings

# Z-slice Use Saved Color Settings

® volume Move >

¢ Random Line [ Display * M Histogram ...

7j2Dlne = Remove B Amplitude Spectrum ...

“# 3D Horizon F-K Spectrum ...
b | Change Transparency ..
AR = 20 Viewer

W Faultset = B

FaultStickSet 2D lewess Wi
@ Attribute transparency - m] x
Transparency ]
© cancel

Workflowcont’d:

11. Additional step: Go to Processing > Dip Steering > Filter > 3D and apply
Recursive Gaussian filter using the stepout of 5, 5, 2 to achieve smoothly
looking results.

Processing Scene View Utilities Help ~. -
z - = Filter St Cubs - m} X
mmu:m : ﬁ]f“.'iQ:i’-,\#",ﬁ ) Filter Steering Cube .
A wets . Input Steering Data [PCA111_MF225 ~| | © select ...
(Re-)start Batch Job ..
coue .. Volume subselection [100/300-750/1250 (463 samples) | © select [
‘A MGS Destriping ... |
- g;‘::;a B o v FiIterIRemrsiveGaumian &
Z5 Faults and Fractu > Filter > = — =
|2 :;rn:wngm;ei. Import 5 g... I |Fi|ter stepout (sample) |InI:S ;I Icr]:S ";‘| ‘2:2 [;”
@ HorizonCube » Track using Inversion ...
10 Madagascar . Set Defaut 30 SteerngCute . Output Steering [PCA111 MF225_GFS52 -] © select ...
Batch execution |Sing|e Process | .Q Options ...
. °Run Joclose eHelp.

Tip: Recursive Gaussian filter is extremely fast and is available for all OpendTect Pro users.
If you're using a free version of OpendTect, for additional smoothing we recommend applying
the Average filter, instead of the Median one. Median filter was already applied during the
steering cube computation to remove spikes (step 5 of this exercise).
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2.3.1b Dip & Azimuth

OpendTect Pro, Dip-steering

Exercise objective:
Compute Dip and Azimuth attributes from a SteeringCube.
Workflow:

LUEEEN Processing Scenes View U

. . . . . § Atributes il & 20 .
1. Go to the Attribute engine: Analysis > Attributes > 3D or click

on the .| icon> 3D ;‘g‘;fg;:f;"';‘;;“ :
2. In the attribute set window, select Dip attribute.
3. Select 2 Steering BG Detailed as input and Polar dip as

output.

4. Specify a name for the attribute (e.g. Polar Dip) and Add as
new (optionally save it).

= Amidte S 10 PR ==
File
sl LR XTI Y 35
PR — oo ] e o]E3
Polar Op Saoering Data ) [/ | 2 Steenng BG Detaen [ seea
[comarores 1]
+
+
+
Iﬂ::mur Name Fotar Dig Ik a5 e b'
Save on Close o Giose| 9 Heip
Workflow cont’d: * 3D ez
20 Honz:
Fault Add at Sections Only
Fault5ticl  Add Color Blended
: W Body Track New
5. In the 3D scene, Load horizon A Consant 2
Demo 1 --> MFS4 by right-clicking = P
on 3D Horizon in the tree. . =k
- er
> Demo 0 -> F54 <
B | Demo 3 > Top Foresets ol
Dermno 4 —> Truncation
Demo 5 - FST o
Demo 6 > FS8
Demao 7 shallow
B s ot
Area subselection 100/300- 7501250 (463 samples) © Sedect .
O cnce] (@ How
* 30 Horizon ining_v6\SurfacesDemo_1_—_ MFS4.hor
7

2 zaes I (T S

' 2D
e Display * |4 Volume Builder Atiribute
FaultStickSet Tracking : Gontour Display

® Body Tools Horizon Data

6. In the tree, right-click on the loaded :‘:Lam E=E=R
horizon and follow Add > Attribute : _
select the Polar dip attribute. The :;TW
attribute is calculated on-the-fly.
Y
Alternatively, you could process the FPolar Dip attribute as %
horizon data and afterwards add it (see the sectionon [S2K] (0 cancel] (@ e |
Spectral Decomposition).
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Workflow cont’d:

7. Change the colorbar to Grey scales and the range to 0 to 70.

Workflow cont’d:

8. Save the attribute to the disk by right-clicking on it's name (i.e. Polar Dip), and
selecting Save as Horizon Data.

P4 3D|;eom"§uin‘.> MFS4 S GRiprXeiection ESSlE o
j Select Attribute y Specify attribute name
2D Herizon Move *
Fault Display ’ Attribute
T e
Lowell Tools ’ o Cancel| | GHE| ]
.« E'r'.kSEt = Remove . B

the two?

Try displaying the Azimuth attribute in the same way as Polar Dip. What differences do you see between

Ouitput | Azimuth -

= Attribute Set 30
File
A AEI TLT LEE
Atiribute set <not saved> Dip [+] |oip |2
Polar Dip Steering Data =‘> & 2 Steering BG Detailed ~| [ Select
Azimuth —

ol =]
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2.3.1c Dip-steered Similarity

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

Compute a Similarity attribute with and without dip-steering.
Workflow:

Go to the Attribute engine: Analysis > Attributes > 3D or
click on the | icon > 3D.

In the attribute set window, select Similarity attribute.

Keep the default Input Data 4 Dip steered median filter and
default time gate [-28 +28] ms.

=N Processing Scenes  View Uil

& Volurne Builder
Ei Cross-plot Data
Well

= Attribute Set 30

Time gate (ms) -28 28
[Extension ITET=T=m—]|
[stepout [ini1 = ent1 =]

Steering None

B

File
o AL LI T
Atribute set | <not saved= <Al Blemiay,  Efk
Input Data |4 Dip steered median filter 3 © Select
Time gate (ms) -28 28 |
Extension Cross [=]
Stepout | inl:1 = |erk1
Steering |None 3
Workflow cont'd:
4. Select Extension: All Directions.
5. Keep the default stepout, i.e. inl:1; crl:1.
= Attribute Set 3D [= o=
File
PPN AW -
Attribute set | <not saved=> <All> Z Similarity Z| ?
Input Data 4 Dip steered median filter 3 _O Select J
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Workflow cont’d:

6. Specify Steering: Full and select 3 Steering BG Background.

7. Choose Output statistics: Min.

8. Give a name (e.g9. FS_Similarity) and Add as new.

|Oulpul statistic Min .l

Time gate (ms) -28 28
Extension All Directions T|
Stepout | inl:1 = e
Steering  Full .]
Steering Data a& -\‘b 3 Steering BG Background E| .O Select
t
+
+

|Allnbute Name |FS_Similarity

Add as new'|| A

Save on Close

lo Close | 9 Help

Workflow cont’d:

9. In a similar way, define a non-steered Similarity attribute by
selecting Steering: None.

10. Give it a name (e.g. NS_Similarity) and Add as new. Optionally save the

attribute set. Click on Close.

Add as new'|| F |

WS _Similarity
Time gate (ms) |-28 28
Extension All Directions T|
Stepout inl:1 = ed:A
Steering Mone '~] |
+
[Fid
—
Output statistic | Min :v
Attribute Name  NS_Similarty
Save on Close
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Workflow cont'd:

11. Display seismic data on inline 425 by
right-clicking on In-line > Add and
Select Data.
Under the Stored tab select 1 Original

Seismics.

12. Select inline number 425 in the tree,
go to the top toolbar, change it to 250

and press

enter.

Elements

Add Default Data
Add and Select Data
Add at Well Location ...

N

W@ Cn
¥ 7s
® Vol

&

" % Add Color Blended

= s )
Select first layer
e ,
4 Dup sleeied median fifter
Steering 5 ChimneyCube g
Ta Al Cube Std
Attributes 7b Al Cube from HorizonCube
. 8a PorosityCube from HC-NN
& 8b Gamma from HorizonCube i
= 6 1 Sirmitarit an EEE caicmic
g Filter
Qe @es

1 Original Seismics

7y Survey Analysis

& il WE E
In-line 250 & «*

Processing &

T |Step 1

Workflow cont'd:

13. Load first the steered similarity attribute (i.e. FS_Similarity) by right-
clicking on inline number 250 > Add > Attribute.

= W In-line
=5-[

@ Cross-line
= 7_clica

14. Similarly, load the non-steered similarity attribute (i.

5§ In-line
> WEE
¥ FS_Similarity
¥ 1 Original Seismi

splay

Pemtinmbn

Display

3

250)
71 ongna I [

% Volume Processing Attribute

4 Volume Processing Attribute

Select Layer 2

Stored

. NS_Simaarity
Steering

&
=Y

[Glows@m)

e. NS_Similarity).

(= Select

== Fon =]
Select Layer 2

Stored

FS S\mi\ams ]

Steering
s
S .

[GeJooms (@)
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Workflow cont’d:

15. Change the color-bars of both the similarity attributes to Similarity.

=- g In-line
=[] 250
EINS Similarity 06 I o9 [m Simiarty &
¥ FS_Similarity
¥ 1 Original Seismics

16. Compare the two similarities by ticking on and off the upper attribute (here
NS_Similarity).

What is the influence of dip-steering?

i ‘.-h I .'*&li .. I i m'. L 'i’!l_l.hlf'.‘.‘; |

Inline 250: Non-Steered Similarity (left) and Steered Similarity (right)
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2.3.1d Dip-steered Median Filter

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

Remove random noise from the seismic data using Dip-Steered Median Filter (DSMF).

Workflow:

1. Go to the Attribute engine: Analysis > Attributes > 3D

LU=l Processing Scenes  View Ut

“4 Volume Builder
Ei Cross-plot Data
Well

or click on the, | icon > 3D.

=
2D ...
(.|

Workflow cont'd:

2. Select the attribute: Dip
steered median filter.

Attribute set | <not saved> <All> [+]| oip steerec median fiter é] 2

3. Select Input Data: 7 DSHF Input Data 1 Original Seismics [0 seect |
Original Seismics. Stepout

4. Set the Step-out tO 11 1 Steering Uma:é-lp "gl]'s-.eenngBGBackground -: £ Select |
(the optimal step-out will
be evaluated later).

5. Select the Steering Data:
3 Steering BG background.

MEICID

6. Give a name (e.g. DSMF
for Dip Steered Median Atrute Name [0S Add as newd] (i
Filter) and Add as new. ——

Keep this attribute set
window open.
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Workflow cont’d:

7. Now in the scene, in the tree, right-click on In-line and choose

Add and Select Data.

Elements Color
Scene 1
' In-line
i Cross| Add Default Data

U X4 M Add and Select Data

@ Volum  Add at Well Location -

~ Randt  adq Color Blended
™ 20 | s

[= Seiet [E=m =y~
Select Layer 2
8. Select 1 Original Seismics from Stored tab and press | © S BT
ip steered median filter
oK Steering | 5 ChimneyCube
- Ta Al Cube Std
Aftributes Tb Al Cube from HorizonCube
— 8a PorosityCube from HC-MN
= A o oo G
rg# Filter | *
(O Cancel [ @ e
9. In the tree, right-click on inline number (i.e. 425):
Add > Attribute. 3 ln_l&em
s &
SRR Add |5 atnibute
@ Crossin  Display * | % Volume Builder Attribute
@ Z-slice Dupkcate € HorizonCube Display
® Volume Reset Manipulation 85 Systerns Tracts Displa
’T, ZHST::: ¢ Correlate with Wells ... Y By
@ 30 Horiz @ Lock Treeitem
# 2D Horiz == Remove from Tree
Fault
Workflow cont’d: i seec ===
Select Layer 2
Stored |
Steering
10. Select DSMF from Attributes tab. S
fs
B

11. Go back to the Attribute Set window and
click the attribute evaluation tool icon 'm’

to evaluate the step-out.

12. Specify Evaluate: Stepout.

13. Set the initial value “0-0",

increment “1-1”, and Nr of steps “5".

14. Press Calculate.

[20](© caxs) (@ en

Slice

= Evaluate attribute ol - )=
Set parameters

| Evaluate Stepout El

[imitial value |0 0 |

[ increment |1 1 |

Nr of steps 5 :

Store slices on 'Accept’

@ e [ @ s |
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Workflow cont'd:

15. Once the computation is done, move the slider to change the stepout value and see the
impact in the scene.

16. Assess which step-out is best (removing random noise, but not too much smearing)?
Once chosen, press Accept and close the attribute set window.

= ~ @l LEn <sie J i 5 |1 asesmes
0

£

s

785

m=

- Use the keyboard arrow keys, so |
= ' - you can focus your eyes on the

scene.

Workflow cont'd:

17. If you are satisfied with the parameters, you may want to process the attribute definition as
a volume. Follow: Processing > Create Seismic output > Attributes > Single attribute > 3D
or click on the &2 icon.

[ Survey Analysis Scenes View Ulilities Help
L@ Y Create SeismicOuput » | Awibutes > [ Single Attiowe > [P0
(425 Elsieg 10 [5] oot HorizonOutput & | 2D <=>3D Y Multi Attribute .. [ 30 |
(Re-)Start Batch Job . Angle Mute Function ... MultiCube DataStore
Tree scena 1 B N insiam r . )
" Creste Volume Attribute e
Quantity to output DSMF [<]
Volume subselection 100/300-750/1250 (463 samples) _O Select

Null traces @ Discard © Pass

Scale values: Shift/Factor

Output Cube DSMF [-]|[© setect..| (@ cBys ]

Batch execution Single Process j i+ Options ]

(© cancel| | @ Hep |

The processedattribute volume will appear as a Stored Cube (in Seismic Manager).
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2.3.1e Mathematics

Required licenses: OpendTect.

Exercise objective:

Analyze the noise removed by the Dip-Steered Median Filter using the Mathematics attribute.

Workflow:

Note: This exercise uses the attribute setfrom the previous exercise. ‘

1. Define a new attribute (in addition to DSMF of previous exercise) of type Mathematics
and write the formula: ‘filtered — original’ and press Set.

Basic E| | Mathematics E” z
! MathFunctions E| sqgrt (Square root) E| E]
Formula (like 'nearstk + c0 * farstk’) | Set
| For filtered' use DSMF |~
|For ‘original' use [1 Original Seismics] EI

2. Use the previous attribute definition (i.e. DSMF) for filtered and the stored volume 7
Criginal Seismics for original. Give the attribute a name (e.g. Noise) and Add as new.

Workflow cont’d:

3. Right-click on inline number 425: Add > Attribute.

4. Select the Noise attribute.

L Ir1-|\:rﬁa
1 [ Agg
4] DSMF :
7 1 Original § DEy @ Volume Builder Attribute
:: ggﬁilme Eup;!ff,e_ . € HorizonCube Display
® Volume e II g ”III %' Systems Tracts Display
= & Comelate with Wells

o Sedect = o =
Select Layer 3

Stored  [pSMF

Steering

fs

B

'O Cancel: | @ Heip

Use the same color-bar for original seismic, DSMF seismic and Noise for a fair comparison.

| -4500 [ ]4500 I 1Seismics E||
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Workflow cont'd:

Your result should look like this.
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2.3.1f Dip-steered Diffusion Filter

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

Enhance low-quality seismic data near faults using a Dip-Steered Diffusion Filter.

Workflow: )
= Default Attribute Sets (=R R~~~

1. Start the attribute engine , | . Solect dckmut sriaie et

Filter *
2. Open the Default Attribute set..
Evaluate Aftributes o
AVO attributes from Intercept-Gradient E
3. Select Dip-steered diffusion filter and press OK. AVO attributes from Near-Far
dGB Evaluate Attributes

Dip-steered median filter
Dip-steered diffusion filter =

] i »

;O Cancel| | @ Help

Workflow cont’d:

4. In the pop-up window set 7 Criginal Seismics as input seismic and 3 Steering
BG Background as input steering, and press OK.

. Attribute st definition =8 Fch 57|

Select Seismic & Steering input

Input Seismic lg ‘e»| 1 Original Seismics ~ | ©) Select
Input Steering [-_é “‘é. 3 Steenng BG Background v | Select

|W“O Cancel| | @ Help |
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Workflow cont'd:

5. The attribute is defined.

= Attribute Set 3D
File

o IR TEY T

Aftribute set <not saved= [<Al= ~ | [Posttion = ? |
Dip-steered diffusion filter Input attribute | Minimum similarity ~| ) Select ...
Stepout inl:1 S oA
Time gate (ms) 0 0
Steering [Full -]
Steering Data % "¢ 3 Steering BG Background - D Select ...
+ 3
Operator | Max e
*
Cutput attribute | Dip-steered median filter =] | © Select ...
24 ‘
—
Attribute Name  Dip-steered diffusion filter [Add as new| E ]
¥ Save on Close g ECIuse € Help
1y
Workflow cont’d:

6. Keep the attribute set 3D window
open and add the Dip-steered
diffusion filter attribute in tree on

inline 425.

Scene 1

Add Default Data
W Zslice

® Volumi  Add at Well Location ...
~ Randq

2D Lin

Add Color Blended

o Select ==

Select first layer

Stored Dip-steered diffusion filter
Steering

¥ 5

[x] Canr.el: | @ Help
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Workflow cont’d:

7. Go back to the attribute set 3D
window, and click on the attribute
evaluation icon 'm to evaluate the
step-out of the Dip-steered diffusion
filter attribute. o [ e

Set parameters

8. Specify Evaluate: Stepout | Evaluate [Stepout - |

[ nitial value 0 0 |

9. Set the initial value “0-07,

increment “1-1”, and Nr. of steps “5". [ Increment 1 1 |

Nrof steps 5 -

Slice

10. Press Calculate.

Store slices on "Accept

(@)

Workflow cont’d:

11. Once the computation is done, move the sliders to change the stepout value and see
the impact in the 3D scene.

B2 0 P a e M eeos v asesmes
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Workflow cont'd:

12. Evaluate which step-out is best (removing random noise without creating too many
artefacts)? Once chosen, press Accept and close the attribute set window.

Evaluate | Stepout -
Initial value 0 0
Increment 1 1
N of steps >

Slice U

Store slices on 'Accept’

Stepout [2,2]
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2.3.1g Dip-steered Fault Enhancement Filter

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

default attribute sets in two forms:

can be modified.

Remove noise and sharpen edges/faults with the Fault Enhancement Filter (FEF).

The Fault Enhancement Filter is a combination of dip-steered median filter and
diffusion filter, modifying the seismic volume to enhance fault visibility.

Based on a similarity threshold, the data is smoothed (DSMF) away from the faults

and sharpened (DSDF) at the fault location. The filter is released with the software as

* Fault Enhancement Filter. All basic attributes needed as inputs for the filtering are
shielded and the user can only control the amount of smoothing (dip-steered
median filter) versus sharpening (dip-steered diffusion).

* Fault Enhancement Filter (expert): The full attribute set definition is shown, which

Workflow:

1. Start the 3D attribute set window
by clicking on : |

2. Click on default attribute seticon

3. Select Fault enhancement filter
and press OK button.

= Attribute Set 3D
Faa

s LA TILY 35

At <t waved> <Al

Ingut Data ¥ D Seet

' Default Attribute Sets ol @ |-

Select default attribute set

Filter *

AVO attributes from Intercept-Gradient
AVO attributes from Near-Far

dGB Evaluate Attributes

Dip-steered median filter

Dip-steered diffusion filler

Fault enhancement filter 2

v

Q Cancel: | @ Help
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Workflow cont'd:

= Attribute set definition

4. Select the 1 Original Seismics as

Select Seismic & Steering input

'a"a‘@.

input seismics and 3 Steering BG
Background as input steering and

input Seismic (2 ) 1 Original Seismics

Input Steering kg &) 3 Steering BG Background

-|(© select...|

-|(© select

QOK‘OCamd' €@ Help |

press OK.

5. This will create a fault enhancement
filter attribute for you.

6. Keep this window open and proceed

to the next step.

Fault enhancement fier (FEF) /| MathFunctions
Formula (ke ‘nearstk + c0 * farstk’) Similarity = ¢0 ? DSMF : DSDF
For 'Similarity’ use 'Sumwlarriy =

Value for 'c0 0.7
For "DSMF' use | Dip-steered median filter (DS! = |

For 'DSDF use |Dip-steered diffusion fiter (DS ~ |

= 'sqn (Square root)

[ nset | |

]

Workflow cont'd:

7. Load the default seismic data to a small area of the Z-slice at 1640 ms, between inlines

120-400 and crosslines 350-600.

= Select

- Select first layer

Right-click on Z-slice in the tree to
add stored 7 Original Seismics.

Steering
@ [Z-slical Atlrbutes
® v Add Default Data
~ g Add and Select Data | EEE————
o 5 _Add Color Blended B Fier

1 Oniginal Seismics

4 Dip steered median filter

5 ChimneyCube

Ta Al Cube Std

7b A Cube from HorizonCube
8a PorosityCube from HC-NN
8b Gamma from HofizonCube:

.\0 Cancel £ Help

oo =

Once it is loaded, again Right-click on
Z-slice number 924 to change its position.

= Postioning =~
y Specify the element's position
4+ @ Z-slice
- (7924
91 Add L In-line Range 120 400
® Volume Display ' m Histogram )
-~ ?ST’DF Duplicate + Position Cross-line Range 350 600
ing Reset Manipulation . . .
@ 30Ho o ) ook Treeitem # Gndlme.s.. Z (ms) 1640 |2 [ Scroll ...
s 2D Hori @ . 4 Properties .. J
Faut | = Remove from Tree Resohion  * =
FaultStickSet D

|LQ& |‘0 cancel| | @ Hep |
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Workflow cont’d:

8. Apply the Fault Enhancement Filter to the constrained Z-slice at 1640 ms.

* Right-click on Z-slice number 1640 to add the FEF attribute.

= & Z-slice
>
ZREe  Add ' [§ Attribute
® volume Display ’
~ Random Li Duplicate
' 2D Line

% Volume Processing Attribute

Reset Manioulation |

= Select [fe==s

Select Layer 2

Stored Fault enhancement filter (FEF)

Steering

@

I & ok ]'OCanceI| @ Help |

Workflow cont’d:

9. Compare 1 Original Seismics with the FEF
attribute on the constrained Z-slice 1640 ms.
I 8§ Red-White-Black

Make sure to use the same colorbar range E1 Red.White-Blue
# SandShale
for both.

B Similarity

1 SunRise [
P Tasty -
W UVQs Example (5-Classes) ~

4500 [ 4500 [raseismics
Wl Rainbow
B Rainbow Plus

y [

Did you get clear enough differences
between criginal seismicsand FEF?

Original Seismics (left) and FEF Seismics (right) displayed on Z-slice at 1640 ms.
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Workflow cont'd:

Evaluation of constant c0

A critical parameter of the Fault Enhancement Filter is c0. If the similarity
value is higher than the c0 value, then the Dip Steered Median Filtered
Seismic is used and otherwise the Diffusion Filtered Seismic is used.

10. Go back to the attribute set window, N Ev b e E=3 EoR =x=)

and click on the attribute evaluation SERTEMEER

icon 'Fh to evaluate the constant cO0. :
: Evaluate |c0 -

| Initial value 0.1 |

| Increment 0.1 |

11. Use Initial value: 0.1, Increment: 0.1,
Nr. of steps: 9 and press calculate. |Nr of steps 9 - |[ calcuate |

(@ Accept] | @ Help |

Workflow cont'd:

Evaluation of constant c0

12. Move the slider to assess which constant shows the best results (more faults visible and
less noise)? Press accept to save the constant ¢0.

SJiwabBE=T-of
= T e 2040 Sepd - F = SR yn a7 T 5 000 Semmecs
Teee seene 1

il
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Workflow cont’d:

Fault Enhanced Similarity

13. Open the Attribute set window and create a new dip-steered similarity attribute using

the FEF attribute as input. Use the default values for rest of the parameters. Name it
FEF_Similarity and Add as new.

= Attribute Set 30 RO =
File
*Pe ¥R NAE -
Altribute set <not saved> <All> ~| [ Simitarity 1 |2
Fault enhancement flter (FEF input Data | Faul enhancement fiter (FEF) =] | © Select ..
FEF_Similarit
- g Time gate (ms) -28 2
Extension | Cross -
Stepout inl1 e
Steering | Full =
Steering Data fies| &) 3 Steering 86 Background - [© seeat
*
\ 4
B!
—_
Oulput statistic |Average -
v | Attribute Name FEF_Similarity " Add as new I;.
Save on Close lo Close| | £ Help

Workflow cont’d:

Fault Enhanced Similarity

14. Create yet another dip-steered similarity attribute using the 7 Original Seismics as
input. Use the same parameters as the previous step. Name it FS_Similarity and Add

as new.
= Attiibute Set 30 o=
File
ad A N1 ¥ 1N
Atribute set <not saved> <Al - | | Simikarity = |2
Fault enhancement fiter (FEF input Data | 1 Ongmnal Seismics *| | Select...|
FEF_Similarit
|:s_{;.rr..|.;;—|,|yJf Time gate (ms) -28 28
Extension | Cross -
Stepout ind1 T et
Steering | Full z)
Steering Data fis| )] 3 Steering 86 Background - [© seect
*
\ 4
24
—
Cutput statistic |Average -
v I Attribute Name  FS_Samilarity II Add a5 new I;.
Save on Glose [Gcose] [@rer
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Workflow cont'd:

Fault Enhanced Similarity

15. Apply one-by-one the FS_Similarity (calculated using original seismic) and the
FEF_Similarity (based on the Fault Enhancement Filtered seismic) to the constrained
Z-slice at 1640 ms.

07 055 [m Smtarty -
1 Ranbow

Don't forget to use identical
Similarity colorbars!

j ‘ N b v AT ""l"‘

Dip-steered similarity from Original Seismics (left) and FEF Seismics (right)

Tip: Both Fault Enhancement Filter and Fault Enhancement Filter (expert)
can be accessed from the ‘Default Attribute Set’ using the Drawer ' icon
from the row of icons at the top.

= Default Attribute Sets =3 Ecn =]
Select default attribute set

Filter *

Evaluate Attributes o

AVO attributes from Intercept-Gradient £

AVO attributes from Near-Far I

dGB Evaluate Attributes

Dip-steered median filter

Dip-steered diffusion filter

Fault enhancement filter

Fault enhancement filter (Expert) >
n

‘ « G

©) Cancel| | @ Help
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2.3.1h Unconformity Tracker

Required licenses: OpendTect Pro, Dip-Steering.

Exercise objective:
Create two horizons: 1) a seismic event constrained by a few manually picked positions;
2) an unconformable event constrained by well markers.

Workflow:
1. Pre-load the default seismic data set (4 Dip steered median filter).
2. Add an in-line (Add Default Data)
3. Add the stored Random Line called: “Random Line through wells”
4. Add all 4 wells o E P
5. Go to 3D Horizon > fi:wj‘ P
New > Track Unconformity ... )EE{:II:M' :i?vmfmmdm | Aukp an Mamul Tracking

Track Unconformity ...

¥ FO6-1
¥ FO3-4
¥ F03-2

Thalweg Tracker ...
With Constant Z ...

Traditional trackers follow amplitude and phase. Unconformities do not exhibit consistent
amplitude / phase behavior and can thus not be tracked with a conventional tracker. The
unconformity tracker flattens the dip field using a constrained inversion-based algorithm.
Constraints are given in the form of picked positions and (optionally) a confidence weight
volume.

Workflow cont’d:

6. In the Unconformity tracker window, select the input steering cube for the tracking: 2.
Steering BG Detailed.

Ideally, use a detailed steering cube (see Exercise 2.3.1a) calculated on enhanced seismic.

7. Optionally, limit the output  Uncrtormey ch =
extend by using the Steering Data .é, =Y Iz Steering BG Detalled ~ ) select..|
Volume sub-selection. Volume subselection I1m_um-150,fusu (463 samgles) B Select I

Pickset Color  Options Horizon
8 OptIUna"y Char‘lge the Horlzon 1 - Edit ... IM.rf.\r'Man-:h.\an by Constraint 1 I
- H
. Horl 2
names of Pickset and
Horizon by double clicking
on the respective fields.

Horizon 3

Horlzon 4

{[1][ %

7 Execute in Batch | 4% Options ... Processing parameters ...

© Run | | Close | @ Help
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Workflow cont’'d:

9. Click on the Pick Seeds icon «s® and
pick a few points (minimum 3) on the
event you want to track.

and cross-lines. Alternatively, open an
existing pick set with interpreted points
by clicking on the corresponding icon: =

11. For the second horizon press the
wells icon 4 and select the FS7
marker from all wells.

Pickset Color  Options Horizon
Horizon 1 Constraint 1 - Edit ... Surface constrained by Const

Herizon 2 - Edit ... Surface constrained by FS7

Haorizon 3

" Sebect well madken

Select markers from one or more wells

Markers o =

I F53

[ 54

I P56

7 is?
Fas

I MFs10

L mFs11

Wells & = Fllter *

¥ P21
¥ FO3-2

% 7 2 H03-4 <
¥ FO6-1

a0

Q@ ok | O cancel

Workflow cont’d:

12. Select Processing parameters ... and read the information for each of the parameters.*

= Processing parameters
Apply faull dips ) Yes @ No

Gonfidence weight s i)
Flip weight
Confidence Power |6
Number of Horizon updates 10
Advanced CG Solver parameters
Number of CG Solver lterations 200
Solver residual error 0.01
Preconditionning fier stepout ink&é 3 crl6 2
Inversion operator weight O

Resat

O

|

ceooe coCQ

o
§
-
z

* A good “Confidence weight” volume example is the Planarity volume.
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Workflow cont’d:

13. Close the Processing parameters
window and start processing by

pressing

14. When the batch process is finished
Close the window and Add the new
horizons to the tree.

15. Add a random line to QC* the horizons.

16. Improvements can be made by (if
needed): adding more picks; adding a
confidence weight volume and by
changing the inversion parameters.

*Tips: Change the color bar of the random line to grey scale; Show the horizons at sections
only; Change the line thickness (Horizon -> Display -> Properties); Move and rotate the
random line to check whether the horizon is following the events properly.
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2.3.2 Attributes for Faults & Fractures

What you should know about Faults & Fractures in OpendTect

The Faults & Fractures plug-supports a collection of attributes, filters and tools for
visualizing, manipulating and analyzing faults and fractures. Some of the tools in
this plug-in can be found elsewhere in the system, e.g. in the attribute engine, oth-
ers are only available through this plug-in. In combination with dip-steering the
plug-in offers additional dip-steered and dip-derived attributes and dip-steered fil-
ters (Structurally Oriented Filters) such as fault enhancement filter and dip-
steered median filter.

Important fault attributes are:

» Thinned Fault Likelihood (developed by the Colorado School of Mines)
» Dip-steered similarity (best applied after fault enhancement filtering)
» Polar dip (directly computed from a (dip-)SteeringCube)

Special fracture attributes are:

» Curvature attributes (points up flexure of reflectors without fault throw)

» Fracture proximity (measures the distance to the nearest fault / fracture)

» Fracture density (measures the number of faults / fractures within a user-
defined radius)

-216 -



2.3.2a Thinned Fault Likelihood

Required licenses: OpendTect Pro, Faults & Fractures.

Exercise objective:
Create Thinned Fault Likelihood attribute.
Workflow:
1. Launch the Faults and Fractures Control Center by clicking this ;: icon.
g @ >
2. Select 3D 0.
3.
3. Select the Thinned Fault Likelihood attribute from the list and press Go...
" Faults and Fractures 3D Control Center ?’T
Available Attributes
’l Attributes Fault Likelihood (FL)
A Thinned Fault Likelihood (TFL)
Create TFL from FL
Basement Fracture
Y Filters Convolve (Edge Enhancement)
Curvature
Dip/Azimuth Attributes
. Fault Dip/Azimuth
\ ‘;\ o Fault Painter
\\ i Panes Finger Vein Attribute
: Fracture Density/Proximity
Gradient/Azimuth of Curvature
Semblance
% Tools Similarity
{ © Close ‘ | ) Help J
Workflowcont'd:
. . - Create Thinned Fault Likelihood - olEd
3' SpECIfy the l_nput CUbe 4 D',p Input Cube ‘& 4 Dip steered median filter v| © Select
Sfeefed mEdIan fh’tef'. Voluma sunsslechori 120/350-400/600 (113 samples) © Select
4. To speed up the process set
Volume sub-selection to inline N - —
. Output Cube{ TFL v elect ks
120_4007 CrOSS“ne 350_6007 Batch execution Single Process = 4.t Options
z range 1400-1848. O Close || @M
5. Choose Advanced Settfngs to @ Advanced parameters for Thinned Fault Likelihood — & Ex
view the parameters. Keep a large Z stepout | Fiter size (nlcisampie) in'2 “len2 &l[z32 2
(recommended) Maximum dip (us/m) 800
6. Keep the default parameters, With planarity () Yes  ® No
as ShOWn |n the |mage on the Fault strike scan range in degrees 0 < 360 % Nrsteps 25 =
right and Close the advanced Strike sean smoother 16 |2
parameters dlalog Fault dip scan range in degrees 25 |5 65 5 Nrsteps 6 s
. . . Dip scan smoother |20 =
; Smoothing along dip/strike )
7. Provide an Output Cube increases the continuity of a fault RS 2500
name, e.g. Thinned Fault plane. Over smoothing may also Apply thinning ® Yes No
Likelihood, and press Run. S e
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Workflow cont'd:

8. When processing is finished, display the Thinned Fault Likelihood on inline 200.
* Right-click on inline > Add Default Data.
* Change the inline number to 200. In-line 200 [~ Step 1 [~
* Right-click on inline nr. (i.e. 200) > Add Attribute; Under the Stored section, select
Thinned Fault Likelihood.

9. Apply semi-transparent color bar (e.g. Chimney) on it for better visualization.

10. The result should be similar to the one shown below.
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2.3.2b Volume Curvatu

re And Others

Required licenses: OpendTect Pro, Dip-steering.

Exercise objective:

Compute and compare various attributes

Workflow:

1.
3D.

Start the 3D attribute engine: Analysis > Attributes >

that pick up faults and fractures.

T Surey m Proceseing Scene  View  UMilit
&y 5| R i 2o
N . &% Volume Builder ... m
o In-
Wt Ei Cross-plotData
Tre & Wells
& | E1 &l Layer Modeling

= Fluid Contact Finder

t+ Meural Networks

. ssi8

Z, Thalweg Tracker ..

T \Velocity Model Building
Well Correlation Panel

TS Y )

Workflow cont’d:

3. Keep all the parameters by default a

4. Press Add as new.

2. Select Similarity attribute from the list of attributes.

nd give it a name, e.g. Non_steered_Similarity.

r ——
& Attribute Set 30 = | E ]
File
> K L o
b AR T T 1%
Adtribute set [<not saved> <A Fllsmee (7
Hor-Shared Smilariy Input Diata 4 Dip stesred median filer ][ 6 seiect.
Time gate (ms) |28 |[28
Extension Cross [=]
Stepout |inl1 ¥ o1 5
Stuering None =
t
+
=4
=
Output stasistic Average
Atribute Mame [on-Steerea Simiarity ] [ as new |
4] Save on Close [ close | | @@ Hei

-219-




Workflow cont'd:

5. Change Steering to Full with 3 Steering BG Background.

6. Type in a new name: Steered Similarity.

7. Press Add as new.

-
9 Attribute Set 30
File

PSR AR -

Aribute Set| <not saved> <Al x| Simitansy

MOn-steered Simianty InputData 4 Dip steered median filter

Steered Similarity
Time gate (ms) 28 28

Extension | Cross =]

Stepout |ink1 & |en1

Outpul statistic Average =l

=12
[=][ © setect...

Stearing | Full -]
Steinoan ) i o ssawans ][0 s
)
4
4
.—

Asribute Narme[ Steared Similarity ] [[add a5 new |kl

J] Save on Close

Qo) [@ree

Workflow cont'd:

8. Select Curvature from the list of attributes.

9. Change output to Most pos curvature and type in a new name, e.g. Most Positive

Curvature.
10. Press Add as new.

= Attribute Set 30

File

ot B N-EIL Y A0

Non-steered Similarity InkCrl stepout 2

Steered Similarity
Most Positive Cunature Constant vidocity & Yes No

WVelocity (mfs} 2500

Cutput [Most pos curvature | =

Steering Data % ‘g 3 Steering BG Background

=] © seteat—

Aftribute Namellﬂlast Pasitive Curvature

| Eeszsnew]|ia

] Save on Close

Lo ()

| gcmse & Heip 1
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Workflow cont’d:

Curvature.

12. Press Add as new.

o Attribute Set 30

11. Change Output to Most neg curvature and type in a new name, e.g. Most Negative

[ Fue

*Pe NN WAE -

Afribute set| <nct saved> <Al =] Cunature
Non-steered Similarity
Steersd Similarty

Most Positve Curvature
Most Negative Curvature

InliCx stepout 2
Constant velocity @ Yes Mo
Velocity (m/s) 2500

Steering Dala % fi&] 3 steening BG Backgroung

(4]

== ~=)

[+][© seiea

Attibuts Nama| Most Negative Cursature

| [d as new |jil

1 Bave on Close

(@) (@)

Workflow cont’d:

13. Select Dip from the list of attributes.

14. Change Output to Polar dip and type in a new name, e.g. Polar Dip.

15. Press Add as new, Un check Save on close and Close the window.

& Attribute Set 3D

File

S IETTLEY I NE

Asribute set | <not saved=

FS- T—
Hon-seered Similarty Stesting Data % Fi) |3 steering BG Background [=]|© seiea.|
Steerad Similarity —

Mozt Positive Curvature Oulput Polar cip x

Lost Nagative Curvature

Poar Dip

o

Atrioute Name [Potar Cip

| ezsenen] il

Save on Close

L

[ Lo

[G 5] @i |
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Workflow cont'd:

16. Right-click on Z-slice in the tree = Add
and Select Data.

17. As visualization of the full z-slice will
take some time, we will limit the inline
and crossline ranges. So, press Cancel
in the pop-up window.

18. Right-click on the Z-slice number in the
tree > Display > Position.

Elements. Color
Scene 1
&' Indine
i Cross-line
& [Z-slice
@ volume _ Add Default Data
PRI s and Selct Dl |

* 2D Lin¢  Add Color Blended

@ AN e

= Select = Eoh =]

Select first layer

Stored Hon Steered Similarity

. Steared Similarity
Steering | Most Positive Curvature
Most Negitive Curvature
9 Attnbutes | Poloar Dip

ig
(@0« ][O curcal] [ @ e
Elemenis Color
Scene 1
¥ Inline
@ Cross-line
= & Z-shice
SR aga ')
© volun I 1, Histogram .
~ Rang Ouplicate i
¥ 20U Reset Manipulation il
< 30H L. kT ‘“ = f Gridlines .
ock Treeitem
204 @ 43 Properties ..
Fault == Remaove from Tras Resoluion

FaultSiekSel
® Body
& well

Workflow cont'd:

19. Position Z slice 1640ms between
inlines 120-400 and crosslines 350-600
and press OK.

20. In the pop-up window select Non-
steered Similarity from Attributes tab.

21. Press OK to display it in the scene.

-~
[ Posmoning Py
Specify the elements position
In-line Range 120 = 400 =
Cross-line Range 350 5 600 [+

w Apply |

| Qox IQCannel @) Help

) Select [F=8Hon =

Select Layer 1

LI on Steered Similarity

Steered Similarity

Steering | Most Positive Curvature

Most Negitive Curvature

@ Attributes | Poloar Dip

S
3

| gEOK | 9 Cancel‘ [ ) Help J
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Workflow cont’d:

=8| 1645
22. Right-click on the Z-slice 1640 in the tree > Add > ,‘vg\aunr:oe gispl:avt * & Volume Builder Attribute
. | uplicate
AttnbUtE- 2D Ling Reset Manipulation
% 3D Hor|

4 20 Hor Lock Treeitem

Fault |== Remaove from Tree

' Select folla =
Select Layer 2
Stored [Non Steered Similarit ]
. o R Sicoreo Smiarty
23. In the pop-up window select Steered Similarity Steering | Most Positive Curvature
. Most Negitive Curvature
from Attributes tab. & Attributes | Poloar Dip
: . =
24. Press OK to display it in the scene. B
=
[© 0o ](© conce] [ @1 |

25. In similar way display the rest three attributes.

Workflow cont’d:

26. Now you can compare them by checking/unchecking the attributes.

0781 |o.941¢m Similarity
1 Rainbow_classes

27. Click on an attribute in the tree to make it active and change the 11 Red-Whte-Black
color bar to Similarity. Do the same for all the attributes. ':' g:ﬁ:'gz":ga'“
11 Seismics
28. The result should be similar to the one shown below. Display and | Sunisse 2
compare the different attributes. What do they highlight, and why? S vids Erample (5 Classes) =

Which attributes are best under what circumstances, and for which
purpose (fault or fractures)?

N §
ﬁ;:f :

,- .‘
‘:.‘%.’.‘
...:"!

~

ol
.
%

2}
£

| oAt
J )
-"} VIR

Steered S|m|lar|ty Most Negatwe Curvature

i
)
.
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2.3.2c Bodies

Required licenses: OpendTect Pro, Faults & Fractures.

Exercise objective:
Create and rank fault bodies from a fault discontinuity attribute volume.

Workflow:

. Click on the Faults and Fractures icon -
2. In the Faults and Fractures control center: Select Voxel Connectivity tool in the Planes

module.
3 P G " Faults and Fractures Control Center | =85~
. ress 0. Plane Tools
A i | Attributes | | [ iract planes

2 | Extract Skins

Fault Throw
i | Filters
\.\\\\ Planes

(@ close]| [ @ nelp

Workflow cont’d:

4. Define the first step:
a. Select Fault_Likelihood_Thinned_from_DSMF_seis as Input Cube

b. Give a Name for this step and click Ok.

- Edit step - olEd

Input Volume

Input Cube LE’} = |ult_Likel|h00d_Thinned_from_DSM F_seis v/ |© Select ...

Name for this stepl Fault_Likelihood_Thinned_from_DSMF_sei |

@ OK | © Cancel @ Help
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Workflow cont’d:

& Edit step - olEN

Voxel Connectivity Filter

5. Define the second step:
a. Select the Voxel Connectivity

Filter step and clickon . [ Keep Values larger than ~|
b. In the Edit step window, Keep [ Value 0.6 |
Values larger than 0.6. Connectivity [Full (26 neighbors) v
c. Set the body size threshold to |Keep bodies larger than [voxels] 100 = |
100. | Kept output Body size V|
d. Set the Kept output to Body-
size.

A . Rejected output ® Undefined value ) Value
e. Give a Name for this step.

f. Click on OK.

Name for this step Extract Fault Bodiesl

-lﬂm © Cancel @ Help

Vioxel Connectivity Filter is a special tool to create continuous bodies based on the
amplitudes in a stored volume. A voxel is defined as the volume around one sample. It is
thus linked to the survey bin size and sampling rate.

Workflow cont’d:

6. In the next Volume builder main window, give a name to the Volume builder setup.
7. Make sure the box Process on OK is toggled on and press OK.

! Volume Builder: Setup o ==
Available steps Used steps D
Body shape painter - Fault_likelihood_Thinned_from_DSMF_seis .’ d
Lateral Smoother Extract Fault Bodies 3 “\J
smoother

Horizon-based painter - Simple
Horizon-based painter - Advanced =l
Velocity gridder 1 *
Input Volume

WellLog Interpolator

Fault Painter
HorizonCube-wWell Interpolator
Voxel Connectivity Filter

" |

O select...
(G0 (@1

If the Process on OK box is toggled on, pressing OK will prompt you to save the Volume
Builder setup and specify an output volume name. You can also save and retrieve setups
with the icons: i and “=. Processing is then started from the Processing menu, option
Volume Builder ...

On OK, store As  Extract Fault Bodies '|
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Workflow cont’d:

8. In the Create output window, the active Volume Builder

setup is selected by default.

9. Reduce the volume to process: press Select and specify ¢ ocqjine Range

Inline, Cross-line and Time ranges as shown.
10.

Specify a name for the Output cube and press OK.

In-line Range| 120 5 400 3
350 3 600 3
Time Range (ms)| 1400 = 1848 =

Volume Builder: Create output

- o IEN

| Volume Builder setup Extract Fault Bodies

v||© Select .| W Edit ...

Volume subselection | 120/350-400/600 (113 samples)

|0utpul Cube | VCF ranked fault bodies

v| © select ... @ cCBVS -

Batch execution Single Process ~ < Options .

€) Cancel | (@) Help

Workflow cont’d:

11. To display the created volume, click on Volume in the tree and select Add fo add a

volume viewer to the 3D scene.

12. Click on the new tree item and go to Display > position. Set the viewer to the ranges
specified in the previous slide either using the menu.

Alternatively use the ﬁs icon.

: Z-slice

Volums;

~ Rand|
=/ 2D Lii Add Color Blended
# 3D Horizon

W Z-slice
® Volume
] 343-50.
| <righ, Add '
~ Random . [N 1 Histogram ...
= gg hlgﬁzc Duplicate ¥ Properties ...
120 hor , et Maripuatn
Fault o Lock Treeitem

FaultStic. = Remove from Tree
® Body

|

) Positioning

Specify the element's position

Indine Range| 120 7 400 %

Cross-line Range| 350 % 600 %

Z Range (ms)( 1400 7 1848 2

| @OoK | @cancel | @Help

- 226 -




Workflow cont’d:

. . E - olEd
13. Select the volume you just created in the ' seed
. - Select Layer 1
pop up window and click Ok.
. * Stored P-Impedance_rel_F03-4 -
14. Select a color bar (e.g. Extremes). Adjust Steert Spec Decomp FFT
teering Systemn Tracts
transparency as needed and ensure that _—
. . . Attributes Velocity model (INT)
undefined values are displayed with 100% ™ Velocity model (RMS) -
transparency:. o . 2
= Fiter *

To edit the colorbar: see Exercise 1.2.2 | T

[i I | |I

Segmentation None 1=
Undefined color | J Transp 100% =
Marker color [- ]
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2.3.2d Planes

Required licenses: OpendTect Pro, Faults & Fractures.

Exercise objective:
Extract fault planes from a Fault Likelihood volume.
Workflow:
1. Click on the Faults and Fractures icon &3 .
2. In the Faults and Fractures control center: Select Extract Planes under the Plane
Category' = Faults and Fractures 3D Control Center - [m] X
3. Click on Go. Plane Tools
-I Aliributes Extract Planes
A : Voxel Connectivity
i i Filters
‘\:1 .:~ Planes
AN
@
Workflow cont’d:

4. In the Fault Skin Processing settings window create an input Fault Likelihood cube.

%, Fault skin processing settings ol -2 ]
Fault likelihood cube () Fiss) - [© select .|
Volume subselection - B Select ...

¥ Use Recursive Gaussian filter for pre-conditioning
Minimum Fault Likelihood: For Skin 0.10 7 ForSeed 0.50 2
Maximum delta: For Likelihood 0.10 T For Strike 15 = For Dip 5
Minimum Skin size 1000

Velocity (ft/s) 10000

©@Rrun || ©close | [ @ Help |

-228 -



Workflow cont’d:

5. Select 4 Dip steered median filter cube and keep the processing parameters by default.
6. Restrict the volume subselection to inline 100-400, crossline 300-750, z range 1400-1848.

Volume subselection 100/300-400/750 (113 samples)

. ¥ Advanced Settings

Output Cube Fi]

Batch execution ‘Single Process - ‘ . .~ Options I

‘2 Create Fault Likelihood | T
Input Cube E} "B, 4 Dip steered median filter - [6 Select l

- [© select ..

LORun | @ cose | [ @tep |

& Positions [?"ﬁl
Specify Positions
Volume subselection |Range 7 i{:}; 3‘ Ig
In-line Range| 100 > 400 < |Step 1 ~
Cross-line Range| 300 s 750 > |Step 1 :
Time Range (ms)| 1400 7| 1848 I (Step 4

[ ©@ok |[© cancel| [ @ el

Workflow cont’d:

7. Select the processed Fault Likelihood volume.
8. Press Run to extract fault skins.

‘@ Fault skin processing settings
Fault likelihood cube (i ) FL
Volume subselection 100/300-400/750 (113 samples)

Minimum Fault Likelihood: For Skin 0.10 7 For Seed 0.50 |2

Maximum delta: For Likelihood 0.10 7 For Strike 15
Minimum Skin size 1000 *

Velocity (ft/s) 2500

| Use Recursive Gaussian filter for pre-conditioning

- ForDip 5 —

== )

- st

[© select ...

[ ©run | €) Close H @ Help |
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Workflow cont’d:

9. A set of fault skins is now displayedin the 3D scene along with Fault skin QC window.

LY, - IPY W UL P YT B T . ESY,
2 Faultskin O sl |
" ¥ s o
RN .,
VAR T AN <
/ S \
/ . * - \. -
I - - EY
i
wloe o, c ke w
\ . ¥ | ) Show Skins ¥ Hide extracted e
[ e 0% / ®
Y . e / Display [Skin Size: Z i
\ . et . / A
\ ] s wse B Wz [cipastel i
| ~ e Selection color [N B8 Lime E,
R 1 Extract selocted .. | | Merge <€
=
¢
E 20]
1%9 5000 10000 15000 20000
Skin Size:
Filter Criteria Skin Stze. = 9 Inside Outside ¥ Keep Selected
Total rumber of skins: 112 Number of skins In range: 112
D Finish | | < Back
o Skins selected
2~
Workflow cont’d:

10. Select an individual fault by clicking on a skin (it turns green) and Extract Selected as an
individual fault plane.

o 1 BEWN " W L Y r G a o

& Fault skin QC
N
e ™~ (i
S L T SN -
Vi, e A\

‘I.‘ - -0.— \I | i
!
wl . fe w2
\ . e ! ) Show Skins ) Hide extracted iy
1|\ ees . T / ®
\ - " p—— / Display [Skin Size - i

\ TR
\ N ‘d % / wee WMoz [Cipastel Ay
| . e Selction color | NN [ BLime E.

Filter Criteria Skin Stze. = 9 Inside Outside ¥ Keep Selected
Total pumber of skins: 112 Number of skins In range: 112
@ insh | | © < Back
1 Skin selected, use Shift-Click to select more:
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Workflow cont’d:

11. Select several skins using Shift + left mouse click.
12. Check the Merge option and extract the skins as one fault.

o 1W, BV W tE P N WY G VA ESNY S
1 Fault siin QC ol@l®
4 Skins selected

% Show Skins ¥ Hide extracted
Display [Skin Size -
wee B W  [Oresel
Selection color | [ | | Lime

Extract Selected ... /| Merge

LR

am>

o
§ [24
20]
h 5000 10000 15000 20000 24410
| Skin Sloe
Filter Criterla  Skin Size. =| @ Inside Outside + Keep Selected
Total number of skins: 112 Number of skins In range: 112
| @ Finish | (O <ack| | @neip |
4 Skins selected
H -
Workflow cont’d:

13. Select all skins using Ctri+A.
14. Extract all skins as a Fault Set.

s BEEWN | ST P » BB e o Bl . B0 T L ED At B
1 Fault siin QC olars
116 Skins selected

¥ Show Skins ¥ Hide extracted

Display [Skin Size -
wes B WMz [Orasel

Selection color | [ | (5 Lime

I Extract Selected .| Merge
[24
10000 15000 20000 24410
Skin Size
Filter Criteria [Skin Size -] @ Inside ) Outside ¥ Keep Selected

Total number of skins: 112 Numiber of skins In range: 112

| @insh | O < gack| | @t |

116 Skins selected

1

S>A NS

ams
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2.3.3 Ridge Enhancement Filter (REF)

What you should know about the Ridge Enhancement Filter

The Ridge Enhancement Filter is a post-processing filter for fault attribute
volumes, such as Similarity. It sharpens the attribute response such that faults
are more clearly visible.

The ‘Ridge Enhancement Filter is delivered with the software as part of the
default attribute set.

The set calculates similarity attributes at 9 locations surrounding the evaluation
point. Then it compares the differences between similarity values in 4 horizontal
directions. The direction perpendicular to a fault usually exhibits the largest dif-
ference and is therefore output as the Ridge-enhancement attribute. The effect is
a sharper outline of the faults.

Similarity

time-slice

Sumilarity s caleulated as the sverage of
bwo trace-peairs at 9 locations surrounding
tee evaluation point

The default attribute set is based on Similarity. With only minor modifications, this
attribute can also increase resolution of other attributes like curvature, or volumes
as fault probability volumes.
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2.3.3a Ridge Enhancement Filter

Required licenses: OpendTect.

Exercise objective:
Compute the Ridge-enhancement filer attribute for improved fault visualizations.

Processing Scenes View Utk

Workflow: - _t
“§ Volume Builder ..
Ei Cross-plot Data v
1. Start the 3D attribute engine: Analysis > Attributes > 3D. wel .

& Layer Modeling

= Fluid Contact Finder ..
i+ Neural Networks

58I v
Velocity Model Building  *
Weidl Correlation Panel ...
Workflow cont’d:
= Defauk Attribute Sets (=R =
2. Open the default attribute set . Select default attribute set

Filter *

. " Evaluate Attributes
3. Select Ridge Enhancement filter (Expert). AVO attributes from Intercept-Gradient
AVO attributes from Near-Far
Workflow - Data Enhancement (dGB)
4. Press OK Ridge enhancement filter (Expe

Fault enhancement attributes

RIrTS Samman
b

i
0 Cancel: ) Help

5. Select 4 Dip steered median filter for Input seismic and 3 Steering BG Background for Input

Steering.
. Attribute set definition =8 E=h |
6. Press OK.
Select Seismic & Steering input
Input Seismic =) I"" | 4 Dip steered median filter B 6 Select [
= S |\S Select ..
Input Steering i":’) l&;]l 3 Steering BG Background B 9 Select ...

0 T @) Help ]
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Workflow cont’d:

7. Keep everything default with the default name Ridge enhancement filter.

8. Uncheck Save on close and then Close the window.

_
File

*PeREa NWAE
Aftribute sel <nol saved> <Al>
Similarity

Calculated_or_Stored_Simi
Dip-steered median fitter (D
Dip-steered diffusion filter (
Fault enhancement filter (FE
Similarity on FEF

Attribute Set 3D

<

M (2

~| sgrt (Square rool v

Mathematics

/' MathF unctions Insert I

Formula (like 'nearsti + ¢0 * farstk’) max(inider cider,diag_oneder,diag_twoder)

For ‘inider’ use SecondDerivative~

- o lEN|

RS_+1_0

For 'cider’ use
For 'diag_oneder use

For 'diag_twoder’ use

SecondDerivative v

SecondDerivative v

SecondDerivative »

RS_-1_1 t
SecondDerivative_Inline
SecondDervative_Crossling '
SecondDervatve_Diagonal |
SecondDervatve_Diagonal :-’."
RidgeEnhancementF ilter
Laplace on similarity —
< > Aftribute Name |RidgeEnhancementF iter Add as new [l
o
Workflow cont’d: Elements Colot
Scene 1
N Inline
9. Right-click on Z-slice in the tree > Add and e
@ Volume  Add Default Data
Select Data. R o i
* 2D Line  Add Color Blended
S AN U
10. As visualization of the full z-slice will take = sdest el

some time, we will limit the inline and
crossline ranges. So, press Cancel in the stored

pop-up window.

11. Right-click on the Z-slice number > Display

> Position.

Select fiest layer

RS_1_-1

RS_1_-1

RS_-11

SecondDerivativa_inling

& anributes | SecondDerivative_Crossline

SecondDerivative_Diagonall
]

Steering

RidgeEnhancementF iter
;::'. Laplace on similasity

(o] Qs

Elements
Scene 1
W In-line
W Cross-line
& Z-slice
v EEn
Add *

Al
© volur IEETTRNNN 10 Histogram

~ Rand Duplicate P
2D Li Racal Maninukshion =

* 30 H tesel Manipuialion | 4 Gridiines

® op @ Lock Properties
Fault % Remove from Tn?e Resobdion "
FanliShirkSat
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' Positioning EI@

Specify the element's position

Workflow cont'd:

. .. In-line Range |120 = |a00
12. Load Z slice 1640ms between inlines 120-
400 and crosslines 350-600. Cross-line Range |350 | < | 600
z (ms) [16a9 5] [ seroll... |
v Applv|

I OOK | |o Cancel| ‘ @Help ‘

= Select = F@
13. In the pop-up window select Ridge Select Layer 1
enhancement filter from Attributes.
Stored RS_-1_-1 e
RS_1-1

Steering  |Rs_-1.1
SecondDerivative_Inline
9 Attributes | secondDerivative_Crossline
SecondDerivative_Diagonall

. [P R SecondDerivative_Diagonal2 L
14. Press OK to display it in the scene. '* RIREEThemEE merEateT ,
.,‘='> Laplace on similarity

©) cancel| | {3 Help

Workflow cont’'d:
15. Once the slice is displayed, click on its attribute in the tree to activate it and change the

color bar to Grey scales.

16. The result should be similar to the one shown below. Compare it with the attributes of the
previous exercise.

= Opesdlext V60.0pres- 20150821 finéd: F3 Demo_015 - [Scene 1]
Surery A Processng Scones View  Utiities.  Holp

o] 267 9 G8 [ -
o
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2.3.4 Frequency Enhancement (Spectral
Blueing)

What you should know about Seismic Spectral Blueing

Seismic Spectral Blueing (SSB, by ARK CLS) is a technique that uses well data
to shape the seismic spectrum, to optimize the resolution without boosting noise
to an unacceptable level.

The workflow is as follows: an Operator is designed for SSB using both the seis-
mic and well data. This operator aims to shape the seismic amplitude spectrum
such that it becomes similar to that of the well reflectivity spectrum. Once the oper-
ator has been derived, it is converted to the time domain and simply applied to the
seismic volume using a convolution algorithm. As the SSB technique uses both
seismic and well data, one of the main prerequisites of this workflow is to have
good quality well-to-seismic ties.

Typically, the aim is to design an operator at the zone of interest (target). It is
therefore best to identify a time gate for this interval before proceeding ahead with
the SSB workflow. Ideally one should use a good interpreted horizon in the target
zone to guide the seismic traces and well data (log traces). In this manner, the
various gated log traces should have sample values over a similar geology.
However, for this training exercise, in our case we will just use a window interval
instead.

Here is the workflow for how to create and apply these techniques in OpendTect:

Seismic: Amplitude-Frequency plot
Smoothing of seismic mean

Well: Amplitude-Frequency plot
Global trend of well plot

Design operator

Apply Operator

Quality Check

NookrwN -~
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2.3.4a Spectral Blueing

Required licenses: OpendTect Pro, Seismic Spectral Blueing.

Exercise objective:

Workflow:

1. Go to the Aftribute engine:
Analysis > Atfributes > 3D or click
on the » | icon > 3D.

2. Choose Spectral Blueing attribute
from the drop-down list.

=7 Survey Analysis

Q[ W 4

Attribute Set 3D

Increase the vertical resolution ofthe seismic data with Seismic Spectral Blueing (SSB) technique.

3. ISeIetcE t‘,' Original Seismics as Al < [Spectaiueing 2
nput Data.
P |IannData 1 Original Seismics v | Select |
4. Keep the default Single Operator
option selected. ® Single Operator O Time Variant
: Input wavelet [.‘;) v Select..
5. Click Analyze and Create ... to
launch the SSB Module.
Workflow cont’d:
a Seiemic Spectral Blueing: F3_Demo_2015 - Untitled - oiEM
File View Tools Help
In order to design an SSB operator, | - B 5= ' HuEEEAPES ——
it is mandatory to analyze the 100 100
seismic and well data spectra by 1
. . . i elect Input Data ?
loading some seismic traces and " — e =
time converted acoustic impedance | | | ‘"Z"‘f’e's"": '"""::“““5
% elect races
We" Iogs g Seledt Seismic 1 Original Seismics
40 30 Survey Area
® Ful Stan End Inc
6. Click onthe [¥ icontopopup | ™ Sib | Inkee
the Select Input Data window. o] Load Traces
o 2 Num'rramr. w0 F 100
7. Keep 1 Orfgfnaj Sejsmics as . L Clear Traces| |Clear Unselected Traces 120 Selected
selected seismic. Tim
0] Select Horizon
Range Absolute
8. Click Load Seismic to load 40 o Ful © Honzon  fstan 500
random traces from the selected | : T Ent 1500
seismic. @
. 0+
9. Keep the default Sub option for = e
Time Range and enter 500 o ; ; ; R : ; . .
] 2 40 &0 80 100 0 20 40 60 a0 100
Start) and 1500 (End). Tim () v
( ) (End)
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Workflow cont’d: Y Select nput Data »

IroLrISerm\c
oadASC Vi Define Format.
10. Switch to Input Well Logs tab. FiekiWelslLogi~og_ Base Horz Time How: InLine X-Line
- Select Input Data 7 IEN
11. Click Load wells. Input Seismic | Input Well Logs
Reload Weils ad ASCIl We Define Fomat.
12. Select the well F3-04 and the At g g neRSte mbie LN
F024 256 1460 undefined 362 13
P-Impedance log. ) Dimoctane: o 20 10
F03.2 0 1841 undefined 722 B4
Pdmpedance 0 1841
. P adance 0 1841
13. Keep the default Sub option for ‘ 5 1813 undefied w100
Time Range and enter 500 ea— Foar “ § %g o s
(Start) and 1500 (End). S Pimpedancetsl 0 1623 GenenieAitos. T
Range
14. Close the Select Input Data 050 8 lan T '
window. Time
J Hep Select Horizon
Range Absclute
Full Hornizon Start | 500 500
@S OMakers gy isog 500
. Help # Clase

Right-click on a well either to select another or to
generate a new acoustic impedance log if it is not —
available.

Workflow cont’d:

- Sefsmic Spectral Blueing: F3_Demo_2015 - Untitled - B ﬂ
File View Tools Help

TMHESP TalNER 82zppEH©O

15. Once the seismic and well data
are loaded, you can see various
curves displayed in different .
plots. . 1
Take your time to scroll through '

100 &

this window: left-click on any ;é“
curve and in the lower left ol
corner find out what does it
represent. 0]
. . s'aF 0 w0 i
- req (Hz) Freg (Hz)
16. Right-click on any plot to see a Log It (e darrsi Log I Dot tire dorrsi)
menu that allows to change 6200000 ] '
various display options, show a oo 005
legend, etc. |
- . £000000
Zoom Data (Ctri+Wheel or Shift+MB1) o _—
Move Data (CtrHMB 1) i H
Unzoom/Unmove Data (MB2 or Shift+MB 1) 4500000
B Unzoom AlVR e data | |
Show Legend Aavon0 Wi gl oos<
Display Options... ! ‘h |
Screenshot v 3500000 !
X Axis r

T T T T T T
Y Axis v 0 500 1000 1500 0 500 1000 1500

Time {ms) Time {ms) vl
Help [Datatem: Averags (70.501, 30815 [(Darkels]
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Workflow cont’d:

17.

18.

19.

Click on & to pop up the
Design Controls dialog.

Smooth the average amplitude-
frequency spectrum of seismic
data displayed on the Seismic
Mean plot.

Uncheck the Full Range option
for Fit Well Log Curves and
enter 125 Hz as the High Cut
frequency, thus limiting it to the

a Seismic Spectral Blueing: F3_Demo_2015 - Umtitled

File View Tools Help
il =N

a Design Controls * IEl
Smooth Seismic Mean

Smoothing Operator Lengh 5 Hz
Fil Well Log Curves

Low Cut High Cut
Full Range 0 S HIZ 125 5 Hz

Beta: 0.3439

Design Operator

@ AuwoCae.  Ful[2

A alc. 6048 [ B

9 Auo Cak.  Num Zeso X 20

Energy. 809696 %

- olEN

IEI“" EEBzpPpPEO

T T
50 W00
Freq (Hz)

Nyquist frequency of input O:Awml'mmc
seismic. e
20. Observe changes on the Global g
plot. fa
1 |In - ||‘|o 1 1In caties |c||n
Workflow cont’d:
[ & Seksmic Spectral Blueing: F3_Demo_2015 - Untitled = Un
File View Tools Help -

21. Tweak the Low and High Cut _L LA L L R i .
parameters of the Design Deson oad (fme damin
Operator such that the residual /_P‘-J\
operator (blue curve on the \ 06
Residual Operator QC plot) | |/ T ol
stays 0 in the frequency domain, z i \ £
with a quick drop on both sides. 101 024

22. Save the operator B by giving ol \ " w\/u ]_J'Lm"
it a name. This operator is saved T - Tt T T
as a wavelet. ol Comoived Okt Mean (GC)

23. save [ your session (optional). - Desan Convos T

The SSB operator is stored as a wavelet
and can be visualize in the wavelet
manager.

Amp (d8)

Freq (Hz)

100 <

Smooth Seismic Mean
| Smoothing Operator Length 5 [ Hz
Fit Well Log Curves

LowCu  HighCut
Full Range: o T Hz 125 = Hz
Beta: 03439
Design Operator
LowCut  HighCut
AuoCale.  Ful's8  [S Hz80 5 Hz
< Auto Cale. 6048 [B Hz B0 -
@ Ao Calc.  Num Zero X-ings: [
Erergy. 989575 %

QC Against Input Seismic

& Help # Clase
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Workflow cont’d:

-

L tnline 443 :
The effect of the parameter tweaking | conens
of the Design Operator is L

immediately visible in View Seismic
window which can be popped up by
clicking on = and is updated
automatically.

| = Blueing

=3 Crosshine

Property Editor 8%
- =
Hints &x
Zoom (Ctr+Wheel)
Honzontal zoom:(Cir+Alt+\Wheel)
Vertical zoom: (Ctri+Shift*Wheel)) 970 980

Step 1

View Seismic

= Well Tolerance 1

> km

- =N

Cross Hair ® € |l

& x

Inline 442 - 1 Original Seismics

] 9;{0 gzlm QIQO 10|00 1U|10 Iq20 1U|30 10|40 10‘5

| = 1 Onginal Seismics

¥ " F03-4 . Pdmpedance

Hornzontal scroll (All+Wheel) <

L B e s R e R R R R R e e ma

>

»

990 1000 1010 1020 1030 1040 10fw

Workflow cont’d:

24. Close the SSB module and return to the Attribute Set 3D window.

25. Check if the newly-saved operator is selected.

26. Specify the Attribute Name and Click Add as new.

- Attribute Set 3D
File

ol BTN LY 25
Aftribute set <not saved= <All- +| | Spectral Bluging

S5B_on_Oninal_Seismics Ingut Data | 1 Original Seismics
Analyse and Create

® Single Operator O Time Vanant

Input wavelet [, | Speciral Blueing Operator_sb

~| | Select

| Awituse name | $58_on_Orinal_Seismics

Add as new |

¥ Save on Close

Close

) - |

Heip
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Workflow cont’d:

27. Right-click on In-line in the tree and
chose Add and Select Data.

28. Select 1 Original Seismics from Stored
tab and press OK.

Elements Colol

Scene 1

! [In-line*
4 Cross,_ Add Default Data

PP Add end Select Data |
@ Volum  Add at Well Location
~ Rand  Add Color Blended

= AN e -
= Select = EoR ===
Select first layer
9 Siored | 1OnginalSeismics B
3D UVQ 6 biased Texture+Energy+SystemsTrac
Steering 3D UVQ Texture+HC attribs+ Energy disk
4 Dip steered median filter
Aftributes 5 ChimneyCube
Ta Al Cube Sid
= 7b Al Cube from HorizonCube -
= ‘ i )
Filter *
[© ancal [ @riop

Workflow cont’d:

5

29. Apply the SSB attribute on inline
425 and compare the result to the
original seismic data: Right-click
on In-line 425 in the tree and
follow Add > Aftribute.

e 1
In-line

v
v |

# Cross:  Display * %4 Violume Builder Attribute
; Sgllce EEECD @ HorizonCube Display
UMK Reset Manipulation - !
4 ¥ Syste Tracts Di
7 Randc  Display Prosiack Data » | oy isplay
Rl 4 Correlate with Wels

v 4 g Lock Treeitem
2D Lir == Remove from Tree
% 3D Horrzor
= v Demo 6 —> F58

30. Select SSB_on_Qriginal_Seismics

from Attributes tab and press OK.

= Select
Select first layer

9 Aftributes.

i

Stored

S5B_on_Original_Seismics

Steering

) Cancel | | @ Help
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Workflow cont’d:

30. The results should be similar to the ones shown below.

1 Original Seismics SSB on Original Seismics

31. Compare the original seismic and the SSB seismic: tick on and off the overlaying
attribute in the tree.
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2.3.5 Flat-Spot Detection

Various methods have been developed to detect locally horizontal seismic
events, which do not follow the stratigraphy of the geological layers. These
events are potentially Direct Hydrocarbon Indicators, since fluid contacts will
most often be perpendicular to the pressure gradient, regardless of the structural
dip. Multiples will most often also not follow the local stratigraphy, and are a false
positive for these detection methods, since they will also be enhanced should
they be horizontal seismic events.
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Optical Stacking
What you should know about Optical Stacking

Optical stacking is released as a free (open source) attribute in OpendTect. His-
torically optical stacking was the first stacking method to enhance hydrocarbon
anomalies that emerged in seismic interpretation software systems. Optical stack-
ing stacks seismic traces that are on either side of a 2D profile. The 2D profile
should ideally be oriented such that depth contour lines are crossed per-
pendicular to the line direction. The traces in the stacking direction can be expec-
ted to have similar fluid effects (same hydrocarbon columns) hence subtle
hydrocarbon effects are enhanced.

2D profile for
optical stacking
cutting across
contour lines

Stack stepout in
perpendicular direction
to the 2D profile
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2.3.5a Optical Stacking

Required licenses: OpendTect.

Exercise objective:

® Body

S Well
= Picks
e

Track New

select Demo 6 --= FS8.

2. Launch the Attribute Set 3D

Workflow: -
“20Line
@ (30 Hozoos
1. Right-click on 3D Horizon e
in the tree >Add... and Faut  Add Color Blended ...

Create with Constant Z ...

Enhance the amplitude anomaly on a random line with optical stacking.

= Seleet gut Horizen 1) = o =" |
Fillar *
Dee 0 —> F54 =]
Demo 1 > MFS4
Do 2 > FS5

Aroa subselection 1007300-T500 1250 (463 samphes) © Select

QoK || D) Cancal | i Heip
Daemy_201515urtacesDomo_6_—_FS8 hoe

window. © Suvey Analysis S e
I RN o

2D .. I
h T 1

3. Choose Volume statistics
attribute from the drop-
down list.

Aribute 50 <nol smved>

4. Specify parameters as |
shown on the image to
define an RMS amplitude
give it a name and press
Add as new.

Sive on Closa.

ot B NN NL T S

| Vohama Statistcs
Input Data 4 Dip steersd modian filer
Tima gate (ms) -28 28
Shapa Cylnoer =
Swopoat w0 3 o0 2
Min e of vald traces 1
Oufipuit statestic RMS bl

Stoaring Nors -

Asribute Hame RMS_Ampl

= |2
] © Select

] Adow exige effects

Add s e [

G Cioso | | g Hop

Workflow cont’d:

5. Right-click on Demo 6 --> FS8 > Add >
Attribute.

6. Choose the RMS amplitude and click OK.
Optionally, change the color bar for RMS
amplitude to Rainbow Plus.

7. Right-click on Random Line in the tree >
New > Interactive ...

“® 3D Horizon

#ll Demo 6 —> FS8 [

7 Lo I | TR
! 2D Horizor o (L

Fault D) " “& Volume Builder Aftribute
FaultSticks Trecking ' Contour Display
® Body It ' Horizon Data
L wel Workflows *
i PickSet |kl Save
D Polygon | @ Save as
T ﬁ;{:ﬁ ;Lsk g o Lock Treeitem

Remove from Tree

= Select =5 Fol ==
Saelect Layer 2

swered  EEST

Stearing
@ Aftributes
B

| @ok || ©cancel | @Hep
O Tine Add Default Data

“ 3D Horizon Add Stored .

¥ Demo 6 >
7 RMS_Ar Add Color Blended »

* 2D Horizon
Fault From Existing
FauliStickSet From Polygon
&%‘I’IY From Table

¥ PickSet From Wells
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Workflow cont’d:

8. Pick arandom line going

through the structure where the

amplitude anomaly is seen.

Using the left mouse button,

click on the map to insert a
node.

9. Right-click on a newly picked
random line in the tree > Save
as ... and type in a new name.

~ Random Line
Ol Handd]
< 40D st
20 Line
® 3D Horz
| Demo
¥/ RM

Fault
FaullStic

 PickSet
_D Polygon

Display Li
Duplicate
Creale 2D Gnid ...
yhal 2 Sawees |
20Hes Save as 20
Correlate with Wels
o Lock Treaitem
( Export to Google KML
== Remove from Tree

amplitude map
e

= Save Random Line 2.
Select output Random Ling

Filnr *

Examgie mndom contour demo 1> MFE

Export_Paty RL
Frandom Line 1 {Irining maessa)
o el <

Hama Oplical Sincking

[« T3

Q) Cancel| | igh Holp

Workflow cont’d:

10. Launch the Attribute Set
3D window.

11. Choose Volume statistics
attribute from the drop-
down list.

12. Specify the following

parameters to define an

optical stack: 4 Dip
steered median filter as

Input Data, [0, 0] Time

gate, Optical stack Shape,

Stack stepout of 15, Full

Steering by 3 Steering BG

Background.

= Survey Analysis

Qi au

2D .. I
hT L

= Amribute Set 3D

File
P NRA S

Adiribate s01 <not smved>

FIAS_Ampd
Opbcal Siack
4
1)
Siva on Close

Adribats Name Optical Stack

ekl - -
Statstics | Voume Sttstics = |2
Input Data 4 D shoanid mdian e =] | D) Sesnct
Time gate (ms) 0 o . ASow odga affcts
Shape Optical stack
Stack siopoef 15 2| Diroction @ Porpendiculr ' Ling
Min r of vabd baces 1
Output statistic. Avrage
Stoaring Ful
Sioering Data [ 3 Stwering BG Background = ) Select

s as new| [l

Q) Ciosa | | @ Hop

Stack stepout of 15 is equal to 375m at the bin size of 25m.

- 246 -




Workflow cont’d:

® Volume
] /fandan Line
ight-cli R S | WS
13. _ngl_1t click on the random g 20Ung " Deply o e
line in the tree > Add > 2 @ 30 Hor g:;.mnp . > Lo B Dmm
Attribute :gﬂ Create 20 Grid ... i} Systems TiackRenia
49D Hori ® Saveas ..
. ! Fault Saveas 20 ...
14. Choose the optical stack FaullSti &+ Correlate with Wels ... - :
ol e T —

gttribute f_rom the Attributes s Wol |G Export o Google KML .
list and click OK. [ Polygon = Remove from Tree

15. Optionally evaluate the
Stack stepout parameter.

(@K |(© Gocsl] @ o

Compare the optical stack attribute to the input seismic data.
Discuss the results: What events have been preserved, what events have been enhanced, why?

4 Dip steered median filter - Optical Stack
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2.3.5b Seismic Feature Enhancement

Required licenses: OpendTect Pro, Spectral Feature Enhancement.

Exercise objective:

Workflow:

1. Go to Analysis > ARK CLS
Utilities > Seismic Feature
Enhancement.

2. Keep all the SFE windows open
and go to the OpendTect main
window.

Enhance the amplitude anomaly on a random line with Seismic Feature Enhancement (SFE).

Processing Scenes View Utiies CLAS Help

Attributes 'lmMSEXThT-esaG
“&% Volume Builder ... I -]

Cross-plot ¥ | Color

Wells ;

Layer Modeling s

ARK CLS Utiliies Wl m_ Seismic Coloured Inversion
ARKeX |_J_l!|l|155 " | Seismic Spectral Blueing ..
MPS| Utiliies * | = Seismic Net Pay .

= Fluid Contact Finder 28 Seismic Fi =
" Seismic Feature Enhancement ...
I

Neural Networks

- Load RandomLine Geometry

- ol

H ch H H Select input RandomLine Geometry
3. Right-click on Random line in < Randon Ll o b csoid Datn
the tree > Add Stored .... < 3D Horizon Fiter |+
3 2D Horizon |~ Add Color Blended *
) Fault New v Example random contour demo 1 -> MF S
4. Choose the random line created RaASHCKSse 125 S o
in the previous exercise 2.3.5a Random Line troughweks exended | (g
and click OK. >
of OK | §8 Cancel @ Help
...8\Locations\235a_Optical_Stacking.rdl
Workflow cont’d:
= ~ Random Line
. . . =8| 235a_Optic....
5. Right-click on the random line name Z4Dipste.|  Add ,
in the tree > Display > Position. el . Histogram
# 2D Horizon Duplicate 2 Properties ..
Fault Reset Manipulation Resolution *
Fault Stick Set Create 2D Grid ...
s \?V%ﬂy i Saveas... InsertNode *
4 Pickset Saveas 2D ...
6. Keep the Random lines window open. - Random lines - ciEN
This window lists In-line and Cross-line Specity node positions
positions of all nodes of the selected
random "ne YOU Wl” need thlS Enter)(.'\’cnrInI!CrIpnsiliﬂnt:,.Nodecm‘tsidr:)Sur\mg.r
information in one of the next steps. £ y |nine RN Cross ol
Node1 620677.22... 60812238.. 390 902
Node2 62182286... 60796052... 324 946
Node 3 622531.80... 60783996... 275 973
Node 4 62324967... 60777694... 249 1001
Node 5 62418283... 6076595.0... 201 1037
Node6 62478343 60756865 .. 164 1060
Node 7 62522516... 60741983 .. 104 1076

Node 8

Z range (ms) |0 1848

o/ OK 8 Cancel @ Help
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Workflow cont’d:

B Seismic Feature Enhancement - untitled - olEl
File Seismic Process Help
7. Go back to the SFE main DewEnE> > | -
window and Click on Select
. o = Select Data » IEM T IEE
Data icon = P— L_. Select Volume
) ) [input volume .. N ) —
8. Clickon Input Volume in the Output Volume. ;gu%rglssgfsn;ﬁenumEnen
; 30 UVQ Texture+HC attribs+ E
Select Data window Traverse
ool ?ChlmﬂevCube s v
9. Choose4 Dip steered median Inline Crossline Insert Filter options
filter in Select Volume window ! Delefe @ Help * Cancel
and click Select. @Hep = o
= Select Data * IE = SelectVolume  ? HEIM
Seismic Filter
10 CIle on Output Volume in C\Jr:;:m\.’j:::; 4 Dip steered median filter éé)‘l&%??s;mgjgm@;gn;'
. . wure+ firibs+
the Select Data window. [Copaele. | 4 Dip steered median fiter
Traverse 5 ChimneyCube v
Select
11. Enter a new name of the S — = [ Name Ernanced seismic |
output dataset and click - = | Fifter options
Select.
¢ Help X Close @ Help 7 Cancel
Workflow cont’d:

12. Enter manually the random line node positions in the Traverse section from Step 6.

.

Random lines == n B Select Data u n
Specify node positions Table from Step 6 Seismic

Input Volume... | 4 Dip steered median fitter
Enter X/Y or InVCrl positions [Jl] Node outside Survey

Output Volume... Enhanced Seismic

X ¥ In-line Cross-ine |*
Node1 62067722 60812238  [390 902 UEEEE
Node? 62182286 60796052, |324 946 Select... .
Node3 622531.80... 60783996... |275 a73 Inline Crossline Al Insen
Moded 62324967, BOTTT604.. [249 1001 1390 902 Delete
Node5 62418283 60765950, |201 1037 \ 2324 946
Node 6 624783.43.. B075686.5... [164 1060 3275 973
Node7 62522516... 6074198.3... |104 1076 4249 1001
Node 8 . 5 201 1037
6 164 1060
Z range (ms) 0 1848 7104 1076 v
of OK | $§ Cancel | Help & Help

13. Close the Select Data window.

Alternatively, digitize the random line by
14. Close the Random lines window. picking a polygon that you can select as input
for Traverse by clicking on Select button.
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Workflow cont’d:

15. Click on Aperture Design icon &j in
the main SFE window.

16. Enter 375 m and 75 m as Traverse
normal and parallel aperture sizes.

17. Close the Aperture Design window.

All traces inside the ellipse are
stacked and the result is output at the
center of ellipse.

- oW

- Seismic Feature Enhancement - untitled
File Seismic Process Help

DB_'E.’-‘—-:D> u
!

» Il

Aperture Design
Aperture Control | Parameters

Aperture Type

™ True Scale

Rectangular ® Elipse

Display undecimated

375 m

Traverse Parallel Aperture Size 75
(in project spatial units) =

Output 3D Swath Width
----- n: |00 meters

Additional Decimation

Indine |1 % Cross-ine |1

@ Help

Workflow cont’d:

18. Preview SFE results by clicking on

19. Display Seismic by clicking on = i

= Seismic Feature Enhancement - untitied — © I
File Seismic Process H

Dl =0d=

»

Proview SFE

p icon in the main SFE window.

con if it is not displayed yet.

Starts the SFE processing fr Preview | [EIEIRSEE]

= Seismic Feature Enhancement - untitled = © Ik =
File Seismic Process Hep
De@=0a=pT = Lalaail

16,1957 Star SFE procer

161957 Preview moge  (D150kay Seismic]
16:19:57: Calculating 30 swath coordinates
161957 Processing Traverse Segment No. 1
161958 Processing Trawerse Segnient No. 2
16:20:00 Processing Traverse Segment No. 3
16:20.02 Processing Traverse Segment No. &
16:20.03 Processing Trawerse Segnient No. 5
16:20.05 Processing Traverse Segment No. &
16:20.07. SFE Processing complete

Seismic Display - olEl
| Separate display [v| Display Enhanced lll 7
[ Original seismic section
(I) 2‘0 dlﬂ BI'D BIO 1[|)U 1|20 1«‘10 1lﬁﬂ 1|30 290 2[20 2|40 2‘60 2?0
=400
500
600
=700
SFE processed section
0 2‘0 -IID 610 BIU 1LI)D 1|20 v‘m 1([30 wlso 2?0 2!20 2?0 2!?0 QIBG
—400
=500
600
=700

[ESPT——— . |
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Workflow cont’d:

20. Start Processing by clicking on ) iconin the
main SFE window.

21. Click Overwrite to output SFE results along the
traverse.

Question | x |

9 This process is about to write seismic data and will
over-write any data already in your output volume

This process may run for a long time

Press 'Overwrite' to continue or 'Cancel to abort

Cancel

22. Optionally, follow File > Save As ... to save your
session.

= Seismic Feature Enhancement - untitled — & EN
File Seismic Process Help

DeB=a= ] =

16:19:57: Start SFE processing

16:19.57: Preview mode Start Processing
16:19:57: Calculating 3D swath coordinates

16:19:57: Processing Traverse Segment No. 1
16:19:59: Processing Traverse Segment No. 2
16:20:00: Processing Traverse Segment No. 3
16:20:02: Processing Traverse Segment No. 4
16:20:03: Processing Traverse Segment No. 5
16:20:05: Processing Traverse Segment No. 6
16:20:07: SFE Processing complete

Starts the SFE processing or restarts lum

7= Seismic Feature Enhancement - untitled - = IIESM
m Seismic  Process Help

D New CisN == p ) n

& Save Ctl+S &

D swath coordinates
- averse Segment No. 1
Exit faverse Segment No. 2

16207007 Processing Traverse Segment No. 3
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2.3.5¢ Fluid Contact Finder

Required licenses: OpendTect Pro, Fluid

Contact Finder.

Exercise objective:

Enhance the amplitude anomaly associated with a structure with Fluid Contact Finder (FCF).

Workflow: ® 3D Horizon
12DHol  Add

1. Right-click on 3D Horizon in the tree > Add ... Fault Add at Sections Only ..

b 233“5 Add Color Blended ...

. ody

2. Select Demo 6 > FS8 and click OK. L Well Track New ...

“ PickSe Create with Constant Z ...

' Select Input Horizon (5) =R

a - Fitter *

71> Demo 0 —>FS4 <

[7] Demo 1 --> MFS4
Demo 2 --> FS6

1 Demo 3 = Top Foresets

["] Demo 4 --> Truncation
Demo 5 > FST

7| Demo 6 > FS8

|I”1 Demo 7 --> shallow

| ()

=]

]

Area subselection 100/300-750/1250 (463 samples) [© select |

‘0 Canceil [ €9 Help

...aning_v6\Surfaces\Demo_B_--__FS8.hor

down list and Select 4 Dip steered median filter

Workflow cont’d:

3. Open the attribute window g"'s'l'

4. Choose Similarity attribute from the drop-
data as input.

5. Set the time-gate to [-12, 12] ms.

6. Select Steering as Full | s
and use 3 Steering BG | "™
Background.

7. Specify Output
statistics: Min.

8. Name the attribute Min .
Sim and Add as new. 3

®

Z| ISlmllant\r

] |2

-] |© Setect.. |

I Input Data 4 Dip steered median filker

[Time gate (ms) -12 12 ]

Extension Cross

Stepout | nl:1 = et

[

Steering Data l$ & |3 Steering BG Background

Steering |Full

=] |© Select...

I Qutput statistic |Min

| Attribute Name | Min Sim |Add asnew] [l
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Workflow cont’d:

4 ® 30 Horizon

9. Display the attribute on Demo 6 --> FS8 by + [ Dema 6 —> Fsa

right-clicking on Z values in the tree > Select . one  Seectatmoue |
Attribute > Attributes > Min Sim. FORSH  SaveasHotzonDota.- | — e ags— I8
e f:;:‘ Tools *|  Stored2DData »
& PickSet|_ I | Attributes 2D
[ Polygen Steering 20 Data  »

Workflow cont’d:

10. Create a new polygon by right-clicking on O;Iocll;r;gL
) P Add ...
Polygon in the tree > New. : ;‘nnoiiﬁ‘oiim
11. Name the new polygon: Bright Spot. = Coometion Poygon oo

Name for new Polygon Bright Spot| |

Color | I | (== OiveDrab -]

(@K (© cancel] (@ e |

12. Draw the polygon using left-click, as shown = oy
in the image. (P, & Ctrl + Z to undo the action.

Ctrl + Left-clic ete a seed.

13. Right-click on the polygon in the tree (or in
the scene) > Close Polygon.

14. Right-click on the polygon in the tree > Save. -

=-[D Polygon
&) Bright Spo
= Prestack Even  Display »
© Annotations Calculate Volume
| Close Polygon
Save
l Saveas
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Workflow cont’d:

15. Go to Analysis > Fluid Contact Finder (or click on the ___1#‘!‘ |Analysis | Processing _Scene
: o Aftributes L
icon).
“% Volume Builder ...
Ei Cross-plot Data 3
b Wells -
16. Select the Demo 6 --> FS8 horizon, leave the default Input & Layer Modeling '
Cube 4 Dip steered median filter. o Contacl Finde s
17. Click on Select for Volume subselection and choose Bright
Spot polygon created earlier.
= Fluid Contact Findes - Mam window == EEn === T o =
Horizon | Demo 6 —= F58 - |© Select | P Specily Positon
Analysis type @ Poststack © Prestack
— Volume subselection | Polygon -
Input Cube =| &5 4 Dwp steered median fiter O Select
votame o — Folygon Bright Spot ~ [© Select.. I
In-ine/Cross-line Step 1 &1
Z range around horizon -184 8 1848
Time Range (ms) 0 I 1848 D Step 4
Include amgpiitudes | All &
Gontour Z division 0 1848 Step 4 OC"“’- @ Heip
§Run ©) Close | | @ Help

Workflow cont’d:

For the first test, contour Z division as the entire Z range of the survey. This can be restricted
later. Also leave the Z range around horizon as default.

18. Click Run to start the extraction and clustering of the data

" Fluid Contact Finder - Main window

Horizon g
Analysis type
input Cube ) ()
Volume subselection

Z range around horizon

Include amplitudes

Contour Z division

Demo 6 --> FS8
@ Poststack Prestack

4 Dip steered median filter

P: area 100/945-286/1134 (462 samples)

-184.8 1848
All M|
0 1848 Step 4

ol ® =
e |

* | Select |

* | Select ...
IO Select

:OCIosel [ 9 Help
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Display types available in FCF analysis window:
Stack: traces are stacked along depth/time
contour bins and plotted as a 2D profile. The
display can be flattened on a horizon. The
stacked fraces can be stored as a 3D volume if
Flattened is checked.

Single Z: traces belonging to a single contour bin
are displayed in a 2D viewer.

Directional: FCF-stacked amplitude at the
horizon as a function of the distance to a selected
position and the azimuth sector.

T T WA A AN N
\"'
e

=

- ™~ "J':J;: All traces lying along a particular contour (in 3D) on the
. ....'-‘}“;\: Y m refrence horizon are stacked
SRS

Data courtesy: Australian Government

= P Eartnct Finder - Arabyin
Distribution of harizon Z vakses

sfias 5 54 550 8553
Vabet
Desplay typd |SRack =] |+ Flamened
Stack
Stacking
Virde cube

[Grn] (O cose| (@ ree

The image on the left (not from F3 Demo
survey) illustrates the FCF stack concept.

Workflow cont’d:

19. Choose Display type as Stack, uncheck
Flattened and click Run.

This window will remain open so that
several FCF analyses can be run.

20. The FCF stack shows stacked
traces along common contour - T
bins of Demo 6 --> FS8 3 <

= Pl Contact Fnchr - Aralyis (==
Dustribaon of horizon 2 valhues
==
o
540}
sfhas s 0 S50 55536
Ve
Display type | Stack Flattened
Stacking type @ Normal © RMS
0o @1
) } | i 3. v .
I 3
1 » » : i

horizon. The possible fluid
contact is highlighted: observe

[ 534 NEpEPRIEN RS-

the drastic amplitude change T

at the flank of the structure. ¢ IF:
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2.3.6 Seismic Object Detection Using Neural
Networks

What you should know about Neural Networks in OpendTect
Neural Networks in OpendTect are used for:

1. Visualizing seismic patterns along horizons and in 3D. This is a qualitative
approach using an unsupervised Neural Network (aka clustering or seg-
mentation).

2. Visualizing seismic objects such as chimneys, faults, salt domes, anom-
alies, etc. This is a two-class classification approach using a supervised
Neural Network (aka object detection).

3. Predicting rock properties such as porosity, fluid content, etc. Thisis a
quantitative approach using a supervised neural network.

4. Predicting lithology classes. This is a multi-class classification approach
using a supervised neural network.

This chapter deals with visualizing patterns and objects. How Neural Networks
can be used e.g. to predict porosity from inverted acoustic impedance and poros-
ity well logs is described in the chapter on rock property predictions.

What you should know about supervised Networks in OpendTect

The supervised network is a fully-connected Multi-Layer Perceptron (MLP) with
one hidden layer (i.e one layer between the input node and the output neurons).
The learning algorithm used is back-propagation with momentum and weight
decay. Momentum is used as a filtering of the step directions in the gradient
decent algorithm, which has a positive effect on training speed. Weight decay is a
method to avoid over-fitting when training. Weights are multiplied by a weight
decay factor to reduce the weight values, which results in smoother functions with
improved generalization properties. The program sets the number of nodes in the
hidden layer. In practice, supervised training, the user is teaching the network to
distinguish between two or more pointsets.
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What you should know about unsupervised Networks in OpendTect

The unsupervised Neural Network is the Unsupervised-Vector-Quantizer (UVQ).
This Neural Network is first trained on a representative set of input vectors (attrib-
utes extracted at different locations) to find the cluster centers. Each cluster
centre is then represented by a vector. Before the network is saved, the software
sorts the cluster center vectors on similarity. This has the advantage that in the
application phase colours are distributed smoothly over the cluster centers res-
ulting in smoother images which are easier to interpret. In the application phase,
each seismic input vector is compared to all cluster center vectors yielding two
possible outputs: Segment (or Class) and Match. Segment is the index of the win-
ning cluster center. Match is a measure of confidence between 0 (no confidence)
and 1 (input vector and winning cluster vector are identical).

The unsupervised segmentation approach reveals areas with similar seismic
responses and is used extensively as an easy-to-use and quick interpretation
tool. Clustering can be achieved using waveform and also using multi-trace attrib-
utes such as similarity and curvature in the hope of picking up fracture- density
patterns.

More quantitative analysis of UVQ results is possible with the aid of (stochastic-
ally) modeled pseudo-wells (e.g. de Groot, 1999).
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Waveform segmentation

Unsupervised segmentation of data can be done in two modes: horizon-based
and volume-based. The exercise in this section follows the horizon based (or 2D)
approach, which is also called waveform segmentation because the input to the
network is a waveform (= time-gate) extracted along the horizon. A 3D- seg-
mentation scheme is very similar. However, be aware that, in 3D, only attributes
not directly related to the phase at the sample location should be used. If phase
sensitive attributes like amplitude are used, the results will look very much like the
original seismic data.

For waveform segmentation to be successful you need a good reference horizon
to work from and preferably a layer-cake setting. Furthermore, it should be real-
ized that due to convolutional effects the results are influenced by variations in
the over- and underburden. Variations on the waveform segmentation theme are
possible. For example clustering waveforms from near-, mid- and far-stacks incor-
porates AVO effects.

OpendTect supports two ways to create a horizon-based unsupervised seg-
mentation: The Standard Neural Network method and the so-called “Quick UVQ”
method.
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2.3.6a Waveform Segmentation - Quick UVQ

Required licenses: OpendTect Pro, Neural Networks.

Exercise objective:

Workflow:

> Workflows > Quick UVQ.

Scene 1

W In-iine

i Cross-ine

& Z-shce

@ Volume

~ Random Line
20 Line

(30 Horizon

1. Right-click on 3D Horizon in the tree > 20 He
Load... > Choose Demo1 2 MFS4.

Faul |~ ada a1 Sections Only
FaulS  agg Golor Blended

b S‘,'ﬂ” Track New

¥ Picks  Creata with Constant Z

[ Polygon

s Prostack Events

Annotations

2. In the tree, right-click on Demo1 2 MFS4

@ 3D Horizon

Visualize seismic pattern on a mapped horizon using Quick UVQ waveform segmentation.

- Select Input Horizon (s) - olEN
Fitor *
channgi-1 -
Demo 0 > F54
Gl Demo 1 —> MFS4
Demo 2 —> FS6 L]
Doma 3 > Top Forasits x
Deme 4 —> Truncation
Doma § > FST
Demo & > FS8
Demo T —> shalow v
Area subselection 100/300-750/1250 (463 samplas) B Select
O cancsl| @Hep

amo_2015\Surfaces\Demo_1_--__MF 54 hor

LdDemo 1 > MF:

v Z values Add '
@ 20 Horizon Display b

Fault Tracking ’

FaultStickSet Tools 13
® Body Create Flattened Scene
o :‘:’:&'SE' il Save Compute Horizon Curvature ..
D Polygon # Save as Write Flattened cube ...
S Prestack Events & Lock Calculate Isopach ...
Annotations Delete from Database Calculate Volume ...

% Remove from Tree

Pick Horizon Data ...

Quick UVQ ...

Workflow cont’d:

to disk.

5. The time gate describes the investigation window.

7. Click OK to train a neural network and produce results.

3. In the Input Cube field the default 4 Dip steered median filter volume is already selected.

4. Number of classes describe how many clusters the waveforms will be divided into.

6. Optionally, a polygon can be used for sub-selection. Also, the neural network can be saved

= Quick UVQ

UvVQ on ‘Demo 1--> MF54' (unshifted)

Number of classes 10

Time gate (ms) -8 24

Save network

B sl ]
Input Cube IEl [E 4 Dip steered median filter

Polygon subselection | 3D UVQ input between demo 0 a

=)

- e select..]

O ok ”0 cancel € Help I

In practice, we always predict less
number of classes (e.g. 5) fo get a
regional understanding of a
depositional system. We then
increase the number of classes to
predict details.

Time gate can be adjusted relative
to a horizon. In this case, -8ms is
used considering a horizon is not
perfectly snapped to a peak/trough.
The focus is mostly below the
horizon by setting 24ms.
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Workflow cont'd:

8. A NN training window will pop-up. If the training is above 90% and flat, then you can press

OK button.

=

Average Mafch (%
100'_ ch (%

75

50

5

Vectors trained 6400

NN training [91]

Train Segmentation Neural Network [November9 2015 14:12:21]

Sample -8
Sample -4
Sample 0
Sample 4
Sample &
Sample 12
Sample 16
Sample 20
Samnle 24

Pause .

) Cancel (@ Help

- oIEd

Clear

It will start applying the | |

results on the input
horizon.

4 [11%)] Apply UvQ Neural.. — &

1%

0 Pause . OAbort

Applying Neural Netwo Positions handled 72632

Workflow cont'd:

9. Once the NN processing is finished, you will see a NN Info window and two grids, (Class
and Match) which are already displayed on the horizon.

Tip: If you are satisfied, you may
want to save them as Horizon Data
by right-clicking on each ofthem.

@ 3D Horizon

=¥ Demo 1-—>M.. =
¥| Class n
¥| Match i
7| Z values 3]

10. Click Display... to show class centers
and Close the Info window.

= NNinfo

"Quick UVQ® Neural Network

Type:

Humber of classes: 10

Vectora classified: 2889
Class 1 vectors: 182.

Class 2 vectors:
Clasa 3 vectora:
Class 4 vectors:
Class 5 vectora:
Clasa 6 vectora:
Class 7 vectors: 1
Class 8 vectors:
Class 9 vectors: 1
Class 10 vectors: 233,

Average march:
Average match:
Average match:
Average match:
Average match:
Average match:
Avezage match:
Average match:
Average match:
Average match:

Input node relative importances:

Centerl CenterZ

Sample -8 976.1010.. -1006.50..
Sample -4 54.67016.. -1973.59..
Sample0 1924.287.. 1702.556...
Sampled 4646.966.. 4714.869...

Sampled 1654.428.. 455.1835..

.

Center3  Centerd

-1540.89.. -2237.13..
-1949.19.. -795.735..

971.1319... 3495.81...

3954.554... 5872.40...

2603.379... 2770.36...

Save Report ...

Unsupervised (segmentation/slustezing)

903018
909172
91659
922117
919409
3206
909738
920202
904917
804034

coocooocooo

Center5  Center 6
239.771.. -539.130..
621.897... 111.735..
2886.94.. 2141.79..
5027.39.. 2849.06..
2438.40... 231.057..

]

Center7 Center8 Center ”
377.387.. -1313.70.. -2817.7%
-849.821... -2028.79.. -.1528.2.=
-593.750... 188.953.. 2156.68
1592.54.. 2039.47.. 2750.72
1532.06.. 495.336.. -932.29 )

(@]

(7] Help |
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Workflow cont’d:

¥ 3D Horizon

11. To match the colors, click on the Class grid, and choose Rainbow v =
color bar.

12. Optionally, click on the color-bar icon in the class center if you want
to change the color scheme there also.

Colors are not matching....

SN

= “Quic

Workflow cont’d:

13. Your results may look like this.

Iivee mom] 3.4/7 5 68 [ -

For segmentedresults such as UVQs, we preferto use a segmented color bar. You can always
change a color bar through manager (Survey > Manage > Colour tables).
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2.3.6b Waveform Segmentation - Standard UVQ

Required licenses: OpendTect Pro, Neural Networks.

Exercise objective:

Visualize seismic patterns on a mapped horizon using the standard unsupervised neural
network method

Workflow:
1. Open the Attribute set window » | and select the default attribute set ' named
Workflow - Unsupervised Waveform Segmentation.

2. It will pop up a window asking to provide Input Seismics, the default volume is
automatically selected. Press OK.

- Attribute set definition - o IEl

Select Seismic input

Input Cube = S | 4 Dip steered median filter v Select .
= =

©) Cancel | | (§J Help

This default attribute set is designed to extract each samples within the time window
[-100,+200]ms (with a step equal to the z step of the survey) regarding the application sample.

Uncheck Save on Close and close the Attribute Set 3D window.

= Attribute Set 3D - olEN
File

sd A N Y 1A

Alftribute set <not saved> <All> v| Reference shift ~ P

Sample -100 ~ Input Data 4 Dip steered median filter v| © Select ..
Sample -96

Sample -92 Shift inl0 = ci0 = Time (ms) -100
Sample -88

Sample -84 Use steering () Yes (@ No

Sample -80

Sample -76

Sample -72

Sample -68

Sample -64

Sample -60

Sample -56

Sample -52 +

Sample -48

Sample -44

Sample -40 \ 4

Sample -36 A

Sample -32 Al

Sample -28

Sample -24 —

Sample -20

Sample -16

Sample -12

Sample -8

Sample -4

Sample 0 v Aftribute Name Sample -100 Add as new |:‘

@Hov
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Workflow cont’d:

@
3. Start the 3D Neural Network plugin by clicking the =5 icon.
@

“  Neural Network management

Neural Network Manager 3D

- oIEN

Create New Network: Get:
Pattern recognition [PickSets] | Stored Network
4. Select the option Pattern recognition [PickSets]. e [
Active Neural Network
Input Qutput
Store nfo
[ @ Close || @ Help
Workflow cont’d:
5. Set the analysis method fo Unsupervised.
= Design Neural Network - olEd

6. Select Samples within the window [-8,24]ms.

7. Click on Create button... to generate a

random pickset.

Analysis method () Supervised (@ Unsupervised

Input training data set (&) Extract now Retrieve stored

Ok Select input attributes

[] Sample -28 ~ || gas

[] Sampie -24 RMS velocities:
Sample -20 FFST:

[ Sample -16 3D Body:

[] Sample -12 Slumped body:

[v] Sample -8 3D body:

[v] Sample -4 test 2

[ Sample 0 onlap

[v] Sample 4 Chimney YES:

v| Sample 8 Chimney NO

[w] Sample 12

v Sample 16

[v] Sample 20

L Sample 28

[] Sample 32 “

< >

Number of classes 10 %

Sedect Pick set  Create ...

@OK | ©Cancel @ Help
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Workflow cont’d:

8. Create a pickset containing 1000 picks
along the horizon Demo1 2 MFS4.

9. Click OK.

i Random Pick Set Creation

Create new PickSet

| Name for new PickSet Random Pickset on Demc

Display color [JIlll = RoyaBlue v

|Numberof picks to generate 10000 = |

Geometry Volume

Volume subselection -

© Select

@ Cancel @ Help

Workflow cont’d:

10. The pickset will appear in the list. Make sure that the correct set is selected.

11. Click OK.

. Design Ne

Analysis method () Supervised

Input training data set ® Extract now

[a]»  Select input attributes

[] Sample -28 ~
[l sample -24
[_] Sample -20
Sample -16
[] Sample -12
[v] Sample -8
(v Sample -4
[v] Sample 0
v Sample 4
[v] Sampie 8
] Sample 12
[v] Sample 16
[¥] Sample 20
| Sample 28
Sample 32 v
< >

Number of classes 10 -

ural Network

® Unsupervised

Retrieve stored

Select Pick set | Create ...

‘gas:
‘RMS velocities:
FFST:

3D Body
“Slumped body:
:3D body:

test 2:

‘onlap:
Chimney YES:
= 0.

1y
‘Random Pickset on Demo:

@ Cancel| @ Help
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Workflow cont’d:

12. A spreadsheet with statistics will pop up. Click on Run.

B X Y: Y [ qmmp b o = show100.0% 3]

Input Data - olEl

1zl show ke =7 ¢ R

3

X-Coor Y-Coorc Z (ms) *Sampk Sample Sample Sample Sample Sample
Training data 61677... 60830...
Training data 62585... 60804...
Training data 61697... 60828...
Training data 61251... 60806...
Training data 61153... 60860...

1620 -10459 -698 2869 1187 -2389  -5961 €
1264 -7480  -1746 9410 9385 2672 -395 7
724 -7010 4590 5938 573 3880 5909 -&
1152 -6935 1666 8804 2889 -5435  -2451 3

780 -6251  -1353 1831 -1610  -3702 169 3,
>

©) Close | @ Help

Workflow cont’d:

13. This will start the neural network training. After the Average Match curve becomes flat,
click on OK. Training with a 90% (match) is considered as a good prediction.

e

Train Segmentation Neural Network [November9 2015 15:42:36]

NN training [93] - o IEEHE|

100

—

Average Match (%) O Sample -8

O Sample -4

75

Sample 0
Sample 4

50

Sample 8
Sample 12

25

Sample 16
Sample 20

train data

. Sample 24

Vectors trained | 26100 Pause ... Clear ...

[]10On OK, save as =) Select

) Cancel @ Help
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Workflow cont’d:

= Neural MNetwork management  — Dn

Neural Network Manager 3D

Create New Network: Get:
14 The tralned neural network IS now aCtNe! Wlth Pattern recognition [PickSets] ... Stored Network ...
appropriate input and output.
Property prediction [WelData] - From Job file ...

Active Neural Network

Input Qutput

Sample -8 ~ Segment
Sample -4 Match
Sample 0
. . Sample 4

15. Click on Store .. to save the neural network to disk. Sample 8
Sample 12
Sample 16
Sample 20 ~

16. Click on Info...
@ Close || @ Help

Workflow cont’d:

upervised (segmentation/clustering)

17. NN info window will pop up.
18. Click on Display to show Class Centers.

19. Close the NN info and the NN Management
windows.

Center 1 Center2 Cenlerd Cenlerd CenterS CenlerG Center7 CenlerB Centerd Cenler1) *
Sample 100 1043, -1300. 11235.. B098. -1680.. -1202.. 4428 1BSE9.. 2221 STI72

= = - class centers.
Sample-96 -4010.. -6289.. &MS1. 51822 95423 87T26.. 45563 17E4S5.. 7203 MTER

Sample-52 1903 .3080.. TIBS . G481 1312 1876, 55248 29334 JIOS. 16435

o
8 Sample-88 4134, -2480.. -2090.. -4127.. 4037 -4148.. -3620.. 1308, 3252 302
Sample-84 2163 -1865.. -2520.. 3813 . 4273 4483 2086 . 79379 1056 -23BT

Sample-80 10920, 50038 4833 3S2E5.. 13000 64402 15418 37204, 5S4 -mER

Saarised

4& = % R
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Workflow cont’d:

+ = 30 Honzon
+ [ Deme 1 —= MFSd

¥ Z values Add v i Adtribute
2D Horizon Display * | % ‘Volume Builder Attribute
20. Add a 3D horizon Demo1 = MFS4 Fomstcse| o ety

in the tree. Apply the neural ':ﬁa o

network to the horizon by right- gim“gm e e

clicking on the horizon name in the Aot = Remna ot |

tree > Add > Attribute.
M Select = =) lﬁ
Select Layer3

21. When prompted to select data, I
select Segment attribute from

Steering
Neural Network tab. .
Affributes
22. As Segment appears in the tree =>
change the color bar to Rainbow. =
;OCancaI' {9 Help J
P 1 N P -
= 2D Line - B Matteo_Cube_L
“ 3D Horizon
¥ Demo 1--> MFS4 = Colo
7| (Segment) [0 ]
7| Z values m

@ 2D Horizon

Workflow cont’d:

23. Your results may look like this.

In-line
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2.3.6¢c ChimneyCube

Required licenses: OpendTect Pro, Dip-steering, Neural Networks.

Exercise objective:

Create a ChimneyCube with the supervised Neural Network approach.

Workflow:

1. Open the attribute editor using the a I icon

©y Survey Analysis Processing Scenes

QRT- ‘ 2N m‘_ g
2D ...

m Step 0
n'r!rstewl 1 &

Elements

Color
and open the default attribute set NN fﬁ:j;e
ChimneyCube via the . icon and click 4 # Cross-line
W Z-slice
on Ok. x [ ] Volume
- atibete Se1 30 _oEN
1 @t ewa wew
RS = betntaibutes. -~ OIEM| T T
Select delaul stirbute set : =
Filler *
Workfiow - Unsa Wavelom £~
Wiorkdiow - NN ba
Wiorkdiow - ube Adwanced
Workfiow - NN Chimney Cube
+ Wk - NN S8l Cube
3 Woesrkdiow - NN Slump Cube -
- | [E5] ocems ome
AR tite Narra Add as vew [
# Saveon Cine Ocem @
Workflow cont’d:
- Attribute set definition - oiEd
2. A F.JOP _up messag? will prompt for Select Seismic & Steering input
seismic and steering data. Please
select 4 D.rp steered median filter for Input Seismic a,":’) ‘| 4 Dip steered median filter v |© Select ...
seismics and 2 Steering BG Detailed | |,y sieering & ") 2 steering 86 Detaited v||© select ..

for steering Data and click on Ok
and close the Attribute window.

) Cancel @ Help

l

Altribute Set 3D

- olEN

P VLA BAME

Aribate sot <nol saved>

The attributes in this set
should help differentiate
chimneys and background
noise. Visual inspection of
the data shows chimneys
present around inline 290
and 690. The chimneys
appear as vertical noise
trails

RMS [-40,40)
Down 100Ms (RMS |-

NahMNIngut Median D
Hoise (RMS [-40.40]
Down 100ms )
Up 100ms {Notsa)

SignalNioise

¥ Sam on Claso

Up 100ms {RMS [-40,40

el ~
o

0,

ipl | 24

Fit

NoNNingut Signal (RMS

Down 100ms (Signaitiol
Ug 100ms {SianabMos
<

5’
»

AP - | | Simaanty =] |2
Ingut Data |4 Dip steared modian fler = O Seect
Tims gate (ms) -40 40
Extonsion Mirror 90 degroes. =
Trace posibons k0 (| o1 (3 & w0 2 jena 3
Stoaring Ful

Stoering Data ISy 4 2 Stedring BG Ditadod v ©) Select

Output satistc | Max

Aibute Mo Similariy [-40,40] Parolel Asd o new| il

@ Hop
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Workflow cont'd: B Save Attributeas — O RSN |

Select output Altribute

Filler |*

. 30 UVQ Aftribs Texture + HC ~ 3

3. Save the Attribute set as NN ChimneyCube strutes
ChimneyCube Training and click on Ok. Demo atiibutes 32
FaultCube attributes ~

Imversion attributes
MyF irstAtiribute v
< >

Name NN ChimneyCube Training|

x Cancel ed Help
(*] e

4. Add default data (i.e. 4 Dip steered [Tree scene 1 =
median filter) by right-clicking on inline. Elsments Colox

Scene 1

NP Add Defautt Data
& Z-sli Add and Select Data
® Volt  Add at Well Location ...

- ;‘S’L Add Color Blended
5. Click on the added inline number 425 -
and change it to 690 by entering it in the _
Inl box. Qb mh-s =8

[inf6s0 =htes(1 [+ ¢m mp | 500 T 1]
h Tree scene 1 ] -
I 1

Workflow cont’d:

¥ |PickSet

6. In order to pick chimneys and (> pol Add ... |
differentiate them from the background 7 gﬁgﬁém
noise, two picksets are needed. N Prestack Events Generate 3D ...
Annotations Generate 2D ...
7. Click on Pickset in the tree > New
Pickset > Empty. In the pop-up you will .
2 PickSet

give a name to this as Chimney_Yes. ¥ Chimney YES
_ ¥ Chimney_NO
8. Repeatthe Step 7 and create another

pickset called Chimney_NO.
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Workflow cont’d:

9. Highlight the Chimney YES pickset and
pick locations in the scene that appear
as chimneys.

10. Repeat the process for the Chimney NO
pickset, pick locations where chimneys
are not expected. Save both picksets by
right-clicking on their names.

11. Scroll to another inline using the
4= icons to make more picks. Save
both picksets.

Workflow cont’d:

12. Open the 3D neural network by
clicking on the §>a icon.

13. Click on Pattern recognition.

ME) %
mm 2l

Meural Network Manager 3D

Create New Network: Get:
[Pattern recognition [PickSeis] ] | | Stored Network ...

Property prediction [WelData] ... | From Jobfie ... |

Active Neural Network |

Input Output
Store ... Info ..
[Ocme | @1 |
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Workflow cont’d:

14. Set Analysis method to Supervised. Deselect attributes with prefix “NoNN”from the list.
Select Chimney_Yes and Chimney_No picksets made by you. Specify 30% of the data for

test set and press OK.

£ Design Neural Network

Analysis method © Supervised

Input training data set @ Extract now

W - Selectinput attributes

Unsupervised

Retrieve stored

@ - Select output nodes

Y] Similarity [-40,40] Parallel

9] Similarity [-40,40] Diagonal

] Down 100ms {Similarity [-40,40] Parall:

) Up 100ms {Similarity [-40,40] Parallel}

) Down 100ms {Similarity [-40,40] Diago

¥ Up 100ms {Similarity [-40,40] Diagonal

9] Similarity [-40,40] AlDIr

¥] Down 100ms {Similarity [-40,40] AlIDir

V| Up 100ms {Similarity [-40,40] AlIDir}

Y] Simple Chimney Attribute
NoNNInput PolarDip

] RMS [-40,40]

] 11000 between MFS4 and FS8: e
s :1000 between F$7 and FS8: r
11000 between FS6 and FS7:

“fingerprint input:
:gas:

11000 Random on Demo 1-> MSF4:
:Random line through wells:
:Selected Points from Well:
:Misclassified [NN]:

:RMS velocities:

7| Down 100ms {RMS [-40,40]} sslumps-1:

7| Up 100ms {RMS [-40,40} - :Slump-2b: -

« m » « i f
Percentage used fortestset 30 | %

Non-standard number of hidden nodes |14

(@] (@ concel (@ e

Workflow cont’'d:

15. A spreadsheet with statistics will
pop up, here you may edit and
analyze the attributes by cross-
plotting them against the Chimney
YES and NO picksets. After
investigating, click Run.

16. The neural network training will

begin.

-

B XYY @

X-Coor  Y-Coon

Training data 62820 .. 60889.. 586.81 0368.. 0347. 0761 0846 0711.. 0812
Traning data G2703.. 60B89... 9873 0570... 0455, 0789.. 0557. 0801 0.225,
Traming dala 61568.. G0BBS... 81882 0603 .. 0835. 0967 0822 0955.. 0889
Traning data G2833.. 60889 .. 53202 0621 0.585... 0.760.. 0856 0700.. 0878

Training cata 62226 60887
<

Input Data - olEN
b o = show100.0% = |EE| T show i 2 E
Z(ms) " Simiar Similari ODown1 Up 10r Down 1 Up 100r {*

CR-R-IE-IN-1

132162 0621 0.480... 0577 0.766... DB36... 0542

»

© Closa | @ Help

= Mitraiing [5] [E=S BB =
Train Neural Network [November16 2015 17.59:39)
Nermatees i3
|
L s
05 05
025 0.25
N asmasanen
v &
Vectors irained 20600 Pause | [ Clear
On OK, save as C
¥ Save misclassfied [(@ok ] (O cancel [ @ren
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Workflow cont’d:

17. As the training of the neural network runs, the normalized
RMS and % Misclassification curves will decrease. In order
to avoid overtraining of the neural network, click OK as
soon as the normalized RMS curve becomes flat.

18. If the training graphs become flat and are not changing, you
may proceed and click OK button.

= W traiming 18] = e
Train Neural Network [November16 2015 18:01:18]
e
0.8
0 sl s
|
0 | | 025
| — ]

0 50

Al Ho

c; i_ = ¢ e 2]

Vectors trained 54100 Resume | | Clear
On OK, save as =

4] Save misclasséied O Cancel| | @) Help

Stopping points for neural
network training

Error

Error

Error

Leveling
‘ STOP
Train set terations
Test sel
Overtraining
‘ STO|
Train set lterations
Tes! sel
\ JsTor?
/—\" sTOP
Train set lterations
Test sel

Workflow cont’d:

You can press clear to restart the training, for example if
the neural network becomes over-trained

The colors of the input attributes change during the
training. The colors reflect the weights attached to each
input node and range from white via yellow to red. Red
nodes have the most weights attached and are thus more
important to the network for classifying the data.

Colors are very useful indicators on how to tune a network
and discard attributes that may take up a lot of CPU time
without contributing to the final result

Stopping points for neural
network training

Error

Error

Error

Leveling
‘ STOP
Train set lterations
Test sel
Overtraining
‘ STO|
Train set terations -
Test sel
\ JsTor?
f\* STOP
Train set lterations
Test sel
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Workflow cont’d:

19. Optionally, Store the Neural Network (you will need to

provide a new name).

20. Close the Neural Network Management window.

21. Test the training results on your data. Add the neural
network attribute named Chimney YES by right-
clicking an inline (e.g. inline 690) in the tree.

+ winne
« [¥][425 E
W 4Dpste  AK " i Aibse
@ Cross-line Display * % \Volume Buider Attribute
¥ Z-slice Duplicate @ HorizonCube Display
® Volume Reset Manipulation N
~ RendomLine |44 Comeite wihWells . L1 T 0o
7 2D Line .
& 30 Horizon o Lock Treeitem
4 2D Horizon = Remove from Tree

Create Now Notwork Got:
Pattern [PickSets] ..
Proparty pradiction [WelData] .. || From Job fila ..
Active Neural Network
Tnpurt Outpat
Similanty [-40,40 ~ | [[Chimney_YES]
Similardy [-40,40 | | [Chimnay_NO]
Don 100MS (Si | | Classification
Up 100ms (Simik | |Confidence
Down 100ms (S
Up 100ms {Simik «
< >

Stor . Infa ...

o

Select Layer 2
() Stored (Chimney_YES
) Chimney_NO
O Steering Classification
O Atribues Confidence
| QOK |°(:ancel| @ Help

Example of chimney display on inline 690. The red arrow indicates
increased likelihood of chimneys.
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Workflow cont’d:

22. If you are not satisfied with the
output, go back and change the
location of your picks using the
Misclassified NN pickset (generated
automatically) by right-clicking
Pickset in the tree

=

) |

e Load PickSet(s)
Select input PickSet (s)

[=] - Filter *

[_] Chimney_NO

[] Chimney_YES

[v] Misclassified [NN]

] Random Pickset on Demo

X |Pickiry
[ Poly " l
S Pres ts

+ Annotations

> &

© Cancel @ Help

... 2015\Locations\Misclassified__NN_ pck

d) on inline 690

Workflow cont’d:

Create Output Volume

23. When satisfied with the results, the

Saenes View Utiities Help

i : [ Create Seismic Quiguts | _Atibutes | - Single Attibute___+ JE0T
final step is to output the CroaloHorgon Oufput»  20<=30 T um A . F
ChimneyCube volume as a seismic T Wity i e

Y . . . = GMT Mapping Tool ... From Well Logs ... ™ Between Hozons  + |

cube that is stored on disk via € HorzonCube s Prestack Processing  +

. . . [¥] Madagascar ... Velocity X
Processing > Create Seismic i ssis » Volume Buider ..

. X mmmeyovee———————  Re-sot Scanned SEG-Y
Output > Attributes > Single *e.theered mosten Mier
Attribute > 3D ...
=] Create Volume Attribute ==
. . Quantiy to cutput Chimaey_YES -

24. Select the Chimney YES attribute oo sabselecton |-
from the list, give the volume an NN
appropriate name and click OK. [ Scala kice:  ShiftFactor

Outgat Cute| ChimneyCube -] © seeet | mcavs
Balch execution Single Process - 4k Options .,
@ ok ||gcancel @ Help
L Select -8
Solsct Quanity 1o output
Stored Chamnay YES
Chimney_NO
Adrubes Clssificabon
® Nours Natwory | o1TERE
‘B

[E] 0w o
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2.4 HorizonCube and
Sequence Stratigraphy

The HorizonCube is a step-change technology that opens the door to drastic
improvements in understanding the geological meaning contained in seismic
data: 3D sequence stratigraphy, seismic geomorphology with data driven stratal
slicing, improved geologic models, wells correlation, low frequency modeling for
better seismic inversion etc.

Today, seismic interpreters can look forward to the following benefits:

Low Frequency Model Building & More Accurate, Robust Geological
Models

In standard inversion workflows, the low-frequency model is considered the weak-
est link. Highly accurate low frequency models can be created by utilizing all the
horizons of the HorizonCube, allowing a detailed initial model to be built.

In a similar fashion rock properties can be modeled. Instead of using only a few
horizons all horizons of the HorizonCube are used, resulting in greatly improved
rock property models.

Rock Property Predictions

The highly accurate low frequency models can be used to create geologically cor-
rect Acoustic Impedance (Al) and Elastic Impedance (El) cubes using
OpendTect’s Deterministic and Stochastic Inversion plug-ins. To complete the
workflow, the Neural Networks plug-in is used to predict rock properties from the
Acoustic Impedance volume, avoiding the use of oversimplified linear models
which cannot accurately describe most rock property relations.

These advanced tools bring a high degree of precision to traditional seismic work-
flows, resulting in better seismic predictions and more accurate input into the
reservoir management decision-making process.
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Sequence Stratigraphy (SSIS plug-in)

The SSIS plug-in works on top of the HorizonCube plug-in. Users can inter-
actively reconstruct the depositional history in geological time using the Hori-
zonCube slider, flatten seismic data in the Wheeler domain, and make full system
tracts interpretations with automatic stratigraphic surfaces identification and
base-level reconstruction.

Well Correlation (WCP plug-in)

The Well Correlation Panel plug-in is an interactive tool for correlating well data
and for picking well log markers in a consistent manner. The tool supports dis-
playing and manipulating multiple wells with logs, markers, and stratigraphic
columns, plus the connecting seismic data (2D lines, or Random lines from 3D
volumes) with interpreted horizons, faults, HorizonCube and interpreted systems
tracts.

Systems Tracts A0 Wheeler Diagram Well Correlations

Sequance Stratigraphy

GeoModel

iH
L

Uncenventional
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HorizonCube Applications
In this Chapter you will learn how to:

» Create data-driven and model-driven HorizonCubes.
e Truncate HorizonCubes.

» Extract horizons from a HorizonCube.

» Track single horizons from a Steering Cube.

e Correlate between wells.

» Wheeler transform data (= flattening).

 Interpret systems tracts.

- 277 -



2.4.1 HorizonCube

What you should know about HorizonCubes

» HorizonCubes consist of a dense set of (dip-steer) auto-tracked, or
modeled horizons.

» HorizonCubes exists for both 3D and 2D seismic data sets.

» Horizons are first order approximations of geologic time lines.

» Horizons can never cross each other.

e There are two types of HorizonCubes: Continuous and Truncated.

* In continuous HorizonCubes all horizons exist everywhere; when horizons
converge the density of the horizons increases. This tends to happen along
unconformities and condensed sections.

 Intruncated HorizonCubes horizons stop when they get too close together.

» Using HorizonCube density it is possible to convert continuous Hori-
zonCubes to truncated HorizonCubes.

» Flattening on horizons in a HorizonCube is called a Wheeler transform.

» Depositional trends and systems tracts are easier to interpret in a Wheeler-
transformed, truncated HorizonCube. Model building (interpolating well logs
guided by horizons) is easier in a continuous HorizonCube.

» HorizonCube sliders are used in OpendTect to:

* Analyze the depositional history.
« Identify and extract horizons from the dense set of horizons.
» Extract 3D bodies from iso-pach thicknesses or attribute responses.
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Details

In standard seismic interpretation workflows, a coarse 3D structural or sequence
stratigraphic model of the sub-surface is constructed from a limited set of mapped
horizons. The number is limited because mapping horizons with conventional
auto-trackers, based on tracking amplitudes and similarities, is a time consuming
practice. In particular, mapping unconformities - primary targets in sequence
stratigraphic interpretations - is cumbersome with conventional trackers, as amp-
litudes tend to change laterally along such surfaces. HorizonCube maximizes the
amount of information that can be extracted from seismic data by significantly
increasing the number of mapped horizons (figures below).

Seismic section to illustrate the difference between two trackers: conventional vs.
dip-steered: (A) Conventionally tracked event based on seismic amplitude and
waveform similarity, (B) the same event has been tracked using the dip-azimuth
volume (SteeringCube).

A HorizonCube consists of a dense set of auto-tracked seismic horizons. The
auto-tracker tracks the pre-computed dip-azimuth field that is supplied in the form
of a (dip-) SteeringCube. The steering data generally determines the quality of
the resulting HorizonCube.

The auto-tracker used to track in a dip-field works for both 2D and 3D seismic
data. Tracking in a dip field has several advantages: Firstly, the dip field is con-
tinuous. Even if amplitudes vary laterally, the dip continues. Second, the dip field
can be smoothed before applying the tracker, which enables the controlling of the
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detail that needs to be captured. The auto-tracker is applied to a target interval
and generates hundreds of horizons that are separated on average by a sampling
rate. The result is called a HorizonCube. The comparison between conventional
amplitude based tracking and dip-steered tracking with SteeringCube is presen-
ted in the figure above.

The following exercises are showing an application in 3D. The workflows are very
similarin 2D.
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HorizonCube Types
Two types of HorizonCubes are created in OpendTect:

» Continuous HorizonCube: Contains events (or horizons) that do not ter-
minate. All events are continuous throughout the entire volume. They may
come very close together (at unconformities and condensed sections) but
they can never cross each other.

* Truncated HorizonCube: Contains events that terminate against other
events.

Both cubes have their own applications for visualization and also for model cre-
ation. The advantages are also briefly explained in the following pictures.

Two types of HorizonCube based on their geometrical configuration.

Continuous HorizonCube Truncated HorizonCube
Applications: Applications:
* Low Frequency Models * SSIS
» Geologic Modeling » Wheeler Transformation
o Attribute Visualizations in o Attribute Visualizations in
3D 3D

HorizonCube Modes
A HorizonCube can be created with two different modes:

» Data driven: The data-driven mode creates a HorizonCube that is guided
by the SteeringCube, in turn computed from the seismic data. Thus it will fol-
low the geometries of seismic reflections. It is the preferred mode to build
accurate sub-surface models and interpret the seismic data within a geo-
logic framework. There are two data-driven modes: tracking and multi-hori-
zon inversion. In the tracking mode, a 3D auto-tracker tracks in a dip field. In
the multi-horizon inversion, we follow the principle of unconformity tracker
(2.3.1). In both cases the start (seed) position is fixed.
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» Model driven: The model driven mode is a way of slicing the seismic data
relative to the framework (input) horizons. There are three model driven

sub-modes:

Input horizons

Automated horizons

Linear Parallel Parallel
interpolation to upper to lower

Three different model-driven modes to create a HorizonCube.
HorizonCube Tools

The following tools are available in OpendTect for performing different manip-
ulations on the HorizonCube:

» Add more iterations: To fill “gaps” in the HorizonCube.

» Convert to SteeringCube: Convert the HorizonCube into a dip-azimuth
volume (SteeringCube).

» Edit: Use either error-based or linear-based methods to edit events in a
HorizonCube.

» Extract Horizons: Extract horizons from the HorizonCube (stored as hori-
zon data).

» Get Continuous HorizonCube: Converts a truncated HorizonCube into a
continuous HorizonCube.

» Grid HorizonCube: Use various algorithms to fill unwanted holes in extrac-
ted horizons.

* Merge HorizonCube: Merges multiple HorizonCubes either vertically or lat-
erally. The vertical merge is useful for bigger surveys. For instance, if you
have three packages, you may run package 1 on machine 1, package 2 on
machine 2, and so forth. Then you can merge the HorizonCubesvertically to
get a single output. This will speed-up the processing time when compared
to running a single HorizonCube with three packages.

» Add or Recalculate 2D Line (2D HorizonCube): Modify the HorizonCube
by adding more 2D lines or add further horizons and faults.

» Modify or Recalculate 3D Package (3D HorizonCube): Modify a Hori-
zonCube by adding more horizons/faults.

» Truncate HorizonCube: Operation to remove parts of the HorizonCube
based on the event’s density (number of events within a defined time gate).
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HorizonCube Inputs

The following section explains the required inputs to process a HorizonCube.
Requirements include a pre-computed SteeringCube and framework horizons,
whilst fault (planes or sticks) are optional.

Pre-Computed SteeringCube

SteeringCube is a dip-azimuth volume and can be considered as the heart of the
HorizonCube.

A good-quality SteeringCube will usually result in an equally good-quality Hori-
zonCube. However, our experience suggests that in order to create a good Hori-
zonCube, one is required to pre-compute possibly 2-3 different SteeringCubes
and evaluate them by varying the HorizonCube parameters. The best Hori-
zonCube is then picked by quality controlling the results. Understanding the Steer-
ingCube is thus paramount towards a successful HorizonCube.

The simplest way to understand the SteeringCube is to first know the seismic
data that you are dealing with. Visualize the seismic data by scrolling the
inlines/crosslines or in a volume. Focus on an interval of interest and check the
areas of good and bad quality. Get an overview of whether the data quality is
poor, fair or good. If it is poor, you can expect a poor SteeringCube and thus in
turn a poor HorizonCube output. Another way of looking at the SteeringCube is to
look at the geologic complexities. If the data is too complex geologically e.g. con-
tains flower structures, you might not be successful.

In all cases, we suggest various workflows to improve the seismic data. There are
three major workflows that have been tested around the globe and are found
always a useful step to create a SteeringCube:

1. Smooth the seismic data by applying a mild post-stack dip-steered
median filter (2.3.1e Dip steered median filter). Such a filter improves the
quality of seismic at a sub-volume scale e.g. area of 3 by 3 traces.

2. Improve the vertical resolution of the seismic by sharpening the wavelet.
We normally use the Seismic Spectral Blueing (a method to enhance the
vertical resolution) operation to do this. (2.3.4 Seismic Spectral Blueing).

3. Apply a band pass filter on the seismic data to discard the high frequency
noise. It is often a valuable step if you are dealing with a high frequency
noise and you want to create a HorizonCube which follows the major seis-
mic events only.

Computationally, creating a SteeringCube is a slow process if dealing with a data-
set of several GB’s. Therefore, it is advisable to pre-process the SteeringCube
before you do anything else. You can run such processing by splitting the jobs on
multiple machines.
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To read more about the best settings and parameters for computing a Steer-
ingCube, please go to the exercises section of this chapter.

Which SteeringCube algorithm is suitable for HorizonCube processing?

In our experience, the FFT (Fast Fourier Transformation) algorithm of dip estim-
ation is preferred for horizon tracking or HorizonCube processing with a draw-
back of slowness. We recommend using the BG (phase-based) algorithm for data
conditioning and attribute analysis. This implies for both 2D as well as 3D seismic
cases.

What are the best parameters to start experimenting with various 3D Steer-
ingCubes for HorizonCube?

Case 1: Assuming that the zone has a main frequency ranging between 25-
40Hz.

To create the initial detailed SteeringCube, the following parameters are good to
start with:

e Calculation [inl, xI, z] = [2,2,5]
« Filtering [inl, xI, z] = No filtering if the input data is already smoothed through
dip- steered median filtering (DSFM).

You can then progressively filter this output and process the corresponding Hori-
zonCubes e.g.: (using as input the SteeringCube [inl, xI, z] = [2,2,5])

» Create several filtering results [1,1,3], [1,1,5], [1,1,7],... (if the data is not
noisier).

» Or create several filtering results [2,2,3], [2,2,5], [2,2,7], ... (if the data is
noisier).

Case 2: Assuming that the zone has a lower main frequency e.g. 20Hz or below.

To create the initial detailed SteeringCube, the following parameters are good to
start with:

e Calculation [inl, xI, z] = [2,2,7]
« Filtering [inl, xI, z] = No filtering if the input data is already smoothed through
dip- steered median filtering (DSFM).

You can then progressively filter this output and process the corresponding Hori-
zonCubes e.g.: (Input SteeringCube [inl, xI, z] =[2,2,7])

» Create severalfiltering results [1,1,3], [1,1,5], [1,1,7],... (if the data is not
noisier).
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» Or create several filtering results [2,2,3], [2,2,5], [2,2,7], ... (if the data is
noisier).

What are the best parameters to start experimenting with various 2D Steer-
ingCubes for HorizonCube?

The settings for the 2D are much similar to 3D seismic datasets. The only dif-
ference is that the calculation and filtering step-outs are Traces and Z- samples.
Therefore you can use the same suggestions as before.

Framework Horizons

Framework horizons (2D/3D) are the conventionally mapped horizons (3D grid-
s/2D horizons) that serve as a geologic constraint to form a vertical boundary for
a HorizonCube. Note that at least two framework horizons are needed to form a
package/sequence. The HorizonCube is always computed between two or more
framework horizons. So, if three framework horizons are provided, you will get a
HorizonCube with two packages only.

The data-driven HorizonCube is dependent on provided framework horizons. It
uses them as a relative thickness boundary that cannot be crossed by an auto-
mated HorizonCube event. Nevertheless, the automated events may be con-
verged at the framework events. In some cases, such convergences could
highlight key geologic features: pinch-outs, terminations, levees etc.

Notes and Tips

» A horizon with holes will result in a HorizonCube with holes. Thus, it is sug-
gested to fill the holes by gridding horizons with undefined areas.

» Two horizons might have different geometries (boundary ranges). In such
case the lower boundary would be used as an outer boundary of the Hori-
zonCube.

» Two horizons are also used to define an automated start position (a seed
position) to track events. Tracking can in that case be started from the
depositional centre which is the position with the thickest isopach value.

Framework horizons should be free of holes and should not cross. Optionally,
they may stop at the faults. This is the Data Preparation done via the Hori-
zonCube Control Center.
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Does HorizonCube follow the framework horizons while tracking in a package?

The framework horizons are used to calculate the starting points for various iter-
ations. However, the tracked horizons do not follow the framework horizons while
tracking. It follows the dips within the frameworks. The tracker only makes con-
vergence of the tracked events with the framework if the dips are making such a
case.

Can both framework horizons have different geometries?

We do not recommend using such horizons. You may end up with unexpected
results such as HorizonCube stopping at a bigger hole, no HorizonCube, or you
may not be able to process a HorizonCube because the start position lies in a
hole. We recommend using the horizons that have common spatial geo-
metries/extension, grid spacing, no holes. OpendTect has several tools to per-
form such actions.

| have two horizons crossing each other. | want to use them a frameworks for Hori-
zonCube. Can | solve the crossings in such horizons?

Yes! See the data-preparation tools available in the HorizonCube control center.
Fault Planes & Sticks

Fault Planes (3D) or faultsticksets (2D) are optional inputs that can be used when
creating a HorizonCube. Faults serve as structural boundaries along which the
throw is automatically computed using the input framework horizons and a given
fault plane/stick. In OpendTect, there is an additional data preparation step to
make the framework horizons “water-tight” with the faults. There is no limitation
on number of faults or sticks. One can still process a HorizonCube for the inter-
vals where the faults are absent.

The 3D HorizonCube Creator dialog will require Faults whereas the
2D HorizonCube Creator dialog will require FaultSticksets as an input.
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2.4.1a Data-driven HorizonCube

Required licenses: OpendTect Pro, Dip-steering, HorizonCube.

A — Tracking based data-driven HorizonCube

Exercise objective:

Create a continuous, data-driven HorizonCube in order to understand the depositional
history of a prograding system using principles of seismic sequence stratigraphy.

Hﬂcaseinp Scenes View Utilities H

Create Seismic Output »
WOI’kﬂOWZ Create Horizon Om;:_urt 3
(Re-)Start Batch Job

1. Go to Processing > HorizonCube > 3D... o

. . - Madagascar
2. Select the Create a HorionCube option and click the ss c

Go.. buttonin the HorizonCube 3D Control Center.
% HorizonCube 3D Control Center fo-@ '
Pre-load ...
Active HorizonCube ~ |© Select .| | Reload

Create a SteeringCube

4 Filler a SteeringCube
B . Frocessn
‘ Convert to SteenngCube
Create 2D Seismic Lattice

Create Horizons from SteeringCube

»
Interpolate Logs along a HonzonCube
| N‘ | Analysis

%Tﬂo&
B

[©cise || @Hep

Workflow cont’d:

= Horizon sorter o2 s
Select horizons

3. Select the horizons Demo 0 2 FS4, Demo 4 2
Truncation and Demo 6 - FS8. Click on OK.

| R4

| Demo 0 --> FS4 -
Demo 1 --> MFS4
Demo 2 —-> FS6
Demo 3 --> Top Foresets
¥ Demo 4 —-> Truncation
Demo 5 > FS7
+| Demo 6 —> FS8 v

4 1} »

QoK || @ cancel|
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Workflow cont’d:

4. We will create a data driven HorizonCube in

this exercise, i.e. the type that follows the

Tracking.

5. Click Settings... in the HorizonCube Creator
3D window.

6. Set the Steering Data to

3b FFT 225 MF113 and Start at to: Center.
Check the Apply to all packages option and
click OK.

' HorizonCube Creator 3D =]
Read horizons ...
Faults -

-

© Setact .. Clear

HorizonCube calculation mode

Horizon Mode
Demo 6 —> FS8 Data Driven: Tracking M
Demo 4 —> Truncation Settings ...

Demo 4 —> Truncation Data Driven: Mulii-horizon inversior ~

Demo 0 —> F&4 Settings e
Area subselection 100/300-750/1250 © Select ...
Output HorizonCube ~ | © Select
Analyze ... |
Batch execution |Single Process ~| |4, Options

.QRun ] .OCbus.a | € Help

= Package 1: Demo 6 --> FS8 & Demo 4 --> Truncation o a2

Calculation mode - Data Driven: Tracking

Steering Data 2| s 3b Steering FFT225 MF113 - |'0 Select .|

Start at: [Center -

Processing parameters

Processing parameters include settings such as
spacing at start position, number of iterations etc.

| 7| Apply to all packages

_OCancel [ @ Help |

Workflow cont’d: /= HorizonCube Creator 3D o | & [
Read horizons ...
Faults - © Select .| | Clear
HorizonCube calculation mode
Horizon I Mode =
A Demo 6 —-> FS8 Data Driven: Tracking i
8. Click _Se_lect for Area subselection and Demo 4 —> Truncation Selings u 7
set to inline range to 400 — 450.
CIICK OK Demo 4 —-> Truncation Data Driven: Tracking v
Demo 0 —> FS4 Setings ... i
Area subselection 100/300-750/1250 ©) Select ..
9. le_e an appropriate name, e'g'_ Output HorizonCube| HorizonCube_FFT225MF 113 -] |© seiect ..
HorizonCube _FFT225MF113, in the ]
Output HorizonCube field and click Batch execution [Single Process -] [+ options ..|
Run' QRun OCbsej_' ) Help
“ Positions [V.:a |23

Specify Positions

Area subselection |Range

Cross-line Range 302 3

S
@2

1240 <

[©ok | ©cancel| @tep |
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Workflow cont’d:

10. A Batch Processing window will pop up. Wait for the message Finished Batch
Processing and close the window.

) Progress Viewer o | B 8

00= ?

Steering Cube: 3b Steering FFTZZ5 MFI13

Event Type: Continuocus

Number of Iterations: 1

Maximum Hole Size: 1léms by 100 traces

Maximum Event Spacing: 1éms

Initial Event Spacing: &ms

Start Position: 425/771

Start At: Center

Start Position: Center : In-line 425, Cross-line 771
Stepout: In-line: 1, Cross-line: 4

Top Horizon: Demo 6 --> FS8

Bottom Horizon: Democ 4 --> Truncation
Nr Events: 1

In-Line Range: 400-450

Cross-Line Range: 302-1240

Process: 'Creating HorizonCube'

..: 0% (185.185/s) (4m:18s)

= 1% (16666.667/s) (3s)

| 12% (6250/s) (7s)

LEEEEEnn -

Running process od_process_horizoncube.exe with PID 2864.

Workflow cont’d:

Elements Calor

11. Add inline 425 in the scene
and select the attribute
4 Dip steered median filter.

Add Default Data

Add at Well Location ...
Add Color Blended
“ 3D Horizon

= Select oo -
Select first layer

Fitter =
9 Stored 1 Original Seismics -

4 Dip steered median filter
5 ChimneyCube
12. Right-click the inline number (i.e. 425) Aftributes | Ta Al Cube Std

=] fa Al Cube Std_8ms

Steering

and select Add > HorizonCube Display wl A ot ot b
P ] Qa Darncihdiiha feam HC KK T
=

T inine Qox || @ cancel| | @ Hep
+ 41425
g4| Add * & Atribute

@ Cross.i  Display * % Volume Builder Attribute

 Z-slice Duplicate € HorizonCube Display

® Volume Reset Manipulation % Systems Tracts Display

~ Randon 4+ Correlate with Wells .

2D Line

Lock Treeit
© 3D pon @  LockTreeitem
4 2D Hori ™ Remove from Tree
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Workflow cont’d:

13. Select the HorizonCube_FFT225MF113 that
you just created.

14. To explore HorizonCube display options

rl_ght-cllck on the_ HorizonCube in thetree > : —oEs
Display > Properties. Close the window. Fil botween fnes © Yes @) No
Use single color () Yes @ No
Transparency [ | 0
Line width 1 % Spacing 1 :
Horizontal resolution 2 trace -
4 ¥ In-line [ Truncate HorizonCube 2 (events per sample interval)
< [¥] 425 Top [ 0
¥ HorizonCubg ==~ 7" °*" **~ ]
[¥] 4 Dip steereg Msix' HorizonCube : 1 Base ] 47
¥ Cross-line i —
& Z-slice Display » | & Properties Link to ColorTable
. Volume Reload [ Lock Top/Base distance
~ Random Line == Remove [ Apply to all
AN ina
["] save as Default @ Close || @Help |

(B=8 HoR =

/ Select 3DHorizonCube
Filter *

> Continuous_HC_Full <
Continuous_HC_Full_Trim
Horizon FFT 225 MF 113_truncated
HorizonCube_FFT225MF 113
Inversion based HorizonCube
Inversion based HorizonCube Backup
Proportional_HorizonCube
1]

Xm0

=t
=

| »

@0k ] ©cancel|| @tiep |

...\Surfaces\HorizonCube_FFT225MF113.hci

4

Workflow cont’d:

15. Open the HorizonCube slider by
clicking the 151, icon.

16. Observe and QC the results of your
HorizonCube by using the Top and
Base sliders.

| Link to ColorTable

| Lock Top/Base distance

-
g > B3 ’1 W g
Control Center 2D ...
Control Center 3D ...
~} HorizonCube Slider ..

! HorizonCube 3D Slider ...

The HorizonCube slider is a very useful tool
to investigate your data and to make detailed
observation of the depositional history of your
sedimentary basin.
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Workflow cont’d:

17. Observe how gaps are presentin the prograding clinoforms. This is due to the
HorizonCube being created with only one iteration. lterations can be added later.

18. The gaps are filled by finding the gaps 1= Data Drien Advonced ptons

- - @ Continuous events Truncated events
based on a given advanced setting. o
ta Min/Max @ Fixed spacing

Advanced settings can be accessed : =
. . Spacing at start position (ms) 8
by Processing >HorizonCube > 3D > frs
= . paces larger than 16 (ms)
Create > Settings > Processing RS
parameters. Maximum Nr of terations 1
Stepout inl1 T erl4 2

QoK || @ cancel| | @Hep |

Workflow cont’d:

19. Open the HorizonCube 3D Control Center with theq icon.

20. In the Tools menu, select Add More Iterations and click Go.

% HorizonCube 3D Control Center =N o =
Pre-load ...
Active HorizonCube HorizonCube_FFT225MF 113 -
|

[Add more iterations

4 . Check crossings between Horizons
» Processin | | Edit a HorizonCube
‘ . Extract horizons
Fill holes in a Horizon
Filter HorizonCube

4 : Gel Continuous HorizonCube
/'/ ,,;l Analysis || Grid HorizonCubes
. Merge HorizonCubes

Modify/Recalculate HorizonCube

Trim horizons against Faults
Truncate HorizonCube
Tools |
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Workflow cont’d:

21. Leave the Extra Iterations option to 1, for each package.

22. Save with a new name, e.g. HorizonCube_FFT225 MF113_2it, and click OK.

Input HorizonCube HorizonCube_FFT225MF113
Mode
Package 1 |Data Driven: Tracking
Package 2 Data Driven: Tracking

|1 f B

-|1 1

3

l

Output HorizonCubel HorizonCube_FFT225MF 113_2it - | ’e Select ]

4+ Execution Options ...

LQOK | @ cancel| [ @Hep |

The first column lterations finished shows how many iterations have already been processed. The
tracked HorizonCube events from previous iterations will never change, only new events can be

inserted between already existing ones

Workflow cont’d:
23. See the difference between output images of lteration 1 and Iterations 2.

Note the gaps are filled by adding more data-driven horizon during the 2" [teration.
Further gaps can be filled by adding one or more lterations.
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Workflow cont’d:

Elements Color

24. Change the active HorizonCube Scene 1

. I Lo
either by right-clicking the T
. . . 9l Horizax [ |
HorizonGube n the tree: RS oo
: ZC'°II55"'"9 Maove * | HC_trim_D0-D6_4ms_3iter_Truncated
@ Volume Display * | HorizonCube FFT 226 MF 113

~" Random Lin Reload
7 2D Line ® Remove
® 3D Honzon —""7]

Proportional_HC

' HorizonCube 3D Control Center N |
|Pre-load ... |
Active HorizonCube |HorizonCube_FFT225MF 113 ~ ) Select Reload I

or by selecting it in the Create a SteeringCube

i ‘ Filter a SteeringCube
HorizonCube control center @ B, o Pocessn | Groonaemoncu

Convert to SteeringCube
Create 2D Seismic Lattice
Create Horizons from SteeringCube

2 Interpolate Logs along a HorizenCube
/f | Analysis

Only one HarizonCube can be %mw

Go ...

[ € Close [ @ Help |

-293 -




B — A Global Inversion based data-driven HorizonCube

Exercise objective:
Create a continuous and data-driven HorizonCube based on inversion algorithm to
understand the depositional history of a prograding system using principles of seismic

SEquence Stratlgraphy' Processing | Scene View Utilities Help

i Create Seismic Output  » = ’i"; 1
. Create Horizon Output  » —
Workflow: L Wels 5
(Re-)Start Balch Job
1. Go to Processing > HorizonCube > 3D... PSR '
= GMT Mapping Tool
+ ¥ HorizonCube 4 2D ..
. - H | Madagascar 3D ...
2. Selectthe c.reate a HgnzonCube option and click the |~ =° ,
Go.. button in the HorizonCube 3D Control Center.
= HorizonCube 3D Control Center [E=RE=R "= ]
Pre-load ...
Active HorizonCube - | Select .. Reload

‘ Create a SteeringCube

Filter a SteeringCube
-‘ Reecassin Create a HorizonCube
i onvert 1o Sleerng Gube

Create 2D Seismic Lattice
Create Horizons from SteeringCube

4 Interpolate Logs along a HorizonCube
,\f | Analysis | | HorizonCube New Workflow

% Tools

© Close & Help
¥ Horizon sorter = [m(=) E:S
Workflow cont’d: . l
Select horizons
3. A data-driven HorizonCube is created in a package - -
defined by top and bottom horizons. At least two BT -
. . . 1 --> 4
horizons are required. Select the horizons Demo 0 2 DZEEZ..> FS6

FS4, Demo 4 2 Truncation and Demo 6 -2 FS8. Click D ST gk

| Demo 4 —= Truncation

on OK. Demo 5 —> FS7
¥| Demo 6 > FS8 -

[Goc] [©omesl

' HorizonCube Creator 30 =
Read honzons

4. Optionally, Faults can be selected

Faulls - O Select .. Claar

HorizonCube calculation mode

Horizon Mode

Demo 6 —> FS8 Data Driven: Multi-horizon inversi =

Demo 4 —> Truncation Seltings ...

Demo 4 = Truncation Data Driven: Multi-horizon inversi =
In the HorizonCube creator, you Dermo 0> FS4 Settings ...
Choose an algorlthm’ SEttIngS Etc Area subselecbon 100300-T5001250 (463 samples) £ Select

Output HorizonCube » O Select ...
Analyze ..
Batch execution Single Process - | 4.k Options ..

G Run | Q Clse || E@Hep
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Workflow cont’d:

5.

We will create a data driven HorizonCube
using inversion based algorithm. Data Driven:
Multi-horizon inversion is defined by default.

™! HorzonCube Creator 30
Read horizons ..

o | & e

Faults € Select ... | Clear

HorizonCube calculation mode
Horizon Mode

Demo 6 > FS8 Data Driven: Multi-horizon inversio =

Dermo 4 —> Truncation Settings .

Damo 4 > Truncaton Diata Diroven: Mulli-hornzon inversio =

6. Click the Settings button for the upper most Demo 0> F54 Setings I
package. Area subselection 400/302-450/1240 (453 samples) 6 Select ...
Qutput HorizonGube ~ | © Select ..
7. Set the Steering Data to Analyze
PCA 111 Balch execution | Single Process = | |4k Options ...
(Qrun ] Q0o [ Bres
8. Click on the Processing Parameters.
= Package 1: Demo 6 --> FS8 & Demo 4 --> Truncation ol @ @
Calculation mode © Data Driven: Multi-horizon inversion
Stearing Data -é‘} e FCMH ~| © Select ...
Initial Moded type | Proportional
In each package, we will be using a same initial Event sampiing method (Spacing ai masimum ickness =
model (Proportional). Each proportional horizon will Spacing (ms) 4 ;
be updated using the defined processing sertat
parameters. Apply to all packages option will set
:
the same settings to all packages. T
| @ok |[©cancal| | @Hep
Workflow cont’d:

+ Fault dips will be calculated from Sl =
interpreted fault planes and merged with SEELEEES s )
reflection dips from the Steering Cube if
toggle is Yes. Confidence woight ) &) create | i)

+ Confidence weight assigns weights to )
the Steering Cube. Planarity is a good @
confidence measure that can be
calculated here, or in the Faults & Hhmteroffioton sy 12 o
Fractures plugin. Advanced GG Solver parameters 0

+ Confidence power increases the Number of CG Solver Herations 200 2 ()
contrast between planar and non-planar Sobr recidust oror|0.07 )
features. Preconditionning filler stepout ifl6 |2 eré 2 -6

+  Number of horizon updates are
typically between10 or 20. MSrsin operetan esOr L9 o
Number of CG solver iterations are Resdt
used to solve the gradient equations. @ Heip

Pre-conditioning smoothing reduces
spikes in the output horizons.

CG - Conjugate Gradient

In this case stick to the defaults, hence
press Close to continue.
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Workflow cont’'d:

9. Wewill sub-select the processing area to

400 — 450 in-lines.

10. Provide an output name: Inversion based

HorizonCube.

11. Press Run to create this HorizonCube output.

' Progress

Om ?

PRVRTRTR=ERRRN PN =R i i =i nnnini=|n 0%

ed: di 11 okt 2016, 14:11:48

ed: di 11 okt 2016, 14:11:48

: TI% (47.735/8) (0s)

d: di 11 okt 2016, 14:11:49

assing done.

Finished batch processing.

v ==
[rap—
o st [ o
wampange %0 & 454
Croms e e 3§ 1250
[Elossom
=/ HorizonCube Creator 3D =% AR X"
IRead horizons
Faults - O Selact .. Claar

HorzonCube calculation mode

Harizon Mode -
Demo 6 --> FS8 Data Driven. Muli-horizon inversi =
Dema 4 > Truncation Setlings i

Dema 4 > Truneation Data Driven: Mulli-horizon inversi ~

Demo 0 == FS4 Seltings ...
Area subsalection 4007300-450/1250 (463 samples) £ Salect ...
Output HorizonCube | Inversion based HorizonCubel - I D) Select ...
Analyze
Balch execution | Single Process - |4 Options. ...

(DR ][0 cose | [ @How

Workflow cont’d:

12. When processing is finished, Add inline 425

in the scene and select the attribute
4 Dip steered median filter and OK.

13. Right-click the inline number and select Add

> HorizonCube Display

Scene 1
4 iy} In-line
4 [v]|425
q Add Y. Aftribute
¥ Crg Display ' W% Volume Builder Attribute
W I-s Duplicate € HorizonCube Display
® Vol Reset Manipulation 5. Systems Tracts Display

~ Ra @ vert Res. E i

;. §g % Correlate with Wells ...
420 B Lock Treeitem

Fa == Remove from Tree
FaultStickSet

Elements Color

{in-limat

i Cro  Add Default Data

L &5 Add and Select Data

® ‘gﬂ: Add at Well Location ...
. op  Add Color Blended

< 3D Horizon

i Select o |[=] 8

Select first layer

o Stored [ 1 Original Seismics =

4 Dip steered median filter =

5 ChimneyCube

7a Al Cube 5td

7b Al Cube from HorizonCube

Q 8a PorosityCube from HC-NN
8b Gamma from HorizonCube

Steering

Attributes

I @ ok ”0 Cancel] . @ Help ]
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Workflow cont'd: ' Setect 0HorzonCude =3icn ="

Filter *
14. Select the HorizonCube Inversion based B S =)
: - ntinuous_HC_Full_Trim
HorizonCube that is just created. Inversion based HorizonCube
Proportional_HorizonCube_Full =

Test_HC_full_inversion
Tesi_HC_ful_Inversion_v2
Test_HC_full_Inversion_v3
Test_HC_full_Inversion_v4 =

Ocancal_l 3 Help

_.faces\Inversion_based_HorizonCube_hci

X e

15. To explore HorizonCube display options

right-click the HorizonCube in the tree > - ﬁmm.::.:, . -
Display > Properties. Close the window. Use singls color ) Yes  ® No
Transparency [ 0

Line width 1 - Spacing 1

Horizontal resolution 2 trace

Truncate HorizonCube 2 (events per sample interval)
Scene 1 Top [} o
- i‘l,n:l;: Bese SREY
@Al S
& :\S Select HorizonCube  » - Link to ColorTabla
@ Crossin Move v Lock Top/Basa distance
¥ Z-slice Display -] parties ___ > =
. Rando E
+# Random| ==} (Remove Save a5 Defaut @i |
7 2D Line L J
.
Workflow cont’d:
= OpencTect Pro VE.0.4/wing4 F3_Dermo_2016, training_v6 - [5cene 1) |rml=imie
™ Survey Analyss Processng Scena Vew Utibes Help -|#n
QHwAEST 0 aSEeD B K@ TSN i iy o [
Troe scena 1 L = = =
1 Elomants Colal - — - ‘ih
Seana 1 "
+ @ In-ine 3
& | e 4
¥ iversion based HorzenG. n
= ¥ 4 Dip seured median for i
o | 9 Crossine w
 Z-sice S
N - @ vokme -
P ~ Random Line }
20 Line )
30 Horzon
A 4 20 Horizon B N
", Fanil
o FautStcksSal <«
B sy
4 Wel
@ - ¢ PrkSal
% Polygon
" | B Prestack Everts.
H
h
L}
=
—
‘ ) - - - -
425531 (611372, 6081838, B35) Walue = -2931 {4 Dip steered median filler)  In-line. 425 [free memn] 1.67 9 GB E.'

An example of this HorizonCube overlain on inline 425.
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Workflow cont’'d:

= ig@> B RN
16. Open the HorizonCube slider. Control Contor 200

LControl Center 30

~| HorizonCube Slider ...
TZonGu er ..

17. Observe and QC the results of your
HorizonCube by using the Top and
Base sliders.

The HorizonCube slider is a
very useful tool to investigate
your data and to make detailed
observations of the
depositional history of a
sedimentary basin.

Workflow cont’'d:
Optional Steps (Filling the gaps):

You may want to fill the holes by taking some events from a HorizonCube and re-

computing the packages using the horizons. This workflow is presented in the following
slides.

18. Choose the events defining a gap from this HorizonCube. Use Top slider to know
which events are needed (e.g. events 86 & 91).
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Workflow cont'd:

'-rSumanbm Processing Scene View Utities Help

- SEeR 8

19. Open the HorizonCube manager.

20. Copy the inversion based HorizonCube with
a new name since we will be changing this
one and the other one will be our backup.
Once done, close the HorizonCube

manager.
T vtanage 30 vorzcs T 5|
Fiter * i HorizonGube data
> Confinuous_HC_Full < A= *

Contirmcus_HC_Full Trim
Iversion based HoNZonCube
Imversion bissed HorizonCube 151
Imversion based HorzonCube 2nd
Imviirsion Bised HonzonCube copy
Imarsion based HorizonCube copy v2
Propostional_HorizenCube_Full
Test_HC_ful_inversion b4
Tost_HC_full_lnversion_v2
Test_HC_ful_imversion_v3

el

47 Select/Setup e
Sassion .
Import v
Export
| Manage . Atiribute Sets
Fro-oad ' | & Bodies
Exit Color Tables
=, Cross-piot Data
o | WCossine |0 Faus
:i;:'“ , FaulStickSets
= ima
®, Geomet
.4- ~ Random Ling _* £
20 Ling *  Horizons

%, Layer Propertes

r‘ 4 ® 30 Horzon | 4
- @ [T Ime__0091 |, PickSets/Polygons

| I valued 7 Probability Density Functions

-ﬁ #Flime_0085) " Rangom Lines
to S
20 Horizon | 11 SeIsmics
& - Fault % Seismics Prestack
FaullStickSel  Sessions
x & Body B, Straigraphy
HH | A we A, Walets
¥ PickSet . Wels
S Prastack Eve ®  HorizonCube

B | O roygon

" Annotations.

= Copy HorizonCube

Input HorizonCube  Imversion based HorizonGube

o Neural Networks
SSIS

2]

PackageRange 1 & 2

Area subselection 400/300-450¢1250 (280 samples)

20
30

= x

- ) Select ..

© Select ...

Outpat HorizonCuba Irversion based HorizonCubs backup] = | © Select

Qoma

Workflow cont'd:

21. From the HorizonCube manager,
extract events 86 & 91 from the
selected HorizonCube. Q/‘*

22. The base name will be set as a prefix
with an automatically generated suffix
(e.g. Inv_0086 will be a name of the
output horizon). Press OK.

23. Once done, close the HorizonCube
manager. At this moment, we are
ready to modify an existing
HorizonCube using these two
horizons.

= Extract Hovizons from HonzonCube
Selact by

Package @ Event

Seloct Eventis) | ¥ Event 86 (Il 400 to 450, Crt- 300 1o 1250 )

Asea subselection 00/300-450V1250 (274 samples)

Event 87 (Inl: 400 to 450; Cr- 300 to 1250 )
Event 88 (Il 400 to 450, Cr- 300 to 1250 )
Event 89 (Inl: 400 to 450; Cr- 300 to 1250 )
Event 90 (Il 400 to 450, Cri- 300 to 1250 )
< Event 91 (Ink: 400 to 450, Crl: 300 to 1250 )
Event 92 (Inl 400 to 450; Cri- 300 to 1250 )

Base Horizon Name I

SRECE

8 Sekect

0%

[E] 0oms (one
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Workflow cont’'d:

24. Open the HorizonCube control
center.

,,.1:;@51: z‘}llji’ 1R

Control Center 3D ...
1 HorizonCube Shider ..
&l HorizonCube 3D Slider ...

25. Set active HorizonCube to Inversion = MorizanGube 30 Control Cemter E=RECE "]
based HorizonCube.
Actve HorzonCube  Inversion based HorizonCube - D Select ... Reload
26. Go to Tools and Select 378 P
Modify/Recalculate ... « 1208 e tactons
Edit a HorizonCube
Extract honzons
4 Get Continuous HorizonCul
27. Press Go_ I&\ Analysis Gr:ﬂlo:wznnCub:s v
- p— = | ModityRecalculato ins
e ittt e D Py Lt R L e g
-
Faciti O Sesect Cmai
B O Ciosa | | @ Hebp
—
ORn | Qoo | Bt
Workflow cont’'d:
T — == E.
28 Select the HOFiZOhCUbEZ fnve."s."on Inpat HorizonCube  Imversion basad HorizonCube = | Select ..
. _Raad horizons ..
based HorizonCube. b
Fauls - © Select..| [ Clear
29. Read horizons: (e.g.) Inv_0086 HonzonCubs caleuation mode
Horzon Mode Action
and |nV_0091 Demo & —> FS8 Datas Driven: Mubi-honizon in = | Keep -
) Demo 4 —> Truncation Seltings.
= Harizon sorter " = .”. (=} .'E
St horaons Demo 4 > Truncation Data Driven. Wuli-horizon in - | Keep -
Demo 0 > FS4 SOmngs .
" -
Demo 5 —> FST -
Demo 7 —-> shallow
Inv2_0103
V! Inv__0086 s
V| Inv__ 0091 1
Trim_DO --> F54 Analyze ..
I[:E—E: 7: 'rl'r;:cat\on - Balch execution |Singhe Process = | |4t Oplions ...
[ @ Cancel | @Fun || O cise || @Hop

We will only select the horizons
which we extracted in the previous
steps.
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Workflow cont'd:

! HorizonCube Creator 3D E=REon "%~
30. We will choose Action keep for the Input HorizonCube Inversion based HorizonCube - e s«alecl]
first package and compute for the Read harizons .. |
rest of packages. Fauts - (& Select..| [ Cloar |
HorizonCube calculation mode
31. Ensure that the three packages for Fr— Frow et —
compute have the same algorithm Domo & —> F&8 (Dala Driven: Muki-hor - Keop ]
i.e. Data Driven: Multi-horizon Demo 4 > Truncation | Seftngs.. |
inversion. Demo 4 > Truncation _Daln Driven: Multi-hori vlCompll.e -
Inv__0086 [ Settings ... ] =
32. Run
Inv__0086 'Data Driven: Muti-hori = | Compute -]
Inv__0091 | Settings ...
Optionally: You may choose a '[;':;‘)g“j}m .ID"“ Dxr;g';‘f'f'm" Yfoompse ]
different algorithm and settings — ) '
.y L: I
(such as start position) for each e : :
package. It depends on the nature Bch sxcuton Ginge Pecess /i PR -
and data quality in a package. [Grn ][ @cose ] @Hep |

Workflow cont'd:

33. Once the processing is finished, Reload the HorizonCube: Inversion based
HorizonCube.

34. The results may look like this after filling the gaps:

Scene 1
4 @ In-line
4 (V] 425
: Lm;:: Select HorizonCube  »
@ Crossdine|  Move *
 Z-slice Display
@ Voume Reload

~ Random L == Remove
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2.4.1b 3D Bodies From HorizonCube

Required licenses: OpendTect Pro, HorizonCube.

Exercise Objective:

Visualize a HorizonCube in 3D by using the 3D Slider - an add-on to perform analysis in 3D
along iso-timelines.

In this exercise we will investigate a prograding system in 3D by making thickness maps and
geo-bodies.

HorizonCube 30 Control Center
Pro-oad

Workflow: e HorzonGabe | Goninaoun,HC_F 70 sowt | oked

1. Open the HorizonCube 3D ,“ & Procossn || aks Croespion of HorgonGe D

Control Center with the @ icon.

2. Select an active HorizonCube ozl
Continuous_HC_Full.

3. Click the Analysis button, Select
the 3D slider and press Go. © cose

Keep the 3D slider window open.
You may close the HorizonCube
3D control center window.

- o

€@ Hep

Workflow cont’d:

4, Add Default data for inline 425. Tree scens 1 P

Elements Calor
Scene 1
-4
W €16 i and Select Data
B8 25 g o Wil Location
P wi

7 R

5. Right-click on the inline number > Add >
HorizonCube Display.

4 i In-line
4 7425
7 4Dip  Add Yl Attribute

# Cross-line Display ' |9 Volume Builder Attribute

; 5’?"‘:3 Duplicate € HorizonCube Display
olume set Manipulatic .
~ Random Li Reset Manipulation Systems Tracts Display
B Correlate with Wells ...
) 2D Line

@® 3D Horizor @ Lock Treeitem
1 2D Horizor == Remove from Tree
Fault
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Workflow cont’d:

6.

8.

9.

In the 3D slider window, click on
Change to pre-load the HorizonCube
Continuous HC Full.

In the Pre-load Manager press Load 3D...

Set the Event range from 260 to 310.

Press OK and close the HorizonCube
Pre-load Manager window.

Always preload with limited range when
using small RAM (under 8GB).

Pre-doaded HorzonCube None Change

Display reschation 114 (=] |Preriangulate siders

Top |1} L] Il Sve
Display In full [=] 71 Usa singhs color
- HorizonCube Pre-load Manager — O n
Ho Horizon Cube preloaded Load 2D
Load 3D .
Unload
© Close | @ Help
frem Select Horizon Cube -8 n
Input HorizonCube Continuous_HC_Full ~ B Select
Select by O) Package (@ Event
Event Range] 260 < 310 2
Area subselection 103/302-748/1248 (278 samples) © Select .

© Cancel | ) Help

Workflow cont’d:

10. Set the Top horizon display: None and

Base horizon display: In full.

11. Check Link to 2D displays option to see

the HorizonCube events on the sections
within the selected range.

12. Set Display data to Top-Base Isochron.

13. Press the Calculate button.

Note: The scene will be updated
once you press the calculate button.

¥ HorizonCube 30 Slider
Pre-loaded HorzonCube  Cordnuous_HC_Full Change
|| Dispiay resalution [ 14 = | [Pre-nanguists siders

Top [} 261

Display | Mone =

Base mn

s

(S

Dieplay [ Infull =

T e

| Cispiar data [Top-Base schren =] |
Calculate || suto-upaats

125606]

Usse singls color

10000

L sgzz‘?‘“ec-?l
3

5000

0.07903671

25000

#loos 0.025 0.05 0074 a1 ool

Data range 0.00054 0.1101% Theshold 0026541

.l 1Selsmics +

Transparency Bisatied »

Color 5emng

[(© cuse | [ @ rew
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Workflow cont’d:

Making Thickness Maps

14, Set the top slider to 302 (press ENTER to update) and the Base slider to 310
(press ENTER to update) and click Calculate.

15. The result will appear automatically in the 3D scene on the base horizon after
clicking Calculate.

Example isochron map
between events 302 and 310

Workflow cont’d:

16. Repeat the exercise for the following horizon pairs and observe the shifts in the
depositional center. Press Enter and Calculate every time after updating the numbers
for the Top and Base sliders.

Top: 265, Base 275

Top: 285, Base 302 Top: 275, Base 285
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Workflow cont’d:

Extracting Geobodies

17. For this exercise we will apply a
transparency threshold for all thinner
regions below the cut-off to preserve and
outline of a thicker region.

18. At the bottom of the 3D slider, specify
Threshold = 0.02 (Press Enter) and set
the transparency to Transparent below
threshold. (In the histogram, a thin vertical
red line will appear, which corresponds to
transparency).

= HorizonCube 30 Shider L i)
Pre-laded HarzonCube Continuous_HC_Full Change
|| Diispiay resolution 164 = | [Pre-rianguiate siders
Top [} 25 |l sove |
Déspiay | Hone -
Base ] 275 [l Save
Daspiay |In kil = | ] Us# single color
¥ Linkbo 20 displays [ Lock Top/Base distance |Creale Body ..
Display data [Top-Base lsochron ~
Caleulate Aute-update
125601
10000
it sys2AEHl 007903671
= 5000
3
25000
03 005 0025 005 0078 01 0101
Valus

Datarange 0.00054 0 nmgl Thresfioid 0.02 memq asasied x
Transparency dsabied
Color semng l -l ASsismics = Transparent below rashold
Transparent above Mresnold

@

Workflow cont’d:

Extracting Geobodies

19. Press the Create Body button.

20. Set mode to Automatic filling, the
threshold value will remain unchanged.

21. Set the Body value option to Above
threshold. Click Run.

22. Close 3D Slider.

% HorcorCube 10 SEder Lo ) i |
Pre-doaded HorzonCuse Contrmupus_MG_Ful Crang
H Display resolution | 144 = | |Presnanguiate shsers
Top [ 266 [l san
Display None =
Base 1 275 ol Sae
Display (in =] 1 use singta catar

Dispiay data [Top-Base isechien =

Caculate | [7] Auto-upaate

12560
10000
4 sy i) T T 007500871
2 5000
2500
hoos 3 005 007 0.1 0101
.
| = I

Data range 0.00054 0.1101% Theeshold 062

cotorsetng [ I 15eismics ~

Transparent below treshold =

[E=Te=
|

S Create body from sliders

Body value () Above threshold

0 e

Below threshold

® Help
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Workflow cont’d:

Extracting Geobodies

23. The body will appear in the scene. If you are satisfied with the geobody you may saveiit to
disk by right-clicking on the <New Body > in the tree > Save as..

4 @ Body | I
4 [V]|<New Body-1> -
V] <right-g Display L
b well Calculate Volume
' PickSet B save
D Polygon ,
=\ Prestack Even ™ Se.as
Annotations g LockTreeitem

== Remove from Tree
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2.4.1¢c Truncate HorizonCube

Required licenses: OpendTect Pro, HorizonCube.

Exercise Objective:
Truncate a HorizonCube to prepare Wheeler diagrams and perform seismic sequence
stratigraphic interpretation.
1. Open the HorizonCube 3D Control Center with the @ icon.
fe HorizonCube 3D Control Center -0 n
Pre-load
Active HorizonGube  Continuous_HC_Ful v| © Select Reload
2. Select the Truncate A Fihoos ma toraon
HorizonCube ey || mors et
. Edit a HorzonCubae
option from the Tools Exiract horizons
- Get Contnuous HonzonCube
menu and click Go... ; Grid HOMZoNGubes
If_p | Analysis || Merge HorizenCubes
Modify/Recalculate line
-
Go
There are two types of HorizonCubes:
continuous and truncated O Cless || @ Hep
Workflow cont’d:
3. Select HorizonCube FFT 225 MF 113 (created in previous exercise) as Input
HorizonCube.
4. Leavethe area sub-selection and minimum spacing as default.
5. Give an appropriate name, e.g. HorizonCube FFT 225 MF 113_truncated,
and press OK.
= Filter Herizon Cube oo ]
Truncate HorizonCube
Input HorizonCube | HorizonCube FET 225 MF 113 -|[© select.
Area subselection 102/302-748/1248 (463 samples) © Select ...
Tlp |f the trUncatEd Maximum density (Nr events per sample interval) 2
HorizonCube includes too Output HorizonCube | HorizonCube FFT 225 MF 113_truncated "l © Select..|
much irrelevant events (noise), B
go back and increase the :
3 5 LJ Cancel Hel
Maximum density [©ox]© corce] (@ e
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Workflow cont’d:

6. Batch processing window will pop up.

7. Leave the process running until you read the message: Finished batch processing.
! Progress - Eln
OR ?

End of process: 'Filtering HorizonCube'

Trimming the output horizoncube ... Done

Saving output for package 2

dTect VE.0

Process: 'Writing 3D Hori
started: Thu 12 Nov 2015,

Saving HorizonCube

: 19% (14.78/s) (14s)

Finished: Thu 12 Nov 2015, 16:51:55

End of process: "Writing 3D HorizonCube'

Finished batch processing.

Processing ended

Workflow cont’d:

8. After processing, switch to the truncated HorizonCube via HorizonCube 3D Control
Center@ by selecting HorizonCube FFT 225 MF 113_truncated.

9. Close HorizonCube 3D Control Center.

= HorizonCube 3D Control Center

|Pre-load ...

Active HorizonGube [ HorizonCube FFT 225 MF 113_truncated r| © Select...| [ Reload

Check crossings between Honzons
Fill holes in a Horizon
» Pracessini | | Trim against Faults
‘ B Add more iterations
Edit a HorizonCube
Extract horizons
Get Continuous HorizonCube

4 Grid HorizonCubes
M | Analysis Merge HorizonCubes

Modify/Recalculate ine
% Tools

Truncate HorizonCube

:Go
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Workflow cont’d:

Elements
Scene 1
& Indine!

R Add Default Data

10. Right-click on In-line in the tree > Add Default Data. @ Z-slic. Add and Select Dala

11. Right-click on the inline 425 > Add >

HorizonCube Display, to display the truncated

HorizonCube in the scene.

12. Switch back to the continuous HorizonCube
by right-clicking on HorizonCube name >
Select HorizonCube, to compare the two

results.

@ Volum  Aqd at Well Location ..

~ Rand - agq Color Blended
N

Elements Colof
Scene 1
= g In-line
e 5]
(= Add W .1 Aftribute

- ;:r:ss Display * | Volume Processing Aftribute
-slice Duplicate "~ HorizonCube Displa
Volumé  pecet Manipulation M . o

~ Randd ey Prastack Data » Lo oYooms 10acts Display

Elements
Scene 1
- @ In-line
71425
Bl HonzonGyibe FET 225 MF 113 1)
< 4 Dip ste [ETEIINCIICTH  HC_trim_00-D6_dms_3iter
@ Cross-line Move * | HC_trim_DO-DS_4ms_3iter_Truncated
: Zslice Display B HorizonCube FFT 225 MF 113,

et R.""ndme Ling | Peload v HorizonCube FFT 225 MF 113_truncated
* 2D Line # Remove Progortional_HorizonGube

‘ The results should be similar to the ones shown below
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2.4.1d Horizons From HorizonCube

Required licenses: OpendTect Pro, HorizonCube.

Exercise Objective:

Extract multiple horizons from a HorizonCube.

the tree. Next, add a HorizonCube
overlay. Select the active HorizonCube

Continuous_HC_Fullif prompted.

Open the HorizonCube 3D Control

Center with the @ icon.

Select Extract Horizons under the

tools menu and click Go ...

The active HorizonCube is
automatically displayed

Scene 1
W In-line
@ Cross-lil Add Default Data
® Z-slice Add and Select Data
@ Volume Add at Well Location ..
~ Randon  adq Color Blended
20 Line
._ 29 ﬁanzon 4 @ Inine
 [71/425)
Workflow: ¥4
W Cross-
& Z-shice
. . L. . @ Volume
1. Add the default data by clicking inline in ~ Rando

20 Lint

Add oF

Display
Duphc.ate
et Manipulati

¢ Conelaje with Wels

® 30 Ho B Lock Treedem

Attribute

* |4 Volume Builder Attribute
® HorizonCube Display
%! Systems Tracts Display

! 2D Hor = Remove from Tree
Fanlt

= Hotasrdbe ¥ Cortes Contnr r=s |
Protoss

|N|M: HarzonCube Continuous_HG_Full - I:nmcx Fielond

Check erussngs between Horzons
& Pllcie v otz
s
| Close| | ) e

5.

Workflow cont’d:

4. Scroll up and down using the slider, while
observing the HorizonCube events in the
scene.

When you locate a horizon you wish to
extract, click on Pick Horizon. A separate
pop-up window will appear.

Give an appropriate output name and click
OK.

S 2= =] . o
—
Everd idex . |
= f
— .
f — .-#'—
ot e [ — —
- '{_..—-—4- | —
— —
= —-——_—_——_-
Lk 1 ColerTatin
Enecutnn Optons. _,..._---
[Grox | [© cancel] | @ree
= Insent Horizen = | & e
Output 3D Harizon  event_283 © Select .| = dGB -

Tied to Leved |-

Base color

Medium Turgquoise

) Cancel | ) Heip
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Workflow cont’d:

7. Repeatthe exercise a few times for the
events you wish to extract. Then click OK.

8. A separate bafch processing window will
open. After the processing is done, the
extracted horizons can be loaded via

20 Line
horizons 3D > Load .. in the tree. bz | M-
Faut Add at Sections Only
FaukStickSet Addd Color Blended
% Boay Track New
Wel Creste with Constart 7
PickSet

= Etenet Hesizem
Pick Horzon

Ewvent Index

73
Linik to ColorTable

L4 Execution Optons

G0 @

Picked horizons in the slider

= Sebect Input Hesizon (5) ol ]
" - Fiker =
Demo 7 --» shallow A=
4 event_102 -
7 event_213 o
) event_283
e Fal
Trim_D4 —> Truncation
Trim_D5 > FS7
Trim_D6 > FS%
Area subselection 103/302-748/1248 (463 samples) O Seiect
© ol (@1
15 chosan
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2.4.2 Sequence Stratigraphic Interpretation
System (SSIS)

What you should know about SSIS

o SSIS is a commercial plugin by dGB that operates on a HorizonCube.
» SSIS supports Wheeler transformations and Systems Tracts Interpretation.

Details

In essence, sequence stratigraphy is used to provide a chronostratigraphic frame-
work for correlation and mapping and for stratigraphic prediction (Emery and
Myers, 1996). Although sequence stratigraphy has proven to be a powerful instru-
ment, and despite major advances in concepts since its introduction in the nine-
teen-seventies, sequence stratigraphy has not lived up to its potential because of
the lack of supporting software tools. OpendTect’s SSIS plugin came to the mar-
ket with the aim of filling this gap.

ain =
b TimE-DEPth Domain _ﬂ'ﬂ"’ﬁ ,.__f_,-,_-r-“""""'ﬁ'_——f

,91#. e Systems Tracts

Wheeler diagrams and wheeler transforms can be powerful tools to aid in
sequence stratigraphic interpretations. Non-depositional or erosional hiatuses
are visible, the lateral extent of stratigraphic units can be determined at a glance,
and a clear understanding of the lateral shift in deposition over time can be estab-
lished. The Wheeler transform is constructed, by flattening each horizon, thus
enabling the user to study seismic data, and its derivatives (attributes or neural
network outputs) in the Wheeler domain in three dimensions. Previously,
Wheeler diagrams were constructed by hand, making this a time consuming pro-
cess. This is unfortunate because the Wheeler diagram, or Wheeler transform as
its seismic counterpart is called, is a very valuable tool to gain insight and to
extract additional information.
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The Sequence Stratigraphic Interpretation System (SSIS) plug-in to OpendTect
allows interpreters to automatically create a Wheeler transform in which they can
study the depositional history of the area through flattened horizons, showing the
stacking patterns including depositional hiatuses and condensed sections. Using
this added feature, interpreters can make more informed decisions about seismic
facies and lithofacies predictions, thus helping to identifying potential strati-
graphic traps.

SSIS will only be of use if you have already calculated your HorizonCube. If you
created a continuous HorizonCube, you will need to truncate this to see depos-
itional variations in the Wheeler scene. Both creating a HorizonCube and trun-
cating an existing one are covered in the previous section of this training manual.

Lap-out patterns & stratal terminations

While it is not a requirement as part of the workflow to perform this step each
time, but it is considered as a good practice. Annotating the stratal terminations in
your data before making your interpretations can lead the observations towards
proper interpretation.

Annotations are graphical interpretation tools that are available in OpendTect dur-
ing the whole workflow. They can be a great help at the start of an interpretation
when tracking bounding surfaces, or when making an initial interpretation.

The annotations comprise of three basic tools: Arrows, images and scale bar.
The arrows are intended to indicate lap-out patterns or stratal terminations, but
can be used to highlight any feature. Seismic data can be animated with pictures
to make communication easier and more direct with colleagues who are working
on the same project. The scale bar allows you to very easily add scale inform-
ation.

The types of stratal terminations are truncation, toplap, onlap, downlap, and
offlap. They provide diagnostic features for the recognition of the various surfaces
and systems tracts. “Stratal terminations also allow inferring the type of shoreline
shifts, and implicitly the base level changes at the shoreline. For example, coastal
onlap indicates transgression, offlap is diagnostic for forced regressions, and
downlap may form in relation to normal or forced regressions.” (Catuneanu,
2002):
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Downlap Onlap

Downlap

Downlap

Types of stratal terminations
Stratal Termination|Shoreline shiftBase level
Truncation Fluvial |FR Fall
Truncation Marine |FR, T Fall, Rise
Toplap R Standstill
Apparent toplap NR, FR Rise, Fall
Offlap FR Fall
Onlap, fluvial NR, T Rise
Onlap, coastal T Rise
Onlap, marine T Rise
Downlap NR, FR Fall, Rise
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Onlop ond Baselap

Geological Model

£z = mign of reflection coefficent
(a)

Wrong pack

(A A A e e

Cordermify of reflection from
top sondwiond 40 limestona.

(b}

Slay down when pching Sgaingl %‘ ‘—;
the dirsction of onkp or downlap

()

FIGURE 7.14 Picking criterion—onlap and downlap, (a)
Geologicel model: A sendstone of intermediate acoustic im-
pedance is onlapped by shales of low acoustic impedance,
and limestone of high acoustic impedance. The reflection
eoefficient signs are indicated on the diggram. (b) Seismic -
pression; The top sand reflection, the gequence boundary
defined by the onlap, changes polarity due to the varying
reflection cocfficients between the sandstone, limestone, and
shale. The apparent continuity between the top sand and top
limestone reflections is o potenitial trap for the wheary in-
terpreter. (c) A general rule when following an onlopped se-
quence boundary is to sty down when picking against the
onlap direction.

Truncotion ond Toplap

{a)

FIGURE 7.15 Picking criterion—toplap and truncation. (a)
Geological model: An interbedded sequence subcrops an un-
conforrmity overlain by a sand. Signs of the reflection
coefficient are indicated. There is no aooustic-impedance con-
trast between the sands. (b) Seismic expression: The uncon-
formity has a positive reflection coefficient to the right, no
reflection where if is subcropped by sand, and o negative
reflection coefficient to the left. A potential interpretation pit-
Jall would be to take the unconformity pick along the top
limestone reflection. (c) A general rule when following a sur-
face in the direction of truncation or toplap direction s o
stap high.

Selecting unconformities
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2.4.2a Stratal Terminations

Required licenses: OpendTect Pro, SSIS.

Exercise objective:
Annotate stratal terminations and lap-out patterns using standard Arrows.

Workflow:
Scene 1
. . b AP /i Do 0sta |
1. Add inline 425 using default data. o oo™ Add and Select Dta

@ Volury  Add 8t Wall Location

= Ruandq _Add Color Blsndsd

20 Line
@ 1D Horizon
i PickSet
[ Palygen

S Prestack Events

x
HH [E] Annatations

B

Annotations
Y-

3. Click on Arrows and select New Arrows Group... i TR T

& -
2. Expand the Annotations item.

= Annotations | — | (=) -'R‘

Asrows Annotations

4. Name the arrow group to Stratal Termination and Group name | Siratal Terminatior|
press OK to add this to the tree. _ _
| D Cancel |
OpendTect annotation (arrows, images, and scale) are handy tools to highlight and describe

features of interest. In seismic sequence stratigraphic interpretation arrows are used
traditionally to map lapout patterns and truncations.

Workflow cont'd:

5. Stratal Termination element should be
active in the tree (a click on the name
activates the item). Switch to the right
mode Q

6. Now you pick on the seismic inline at
positions where you want to insert an
arrow. First click adds an arrow head.
Rotate and click one more time to pin it. Line color [ ] width [5

Scale P,

» Ctrl + Click on the arrow to delete it.
= Change the type, color, width and size of the arrow via right-click on Tree > Annotations >

Arrows > Stratal Terminations > Properties...
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Workflow cont’d:

7. Continue the interpretation on this line.

8. Right-click on Stratal Termination and Save. & Annotations
- Arrows

mage
- Scale Bar ﬂ Save as ...
¥ Properties .

Optionally make different arrow groups:
*  Downlaps.

*  Onlaps.

*  Truncations.

a Lock Treeitem
== Remove from Tree
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2.4.2b Stacking Patterns

Required licenses: OpendTect.

Exercise objective:

Evaluate stratal stacking patterns using the HorizonCube slider.

& Zslice Wl
‘ Volum{ #1393t Well Location

Workflow: = Randd _Ad Color Blended

T 2D Line
& 30 Horizon
1. Add inline with default data (if the line
. . . Scene 1
exists, skip this step). @ne -
2 40 swerd
. oo 'Crnssdme“"‘ Display ’ :ilmmm _—
Z-shce - s -
2. Add HorizonCube overlay on inline 425. b Sl D
~ ;;r\:amun‘ e o s, | B Systems Tracts Display
3. If no HorizonCube is selected, it will ask @ 30 Hoizon e
# 20 Horizon
you to select a HorizonCube. You will o =i
choose Continuous_HC_Full.
/! Select 3D HorizonCube =R ey "
Filter "
Common stacking patterns are: Gt Pl =
* Aggradation sl s )
+ Progradation Truncstod HC_FollTim ®
* Retrogradation (&
+ and combination ofthese.
e[ oo | [ @ )

_2015\Surdaces Continuous_HC_Full hei

Workflow cont’d:

> Ei A
Control Center 2D ...

4. Launch the HorizonCube slider. Control Center 3D __
T

@l HorizonCube 3D Slider

5. Play with the sliders by moving the Top
Slider & observe changesin the scene.

Link ta ColorTabis

Lock TopBase distance

(oo ] @m ] |

e ——n
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Workflow cont’d:

6. For better color contrast, you may want to
change the color scale of the background
image to Greyscale. See the steps below:

inf425 *istep1 2 qm | as00 || 4500 [raseismics 5|
et L
= - — e ————————— | 1] ENIGY-2
@ indine — - Il Experimental
[¥] 425 I 1 Extremes

¥ Continuous HC Full Bl
1] 4 Dip stoered median_ [T

W Cross-ling

&S 7.clica

Workflow cont’d:

7. (a) An example illustration of making observations:

_'Aggracla}igﬁa}nlf:.-. =
- Shiffgled reflection s

[7] Link to ColoiTable

|| Lock TopBase distance

@ |

* You have also learnt about this zone while doing spectral
decomposition (RGB Blending) & waveform segmentation.
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Workflow cont'd:

7. (b) An example illustration of making observations:

Aggradation to progrdation
(flux dominated).

Link to ColorTable

Lock TopBase distance

(Ocen ][ @M |

Workflow cont'd:

7. (c)An example illustration of making observations:

Fall with subsequént
progradation —aggrdati

—

27

429
I Link to ColorTable
] Lock Top/Base distance

[ @t

S——

Note: The scene is a bit zoomed out.
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2.4.2c Wheeler Scene

Required licenses: OpendTect Pro, SSIS.

Exercise objective:

(a) 2D Structural Section

(b)

Wheeler transform (flatten) seismic data and co-render the flattened seismic with
the flattened horizons of a truncated HorizonCube.

Basic concept of Wheeler diagrams (Flat horizons)

Distance

Distance
t 1
= =
3

(a) 2D Wheeler Diagram

Structural domain horizons / sutfaces are representative of relative geologic time (from P.R. Vail)

RGT - Relative Geologic Time

Workflow cont’d:

1. Add Scenes > New [Wheeler].

2. If no HorizonCube is active, it will ask to
select a HorizonCube, Select
Continuous_HC_Full. Otherwise, it will use
the active HorizonCube to create a new
Wheeler scene.

T Suvey Analysie  Processing [[EEIHEN View Wilties  Help

&

Cd 0

i
e
&
x

7

P bopm s New
r, BN 2
dl = 2 Now Map View
- Step 0 Naw [Depth]
—_— New [Harizan Flattened]
il
Elements
Scane 1 Cascade
) Indine Tiie
@ Crossdine Properties
e Zshce Save scenelo JDPDF +
P voume
~ Rander Line vl 00000 |
jj Seect2Dce 30 HarmeCube
) I 5} I Gancel
% Select 3D HorizonCube =
Filter |*
Continuous HC Full —

Continuaus_HC_Full_Tam

Propertional_HorizonCube P
Truncated_HC_Full
Truncated_HC_Full_Trim x

[ ©@cancel || @ten |

_2015\Surfaces\Continuous_HC._Full hci
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Workflow cont’d:

It will launch a new empty scene with a special Tree Scene 2 attached to it.

Wheeler

Workflow cont’d:

3. Add a default data in both the normal and Wheeler scenes.

4. Add a HorizonCube on inline 425.

Elements Color

Wheeler scene: Continuous

HefhAnBs &
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Workflow cont’d:

Your display may look like as shown below. Note that viewing a continuous
HorizonCube in Wheeler scene is not interesting. You may want to truncate it to
remove all convergence patterns (next slide).

[ Whesler scans: Contimscus_HE_Ful = | 7 oene 1

Tree scona 2 L)

Workflow cont’d:

5. Make a truncated HorizonCube display (on-the-fly) using HorizonCube display
properties dialog.

6. Check Truncate HorizonCube, click next to 2 and press Enter from the keyboard.

7. Apply to all to apply the same HorizonCube settings to all displays. When you will
close the dialog, it will apply the same settings to all other scenes.

= HorizonCube display options =N G "X

Fill between lines () Yes 9 Mo

scene: Continuous_HC_Full Use single color () Yes 9 Mo

_ Transparency 0
Select HorizonCube » U h 1 = o 1
J . Mo o ine wick = Spacing
TR T | | eossesien v S
—_— ® voume Reload r
>
~ Rendom L| = Remove | %) Troncata HorizonCuse |2 J(events por sample intercal
Top [} 0
Basa 42

Link to ColarTable

Lock Top/Basa distance
Save as Default -0 Close i) Help
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Workflow cont’d:

Adjust the display:

8. Make an inline view.

9. Tile the scenes.

10. Change the z-scale of the
Wheeler to adjust the display
according to your view.

Surey Analysis Processing  Scene [ viities Help

Al o N ES

/| Continuous_HC_Fubr
7| 4 Dip steered median filter

| Tree scene 1
h Elements
ﬁ Scene 1
W Inine
6 7] 425

) 8
el

Wark Area .

Viewer 20
Stereo Viewing »
lcons »
Toolbars. *
'? Basemap .

(RS v ivine
© W View Cross-line
r View Z

.b View North

% @ View North Z

) vew Wiities Help
How R
New Map View L.
New [Dopth]

Naw [Horizon Flaetaned]
o [Whaslor]
Cascade

T D
Properties

Save scene to 30 PDF

Scona 1
v Whetler scene: Contimsous_HC_Fll

= Z Scaling
Set 7 scaling factor
|App|y 0 LRl VWheeler scene: CDnllﬂ |
Z stretch

=S o)

0.03435579

[ XX Fitto scene: [ t To Home ]

| Save as Default

[Tl @m

Workflow cont’d:

11. Change the perspective —' view to the orthographic J view.

12. Adjust the scene by co-visualizing both views. You may also need to zoom in.

Tip: Avoid rotating a

scene. Just use:

» pan (mouse wheel
pressed or

Ctrl+left mouse
button pressed)

* zoom (spin mouse
wheel or
Ctri+Shift+Left
mouse button
pressed).
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Workflow cont’d:

o ¥ -

events up and down. Now you are ready to Control Center 2D .
perform sequence stratigraphic e
interpretation.

13. Use the HorizonCube slider to slide the E; S EI LN

Link 1 ColerTable

Lock TopBase Satance

Qe || @
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2.4.2d Systems Tracts

Required licenses: OpendTect Pro, SSIS.

Exercise objective:
Perform systems tracts interpretation with the SSIS plugin.

This exercise assumes that you are familiar with sequence stratigraphy and
the followings:

* Transgression & transgressive systems tract (TST)
* Normal Regression & highstand or lowstand systems tract (HST/LST)

+ Forced Regression & falling stage systems tract (FSST)

Sequence Stratigraphic Models in OpendTect:

Each model has its own name, color code, base-level phase, Top surface name, top

surface color.
~ )
* Manage Sequence Models [ = 1[ (=] |
Sequence Model Depositional Sequence [V 3
Depositional Sequence Il -
Name Depositional Sequence Il Color
Depositi equence [V
HST Genetic Sequence =
TR Sequence =
FSST Channel Stages
Stratal Packages
LsT Sequences
TST Flwial Depositional Sequence L
N-layers
Undefined MNone w | Top Undefined
Sequence Boundary is top of FSST j
[ Add model ... &l Save as [Remove model ...

l_o OK ©) Cancel ) Help

You can also make your own model if you press the Add model button.
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Worklow:

| Tree scame 1 a
Elements Calor
&e_nal
& oo IR
- - . . . Add and Select Data
1. Add inline 425 (if it does not exist). | 5 s et

Frande_ 04 Color Blanded

2. (Optional) In Exercise 2.4.2a, you made some annotations (arrows) on inline 425.
You may want to display them in the scene to begin with SSIS interpretation.

2 Prestack Everts
5 Annotations

s Following this, select the ones that you

Workflow cont’d:

Tip: Ifyou intend to study depositional shifts, we recommend

selection of a truncated HorizonCube (which is already pre-
processed).

3. Activate a truncated HorizonCube (Truncated_HC_Full).

* Launch the 3D HorizonCube control center.g
*  Select the active HorizonCube.

i MonzonCube 30 Control Canter =

Frerioad_|

4. Add the HorizonCube display on inline 425, | s mmmere o] (s
[ | Craie b SteeangCude
‘ o Filter 3 SheennyCute
_— e
= i Indine .‘. ot Sasngiss
= | _ | ot
R s s - ; )
i Cross-ine - al . Irtarpislate L3t aong 8 4
¥ Zalice Display 3 & Volume Buider Attribute Il_féﬂ LS
3 20 Line Display Prestack Data » Sywtens Tocls Dis play

® 0he & Comelate with Wells .
4 20 Hoizon | 8 Lock Tresitem
| Fault == Remove from Tree
FaultStickSet
Bady
A Well

I SRTE

% -

=
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Workflow cont’d:

If you do not have any Wheeler scene
display, Add a Wheeler Scene*

There are two ways of preforming S5IS interpretation:

. Stacking patterns in a normal (structural) scene.

. Or co-visualizing both the normal and Wheeler
scenes.

. In this exercise, we will co-visualize both scenes.

(Scene > New Wheeler ..) .

5 Suvey Analysis Processing [JESIIEN View Wrilities Help

[ YN New
o i T . HNarw Map View
oo = SteplD New [Depth]
Fn : New [Horizon Flattened] »
Add inline 425 with default data for [t ‘ .
Elements
the Wheeler tree/scene. B | Toom Cascade
é W Indine T O
¥ Crossdine Properties
= & Zslice Sme scene 1030 POF »
p ® Volume p—
H ; ' Randam Line ¥ St
7. Add HorizonCube display.
= @) Indime
=1
V! 4 Dip stg - e
@ Crossine T b Atribute
Elements Color & Zslice isplay B Volume Builder Attribute
Wheler scene: Cortinuous @ volume LI "~ HanizonCube Display
e - =
: Cr{:s: ot Data - zsn:i::‘ Line Display Prestack Data » Systems Tracts Display
@ zaic A4 and Sehect Data @ 30 Horgon | Conelate with Wells
@ Volur A4 at Woll Location 4 20 Horizon | 8 Lock Tresitem
~ RandIROSICROURGAdA Fauh == Remove from Tree
FaultStickSet

* See Exercise 2.4 2¢

Workflow cont’d:

& Survey [EEEDELN Processing Scene View Utities Help

ol Adtribates vh L E
Q S & Volume Builder et
] . Ei Crossplot Data .
£ Walle .
8. Open the SSIS interpretation window by clicking on this @ = :‘*’“:"“’““: &
. -] . . . . . = Fluid Contact Finder
icon.” @ An interpretation window will open, with the é 3+ Newral Networks -
familiar HorizonCube sliders on the left side; 2l
interpretation column, base level curve, and timeline in & | in Py ©
the white pane on the right. --
= Interpretation: Systems Tracts Demo = |
a8 E X
J HorzonCuts. Trencated HC Full
Insart Insert Sequence Model: Depositional Sequance IV
Top Base Absoite Systemns Sratgraphic Base Level
age (My) Tracts. Surisces Ra*—*Fal
Horlélci)(r’\;ube = ssis
~owene | It@rpretation
Panel
Link to ColerTable - e e
Leck TepBase astance Coa Ll v |SewAl Suteces .| B
Q) Owsws | | O Cancal el
P —— e ot Time: 268
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Workflow cont’d:

9. Open the Sequence Models selection window
by pressing:
* View the options of the sequence models
available. For this exercise, the default
model (Depositional Sequence V) will be

used. = Eepretaton Werpreaton 1
» Close this window when you have finished B —
viewing the options. —
10. To begin your interpretation, you will use the -
HorizonCube sliders:
= Slide the top slider all the way to the
bottom while co-visualizing the Wheeler
and normal scenes.
« Slowly drag the top slider up until you find .
a breaking point that would indicate a Lk CoaTibe .
different system tract.
Workflow cont'd: B ver e b
:I_:va" I nding 425 2t
Hew [Depih]
Tip: You may want to tile the e |
scenes vertically. T
I .o
e “les |

11. Position the top slider where you intend to insert a boundary.

Save scenw to 30 PDF »

v Wheeler scene: Truncated_HC_Full

insan e

Top Bas

= Interpretation: Systems Tracts Dema

*dd 8 E X%

Systems Tanct Type: Undeboed

oizoaCute. Trencaes_HG_Fil

‘Saquence Model: Dapoais

Abaote
o )

Rolatwn Gaol T &
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Workflow cont’d:

12. Press the insert button which lies just above the top slider. This will
insert a boundary in the stratigraphic column.

= Interpretation: Systems Tracts Dema

et - LU= 1

Workflow cont’d:

13. Right-click in the middle of the package that you added and assign
the systems tract.

= Intevpretation: Systems: Tracts Demo

o 8 E X

[ —r—

Saquence bese Depen
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Workflow cont’d:

14. The selected systems tract will be assigned.

= Interpretation: Systems Tracts Demo
28 E X%

HoizonCate: Trancated_HC_Full

st et | Seqence Moo De
Top Base Abaote
g )

Systems Toact Tyge HGT

Filatvn Gaol Torer 197

Workflow cont’d:

15. By repeating these steps, the entire stratigraphic column can be
interpreted and systems tracts are assigned.

Sysnems Tracts Demo
> H &8 E X
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Workflow cont’d:

16. You may want to overlay the inline with the interpreted Systems tract in both scenes.

17. Once done, you may want to Save H this interpretation.

Tree scone 1 L
Elements Calor
Scene 1
= g Ineline
= VI
v T | Aot
#| ¢ Display * | 4y volume Proces:
| ing Attribute
@ Crossd Duplicate & Honizo
Z-shice Reset Manipulation

Velurmg Desplay Prestack Data »
~ Rando| 4 Conelate with Walls

You can save ! more than one interpretation per HorizonCube.
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2.4.2e Statistical (Thickness) Curves

Required licenses: OpendTect Pro, SSIS.

Exercise objective:

Extract statistical (thickness) curves to express data-driven nature of base-level
variations.

This exercise requires an existing SSIS interpretation and an active* HorizonCube.

In Exercise 2.4.2d, you made some SSIS interpretation. You may want to use them as a
reference interpretation to extract statistical curves.

59 Ot Tace VA e 30041058 il 13, . 075  icems

&

i, L 2 Fo G- HYEN | ]

An example display from Exercise 2.4.2d

bl SRS LY

mEw?

I dew Fd

-t rrre8 ]
* Processing » HorizonCube > 3D =

Workflow:

1. In the SSIS window, launch the statistical curve extraction dialog:gl.l

8 Interpretation: Systems Tracts Demo =B |3
o8 E XA
: ncel odt | HorzonCube: Truncated_HC_Full

Insen. '_ fnsen Sequence Model: Depositicnal Sequence IV

Top B,
= SystemsTracts Statistics = | =
On OK. the statistics Min, Max. Median. and Average il
will be calculatod within the guven range
Youll be able to switch between the results by
right-clicking ca the statistical curve

TIpS on area Sub'selection: Aran subselaction | 1037302-T48/1248 (453 samplas) © Select ... |
[ Q= © Cancel | [ @ Help
1. Try to plot the thickness T aa S

s FSST1 e — )

variations at a given
depocenter vs. coastal regions )
per systems tract : = N e

“ummsgrans

Top HET1 et of Base beel tall

Link to ColorTable * Setuenos Bruntey
2. Compare the two curves by I T A @
taking snapshots. @@ —
QGueel | [ @rio
Systems Tract Type: TST Relative Geol Tima: 410
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Workflow cont’d:

2. If you proceed further, it will start extracting data within the sub-selected area and
perform statistics.

= Interpretation: Systems Tracts Demo
= I o i
A E XA
t t | HorzonCube: Truncated HC_Full

Ingedt fnsen Sequence Model: Depositicnal Sequence IV

4 ) [33%] Reading = ’E

Link to ColorTable

Lock TopBase distance Clear Level

Systems Tract Typa: TST Relative Geol Tima: 410

| 3%
0 Pause [ O Abort ‘
Gridlines read 646
PESTY End ot Bave levet il
g HET Y F et of Bate el tal
0 430 ®Ens of Traragramicn
ad NR——

* Setuenie Beuntey

| [Save Al Sufaces .| (ol

(@omn)

Q) Cancel

1) relp

Workflow cont’d:

3. Once the processing is finished, an Average Thickness curve will appear in red.

. /= Interpretation: Systems Tracts Demo
= H '&J E’ X jll

HorizanCube: Truncated_HC_Full

Relative Geol Time: 326

Systems Tract Type: HST

==re x|

Insert Insert Sequence Modal- Depositional Sequence IV
Top Base Absalute Systems Stratigraphic Base Lavel
age (My) Tracts Surfaces Rise*—"Fall 12
Top HET3
Top L5T2 End of Regremich
op Fe5T2 Ena ot Bave el 1
Top HET2 5sat of Base level il
w2 a0l T
Top LSTY End of Ragremich
Top FSST1 End cf Base leval 10
¥ B HET #ommat of Base el 3l
0 430 0 of Tramagrasion
3 “Unamigness
Link to CoborTable ® Seauancs Bourdery
Lock TopBase distance Clear | Lewel ~| |Save All Surfaces .. .ﬂ

(@ owsse || Qcancel || @Hep |

Awerage Thickness

&7
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Workflow cont’d:

4. You may want to change the statistics and plot a different curve. To do that, just right-
click on the curve and choose other stats.
= Interpretation: Systems Tracts Demo = OE %™
> a & B X

HorizonCube: Truncated_HC_Full

Insert Insert Sequence Model: Depositional Sequence IV
Tap Base Absclute Systems Stiatigraphic Basa Level Average Thickness
age (My) Tracts Suraces Rise* »Fall 12 &7
L op HETS Wt of Base baved i
®ena of Tsagrestion
op LSTZ Fiagrassich
op FEETZ Bas brul 1
op HETZ
acagremicn
a3 op LS T1 End of Ragressidh
’ 78 op FEET! £ o4 Base bovel 40
n o HET1 FOruat o B bavel Min
Max
v Average
0 430 ? 2] MFs1 ®ena of Traragramicn o
a3’ “nssaigness

Link to CalorTable * Secew

Lock TopBase distance Clear Level v | Save All Surfaces [~ ]

| © okisme | | Q) Cancel ) Help
Systems Tract Type: FSST Relative Geol Time: 311

-335-




2.4.2f Stratigraphic Surfaces

Required licenses: OpendTect Pro, SSIS.

Exercise objective:
Extract systems tract boundaries as seismic horizons of OpendTect.

There are several ways available to extract stratigraphic surfaces (or horizons) from a
HorizonCube.

In this exercise, you will learn three ways:

1. In SSIS window: one horizon at a time.
2. In SSIS window: multiple horizons.
3. In HorizonCube manager: extract events.

Workflow:

Method 1:

1. In the SSIS window, right-click on the surface name and choose Save as surface.

= Interpretation: Systems Tracts Demao =g E
=3 L’ &
= 8 E X .
HorizonCube: Truncated_HC_Full
Insert inser Sequence Model Depositional Sequence IV
Top Base Absohde Systems Stratigraphic Base Level
age (My) Tracts Surfaces Rise Fall

20 LST1 Eng of Magraasd

o FEST1

v
Rename

o P . . Delete Fos e Tonssgrussion
Hade Surface Names

Link to ColorTable * Setuence Bousdwy

Lock TopBase distance Clear Level 1 *| |Gave ANl Surfaces | g

Q@ OxSan | [ O cancel || gHielp
Systems Tract Typa: HET Relatie Geol Time: 315
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Workflow cont’d:

Method 1:

2.

“ Save Surfaces

In save surfaces dialog, specify a Horizon name and press OK.

Specify Parameters

Surface Name: Top HST1

Area subselection 103/302-748/1248 (463 samples)

e ) [l

Output 3D Horizon  Top HST1

Tied to Level — |Z|

Base color Orange

=] © select .. | | @ acB v

M
L ©ok [ Ocacet |[ @Hew |

Workflow cont’d:

Method 1:
3. It will start extracting a horizon from the HorizonCube. In case, the HorizonCube is
truncated, it will start interpolating the horizon.
¥ Interpretation: Systems Tracts Demo B |3
> @ 8 B X

HuorizonCute: Truncated_HC_Full

; ¥ Save Surfaces

Lock TopBase distance Cloar | Lot

Systems Tract Typa: HST Relative Geol Time: 315

==l b
Speciy Paranatacs -
= [0%] Horizon Creator = =
e et v
0%
[P | [ Qasen
Output 30 H| Reading HorizenCube . Indnes procassed dect ] -
Tied to Level =
Base coke

Link to ColorTable b

LY.

T | Sae Al Surtaces .. B

| © OkSaw | | D Cancal i Heip
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Workflow cont’d:

Method 1:

4. The extracted horizon is copied as a general OpendTect horizon to the project
database. Hence, you can display the horizon in the scene to QC it.
=/ Select Input Horizon (5) [E=RECE 5

~ Random Lina - Fiter *
7 2D Line TaieD

- e | eloted_Manual =]
.A x :°" il | ToBaDeleted_Test_Trck -

ot 1 | ] TODELETE BugTesting
[Pl Add at Sections Only .. —_— % ! ToDsiste. TestBog o
Add Calor Blended .. | Top FSST1

i oy 7| Top HSTY 25
@ Body | TrackNew ... | Training_ 0004
. Well Create with Constant 7 I Training_ 000G .
. Trim M~ FS4

Area subselection  103/302-T48/1248 (463 samples) © Select .

: B\Gucts] kbl
talF3_Demo_2015\Surfaces(Top HST TR

Workflow cont’d:

Method 2:

1. If you want to save all surfaces, then proceed with this part.
= Interpretation: Systems Tracts Demo [=E s
— H N E % 2.fll

HesizonCube: Trencated_HC_Ful

insot || iset | Saquance Modal: Dapesitional Saquance IV
Top Base Absolute Systems Stratigraphic Base Level
] sge (My) Tracts Sufaces Rise > Fall
Too HETH @ Craat of Base v fed
1 WG of Traragrassicn.
? 7 o9 4572 End of Eagmith
? ¥ o FEETE £0 00 Bute il 1
wst2 W6 o Bare bt e
Bgns of Traragramman
* a3 W ASTY £ of Bagran
- £ ot B tevat 4
a s st [ CeT——
] 230 ? 5 8503 of Traragrmion
a0 cumamigress
Link 13 ColoTabis ® Seceaton Bourdey

Lock TopBase distance | Clear | Leved [Leved © - o
© OkiSave | | © Concel | [ @ el

Systems Tract Type: TST Relatie Geol Time. 178
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Workflow cont’d:

MEthOd 2: fm Save Surfaces = | B ]| &3
Spacity Parameters
2. On the left panel, you see the Avea subselection | 103/302.748/1248 (463 samples) © Select
surfaces names that you have s
interpreted. You will have to add ‘ - —
i ! op H
them to the right. Top HST!
ey =]
. =
3. For each surface that is added, you nFss
will specify the Output Horizon S
wface Name: Top
name. [ 0 e F|@ st ) (@0 5
Tied to Level [
Base color ihite -
QoK || © cancel @ Help
Tip: You can copy the input name for
output horizon, e.g. MFS2 (using mouse
drag over the label and CTRL+C).
Workflow cont’d:
Method 2: S Save Satares ==
Specify Parameters
4. Following this procedure, you can Avea subsslecton | 103/302-T431248 (463 samples) O Sewet
add multiple horizons in the list.
Select surfaces 10 save
5. Once done, proceed by pressing the - ?;2?35;3‘ ;
op T
OK button. - T
Top LST2
MFS3 -
6. It will output all of them as general
OpendTect horizons and you can QC I e e .
. . . Output 3D Horizon | MFS3 -I ©) Select ... | #dcB -
the outputs by displaying them in the 5 -
H Tied to Level - -
scene as shown in pt. 4 (Method 1). : -
Base color Lime hd
) Cancel 1§ Help
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Workflow cont’d:

. = Manage 30 HorizonCube [E=RECE =
MEthOd 3 - Filer * 'y - HorizonCube data
> Continuous_HC_Full < — 7~
Directly extract horizons from a Ioersion basodHoronCubo 3 o
. . - Inversion based HorzonCube 151
HorizonCube using HorizonCube Imersion basod HorizonCube 151 Gap filod x
Imersion based HonzonCube 2nd
manager. e
1. Survey > Manage > HorizonCube > | ouHc Trackng [=]
OMHC_Tracking_Itr2 —
3D Proportional_HorzenGube_Full - | .
2. Select Continous_HC_Full & press 2
copy to horizons icon.
S s Prciasny Sume e s e
:,:::4..; |m=2-=
8 (ms3)
: Center @ Undefined
Notes:
2!
[©cose || @Heo
Free space on disk: 15.67 GB
Workflow cont’d:
Method 3:
3. thézzzza-;i;:zgr?v; ry[?"lLl:I”:I;g "-‘}‘ Extract Horizons from HorizonCube : (=] ..
. Select by Package-m
horizons (say Event 4 and Event 6
only) to be converted to general iy
; | | Event 1 (Inl: 103 to 748; Crl: 302 to 1248 ) ~
e anraons. The s ) ez s o e e
orizon _ame IS € pre Ix Ol? e Z Event 4 (Inl: 103 to 748; Cd: 302 to 1248 )
output horizon name. On OK, it will Erect 5 (- 10310 74B.C1E 02 to 1248
. . : 103 to 748; Cd:
start extractmg the horizons. — Euent 7 (ol 10340 748 Cd 307 301248 ) I
Fuarnt 8 (Inl- 107 tn TAR- Cd- N2 ta 12481
4 Once done. close this window Area subselection | 103/302-748/1248 (219 samples) |e Select
Base Horizon Name |
Uncheck-all: Ctrl+Z or uncheck the list o
through the small check box available at QK )| ©cuce | [ @reb |
the top of the list.

Group selection: Mouse drag over the
check boxes in the list.
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Workflow cont’d:

Method 3:

5. To QC the outputs, you may want to
display the extracted events in the
scene as follow:

] 2D Line I
@ (30 Hor=n 1
@ g Lo
Faul
Famg  Add Color Blended .
Track New .
Craate with Canstant 7

/= Select Input Horizon (£)
- - Fiter | *

Horizon_altematre -
__| Horizon_step1 g
. Horizon_step? m
] ?SIS-GHGS-O%??_JD -
 Traming i
Ly AETRTs =
| Trim_DO > FS4
Trim_D4 == Truncation
L Trim N4 > FST

Area subselection | 103/302.748/1248 (463 samples)
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2.4.2g Stratigraphic Attributes

Required licenses: OpendTect Pro, HorizonCube.

Exercise objective:

Define and understand the HorizonCube/SSIS attributes.

Workflow:

1. Launch the 3D attribute set window. 2 -'I

2. Select a HorizonCube density attribute.

= Attribute Set 3D
File

sd B& N NI Y 1

Asvibute vel -

-l?

=] [ © Select

We suggestusing a Continuous HorizonCube as an input forthis attribute because it

requires horizons within a specified time gate. The truncated HorizonCube removes such
events and hence this attribute is not suitable for such inputs.

Workflow cont’d:

3. Specify the attribute name and add it as new.

Attribute Set 3D

- o IEl
*PS ¥R WA

Aibute et | <nol saved- ~ | |HorizonCube Density -1|2
HorzonCube Density-8.8)ms Input HorizonCube  Continuous_HC_Full v ) Seled ..
Time gate (ms) -8 8

Avibute Name HorizonCube Density-8 ims

Asd as new | [l I

[¥] Save on Close

@ close || @ Hen
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Workflow cont’d:

4. Following the previous steps (2-3), define* a few more attributes e.g.
HorizonCube layers and Systems tract (Common ID, Unique ID, and Isochron)

attributes.

Note the input HorizonCube
for this attribute is the
truncated one because the
interpretation is made on
that input.

<All> [*] HerizonCube Layer = (2

ZI © Select .

I Input HonzonCube | Continuous_HC_Full

Nr events per layer |10

<All=

& 2]

Systems Tract

I Input HorizonCube | Truncated HC_Full

Flle

Select ... ]

Select Interpretation |Systems Tracts Dem[lﬂ Level 1 =

Output SystemsTract |[$afil 0] §In} =

Sequence Model : Depositional Sequence [V
HST -1

FS5T:2

LST:3

TST -4

Undefined - &

* Per defined attribute, you will have to specify its name and press the button add as new.

Workflow cont’d:

5. Once you have defined these five attributes, save H the attribute setas e.g.
Stratigraphic Attributes. If the name already exists, then overwrite.

6. Close the attribute set window.

= Save Attribute as (=]

Select output Artribute

Filter *

30 UVQ Attribs Texturs + HC =
ChimneyCube attributes

delme

Demo attnbutes u

FaultCube atiributes K
FauEnhancementFilter with Edgs prasening fit
Imversion atinbutes -

F 1l v

Name | Stratigraphic Attiibutes]

[ @ © Cancal | [ g Help

= Attribute Set 30 = s
Fie
el ! x
UeENEn R
Arite 0 | SUratigragtec AllnDavs v1 e =] morzoncuos Doy =7
nput HosizoaCube | Comnucus_HC_Fol ¥ [ swea
Time gate jms) 4 ]
L 4
L]
]
Attt Narra | HomzonCuba Dansty|-081m add wsnew | [l
| Save on Close -— Q) Ciose ) Help
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Workflow cont'd:

7. Next you may want to display these attribute on an inline before processing.

bl Add Defout Data

+ W nan
v g" Add and Salect Data it
; *  Add at Wel Location > ¥ 4Dipsten A VW Aibute
| Add Celor Blended @ Cross-ine Drsplay ' Volume Builder Attribute
- ;7-‘-“ Duplicate # HorizonCube Display
Volurme Resel Manipulation
>; Systems Tracts Display
 RandomLine | o omelate with Wels

o Lock Treedem
s 20Horizon | = Remove from Tree

= Select = | E

Select Layer 2

SEE
) HorizenCube layers
Steefing | Systems Tracts Common ID
Systems Tracts Unique ID
@/ Attributes | Systems Tracts Isochron

&)
Y

Qo || Ocacel |[ @rep |

Workflow cont'd:

8. Following the same steps, overlay the remaining attributes on the same

inline.
=iy In-line

4 W Inane .

" s — - =

. e 35 &T::su e Systems Tracts Isochron i

® Z-sice Duplcate @ HorizonCube Dispiay Systems Tracts Unigue ID i
._\::g:mlm Reset Manipulati I Sysiams Tracts Display Systems Tracts Common 1D F1

%5 20 Line f’“'f:’"““"w* HorizonCube layers n

“ D Horoon |5 o HarizonCube Density[-8.8]lms 1

20 Harizon from Tree 4 Dip steered median filter i

A Your inline vi look like thi

B our Iniine view may I0oK lIke IS
o =1 4

after overlaying six attributes on

Select Layer 2
each other.
Stored HorizonCube Density]-8.8]ms
HorizonCube layers
Steering | Systems Tracts Common ID
Systems Tracts Unique ID
Q) Attributes | Systems Tracts Isochron

5

s

=

QOK ,:OCancei @ Help
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Workflow cont’d:

9. Your attributes may have a coloured (default undefined values) areas
which could be set to transparent by following these steps.

4500 PP v r—
Flipped - B
Ranges/Clipping ... g
Color
Set as default
15 Manage ColorTable o B ]

Add, remove, change color tables
.Cnlnr table Status -
Farosity Ediited
Porosity-1 Own
Pressure Default
Rainbow Edited

Rainbow Plus  Deault =
RedWhite-81... Edited Please specify ﬁ
Red-White-B1... Own

Red-White-81... Own = - The Edited colortable will be replaced
Red- White-Blue Default 1 Do you wish to continue?
Red-White-B1. Own

SandShale Default

Saizmics. Edited | Segmentation MNone E Abort

Seismics - test Own
Similari Edited

ity Undefined color ] nm
Samilarity_tra... Own [ . -

Siten " Eaneg v Mo coo I
Remove .. || Impot.. | | Sawas .
| gon | © Cancel Quaip

Your results may look like this:

HorizonCube Density:
Black regions in this case represents gaps in depositione g
unconformities and condensed sections.

HorizonCube Layers:
This is like an input model containing layer definition per 10th event A
good input for geologicalireservoir modeling.

Systems Tracts Comon ID:

Acrepetition of same colour in this case represents the same systems
tract, which has a common ID in this volume Again, this volume can be
use for modelling or prediction purposes.

Systems Tracts Unique ID:
All systems fracts have their own unique IDs in this volume.

Systems Tracts Isochron:

This is a thickness volume per systems tract. A good product to explain
the base-level variations based on your data. Or adding another
dimension to the Wheeler diagrams when this attribute is used as an
overlay in the Wheeler scenes (e.g. 4D Wheeler diagrams).
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2.4.2h Stratal Slicing

Required licenses: OpendTect Pro, SSIS.

Exercise objective:
Analyze 3D seismic data by slicing through all available data.

WOI’kﬂOW: 5 Survey Analys\sScanB View Utiiies He

Q | ‘ Create Seismic Output » |
- Create Horizon Output *

ine [

1. Go to Processing > HorizonCube > 3D. § [Teescensl]  Rejsiartaich Joo
Elements ~ Dip & v
—— ip Steering

[ @ Indine = GMT Mapping Tool ...

i
@ | @ CrossIICT NN 20
) & Z-slice Madagascar

. = | @ voume 5 sSIS v
2. In the HorizonCube 3D Control Center T
select on Create a HorizonCube R S— e
from the list and click Go... Acke HaezonCate - [© 5ot ] [ Anond

Creatis Horzons Srom SteeringCube
Exst Horizors from SxanngCubs
Inteepoate Logs along & HoflzonCuts

[ D ciose || @ o
Workflow cont’d:
3. In HorizonCube Creator, click on
Read horizons... ! HorizonCube Creator 3D =R X
Eead horizons |
Fault | - © Select .. Clear

HorizonCube calculation mode

4. Check three horizons Demo 4, | Horlzon Mode E
Demo 6, Demo 7 and click OK.

= Horizon sorter [E=REC] E v
Select horizons Area subselection - © Select ...
o - Output HorizonCube ]| © Select ..

Demo 3 --> Top Foresets - Analyze ...

| Demo 4 --> Truncation
Demo 4 --> Truncation trim & fill

Demo 5 —> FS7 i+ Execution Options _..

+| Demo 6 —> F58

| Demo 7 --> shallow [ ]
Demo-6-Copied QRun || ©Close || @Hel
F3-Horizon-FS6 S

Ocowe

- 346 -



Workflow cont’d:

5. The table will be filled automatically with two packages. Select Model Driven:
Proportional for the both the packages. Type in an output name to the HorizonCube
Proportional_HorizonCube and press Run to start the batch processing.

¥ HerizenCube Creator 3D o (=)=
Read horizons ...|
Faults - 0 Select Clear |
HorizonCube calculation mode
Horizon Mode
Settings for the propo rtional Demo 7 > shallow [Model Driven: Proportional -|
HorizonCube are based on event Demo 6 > FS8 Senings '
sampling (spacing at maximum — |
. Demo 6 > FS8 Model Driven: Proporti -
thickness and fixed number of events). metmhE [Model rver:Propocions |
Demo 4 --> Truncation Settings ...
Area subselection  100/300-750/1250 (463 samples) D Select
IOurpurHoriwnCuhe Proportional_HorizonCube * | © select...
Analyze ...
Batch execution |Single Process T | |4 Options ...

©) Close| | 4 Help

Workflow cont’d:

6. When processing is finished, set an active HorizonCube: click on Select button in
HorizonCube 3D Control Center and pick Proportional_HorizonCube.

7. Press Close.

= HorizonCube 30 Control Center

Actve HorzonCube  Proportional_HorzonCube

Croate & SloenngCube
Filler a SteeringCube
Create a HorizonCube.
Comvert to StearingCubs
Create 20 Seismec Lalfice

Processing

>
(]

Edi Horizons from SteeringCube

Crodte Horizons from SteeringCube

Interpolate Logs along & HorizonCube

Pre-load

- ]

(1)
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Workflow cont’d:
[T view utiities Help

New
8. Make a Wheeler scene: Scene > New [Wheeler].  fowier vow
ew [Depth]
New [Horizon Flattened] »
New [Wheeler]

Casrada

Wheeler scens
) Indine
W Cross-line

9. Load an empty volume in Wheeler scene: Right-click & Zsice

P [Volume
. = ~ Randol
on Volume in the Wheeler scene tree > Add. Rando| AC—
@ 3D Horizom ™
@ 2D Horzon
Fault

e om
® Volume

v

~| <right-cl Add *

10. Right-click on the volume > Display > Position... ~ ranomLine e oomam

2D Line :

a0 Hortzon Duplicale 33 Properties
D Horon
Fault o Lock Tr

FaultStickSet | == Remove from Tree

= Positioning =l ]
11. Set ranges to the full survey : click on the ® icon and | speciy ne sements poston
press OK. In-line Range 100 = 750 :E
Cross-line Range 300 2 1250 =
ZRange 0 = 3
Ocuce | @10

Workflow cont’d: S
= Select =REoR "=
Select Layer 1

12. Select 4 Dip steered median filter from the list ® Stored [ { Original Seismics A
of attributes and press OK. Steering -:m_.. =
Ta Al Cube Std
Aftributes Tb Al Cube from HorizonCube
8a PorosityCube from HC-HNN
‘Wheeler 8b Gamma from HorizonCube
-1 Simaarity on FEF saismic

K 9-2 Dip-steered diffusion fiter o
b 013 Eank anhansnmnnt fillne
2 Fier[r

[ @k ][0 cancel| [ @ e

L] :| View Inine
13. Click View Z or View North Z to rotate the <2 @ Viow Orocsdne
volume. | g viow norn
o ViewNorhZ__|

14. In mouse position mode ﬁ , click on section
and pull down to slice through. Slice the
volume upward and downward.

In similar way you may slice in inline and
crossline directions
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Workflow cont’d:

Optionally a Wheeler Cube can be created as follows: % Suney Analysis

. . . . G[l= N
15. Click on , | icon > 3D to launch Attribute Set window. 20 l
16. Select Similarity attribute from the attribute list.
17. Type in a name, e.g. Similarity, and press Add as new.
18. Uncheck Save on Close and close the window.
= Anibute Set 30 = =
File
sd AR T YT 159
Aot 3ot <ot s> e G| S — |
Simaarity Input Data 4 Dip steened madian filler =| | O Sewect
Time gate (ms) -28 8
Extursion Cross -
Swepout inl1 3 et 2
Stpering None -
+
4
+
Output statistic Avirage =l
Adiribute Name | Simitanty ||Moasm|[;.
S on Goe @
Workflow cont’d:
. St:ene View Utilities Help
19. Create wheeler volume: go to Processing > Creats Seismic Output »
SSIS > Create Wheeler Output > 3D. (oass Horon Output *

(Re-)Start Baich Job ...
= Dip Steering ]
= GMT Mapping Tool ...
@ HorizonCube

Madagascar

Create Wheeler Output  » BT
:' L T Flatten Horizon/Seismics » [NERIN

20. Fill the required fields as shown below and press OK to start processing.

= Create Wheeler Volume o = = = =
Input HorizonCube Proportional_HorizonCube :| © Select ... Soloct Input Data
Input Data Similarity :] |O Select I Stored
@ Ansibutos
Volume subselection 100/300-750/1250 (463 samples) © Select ...

2

Output Wheeler Cube | Wheeler_Similarity 7] |© select ...| @ cBVS Z| =

1+ Execution Options ..
O ccel L0
0 o [ @10
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Workflow cont’d:

21. Display the Wheeler Similarity cube in a volume
by selecting the attribute from the Wheeler tab:

22. Click on Wheeler_Similarity attribute in the tree
to make it active and change the color bar to
Similarity.

23. Slice the volume upward and downward for
the z-axis to see geomorphologies.

= Select
Select Layer 1
Stored
Steering

Adfributes

B

o

i Wheeler-stratal-shcing
Wheeler_Seis

O Concd| | @b

siR-qM:: N

| mp ussl .095 11 Seismics

> 5]

i ]
5 Wheeler scene: Propd ; x Red-White-Black

_classes

11 Red-White-Blue
m SandShale

® SandShale-none
11 Saismics

1 SunRise

- 350 -




2.4.3 Well Correlation Panel

What you should know about Well Correlation Panel

The Well Correlation Panel is a commercial plugin by dGB.

It is used to pick and QC well log markers.

It can be used to create conventional well correlation panels without seismic
backdrop.

Typically, however, a random line is created through the wells and the seis-
mic is used as a backdrop to guide the interpretation.

A HorizonCube, either 3D, or a dedicated 2D version created along the ran-
dom track, can optionally be added to help correlate markers from well to
well.

Seismic and Well locations

Sefsrm: and We| Iagsfmarkers

o,

Well-Well Correlation

Details

A part of sequence stratigraphic interpretation (next chapter) is to integrate the
seismic information with the well data. This is done in the Well Correlation Panel
(WCP). The panel is an important tool for creating consistent geologic frame-
works. It integrates stratigraphy, well logs, markers, mapped regional horizons,
seismic and horizons from the HorizonCube in one view. It enables the user to
arrive at interpretations that are consistent between the different scales of
(regional) geological concepts, seismic data and well logs.
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Its primary functionality is to pick (and/or QC) well log markers that are defined
within the (regional) geological or stratigraphic framework in a consistent manner
using seismic correlations to guide the picking. Typically, the user starts with a
random seismic transect connecting the wells in a 3D volume. A well correlation
panel is constructed along this random track and the Well Correlation Panel is
launched.

However, if the user wants to use a HorizonCube to guide the correlations it can
be beneficial to convert the random line into a 2D seismic section and to continue
with 2D mapped horizons and 2D HorizonCube. In that case 3D regional horizons
are converted to 2D horizons (tree option under 2D Horizon) and a HorizonCube
is created along the 2D section. When this is done, the Well Correlation Panel is
launched. Here the user points and QC’s markers.

To use all supported functionality the user should build a stratigraphic framework
that links (regional) well markers to seismic horizons. Both time and depth
domain are supported in the WCP module. OpendTect’s synthetic-to-seismic
matching module is fully integrated and is used to align all wells optimally before
picking/editing markers. WCP supports various display modes including but not
limited to: wells only; wells plus seismic; equidistant; connecting markers; filling
stratigraphy. Unique is the capability to display the dense set of horizons from the
HorizonCube and use of the HorizonCube slider to guide detailed correlations.
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2.4.3a Well Correlation Panel

Required licenses: OpendTect Pro, Well Correlation Panel, HorizonCube.

Exercise objective:

Create a well correlation panel and QC the well markers using the seismic data
and a HorizonCube to guide you.

Workflow:

1. Launch the Well Correlation Panel (WCP) window: Analysis > Well Carrelation Panel,
or via the “="icon.

& Survey Processing Scene

Q |+l Attributes >
AL
Tre ‘% Volume Builder ..
Q El Ei Cross-plot Data >
- L Wells >
| == Layer Modeling 4
‘ = Fluid Contact Finder ..
p‘ | &+ Neural Networks »
f: SsIS >
-7 Z, Thalweg Tracker .
. = 1 Velocity Model Building »
© . Well Correlation Panel ...
Workflow cont'd:
' Well Correlation Panel =% R~

2. Select data type: 2D line.

Wells only () Yes @ No

3. For Input data, select Seis Posiion tye pDine -]

and select the line name Input Data |Se:s E"O Select ...| |Create from Wells |
Weill Correlation-Line. g
Trace subselection R° Line 0:6-1448 (463 samples) 6 Select

4. At the bottom of the window,
select all four wells available
in the list.

5 Press OK Select Well(s) to be projected on data :
v - Filter ™

| FO2-1 -
¥ FO3-2 L
v F03-4
¥ F06-1

0 Cancel ) Help
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Workflow cont’d:

6. Change the seismic color spectrum to Grey scale: click on VD and from the top bar
spin the color to Grey scale.

o well C Line: Line oo
Q| am A{ = Az B, a8 ? | s | et [rasesmics ] eo®

Tree items . Tt ot ' 3 034

Elements. Colot

4 Grun
" HorizonCube

Malleo larrain cube
Matteo terrain cube red
Malteo larrain linaar

v
p— ) =
‘ m , |View [Wets & Seiemics e | , K| 1| Keap zoom ratio (] @
Gamma Ray 41 56888199AP1 Porosity-0 28062165Fraction Marker Top Foressts MD1101 33m TVD:1101 33m TVDSS1071 33m TWT1077.00ms

Workflow cont’d:

7. Overlay the seismic data with the HorizonCube: right-click on HorizonCube in the tree
and select Add Display.

Choose the 2D HorizonCube “HorizonCube SC-FFT-frunc Random line between wells”.

= Well Correlation Panel - Line: Well carrelation-Line

Slakert o A= Aghn H a7 s [
&

[E=REOR =
m Gray scales 3 o'
Trea items. Fo21 Foe1 Fo32 FO34
Elemarts ' =
o=y
4 2D Horzon

]
- - | View Wels & Sesmicsx] | |

1] Keep zoom rato [} '
TreMr=471 (611381, 6083730, 1844)  Val=1811 (Seis),  ReUSP=1e30
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Workflow cont’d:

8. Now display a Gamma Ray (GR) log on all
wells: click on the well properties icon
A from the WCP window.

9. In the Log 1 tab, you may select Gamma
Ray log with a SandShale color bar.

‘g zk: e B w8 ?

Color| |-28212
Porosity
a 06 0.
= Display properties of: F02-1 = ]
Seloct Well F03-2 =]
Panel 1 [=] Number 1
Display well siratigraphy
Log1 | Log2 | Markers
Selectlog Gamma Ray -

Spacify data range Z|

Log range (min/max) -2.8 133.453¢ [ Logarithmic

Style [¥] Welllog || Seismic
Line thickness 1
Line color | [l w Black
Fill LeRt of log =] (71 single color

Fill with Gamma Ray q flip color table

133.453¢

Apply 10 all wells

Save as Default

©.cosa | [ @riew

Workflow cont’d:

10. In the Log 2 tab, leave the log selection to
None.

11. Press Apply to all wells to display
the Gamma Ray log on all wells displayed in
the panel.

12. Close this window.

=) Display properties of: F02-1 ol a=
Select Well F03-2 =]
Panel 1 [=] Number 1
Display well stratigraphy
Log 1 Log2 | Markers
Seiect log [T -
0 0
e s
r [ | | = Dark -
Apply o all wells
Save as Default © Close | @ Help
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Workflow cont’d:

13. Now start interpreting the depositional trends and possible systems tracts boundaries
by moving the HorizonCube slider @} up and down.

8 Well Comelation Panel - Line: Well correlation-Line =0 ol =3

Q(rerel by =250 E @ ? IEI 1 Pl wmenzencive [
i L]

FO2-1 FOG-1

==
ami [ama

Link to ColorTatde
Lock Top/Base distance

csmes]

TVD666.04m TVDSS:636.04m TWT.666.00ms

Workflow cont’d:

14. To edit the markers: click on the ==: icon.

15. Add a new defined boundary as a marker by clicking on %".
In the pop-up dialog, give a new name and color to the new marker and click Ok.

8 Wiell Comelation Pane! - Line: Well correlation-Line (=8 ol &+

Qe A Ea ? @ FEl [ 7 e
Trea dems - Fo2-1 FO6-1 Fe32 Faa4
g =

Eloments Colog ETTETT 1]

- - N Ir =y
, | View Wels & Seismicsr] |, ¥ Kaep zoom ratio (] .

. ik
TreMr=198  (G0GBE9, 6079406, 424) Val=-04 (Seis) Ral/SP=1a30
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Workflow cont’d:

16. Once the marker is added in the list, it will become an active marker: click in the well
area to add a marker. To delete a marker, use CTRL + mouse click on the marker.

17. When done with the marker interpretation, press Ok/Save button in the markers dialog.

L

# Well Comelation Panel - Line: Well comelation-Line
F . = A - -
Qixescm Ac=45% F, 8?9+ JHl»n  whorzoncue o s
Troe items Ll FU2-1 FO6-1 F03-2 FO34
Elmonts conn == = =
v =D -
# 20 Horizon
FaultStickSet
@ HorizonCube
| HorizonCu...
F Systems Tract
0
0
.
= |
F i | View Wi & Saismicsz] X Keep zoom ratio (] .
Trchr=100 (606073, BOTU226, 1704)  Val=1585 (Seis), RefiSP=1e30
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2.5 Seismic Predictions

This chapter deals with Quantitative Interpretation possibilities in OpendTect
using commercial plug-ins developed by dGB, ARK CLS & EarthWorks. These
plug-ins cover a wide range of seismic inversion and forward modeling methods.

In this chapter you will learn how to:

» Perform relative (band-limited) acoustic impedance inversion with Seismic
Coloured Inversion (SCI) plug-in.

» Perform model-driven absolute acoustic impedance inversion with
Deterministic Inversion (DI) plug-in.

o Perform stochastic inversion with Multi-Point Stochastic Inversion (MPSI)
plug-in.

» Predict porosity from inverted acoustic impedance and porosity well logs
using Neural Networks plug-in.

The inversion plug-ins (SCI, DI, MPSI) can be used to invert to (Extended) Elastic
Impedance volumes using the same work flows described in this Chapter. For
more extensive training in inversion, please contact dGB at info@dgbes.com.

Training of SynthRock, dGB’s plug-in for simulation of pseudo-wells and HitCube
inversion (matching stochastic pseudo-well synthetics against measured seismic
responses) is not included in this manual. A separate training manual exists. For
more information, please contact dGB at info@dgbes.com.
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2.5.1 Relative Impedance Inversion (SCI)

What you should know about Seismic Coloured Inversion (SCI)

e SClis aplug-in by ARK CLS.

* It enables rapid band-limited inversion to Acoustic or (Extended) Elastic
Impedance.

» The SCI operator matches the seismic amplitude spectrum to the well log
spectrum.

» Default trends can be used in the absence of well logs.

» The workflow is very similar to Seismic Spectral Blueing (see section 2.3.4).

The workflow is as follows: an operator is designed for SCI using the seismic and
well data. Once the operator has been derived, it is converted to the time domain
and simply applied to the seismic volume using a convolution algorithm.

Our aim is to design an operator at the zone of interest (target). It is therefore
desirable to time gate the selected traces prior to generating well log spectra.
Ideally you should use a good interpreted horizon in the target zone to guide the
well data (log traces). In this manner, the various gated log traces should have
sample values over a similar geology. However, in our case we will just use a win-
dow interval instead.

Here is the workflow on how to create and apply these techniques in OpendTect:

Seismic: Amplitude-Frequency plot
Smoothing of seismic mean

Well: Amplitude-Frequency plot
Global trend of well plot

Design operator

Apply Operator

Quality Check

NookwN -~
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2.5.1a Coloured Inversion

Required licenses: OpendTect Pro, Seismic Coloured Inversion.

Exercise objective:

Invert the seismic data to relative acoustic impedance using SCI plugin.

Workflow:
1. Launch the Atfribute Set 3D window.

2. Choose Colored Inversion from the
Attribute list.

3. For Input Data click Select and choose 1
Original Seismics.

4. Toggle the Single Operator option to
create a global SCI operator.

5. Click on Analyze and Create ...
to launch the SCI main window.

Adl v
2D ..
a0 ..

Amribute Set 30

d AR TTLY -0

et Data 1 Ononal Semecs ~[DEma

[ =

-omm

Workflow cont'd:

In order to design an operator with the SCI application, it is first necessary to select
and analyze the seismic and well data spectra. This is achieved by loading some
seismic trace data and well log impedance data (in time).

N =IN|
ST T
cHHep(EinuEe 822 2B 0
- 3.: 100~ T 100 Setsic Hean
6. Click on i to pop up the ] ]
Select Input Data window. ' Selctinput Dsta TN
Input Seismic | Input Wel Logs
. .. . . Select Traces | QC
7. Check if 1 Original Seismics £ 7 e ]
is selected. ] 30 Survey Area
0l ®Ful Start End Inc
1 Sub | Inine: |1 i}
8. Click Load Seismic to load 0 e ma
0 Load Traces 00
the default 40 traces. [osassmmepamToces: [0 & »
100 = Clear Traces  Clear Unselected Traces 0 Selected
9. For Time Range toggle Sub ol Tine
and enter 500 and 1500 ms ] P R .
as range Start and End E"”i Ful OO Siar 500 .
. . 1 ® Sub ; . |
respectively. o] L
l_r_ Help # Close |_F1
Log Inpat (e domain) - Tiee (as): TSOTES Amp: 144262 _
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Workflow cont’d:

10. Switch to Input Well Logs tab.

a Select Input Data

Define Format...

FieldWells/Logs Top Base HorzTime HorzSrc In-Line X-Lin
H ect Input a ?
11. Click Load wells. = S -
Input Sessmic  Input Well Logs
Reload Wels Define Format._.
12. Select the well F3-04 and choose FawietsLogs Top Base HonTime FazSe niine Xl
P-Impedance log. "'°'§og ' 250 l?‘éé ndefed ww
Ampedance 56 146
. AT Fopp Teoancetel 50 o1 wndefined 722 W
13. For Time Range toggle Sub and GenerateAlLog Pimpedance =~ 0 124
enter 500 and 1500 ms as range Y S R il
- Pimpedance_rel b
Start and End respectively. B e 2o undefoed M N
L] Pimpedance_rel 0 1825
Clear Wells
14. Close the Select Input Data Time ’ ’
WindOW. Select Hon f..[l‘e:;wels Clear Unselected Wells Reshow Wells
Range Select Honzon
Full Range Absolute
® Sub Ful © Horizon  span 500
You can add, generate new log from 2/5ib O Maker ena 15
select input data window. Right click on @ Help — )
any of the wells, then you can chose to
add or create a new Al logs.
Workflow cont’d:
‘A,:\d'-'a'\tec Controls Y=

15. Click on the advanced controls icon :m
to choose the seismic sampling rate for
the well log data resampling.

16. Go to Time Domain tab.

17. Log Data Resampling should be set to
Interval Source: Seismic. Once set,
close this dialog.

Frequency Domain | Design Oparator Wisll Logs Info | Parameter Test

Data Conditioning
Narmalisation
Interval Source

dI Nomalse G Seismic () User

Taper Ends Using Papoulis Windowing
¥ Taper Traces Taper Length: |48 ms

7] TaporLogs  Taper Langth: |48 me

Log Data Resampling

Intenval Source

o Help
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Workflow cont'd:

18. Click on ‘l to pop up the
Design Controls Dialog.

19. Smooth the amplitude-
frequency plot of seismic data
by setting an appropriate
Smoothing Operator Length
(keep an eye on the Seismic
Mean curve).

a

Seismic Coloured Inversion: F3_Demo_2015 - Untitled

File View Tools Help

THE2y SanE®E ®eLLE 0

Raw
- Design Controls

Smoc Sersmic Mean
Smoothing Operaor Lengih

Fit Wedl Log Gurves.

# Full Range
Alpha: .0 555
Diesign Opseratod

# Auto Galc

# Auio Galc. Num 7o
Energy. 939058 %

GC Against It Soismic
& Help

4000000 -

Amp

2000000

0 | bttty

Sagmic Mean .
T Em
e |,
460
40
B T T
50 100
* Close Freq (Hz)
| Loginput Detrend (Bime domeir)
1000000
2
H 0

1000 1500 1000 1500
Time (ms) Time (ms)
Indivicual Vells Gabal
arn |00 L s )
Raw Seismic - Freq (Hz): 3.4821 Amp (dB): 37.5567
Workflow cont'd:

As a rule of thumb, any Operator (time
domain) larger than 200 is too high. You
can adjust the operator by changing the
number of zero crossings.

20. Tweak other parameters (low cut, R —— =l SlEs
high cut) of the design operator T HMEP DREEE B 2 =
such that it overlaps the seismic o om
bandwidth (check in the Seismic 2Y | e
Mean curve) and the residual 10| Adhe: 0718
(Blue curve in QC) is nearly zero. RS Pyt

-104 Aa Cale Ful L;NCM He Ful ‘:":“c": L

21. Save the Operator [ and wy L= - —
optionally you can save the 3
session ] . e

I{" Energy: 39,9037 %
00 - I{ QC Agains! Inpud Seismie
22, Close the SCI| main window. [ | i e
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Workflow cont’d:

23. You will return to the attribute set

window. Q = a L\

Auntribute Set 30 - olEl

24. The input wavelet will already be N I TLY I
Selected for yDU. A 0 R ey | Coersaiein = [

IgutCats 1 Ol Swtsmcs [ seea

Analyse and Croate

25. Give a name to the new attribute : e
and Add as a new. e Tom) (G

Workflow cont’d:

- Atiribute Set 3D - o IEl

2t e Bk

Amsute sat| nons | -7
Ineututa 1 Ongindt Serics -/ © swea

Analyas and Creste

26. Save the attribute set by clicking ;
d iCOn. Input waveiet ke | 51_sa ~ | D Seieat

be Operator () Time Variand

Aty Nare Saiaone Coton imepetion asa ere [

# Save on Ciose Q) ciose | | G e

- 363 -




Workflow cont'd:

27. A new window will pop up, Name
your attribute set and press OK.

e Save Attribute as - o IEN

Select output Attribute

Filter |*

3D UVQ Attribs Texture + HC Al
ChimneyCube attributes
ChimneyCube Training
Demo aftributes
FaultCube attributes
Inversion aftributes

mv first attibute set
< >

X @

Name |Color Inversion |

@ cancel | | g Help

Workflow cont'd:

28. Add an inline in the tree (Inline >
Add).

29. Right-click on the empty attribute
for inline 425 and follow Select
Attribute > Stored Cubes > 1
Original Seismics.

30. Right-click again on inline 425 and
select the color inversion attribute
that you have just created (Select
Attributes > Attributes > Seismic
Color Inversion).

Tree scene 1 ]
Elements Color
Scene 1
A/ In-line:

@ Cros Add Default Data
@ Z-slic Add and Select Data
@ Vel g atwel Location

~ Rani
Add Color Blended

L
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Workflow cont’d:

31. Now you can see the results, and compare it with original data

a. eismic

b. Colored Inversion of the Seismic
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2.5.2 Absolute Impedance Inversion (DI &
MPSI)

What you should know about DI and MPSI

The Deterministic Inversion (DI) plug-in inverts the seismic data using an a priori
impedance model. The output is an estimate of the mean impedance at each
sample location. The prior model is created first using stochastic parameters (vari-
ograms) extracted from the data. Then a 2D error grid volume is constructed to
get spatially variable constraints. Finally the model, error grid, seismic volume
and wavelet are used to create the mean impedance volume.

The MPSI (Multi-Point Stochastic Inversion) module starts after the deterministic
inversion. Many realizations of the impedance inversion are computed starting
from the mean impedance volume (from DI) using the stochastic model para-
meters input in the a priori model building step, and a user-defined NScore trans-
form. Several utilities can then be used to convert the realizations into
geobodies, or probability volumes.

Variogram Analysis
What you should know about variograms

Variogram modeling is free (open source) in OpendTect. It is included in the com-
mercial part of this training manual because variogram parameters are necessary
inputs for deterministic and stochastic inversion described hereafter.

A variogram describes the spatial continuity of a variable. The inversion model in
the upcoming exercises will be constructed in three zones or layers bounded by
two horizons. These horizons are represented in the wells by the FS8 and FS4
markers.

Both horizontal and vertical variograms will be computed for the packages above
FS8, between FS8 and FS4, and below FS4.
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Horizontal semi-variograms

Horizontal variograms are computed from grids (attributes) stored on horizons.
The attribute used for this analysis is the inversion target, impedance maps.
Nevertheless one should not forget that stationarity is a basic assumption in vari-
ogram analysis. Stationarity implies that the variograms analysis should be per-
formed on trendless data. An average impedance map extracted from a
broadband mean impedance volume is very unlikely to show no trends, thus it rep-
resents an improper intput. The closest maps that can be produced, and that
does not contain trend(s) are attribute maps extracted from relative impedance
volumes.
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2.5.2a Extracting Horizontal Variograms

Required licenses: OpendTect Pro, Deterministic Inversion.

Exercise objective:
Extract horizontal variogram parameters from color inverted grids.

Scenes View Utilities Help

Create Seismic Output » | S oo @

Create Horizon Output » EF XTI v

. ) (Re-)Start Batch Job ... Horizon Curvature
1. Extract an attribute map using Dip Steering ,
. . - Isopach .
Stratal Amplitude. Go to Processing o i MsppnaToot-
> Create Horizon QOutput > Stratal Madagascar ..
Amplitude. il :
@ StratalAmplitude = @ 8
2. In the pop up window, select the Quantty o ouput F[Eseea]
quant'ty tO OUtpUt. ‘Window Cption @ Single Horizon Double Horizon
@ Select — lG!tﬂ_-%l-Fk
- . Select Quantity to output :
3. In the Attributes section, select ’
Sefsmic Colored Inversion. soree
@ Attributes E
il Ect.
See exercise 2.5.1 on how to define the Coloured 2

Inversion attribute.

4. Hit OK. (O conee] (@ 0 ]

F T
|4 Execution Options ...

Ocx |0 Camxl: _. € el

Workflow cont’d:

5. Keep thfa wm_dow opU_on as (] Stotmarmplitaic =E—)
defaU|t7 le Slngle Horlzon Quanlny!ooutput[sewsmm Color Inversion 'I E Select...

Window Option @ Single Horizon Double Horizon

6. Select the target horizon: Demo

0 --> FS4 Horizon. Horizon (i) [Demo 0~ Fs4 | [© seteat..]
7. Set offset top: -20, bottom: 20 ZomemTe B Bamn |

ms. Area subselection 226/645-314/695 (463 samples) (© seteat |
8. Select the amplitude option to option [Max____ ¥

output: Max.

Outputfold as an exira aftribute ) Yes @ No

9. Name the attribute.

Aftribute Name Stratal Amplitude |

10. Start the process: click on OK. b Execution Onlicns e
I gg OK || € cancel || @) Heip
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Workflow cont’d:

11. In the tree, Right-click on 3D Horizon
and select Load.

12. Select the horizon Demo 0 --> FS4
and Hit Ok.

13. Add attribute at horizon location:
Right-click on Demo 0 --> FS4 > Add
> Horizon Data.

5 # 3D Horizon

@ Annotations

< (30 Horizog

@ 50 Horizd ML
Fault Add at Sections Only
Fault Sticl  Add Color Blended ...

® Body Track New

. Well

Create with Constant Z ...

' Pickset

B Select Input Horizon (s) )

W - Filter =

/] Demo 0 — FS4 Bl =
Demo 1 MFS4 -
(2} Demo 2> FS6 = |
— Demo 3 => Top Foresets
Demo 4 —= Truncation X
Demo 5> FST —
Demo & —>FS8
Demo 7 => shallow

Area subselection 100/200-750/1250 (463 samples) _rO Select...

‘Q Cam’.ﬂl: @ el |

Dema_2015\Surtaces\Demo_0_—__FS4.nor

) RAZw L | Attribute
< 2D Horiz D'SD@!‘ * |4 Volume Processing Attribute
Fautt Tracking Contour Display
et = f toizonData |
ody
bwer [ Worklows !
i Pickset | m Save

> Polygon | & Save as
& Prestack & |

Delete from Database
% Remove from Tree

Workflow cont’d:

14. Select the Stratal Amplitude attribute
you just created.

15. Hit OK.

= | B i |

Select one or more attributes to be displayed
on the horizon. After loading, use 'Page Up'
and ‘Page Down’ buttons to scroll.

Make sure the attribute treeitem is selected
and that the mouse pointer is in the scene.

.
) Horizon Data

@ - Filter *

|71 Thickness-to-Dem4
(] testhorizon
|| Stratal Amplitude

| QOK ©) cancel
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Workflow cont’d:

16. Right-click on Stratal Amplitude in the tree.

17. Follow: Tools > Variogram.

With this option, you access the horizontal
variogram. It allows you to analyze lateral
variability of your data around the horizon. This
information is in particular used when building
the background model for broadband seismic
inversion.

18. Hit OK.

= % 3D Horizon
I Demo 0 -

5 ﬂli ht-c... B0

£ Z value

%] Siraial

@ 2D Horizon ~ Move

Fault

Fault Stick |

® Body
Well

¥ Pickset
[ Polygon
= Prestack Ev

Display
Save as Horizon Data .

Tools

Select Attribute

® Remove

| e
Set Z values

Filtering ...
Gridding

r
™ Semi-variogram parameters o | B -

Specify semi-variogram parameters

Maximum range (m) 1992 %

Max number of pairs per lag distance 1000 <

|0 Cancet: { eHe\p

Workflow cont’d:

In this window, the objective is to fit a variogram model (Green) by setting it’s sill and range
that best fit your data (Blue curve). Try to achieve a good fit at least for smaller lag distances.
Mind the impact of number of pairs per lag on the smoothness of the data extracted curve.

19. The analysis can be done in different
directions; Inline, Diagonal,
or Crossline (i.e. the analysis is
anisotropic) : change the direction and
observe the impact on the variogram.

20. Modify sill and range, using the
sliders, to fit a variogram model to the
data.

21. Choose out of the three available
variogram models; Exponential,
Spherical and Gaussian.

) Variogram analysi

s

(o[ ]

Variogram analysis

sill

Direction: [Inling &

294

2.5

Normalized Variance
-
o

Jﬁw

0.296

500

1000 1500 19
Lag distance (m)

|range |:

Variogram parameters are used for example
when building the initial model for MPSI
inversion.

Variogram model |exponential .~

spherical
| gaussian

) Close L 9Halp J
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2.5.2b Extracting Vertical Variograms

Required licenses: OpendTect.

Exercise objective:

Extract vertical variogram paramete

Workflow:

Processing Scenes
Attributes v t

& Volume Builder

Well »
& Layer Modeling 4

= Fluid Contact Finder ..
Neural Networks v
S8IS J
Velocity Model Building *
Well Correlation Panel ...

rs from impedance well logs.

View Utilities Help

S ovEge@

1. To extract P-Impedance logs from various wells: Go to Analysis > Cross plot
Data > Well logs vs. Attributes.

dom Ll # Specify

| Cross-plot Data * | Welllogs vs Atiributes ..

Aftributes vs Attributes . I Which attributes do you want to use?
Open Cross-plot ... :
[ ¥ 030 _|[© cancel

==

Workflow cont’d:

data extraction.

3. Select Impedance logs
associated with the wells.

4. Toggle Extract in time and set
step: 1 ms.

5. Extract between Markers:
FS8 and FS4.

6. Select log resampling method
as Take Nearest Sample.

7. Set the radius around wells to 0
and press OK.

1 Attribute/Well Cross-plotting

2. Select all wells that will be used for -

[1 Original Seismics]

[5 ChimneyCube]
[7a Al Cube Std]

Attribute

I7b Al Cube from HorizonCube]

[3D UVQ 6 biased Texture+Energy+SystemsTracts]
[3D UVQ Texture+HC attribs+ Energy disk]
[4 Dip steered median filter]

Cild well - Log

¥ FO2-1 Density

¥ F03-2 Sonic

) F03-4 Gamma Ray

7| FO6-1 Porosity

[ P-impedance ]
P-impedance_rel
Extract Between | Markers «||¥] Extractin time  Step (ms) 1
selected zone [ Fs8 - lFs4 -]

Distance above/below (m) 0

sactusaoundwets [ ]

Filter position -

o

Log resampling method | Take Nearest Sample =

O select...

Ocaru:el_ 9 Help
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Workflow cont'd:

'w Well attribute data
. B2 XY, Y x@mmpld f = snon1000%" ]
8. Cross plot table window :
Well dataF02-1F03-2F03-4F06-1
pOpS Up. X-Coord Y-Coord Z(ms) * MD(m) | Pimpedance | |
F03.2 619101 5089491 592 589.91998291 4149800
9. Select P-Impedance F03-2 619101 6089491 593 59091996291
F03-2 619101 5089491 594 £91.91996291 4150060
Column. F03-2 619101 6089491 505 59291996261
F03-2 619101 5089491 s95 59391398281
. . o~ F03-2 619101 6089491 597 59491996291
10. Click on this ﬁ icon F03-2 619101 5089491 598.01 59591996291
to start the variogram EN12 £19101 AnRGAG1 saan 407 61004201 PN - |
analysis. T
well: FO3-2
11. Variogram parameters
. r B
window pops up. @ Semi-variogram parameters (115 IS
. Specify semi-variogram parameters
12. Click OK.

Maximum range (msec) |50 =

The vertical variogram parameters used here are comparable

L i \ N Step (msec) 1 =
to the horizontal variogram analysis of Exercise 2.52a. The

main difference is in the number of available data points. Min number of pairs per lag distance (10 =
Variogram analysis requires a minimum number of pairs per
lag distance and therefore sufficient data must be input in @OK |[0 Caan @ Her ]

orderto obtain a representative variogram.

Workflow cont'd:

1=

0

13. The variogram analysis can be BB Veriogrom seohssy
done for either all the wells S

(recommended) or for one particular Seurce: [AIWells
We" sill
1.751
o 15
14. Modify sill and range, using the § PR
sliders, to fit a variogram model TE e M
(Green) to the data (Blue). s 0P
=]
20 40 5
Lag distance (msec)
15. Choose out of the three available SN | = T
variogram models; Exponential, vatooram moge o=
Spherical and Gaussian. ’
([ cuse ][ @ e |

It's recommended to use the same model for this vertical variogram analysis, as used previously for
horizontal variogram analysis (Exercise 2.5.2a).
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2.5.3 Porosity Prediction using Neural Net-
works

What you should know about Neural Networks for Rock Property Pre-
diction

» This is a supervised approach using a Multi-Layer-Perceptron neural net-
work.

» The network will find the optimal (non-linear) mapping between seismic
attributes (usually impedance logs) and target well log attributes (porosity,
gamma-ray, Vshale, Sw ...).

» The network is trained on data points extracted along the well tracks.

» Part of the extracted points are used as test set to determine the optimal
point to stop training and avoid over fitting.

» The trained network is applied to (inverted) seismic data.

» The input data (inverted seismic) needs to be scaled to match the scaling of
the input data set that was used in training (logs).

Details

In the exercise that follows, we will convert seismic information to porosity using a
neural network inversion workflow.

As in the chimney cube exercise (see Chapter Seismic Object Detection using
Neural Networks), we will use a supervised neural network to establish the (pos-
sibly non-linear) relationship between seismic response and porosity. The main
difference from the previous exercise is that we will now use well information to
construct the training (and test) sets.

The input consists of acoustic impedance values from the Al volume and the ref-
erence time, i.e. the two-way time at the extraction point. The reference time is
included to capture a possible porosity trend with depth (time).

Theoretically we only need the Al value at the evaluation point as input to the
neural network but this assumes that the inversion process has completely
removed the wavelet and that there is perfect alignment of Al and log responses
along the entire well track. To compensate for potential inaccuracies we will
extract more than just the Al value at the evaluation point. Instead we will extract
Al in a 24ms time window that slides along the well tracks. The corresponding
porosity values from the depth-to-time converted and resampled logs serve as tar-
get values for the neural network.

Porosity prediction is a relatively easy process. The workflow is schematically
shown below:
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Seismic data :f Deflnesa;tttnhute \

\.

Attributes along well tracks
+ target log response

v

" Train MLP \]
Network

~
Y [

Trained MLP
Network

All traces

>
o
e
<

Predicted log
property cube

Log property prediction workflow

This workflow can be used to create log property cubes such as a Porosity Cube
and a Vshale Cube.

- 374 -



2.5.3a Neural Network Prediction

Required licenses: OpendTect Pro, Neural Networks.

Exercise objective:

To convert seismic information to porosity using a neural network inversion workflow.

Well data Preparation

1. Well(s) need to be available in the survey. If they are not available: import wells (track,
logs, markers, optionally time-depth curve or checkshot).
2. Tie well to the seismic (see exercise 1.5.1).

¥ Attribute Set 3D

ELERL TR T 1S

Workflow:

1. Open attribute set window “g.

= Lowd Atbute =
- . . Select input Attribute
2. Click on file> Open set , or click on <&, R

Filter *
3. Select the saved set ‘Inversion e
attributes’ and Hit Ok.

REF

a0

sdtest L
Segmentation attributes (waveform) ~ |
Segmentations attributes (Dip-steered 3D)

Seismic Spectral Blueing and Coloured Inver: -

" = ’

) cancel| | g Help

S\Attribs\Inversion_attributes.attr

Workflow cont’d:

4. Open the neural network plugin with the§ > jcon WLES QBZD HAE
> 3D or go to Analysis > Neural Networks > 3D. .

Y
& Neural Network management By

Meural Network Manager 30

Create New Metwork: Get

5. Select Property prediction [Well Data] from the [Patter racognition Picksets]..) | [Stored Network )
Neural Network manager.

Property prediction [WellData] . 3| From Job file .. 1

Active Neural Network

Input Output

© close | [ @ Help |
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Workflow cont’d: 5 i e

IR Eraining dite 35§ EX1RGE now

6. Data selection window pops up.

7. Select the input attributes as on
the picture.

8. Select the target quantity among
the available well logs: Porosity.

9. Set the percentage of data to be
used as test set: 40%

Sbect inpunt attributes

Percentage

Péan-stanciand number of hicden nodes

RS stoned

et touse | 7 FOR-1
7 For-2
7 Fos4

Setect target %) Fo8.1

Extract between [Statol dta> = cEndol datax

Target contains ® Grdinary well log vabues ) Lithology codes

Distance sbowe/below [m) & 0
wsed fon testset 30 % Raduss srownd walls 15
Verncal Lumgiling methed Tie Neatost samgse
Qx| 1 cancel [@nee
PP PARSRR T—

Workflow cont’d:
[F=5 Eol| ==
v -
Wells to use [[¥] FO2-1
V| F03-2
J| FO3-4
FO6-1
10. Select all the wells. =
11. Limit the extraction window as shown on
the picture.
Extract between |Fs8 -] [rsa -
12. Select Average Vertical sampling method _
Distance above/below (m) 0 ]

and Press OK.

Radius around wells 0

I QOK IQCancel ﬂHalp
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Workflow cont’d:

An optional step is to QC the extracted data set (tested and training) by plotting
Acoustic Impedance (Y) versus Porosity (X)

13. Highlight Porosity column and press X .

14. Highlight Al 0 column, and press Y+-

15. Click on F.:.

7
& Input Data

la-Elg

I ESA

Y. ix @mp 4 i == snow 0005

X-Coord Y-Coord Z(ms)
Training data 619101 6089491 596.48
Training data 619101 6089491 59749
Training data 619101 6089491 59849
Training data 619101 6089491 599.49
Test data 619101 6089491 600.49
Test data 619101 6089491 601.49
Test data 619101 6089491 602.49
.Tmining data 619101 6089491 603.49

Data Set Training data

.

*Referen Acousticl Acoustic I Acous
3828565 4006971

0.596
0.597

0.5980....
0.5990...

0.6
0.601

0.6020...
0.6030...

40765... 40326..

41008... 40731..
40070... 40914..

40327... 4M723..

40542... 41429,
40732... 41675..

4151797 40541

ticy Acoustic |
40012, [EREE
TR 42000
EC iR 4209738
41675... [Erralim
CRLUORY 4239096
4200099 ElrirEx]
FROEERN 4323147
Lyl 4369237

Acousticl Acousticl Acoustic|

42389... 44136..
4278584 444301,
43230... 4470581
436011... 4494539
44137... 45167,
44440, 4542741
4470698 4566790
4494653 4587793

[(©rn] (@ oe) (@ver]

45185...
4542655
4566731
4587762
46046,
4607702
46080..
46081,

Porosity |*
0.3501...
0.3501...
0.2486...
0.2445...
0.3388...
0.3219...
0.3248...
0.2409... [+

Workflow cont’d:

16. Cross plot window pops up.

17. Click on * in previous window to
move Y column and see how other

attribute plot against Porosity.

18. Close cross Plot window.

19. Press Run in Previous Window.

B <NLA train/test duta> Cross-plot - a x
shaw 10000%5 [f} Y2 BothData Sets ~ oy | FRIRBER B D

% =075
P(x)

s
e

02 0.226 028 0275 03 [k~ 035 0378
Porusity
¥ Selected: 0

-377 -




Workflow cont’d:

20. The balancing data window pops up.

) Data preparation =68

step.

In this step, you have the option to balance
your data. If the data is not properly sampled,
balancing is a recommended pre-processing

21. Tocontinue, Press OK.

Specify data preparation for ‘Porosity’

407

Count

0.9259 0.25 03 0.35 0.3902
Value
Balance data @ Yes No

Data points per class [E
Percentage noise when adding 1

Datarangeto use 0.2243  0.39196

. ) cancel| ‘_g Help |

Workflow cont’d:

22. The Training data window pops up.

23. Tocontinue, Press OK.

=% NM training [20]

Train Neural Network => 'Porosity’ [September27 2016 15:42:03]

j—oemeeed RMS . Reforence limo
" ,:" - t::’. Acoustic Impadance 12
'L—_—J- () Acoustic impedance -3
0.5] 5 -
Acoustic impedance -4
25
Acoustic Impoedance 0

) Acoustic Impedance 4

Vectors trained 21600 Recume Clear ___

On OK, save as

0 co

& Help
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Workflow cont’d:

24. Back in the Neural Network, Output

) Neural Network mar t

ERE

Meural Network Manager 3D

Create New Network:

Get:

property is highlighted.

25. Click on Info to see summary

Of Neural Network characterisation.

[Paﬂem recognition [PickSets] . [Stnred MNetwork ]

[Property prediction [WeliDats)...| | [ FromJobfile.... |

Active Neural Network

Acoustic Imped: _
Arnuinbio bmann de

«[.m »

Input Output
Reference time . | [0 M
Acoustic Imped:

Acoustic Imped: =
Acoustic Imped:
Acoustic Imped:

Workflow cont’d:

26. Neural Network info (report) pops
up.

27. Click on Save Report (optional).

-
¥ NN info

L B [y

Type:
Hidden layer has 4 nodes
Traiming stats:

Number of used input vectors: T4%
Fumber of invalid input veeters: 0

Porosicy

Test scats:

NWumber of used input vectors: 483
Humber of imvalid input vectors: 0

Poresicy
Data mean:
Data scandard deviation:

Supervised {(direct prediction)

T 0.115829

0.300373
) 7276

0.221728
0.369145
0.0280442
0.627
0.020771

Q Ciose | [ @ Hein |
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Workflow cont’d:

28. Store the Neural Network.

= Neural N rk manag l‘:l@ﬂ‘

Neural Network Manager 3D

Create New Network: Get.

[Pattern recognition [PickSets] .| | [Stored Network ...

|Property prediction [WeliDatal...| | [ From Jobfie.. |

Active Neural Network

Input Qutput
Reference time . | [FECEL I
Acoustic Imped:

Acoustic Imped: =
Acoustic Imped:
Acoustic Imped:
Acousticimped: _

Anniiatio Inma de

«[.m r

(o] (o]
(Do) (@

Workflow cont’d:

29. Give a name to the Neural Network

output.

30. Press OK.

) Save Neural network as =N
Select output Neural network
Filter | *
[chimneycube ~
NN Porosity training

NN-Test

UVQ 10 classes [-12, 24l ms on MFS4 E
UVQ 10 classes [-12, 60] ms on FS8

UVQ 10 classes [0, +24] ms on MFS4
Volume-based segmentation between FS7 and
Volume-based segmentation between F38 and ~—
< ftt ¢

o X &0

Name Neural Network]

) cancel gHeIp

_..emo_2015\NLAS\NN_Porosity_training.nn
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Workflow cont’d:

31. Create Porosity Cube.

32. Create seismic output using:

Y Survey Analysis Byile:EHULE Scene  View  Utilities Help
Yol " L creaeSesmeouut 2 - Single Attribute »
Multi Attribute . EE

MultiCube DataStore ...
* Along Horizon 12

™y Between Horizons  *

Create Horizon Qutput  » 2D <=> 3D 3
A | iniine 425 |2 A wells 4 Angle Mute Function ..
S RTETT (Re-)Stant Batch Job ... P4 Bayesian Classification .
V) .E]emen!s ~ Dip Steering ¥ FromWell Logs ...
i »
- Goar i1 | = GMT Mapping ool F’resl.aus Processing
stang Velocity 3
= Indine | & HorizonCube 4 _
‘ =[] 42¢ N Volume Builder ...
o 3 Re-sort Scanned SEG-Y ...
o i Cross- 5515
C ¥ Z-slice

Workflow cont’d:

33. Select quantity to output

34. New window pops up.

8 Create Volume Attribute

35. Toggle Neural Network. Guantiyto ot

Volume subselection -

B Select

[E=E =%

Select Quantity to output

36. Select Porosity.

Attributes
3? PrBSS OK @ Meural Network
o)

Y

Sens

(%) Cancel\_ € Help

> | B =

E e

© Select ]

[z][© seea..| mcevs  [7]

ns .|

© 0k | [ cancel| [ @ Heip |
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Workflow cont’d:

38. Give a name to the output Cube.

39. Press Ok.

(@) Create Volume Attribute ESSESE )

. Quantity to output Porosity Z| @I

Volume subselection - (© seteat.|
Null traces @ Discard Pass
Scalevalues: ShiftFactor
Output Cube [Porosit -] (© seteat| @icavs  [+]
Batch execution  Single Process (4,; Options...|

Workflow cont’d:

40. To apply the output on an inline to perform
QC by giving Right click on Inline > Add
and Select data.

41. In the selection window, under the Neural
network category, select Porosity and
Press Ok.

Elements Color
Scenel
N In-lin~
@ Cross Add Default Data
® Z-slici Add and Select Data
® volur Add at Well Location ...
~ Rand Add Color Blended
2D Line
'1_-r Select SE)

Selectfirst layer

Stored
Steering
Aftributes

@ Neural Network

C

EY

Porosity |

| QOK ||0Cancel] @Helpl
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Workflow cont’d:

42. The Porosity prediction result display on Inline 425 should look like the image below.

2.6 Machine Learning

This chapter deals with the Machine Learning (ML) capabilities within OpendTect
Pro using the commercial ML plug-in developed by dGB.

In this chapter you will learn how to use the ML plugin to:

» Perform Log-to-Log Prediction for Density.

» Perform Lithology Classification using Well Log data.

» Predict Seismic Bodies using Supervised 3D Models.

» Predict Fault Locations using the Unet 3D Fault Predictor.

» Predict Rock Properties using a combination of Seismic Data & Well Logs.

» Predict Seismic Features using a Seismic Image-to-Image Workflow.

 Fill blank traces in Seismic Data using a Seismic Image Regression Work-
flow.

» Condition data using the Pre-trained models - Lundin GeoLab Sim-
pleDenoise tool.

More information on these topics an be found online in the Machine Learning_
Chapter of OpendTect Pro & dGB Plugins Documentation - 7.0.

We have an extensive playlist of Machine Learning videos on our YouTube Chan-
nel and on the dgbes.com resources videos page.

Also please take a look on the Machine Learning Knowledge Base page.
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https://doc.opendtect.org/7.0.0/doc/dgb_userdoc/Default.htm#machine_learning.htm?TocPath=3%2520Machine%2520Learning%257C_____0
https://doc.opendtect.org/7.0.0/doc/dgb_userdoc/Default.htm#machine_learning.htm?TocPath=3%2520Machine%2520Learning%257C_____0
https://doc.opendtect.org/7.0.0/doc/dgb_userdoc/Default.htm
https://www.youtube.com/playlist?list=PLusfAjN1yKjEFrJmQzyquzRHOMuVS5kqH
https://www.youtube.com/playlist?list=PLusfAjN1yKjEFrJmQzyquzRHOMuVS5kqH
https://dgbes.com/resources/videos/tags/machine-learning
https://dgbes.com/resources/knowledge-base/machine-learning

For more information, please contact dGB at info@dgbes.com.
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2.6.1 Log-Log Density
Required licenses: OpendTect Pro & Machine Learning

TheWell Log Prediction workflow in this section is a Supervised Machine Learn-
ing workflow and require only well logs as inputs.

The target logs are used for generating/predicting missing logs.

Log Prediction produces continuous logs.

Exercise objective:

We can predict missing logs using the log-log prediction tool, which is part of the machine learning
plugin. In this exercise, we want to predict the Density log.

Well data Preparation
Well(s) used as input data need to be available in the survey. If they are not: import wells
(track, logs, markers, optionally time-depth curve or checkshot).

Workflow: = Rl

i g@E L H e

Control Center [= I

1. Open the Machine Learning Control Center with the &, icon. . D
v Project | Z:\Demo-Surveys\F3_Demo_2023_Training
lg v Workflows
= Wells
2. Click on Wells. #E-.. T

B seane
-
Hs-snm‘ +

Wells
-»ls

Pre-trained

Models

9. MNeurdl
Networks
o)

Using Custom Python 3.9.13 environment odmipython-cudal13

3. Select Log-Log prediction, and Hit Go.

Workflow cont'd: T C
> &
Eesweross]
In the Extract Data tab s = T

4. Press Select - <Select Well Data>

5. New window will pop up <Select logs for data extraction

Log wpscaling to (m) | 0.1524
Edract between |<startof data> | | <End of data> -
Extra 2 adove/below (m) | 0 0
Stepout from center kog ssmple (10 1]
£dge/Gap Polcy @ Exclude incomplete O Add cata

Oulput Daop Learaing Fxarrpla Data | ][ satoct .| [ wEaract

8 SdecLogsor Dot Emcten - 0 x
@ V8 () Mcmiamn v Seeaone st of ata> v <Endofdoie> ~ Ta 14, shovt hore v % Bsebtmptiogs v
2 z L & L i3 put Log:
Well rare AL Wel Tipe X(n) v(m) ™O@)  TSE ki) oLim) o @® w o otk # RAOB VL Seaface  WESIL
1R Quinn  E055M GMIEO0 L6300 166500 0K - - LE] [ Eul)
—
2 os Junn cpw  ome wew  wan - =

et Juen wnaw ormo v e e _ 3G Eaun D R = =




Workflow cont’d:

6.

Sonic). The color of the selected logs cells will turn to blue

7. Select the target logs (RHOB), the color of the targeted log cells will turn to orange

8. Press on Ok

8 et g for Dt rtction
@ V8 Hyoemanw

el name

1 F021
2 F032
|3 Fo34

4 Fo1

well Type
& inove
& Unkoon
& unkoown

© Unknown

SESHI0  6080126.00
61510100 608989100
samssss  ossess?
wmnt e

 Select Zone <Start of datm> -
x(m) ¥ (m)

(0655400 6012600

Q910000 608s100

Gossos Gonseesy

607900.00 SOTT21.00

1695.00 1665.00
214000 211000
204800 pe
120180 1672.36
ToMD(m)  TOSS(m)
1695.00 1665.00
214000 21000
204800 e
170100 167236

> |cendoldne « BB Mo i Showhone

TOMO(m)  TOSS (m)

30.00

endoiimn | B B M stowione

K8 (m)

xa(m)

GL{m)

GL(m)

In the select logs for data extraction window, select the Input logs that will be used (GR and

e J oo
Workflow cont’d: e
@ etract IR Train  «# Apply
)= =l 8
Select Well Data
9. In the Log-Log prediction window, i b i) . -0
. | Fo2-1 GR RHOB
All wells, input logs, and Targets should be |Fo3-2 or
H - | Fo3-4
listed each at the appropriate column '
10. Set the level of extraction
11. Give a name to the extracted example
12. Press on Extract
Log upscaling to (m) | 0.1524
Extract between | <Start of data> ~ | <End of data>  ~
Extra Z above/below (m) | 0
Stepout from center log sample |10 <
Edge/Gap Policy @ Exclude incomplete O Add data
Output Deep Learning Example Data | Well log Extraction || © Select ... | | Extract

Dom @
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Workflow cont’'d:

& Log-Log Prediction = o x

Input Deep Learning Example Data | Well log Extraction ~||© select...| |}
13. The Train tab get activated. Train the
extracted examples data using suitable
Iearnlng a|gOI’Ithm. Select 5CI|(It-|ea rn / Output Deep Learning Model | Model to Predict RHOB{_SCsk-t_xcseost “| © Select ... '}
XGBoost. Training Parameters @
Machine learning platform €3
Scikit-leam v (x)
Different machine learning platforms and %
parameters can be tested. Keep the
defaults parameters.
14. Specify a new Output model name (e.g.
Model_to Predict RHOB_Scikit_XGBoost).
15. Press Run.
Training Parameters
13 H “® Machine learning platform:
16. You should see “ Training Successful e . Do | ©
Workflow cont'd: Y— - o o«
@ EBdract i@ Train ¥ Apply
Survey | F3_Demo_2023_Training v || © Select ...
17. Select the “Apply” tab it
. . odel | ¥ AL Prediction-model
18. Highlight the model name g e R — =
[ : ]
D)

The Survey and Training model can be
modified in here.

19. Press Proceed.

) Fame: Model to Predict RHOB_Scikit_XGBoost
Log Prediction

of inputs: 2
: RE

4 May 2023, 12:24:23
Wed 24 May 2023, 12:24:
Object ID: 100060.57

o 1@
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Workflow cont’d:

20. The “Apply” training model’ window pops
up.

In this window we will Select the input logs
(GR and Sonic) for the blind well FO6-1, on
which we will apply the trained model and
predict the target log (RHOB). Then Press OK.

21. Apply the trained model to a blind
well.

22. Type a new name for the predicted log

23.

Press Run to continue.

@ ViSO

@ Apply Model to Predict RHOB_Scikit_XGBoost - o x
select well Data

Apply to
F06-1

Wells

Output Z step (m) | 0.1524
Create between | <Start of data> ~  <End of data> v

Extra Z above/below (m) | 0 | |o
Log name for 'RHOB' g/cc (Gram/cm3) v
(Crn ) Qo | @

¥4 Domain MD ~ Select Zone <Start of data> - |<End of data> - [ [ B L4 Show None ~ %, | = select Input Logs ~

Well name UWI DT GR MP LITHO OTH PHI RHOB VEL
1 o2 [E I [ I B e —
2 Fo32 [ ! r 7 [ [ |
3 Fos4 [ N N I (N A I—
4 oo I e

Workflow cont’d:

We can QC prediction results by displaying
the predicted log adjacent to the recorded
input log:

24. Click on the Well Manager icon A_l .

25. Select the well “F06-1” and the logs
“Density” and “Density-Predicted”.

26. Click on view logs icon &

[ rm——

U BH A

-

U

Ll

i
2Bl iy

Free spoceom dkz L3 T

Density Density-Predicted

RHOB - Model to Predict RHOB_Scikit_XGBoost - F06-1 (g/cc)

Density - F06-1 (g/ cc)

MD (m)

1200

1400
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Workflow cont’d:

If the results are satisfactory, go back to
the “Apply training” window, and apply
the trained model to the rest of the wells
where you want to predict density log.

27. Select all wells.

28. Type a new name and Press Run to
continue.

'@ Apply "Model to Predict RHOB_Scikit_XGBoost' - =}
Select Well Data

Apply to Wells
F02-1
F03-2
FO3-4

Output Z step (m) | 0.1524
Create between <Startof data> ~ | <End of data> w

Extra Z above/below (m) | 0 1]

Log name for 'RHOB' 18_Scikit_XGBoost |  g/ec (Gram/cms3)

=
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2.6.2 Lithology Classification

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict lithology logs using the “Lithology classification tool”, which is part of the machine
learning plugin.

Well data Preparation
Well(s) need to be available in the survey. If not, import wells (track, logs, markers,
optionally time-depth curve or checkshot).

@ Mansge Wels - o

@ EE Fier

'S
e

o - Log

(O oensity.

O Sonic

[ Gamma Ray

O Porosity

[ P-impadanca

[ P-impedance_rel

Ove

O vp_su

Ovs su

O] Density_gL1

(0 uitholog (10=sand 15=siit 20=chty shale 30=¢
[ P - AL Pradicon-modal

[T et

|4 & ro3-4
|2 @ 7061

|

A=

Workflow: B

For the purpose of this exercise, we will create a fake
lithology log using Mathematics (as no lithology log
exists in the survey)

1. Open the Well Manager 4. ki
no_2023_Training\Kelllnfo

021, 10:13:06

2. Select All Wells in the "Well Manager”, and Hit
Create. =

Free soace on disk: 149 TG

seirEls=

CE T

-5

(o=@

Workflow cont’d:

3. In the “Calculate a New Well Log” window, Specify the parameters as indicated
below to create a fake litho-log:

@ Cruare New Logs

a. Sel e Ct: Math F un Ction S. Calculate new 1095 for 'FO2-1', FO3-2', FO3-4, 'FO6-1"

MathFunctions  ~+ sqrt (Squore root) ~ |_Tnsert | |5 Rock Physics

Formula (ke 'cen / sonic’) [GR < 407 1: 3

b. Type the Formula: GR <407 1:2

For 'GR' use Gamma Ray. § am

c. Hit Set.

d. Select Gamma Ray log.

Formula result Is | Classification ¥ [UTHO

e. Select for the Formula Results, Classification
Output sample distance |0.1524 Creet  Inter/entrapolate input logs? Ho.

HName for new log | Litha._Fake '} New log's unit of measure

g. Select Output Unit of Measures: None.

4. Press Run.

f. Type Name for new log: Litho_Fake. =5 )
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Workflow cont’'d:

Open the Machine Learning Control Center
with the b, icon.

Click on Wells.
Select Lithology classification.

Hit Go.

@ Machine Leaming Control Center -

M & - 8§

Project | Z:\Demo-Surveys\F3_Demo_2023_Training

v Workflows
B3
-
&: Seismic
Seismic +
wp LS Wels

Pre-trained
i Models

Log-Log prediction
Lithology classification

} Neural
Networks
Cea

(0 )@ ®

Using Custom Python 3.9.13 environment odmipython-cudall3

Workflow cont’d:

In the Extract Data tab

9. Press Select - <Select Well Data>

10. New window will pop up <Select logs for data
extraction

& Lenoiogy Camricaion -

Gedan B Ton < Ay

2 &

Log upecaling to (m) | 0.152¢
DUBHbeween <SATCdIA> v <EdOTdil> v
Dira 2 sbevelbeiow (m) 0 )
Stapaut from canter log smpla 10
EdgeiGep Foty @ Exciate nemplete O Add cat

Cutpit Dees Laaming Exzregle Data 01 Emple_Duto_Ltwwlagy_sid] (D zdeat ..

¥ bernat

=D o= 0

8 SeectLogs forData Exacten

ORI

Well rare
1R
2 FR2
3 R4

4 Pl

§ () Momni v sdeazng atoicans v <indofose> v [ [ My [ honehone | Y, WSk mputiogs v
AT WelTpe  K(m) Ym)  TOW(Y)  TSS(M)  KB(m) oin) o7

Ouinonn SN IR LS IS0 3000

Ouinonn  EDLLI  BMOLID 240 0@ XK -

Duinonn 2550 GRSBH  2MEM WA M {

Ouioonn  @POLI MR MK 1623 e \

RHOB VEL

Seaswrfece

L k]

-

Lk

=== I -

L
555

LAt
L EuN]

580

oo EE
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Workflow cont’d:

We will select the following wells : FO03-2, F03-4, and F06-1 for data extraction
and training. F02-1 will be the blind well test

11. In the select logs for data extraction window, select the input logs that will be
used (GR, and Sonic). The color of the selected logs cells will turn to blue

12. Select the Sonic, Gamma Ray, and Density logs

13. Select the target logs, the color of the targeted log cell will turn to crange
14. Select the Litho lo

15. Press on Ok

@ Vil B0 Hyoomeaio  seeazes oo <[ adotans v B § g phseovoimmiogs Y [Bissanpaigs -
well namae wn Well Type X (m) ¥(m) TOMD (m) T3S (m) B (m) GL(m) WVEL Seasurface MFS11 P
1 ROzt & Unknown  604554.00 608012600 1605.00 1665.00 30.00 o - - s - sreon
2 /32 Ounkrown 61910100 G0S99L00 214000 201000 .00 -- » s W22
3 FO34 Ounknown 62925598 GOR2S8S87 204800 0071 3410 W - -aere E SIS
4 FO&1 Ounnown 60790300  SOTR1200 170100 187236 por w - -0 = s8.0m
Jow
Workflow cont’d: @ Lithology Classifcaton - o x
P eaact B Train  + Apply
-
Select Well Data
Wells Inputs Target(s)
= = F03-2 GR | [urvo
We will select the following wells : F02-1, o or
F03-2, F03-4 for data extraction and RHOB
training. FO6-1 will be out blind well test
16. In the Log-Log prediction window,
All wells, input logs, and Targets should be
listed each at the appropriate column
17. Set the level of extraction Log upscaling to (m) 0,152+
Extract between <Start of data> ~  <End of data> ~
18. Give a name to the extracted example Extra Z above/below (m) 0 0
Stepout from center log sample |10
19. Press on Extract Edge/Gap Policy ® Exclude incomplete O Add data
Output Deep Learning Example Data _D_L__gxnmp\_e__[)a__lafylhpln_g_y__ﬁt_lﬂ_ hdl © Select ... | | w* Extract
Deose | @
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Workflow cont’d:

@ Lithology Classification - o x
& ptract P Train ¥ Apply
20 C“Ck on -the “Tra.,'n” tab Input Deep Learning Example Data | DL_Bxample_Data_Lithology_sti0 ~ || O select ... )
Training Type & New (] Resume [ Transfer
21. We train the extracted examples using the
default learning algorithm (e.g. Scikit-learn). ot Deep Learing Mod [odel ik e Precict Lihe Oseeat... | |}
Select “New” at the Training Type checkbox. =
Maching leaming platform
The default algorithm scikit-learn gives decent [eonerr ] g
results when applied. This exercise should not be o @
using keras-tensorflow as the training platform,
except for R&D purposes.Tensorflow has not
proven to be stable for these workflows, and it
should be strongly advised not to use it for this
workflow.
22. Keep the defaults parameters.
23. Specify a new Output model name (e.g.
Model_Scikit-learn_Predict_Litho) e=lo=10
Scikit-learn -
24, Press Run. =)
25. You should see “ Training Successful
Workflow cont’d:
& Lithology Classification - =] x
Oedract 8 Train | # Apply
Survey | F3_Demo_2023_Training v || © Select ...
Filter
26. Select the “Apply” tab e o rackt RO8_Sc Bt =)
Model_Scikit-learn_Predict_Litho o
T}

27. Highlight the model name

28. Press Proceed.

€D |Name: Model Kexas Predict_Litho
Type: Log-Log Prediction
Number of i 4
Oucpuz:
Created by
Created at

ham
30 May 2023, 13:56€:2€
Last Modified: Tue 30 May 2023, 14:10:10
Object ID: 100060.5%

0w @
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Workflow cont’d:

& Apply ‘Model_Keras_Predict_Litho' - ] x
Selact Well Datdl

29. The “Apply” training model’ window pops Apply to Wwells
up. F02-1

30. In the “Select Well Data” window, Apply
the trained model to a blind well. Select
F02-1 and the log (or logs) on which to

apply the trained model and predict the Output Z step (m) | 0.1524 ]
taFQEt lOg (99 DT- GR! RHOB) Create between | <Start of data> | | <End of data> v:
Extra Z above/below (m) :0 \ \ 0

31. Type a new name for the predicted log

Log name for 'LITHO'
32. Press Run to continue. s
(D= | @

a ta Extra
QVHAS O
#1 Domain MD ~ Select Zone <Start of data> | <Endofdata> ~ [ [ ku [ ShowNone ~| . [@sslect Input Logs ~
Well ame uwi DT GR M LITHO OTH PHI RHOB VEL
1oz N [ [
2o I I
3 o L | I I
1 roet [T I D N
Workflow cont’d:
@ Manage Wells - o x
. . o @ [*& Fiter € = - Log
QC results by displaying the predicted EREE IS Doty *|B
log adjacent to the recorded log @ mes 8 |0 ey W=
O & ros-1 1| |D porosty o
[ P-Impedance ¥
F |0 p-impedance_rel %
ﬁ: ISV» *| &
= . Vp_BLI 1
33. Click on the Well Manager A1 icon. B & D G
- ) Density_BLI 5
[ Litholeg (10=sand 15=sikt 20=sikty shale 30=shale)
. . DMP-ALmu_mn-mu "‘
34. Select the blind well F02-1, Litho_Fake i odel Sdkbieom_fredet_litho «| W
and Model_Scikit-learn_Predict_litho. ‘:’
- . - '
35. Click on view logs. AR e ot . [_creat .
olsu:h:: coordinate: (606554.00,6080126.00) = 362/33¢ B
Reference Datum Elevation (KB]: 30.00m
Replacescat velseity [fcom KB to SRD): 2000m/s
File name: FO2-1l.well
Location: Z:\Demo-Surveys\F3_Demo_2023 Training\Welllnfo
i:z?m;d;!::df Wed 31 May 2023, 11:07:36
|Storage cype: dGB b
= =
Q

Free space on disk: 1.49 TB
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Workflow cont’'d:

Predicted Litho log Original Litho log

36. Compare the original vs predicted
litho-log.

rgm)

1000

Workflow cont’d:

If the results are satisfactory, go back to
the “Apply training” window, and apply Select Well Data
the trained model to all the wells where Apply to Wells
you want to make predictions. F02-1
=
F06-1

37. Select All Wells. Keep default
parameters as indicated in the

WIndOW. Output Z step (m) | 0.1524
. Create betw EEFss v | | lFS4 ™
38. Press Run to continue. e
Extra Z above/below (m) | 0 0

Log name for 'LITHO' |s_Predict_Litho_4| |

0o | @
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2.6.3 Seismic Classification - Supervised 3D

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict seismic geo-bodies using the “Seismic Classification (supervised 3D)" tool which is part
of the machine learning plugin. In this exercise, we want to predict Chimney location.

Seismic data Preparation

Seismic need to be available in the survey. If not, import seismic, and interpret key
seismic bodies locations (e.g. Chimney yes, Chimney no), or use existing trained model.

Workflow:

2. Click on Seismic.

and Hit Go.

1. Open the Machine Learning Control Center with the ™ icon.

3. Select Seismic Classification (Supervised) under 3D Seismic,

T m@nyny

AT coN A el |
Project | Z:\Demo-Surveys\F3_Demo_2023_Training
~ W 3D Seismic

E‘IE _ ionon baesd Seiemi Facies
ol 7 = =
Sutmic
v 2@ 2D Seismic

Horizon-based Seismic Facies

smic Classification (Suwervsed)

| B
—

Salimmic Image Ssgmantstion
Seismic Image Regression

Bz
‘ Wels
v

-

Models
B ol
*© Hetworks
<
(Do | @ B

Using Custom Fython 3.9.13 emdronment edmipython-cudall3

Workflow cont’d:

4. The “Seismic Classification” window
pops up.

5. Select Input Data in the “Extract
Data” tab.

6. Inthe “Seismic data field, Select the
Original seismic, and “2 Steering BG
Detailed” as an input

7. Use the default image dimensions

@ Seismic Clazsfication - 30

Pedrat B Train <+ Apply

ATE you selecting Seismic and PortSets Data from this survey onh? @ Yes O Mo

(a] ~ Filter

Seismic Dota |4 ¥ 1 Orignal Seismics

[ @ 2 steering 8G Detailed
# 3 Steering 8G Background
@ 3o Steering PCAL11 MF225
&) 3b Steering FFT225 MF113
9 4 Dip steered median fiter
@ 5 ChimneyCube
@ 6 Wheeler-stratak-slicing
@ 72 AlLube st
) 7o Al Cube from HorizonCube:
) 8 PorasityCube from HC-NN
& b Gamma from HorizanZube
) 9-1 Similarity on FEF seismic
& 92 Dip-staerad defusion fiter
# 9-3 Foult enhancement fiter
@ £PS_1250
& mask
@ veloaty model (1NT)
# Veloity model (RMS)

00000000000000000

Emege dimenions [inti17] (=] [tz (2] [zias [z]

Edge/Gap Policy @ Exclude incomplete O Add cata

Output Deep Learning Example Data |

- [s] S
*n &
a - Component
O [Ominedp
O Crosstine dip
[ ]
0}
][ seer...| [ wearaer
@ eroceed || ) close 9
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Workflow cont’d:

& Seismic Classification - 3D - (m] x
< Bxdract  §R Train  « Apply
sl - LY
B Input Data
8' ClICk on in Labe'S . Click on the plus icon to select PointSets and add dasses.
Class name Count PointSets o
Class 1 Chimneys no 152 "Chimneys no' /
Class2 Chimneys yes 152 ‘Chimneys yes' —
9. Click on add class
and select the first and
the 2@ class example
locations (e.qg. Chimney yes,
and chimney no).
10. Add a name for example
data output and hit on
11. Hit on Extract
Output Deep Learning Example Dato [ DL_Example_Chimney_17x173 | (© select...| [ Extract | O

o | @

Workflow cont’d:

@ Seismic Classfication - 3D - o X
12. Click on the Train tab O exred [T sooy
Input Deep Leaming Example Data [ DL_Example_Chimney_17x17:33 | (@select...] |} [Q

Training Type A New  [JResume [ Transfer

Select the example data.

13. Toggle on New for the training type Tpppg:“L‘ ‘ &
Machine leaming platform s
14. Give a name to the output model Keres (ensorto) ’ g
15. Select one of the learning = 2
algorithnm (e.g. Keras-tensorflow) to
train the extracted examples data.
Different machine learning platforms and
16. Press on Run. parameters can be tested. Keep the
defaults parameters.
0o= @

Machine learning platform

Keras (tensorflow) v

Wait till you see the training is
complete and successuful. =3
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Workflow cont’d:

& Seismic Classification - 30 - o ®
& Baract W Train
. 1 Survey | F3_Demo_2020_ML ~| | O select ...
17. Select the "Apply” tab. ' - .
Model o |
18. Select the trained model. o
o

19. Press Proceed.

: Model_Keras_Chimney
: Seismic Classification

Number of inputs: 1
Number of possible cutputs:

13:26:1

6:18
., 13:26:58

Erewi] 0o 1@

Workflow cont’d:

20. In the “Apply created training model” window, Verify, all the default selected input 3D
cubes are correct.

a. To optimize computation time, Modify “Volume sub-selection” and set it to an
area of interest, where Chimneys have been interpreted (e.g. Inline range: 670-
710, Crossline range: 300-1250).

b. Specify a new name for the 3D output cubes: Classification, Chimney yes,
Chimney no, and Confidence. Toggle on Chimney yes.

@ Apply ‘Model_Keras_Chimney’ - o X
- Predict using O 2D data @ 3D data
21. Press Run to continue. _
Input for '1 Original Seismics' * |1 Original Seismics || © select ...
Volume subselemnn' 670/300-710/1250 (463 samples) I O select ...
& Positions — a X
Specify Positions Output prefix | Model_Keras_Chimney v
[ output 'Classification’  Model_Keras_Chimney - Classificatio O Select Cavs
Volume subselection Range Ml d d
O output 'Chimneys no'  Model_Keras_Chimney - Chimneys n. CBVS
In-line range (670 |+ |710 '+
- ) 4 Output 'Chimneys yes' | Model_Keras_Chimney - Chimneysyes  ~ || ©) Select ... || ¥ CBVS v
Cross-line range (300 |5 |1250 =
b ) [ output 'Confidence’ | Model_Keras_Chimney - Confidence D Select CBVS

Time range (ms) [0 1] [1848
Batch size |32 -

€3 cancel o Predictusing ® GPU O CPU

[ Exacute in Batch |} options ...

o /@
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Workflow cont’d:

QC results: display the predicted
Chimney Yes probability 3D cube

22. Right Click on the: Scene > Inline > Add
and select Data.

23. Select the predicted 3D Chimney location
probability (e.g. Chimney_yes), and overlay
the seismic (e.g. 1 Original Seismic).

Modify the Inline number to be within the
input range.

24. Right-click on the Inline number, and Type
in the Inline field: iniiness0 2: .

SN

El2[» S

Free pa0e on dsk: 14878

(@=)0
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2.6.4 Seismic Unet 3D Fault Predictor

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict fault's location using the “Seismic — Pre-trained models - Unet 3D Fault Predictor” tool
which is part of the machine learning plugin. In this exercise, we want to predict faults location.

Seismic data Preparation

Seismic need to be available in the survey. If not, import seismic, and interpret some “key fault”
locations or use an existing trained model.

FrR@HLH N

Workflow: pedll
AR
Project | D:\ODData\Dema Surveys\F3_Demo_2023_ML

1. Open the Machine Learning Control Center with the =

 Wells
: Lgli Wells NPHI from RHOB, GR, DT and MD
con. -l RHOB from GR, DT and MD
~ Seismic
BB coiornic g\um GeoLab AJAX
. « . » Lundin GeoLab DeSmil
2. Click on “Pre-trained Models”. Lundin Geolah SimpleDencise
B 2 seismic + 2 Lundin Geolab SimpleHmult
1S Wells Net VGG19 20 Fault Predicto
. Stor” = |
3. Select the “Unet 3D Fault Predictor” and Press Go. P Az by
:;"l-Models © UNet Supersample Bin Size
& peural @pre-trained model information| 8] % W
= Networks

(O] @ @

Using Custom Python 3.9.13 envirenment odmipython-cuda113

Workflow cont’d:

Predict using O 20 data ® 30 data
4. The "Apply Unet 3D Fault Predictor” et St ot B :ml ———
ind Apply Overlap (%) [inl: 10 3] [en: 1013] [z: 10121 merge made |slend
window pops up Volume subselection | 100/300-750/1250 {463 samples) O select ...
Outpu(‘Fﬂu\:\'n!l:m! *||© select ... | CBVS v

5. Select Input Cube (e.g. 4 Dip steered TR
median filter). 2 uvate i soch

% Options ..

0= | @
6. Specify a new name for the “Output e
Fault Volume to Cube” (e.g.
‘Fault_Prob_Unet).
If not enough GPU memory, use CPU or crop
the Volume in subselection.

7. Press Run.

8. When the processing finish, Press
button © to close the Progress Viewer
window.

Processing fished successhully
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Workflow cont’d: e

QC the output fault probability results on the In-line 680.

) POroaity AL

b Pam i "
9. Right Mouse click on In-line = Add and select Data OF powes @
> Store. Select the created Fault Probability cube b= el
(e.g. Fault_Prob_Unet_In680), and then Press OK. ‘T‘ree;m i ﬁ
Elements Color
10. Type in the Inline field: 680, and then Press Enter. Scene 1
v iy Indine
v [ 680
The same way, add to the display, the existing Thinned [T Faull Pigh Une{ TEpo... EX
likelihood probability display. & soec - o x
11. Right-Click on Inline 680 > Add > Attribute ® st .
>Stored. Select the existing thinned fault likelihood RO
(e.g. Fault_Likelihood_Thinned_from_DSMF_seis), =
and Press OK. -
Tree scene 1 (-]
Elements Color
v ® e

v [ 680

2 Fault_Prob_Unet_Ini680_AL N o

Workflow cont’d:

Predicted fault probability (un-thinned)

12. Display the predicted fault probability, and
Compare with the thinned fault likelihood.

Note:

The thinned fault likelihood, contains more small
faults and noise. Whereas the predicted fault
probability, contains more faults information and
less noise.

The predicted fault probability is un-thinned.
To be able to make a fair comparison with the
thinned fault likelihood, a thinning needs to be
applied to the predicted fault probability.

In the next steps we will apply the thinning.
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Workflow cont’d:

The next step, is to apply a thinning to the
predicted fault probability.

- = 5 [ [ = T 44
_ hre @ ARGGE R
13. Select: faults and fractures > 3D icon &g
f@ Faults and Fractures 3D Control Center - o x
14. The Faults and Fractures 3D Control Center Availabl Fiters
window POpS up. Select Filters > &5 o Db st din i
Skeletonization. 2] RidgeEatancomen i
15. Press Go. if Filters
I‘;&@ Planes
% Tools
@+
Workflow cont’d:
16. The Volume Skeletonization window pops e
up. nput Volume 5| ! [Faut_Prob_Unet_ini680_AL ~| ' © Select.
Volume subse‘eci!unIE-EU-’SDU-GBU-’1232 (463 samples) | © Select
17. Set the parameters as specified in the L (R
WindOW: Keepvalue above ® Yes O No
a. Volume subselection: Inline range = 680 e
b. Threshold: 0.5 o et
€ | & Run | Clo:
c. Type a new name for the “Output Qooe | Qrue
Cube” e.g. - o x
Thinned_ft_prob_Unet_|680_threshold.5
18. Press Run.
19.

The Progress Viewer window pops up.

Once the computation is done, Press
Close icon. ©

Ena of precess: *

Fana s

Finisneq pacch processiog.

Suzs03ing Sniched succosshilly.
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Workflow cont’d:

20. Display: the new thinned predicted fault
probability. Right mouse click on the Inline 680
> Add > Attributes. Select the new thinned
predicted fault probability (e.g
Thinned_ft_prob_Unet_|680_threshold.5).

21. Compare with the existing thinned fault likelihood.

Note that the thinned fault likelihood contains
small-scale faults and noise, whereas the thinned
predicted fault probability outputs more
continuous faults information and less noise.

Thinned predicted fault probability
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2.6.5 3D Seismic and Wells RockProperty
Prediction

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:
To predict rock property using the 3D Seismic + Wells, Rock Property Prediction tool which is part

of the Machine Learning plugin. In this exercise, we want to predict a Porosity cube.

Well data Preparation
Seismic (and/or attributes) and Well(s) need to be available in the survey. If not, import
seismic and wells (track, logs, markers, time-depth curve or checkshot).

Ry L HET LT

7. Press the Logs Tab.

Workflow: B &=m
Project | D:\ODData\Demo Surveys\F3_Demo_2023_ML
1. Open the Machine Learning Control Center with § « 1} Synthetics from pseudowells
the E-'._ iCOﬂ . ';-EWE‘”S g:;lﬁ;ve:!se:eﬁ:;;nntatmn
_ Supervised Classification
4 Sai ~ Ay Synthetics from real wells
2. Click on Seismic + Wells > 3D Seismic B | ot
— Supervised Regression
42 Seismic + Supervised Classification
3. Select Rock Property Prediction, and Press o 3 [ s |
Pre-trained
Go. S
.\. Neural
o  Networks
9o
Using Custom Python 3.9.13 environment odmipython-cuda113
Workflow cont'd: bl i
&P Extract. rein v Apply
Are you selecting Seismic and Well Data from this survey only? O Yes ) No - @ a |
EinputData B Logs
8 -= Filter
4. The “Property Prediction from Seismic” window e s metantitor W)
B & 7a Al Cube Std o
pops up. - o o il
5. Select the Extract and Input Data tabs.
B |0 @ Fault_Ukelinood_Thinned_from_DSMF
. . . . . o Faull_Mask
For seismic attributes, select 4 Dip steered median ) # Fol ok KR 2
filter and 7a Al Cube Std twrorrnd
)@ bt Pt s
6. Select: Survey, Target Log (e.g. Porosity), and T
Wells as indicated in the window. P R B P
Edge/Gep Policy O Exchude incomplete () Add data
Output Deep Leamning Example Data - | O Select ... [wBxtract
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Workflow cont’d:

8. Click the ‘Select Well Data’ button

9. In the "Select Logs for Data Extraction”
window, Select the PHI (Porosity) logs for wells
F03-2, FO3-4 and F06-1 by left clicking and
dragging to select them. Observe that the
‘Select Target Logs’ needs to be set in the drop-
down menu. Once selected, the green color for
the logs turns yellow, indicating that they have
been selected.

10. Press OK.

The well FO2-1 is not selected,
and will be used as a blind well.

GBact R T Apply

Are you selecting Selsmic and Well Data from this suvey onhy? @ Yes O No = B &
B 1nput Data -_logr,
Select Well Data

Wells

Extract between <Start of data>

Extra 7 above/below (ms) [0

Oulput Deep Leamning Examplz Data

o

Target(s)

<End of data>

O Select ...| @ Exract

Ero=s) (@ | @

Workflow cont’d:

11. The “Input Data” and “Logs” tabs should
now be set

=

default parameters as indicated in this

12. Specify a new name for the QOutput
Deep Learning Example Data (e.g.
DL_Example_Data_Porosity_st1x1x33z4)

13. Click “Extract”

window. e
[FO3-4
FO6-1

@odract B Train - # Apply

Input data can be modified using the Ara you selscting Selsmic and Well Data from this survey only? © Yes
“Select Well Data” button. Keep the B Input ot

B Logs

Select Well Datal

Wells

Extract between <Start of data>

Extra Z above/below (ms) 0 (1]

Output Deep Learning Example Data

B=]

<End of data>

> No 2 o &

Target(s)

- |©Select ...| | w Extract

G (O @
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Workflow cont’d:

14. The Train tab gets activated. Train the extracted
examples data using the default learning

Sldract B Tan o doply

It Doy Loaming Exaemple Data [ Examgle_Dta, Porosity st1xixdict - (@Scest

algorithm Scikit-learn (Ensemble: Random g
Forests). a
Different machine learning platforms
and parameters can be tested.
Keep the default parameters for this
exercise. G=L)
15. Specify a new Output model name e.g.
DL_Ex_Predict_Porosity. _ _ )
16. Under the Parameters Tab, select “Ensemble” 5
and “Random Forests” 2
17. Go back to the “Training” tab and Press Run.
( Qo= | @
Workflow cont’d: =
18. Press Close in the “Machine Learning training
log” window, when the processing finishes, indicated
by the line “Finished Batch Processing” ‘
1
[Bom=] e sreosd
Outouk Deep Laarning Model DL_Ex_Procket_Porcaity O Sebect ... L e
o 3
Q
Eea] oo @
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P Extract  §R Troin  + Apply

Workflow cont’d:

Filtar
Model [ DX Predict_Porosty | =]
Y
g
19. In the Apply tab, Select the Model &
and press Proceed..
20. In the Pop-up window, select
Predict using “3D data”, “Apply
along” 2 In-line. Double-check that : —
the volumes are set correctly and Tize: pussesty Predicsion fien seimtcs
give the output a name (e.g. ’
ML_Porosity_Prediction) L 51 san 2623, p5ais2
21. Set the “Volume Subselection” as
@ Postions o o Elon o
d |
— a S
wmme:ik::: :i:ge T ® a | Predict using C 20 data I@:oml
_- Awhahqvbhne -
Cross-line range 300 3] 1250 % | Tnput for 4 Dip steered median filter' & |4 Dip stoered medion fer ] (@ Select ...|
Time range (ms) 0 « 1848 5 Input for '7a Al Cube Std' ' | 7a Al Cube Std | @ select ...|
Qcancel @ vmmsunssmk-i Sl N e L, I O Sefext ...
i Output 'PHI| ML_Forosity_Prediction - o select ...| | cavs -
. « » 4] Exeoute In Batch |5 Options ...
22. Click “Run —
Workflow cont’d: '3‘ u 7
When the computation finishes, close the Progress
Viewer window.
QC results by displaying the predicted Porosity on
the test Inline, 362) and overlay the crossing well -
F02-1, with the porosity log. @ sass - o %
Salect Layer 2
P . . qul'—J
23. Right Mouse Click on the Inline folder > Add © et [ P Lhass e tom_ DS
Default Data e.g. Deep Steered Median Filter. © s | T e i
Type: 362 in the In-line field Change the In-line o ey R R e
no to 362 . .m _
inine]362 [} Qo] (@i

[o2s JIF W05 |mmporosity
24. Right Mouse Click on the In-line 362 > Add >

Attributes. Select under Stored the new
predicted porosity (e.g.
ML_Porosity_Prediction), and

Press “OK".

25. Modify the Porosity colour limit to (0.25-0.35)
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Workflow cont’d:

26. Right Mouse Click on the well folder> Add,

=

& Lo
Select the well F02-1, Hit Ok. Select Input Wells
27. Right Mouse Click on the Well F02-1 > Display e =
> Properties, Select Porosity log, Change the Bl | %
color bar to Porosity. Modify the Porosity color
range similar to the predicted porosity cube
range (0.25 - 0.33). O] (@1
-.._2016_training_v&\Wellinfo\F 02-1.well
28. Apply to All Wells, and Hit Close. @ ity propesicsf O21 oo B
LeftLog  RightLog  Markers  Track
0.25 035 |ENPorosity In—lln Select log Porasity -
. Specify data range ~ | O Fiip
Log 1ange (minimax) 0 25765201 [0 407581 | O Logarithmic
Siyle & Welllog [] Seismic [ Log tube
Line thickness 1 =
Line color | N | |8 Blue =
Fil Right of log = | [ single color
Fill with  Porosity = | O flip color table
3 Porosiy A CECI | (ET
Log display width (m) i 250
Apply 1o all wells
[] Save a3 Default @ e
Workflow cont’d: b Pestions -0 ox
Specify Pasitons
Volume subselaction |Rangs L4 !leﬂ
inline Range fic0 = [ts0 =
A . i Crossline Range 00 =] [1280 =]
If result is satisfactory, go back to the previous a——

Step and Apply the trained model to the entire
survey.

29. Go back to the Apply tab > Volume sub-

selection > In-line range and reset of the
entire range.

30. Keep all other default parameters and
Press Run to continue.
@ Apply 'DL_Ex_Pradict_Porosity’
Apply along In-line

Input for '4 Dip steered median filter' *& 4 Dip steered median filter

IQOK Qc:ma|| OHnlp‘

~ | (Elselect...
Input for '7a Al Cube Std' "= 7a Al Cube Std v |©Select...
Volume subselection [ 100/300-750/1250 (463 samples) | [© Select ...

Qutput 'PHI'" ML_Porosity_Prediction v (@ Select...| @IcBVS 2

@ Execute in Batch [4.:Options ....|

(Zrun ) (@Cise | @

- 408 -




2.6.6 Seismic Image to Image - Fault Pre-
diction

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To predict seismic features using the Seismic Image to Image workflow in the machine learning
plugin. In this exercise, we will predict fault locations from seismic data.

Note: To predict real faults use the pre-trained U-Net fault predictor

In this exercise we train a U-Net to predict faults from pre-processed seismic input. The input is
Edge-Preserved Smoothed (EPS) seismic data. The target is a mask volume with ones (faults)
and zeros (no-faults) that was created from Thinned Fault Likelihood (TFL) computed from the
EPS volume. Note that from a geoscientific perspective this is not necessary, since we do not
need a machine learning model to predict a desired outcome that can be computed directly with
an algorithm. The main purpose of this exercise is to learn how to run image-to-image
workflows.

: ,</'
Input EPS* seismic Target mask (0, 1) of TFL* from EPS

*EPS and TFL-mask are NOT delivered with F3. To replicate this workflow first create EPS and TFL (from EPS) in the Faults &
Fractures plugin. Next, create a mask from TFL with the mathematics attribute using this formula: TFL > 0.01 7 1:0

Exercise objective:

Note: heavy GPU requirements

In this exercise we create 1008 cubelets of
128x128x128 samples. These cubelets are -
extracted from half the input - and target R~ -’4 g @ YN
volumes. The trained U-Net is applied to the full
volume. Application is very fast (minutes) but
training takes several hours on a GPU. The
graphics card used is a Nvidia GeForce with 11
GB DDR6 memory. In principle, the exercise

(AN I
Project | Z:\Demo-Surveys\F3_Demo_2023_TERRANUBIS

o _g v 40 3D Seismic
can also be run on a CPU but then training may EEWQHS Horizon-based Seismic Facies
take several days. i Iﬁs&msﬂa:ﬂﬁmmﬂﬁm_l
Seismic Image Segmentation
@ e Seismic Image Regression
. v 20 2D Seismic
WO I'kfl ow: — Horizon-based Seismic Facies
L2 Seismic + Seismic Classification (Supervised)
1. Open the Machine Learning Control Center - |S Wells e S e
th the . iCOI"] Seismic Image Regression
wi : Pre-trained
== Models

2. Click on Seismic.

Neural
o , & e =
3. Select Seismic Image Segmentation and
Press Go. o ®

Using Custom Python 3.9.13 environment odmipython-cuda113
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Workflow cont’d:

4. Seismic Image Transformation window pops up.

&)

6. Inthe Seismic Data list,
Select the EPS volume

7. Specify a name for the
Output Deep Learning Example Data
and Press Proceed.

Tip: Additional seismic attributes can
be added using checkboxes

. Select Input Data in the Extract Data tab.

e > y
QExtract i@ Train v Apply
=+ @ &

 Target 5 Samplng

8 -a Filter

Seismic Data
# BLI_seismic_28deg
# BLI_seismic_8deg
# BLI_trend_RHO 1}
® BLI_trend_VP
® BLI_trend_VS
® BLL_Vp
® BLIVs
# Chimney - Chimneys yes
® Chimney - Classification
# delete-fault-Unet
# DL_Chimney_Model - Chimneys yes
# DL_Chimney_Model_3 - Chimneys yes
® DSMF small
. DSMF_SEGY_COPY
E ® EPS |
= EPS_250
® Facies_Test1 - Classification_425
® Fault Volume
® Fault-prediction-IL655
® Fault-prediction-IL665

n

® BLI_seismic_18deg ()

Output Deep Leaming Example Dataf DL_Faults

© Select ...

Ociose | @

w Extract

Workflow cont'd:

8. The Deep Learning: Target Seismics

Definition window pops up. Select
the Fault Mask Volume

9. Press Proceed [Input Data
Selection] >>

a
PExtract iR Train
* = A
[ Input Data

~ Apply

@ Target (5 Sampling

Seismic Data | ™ 1 Original Seismics.

® 3D-UVQ_50_-20+20

# 4 Dip steered median filter

# 5 ChimneyCube

™ 7a Al Cube Std

 7b Al Cube from HorlzonCube
8a PorosityCube from HC-NN

® &b Gamma from HorizonCube

@ AJAX_on_org_swath

® blank every other trace DSM

B s

Filter

= Fault_Likelihood_Thinr from_DSMF_seis
Fault_Mask

# Fault_Mask_KR_v2

= Malenov Classifcation

# ML_2DUnet_Salt

# ML_Unet_Filled Missing_traces

# Salt_bodies_voxel_connectivity_from_ML_2DUnet
 Salt_mask_all

# Seismic with random missing traces as zeros

Output Deep Learning Example Data  Ex_EPS_Faults

O Select ...

[©roed) [ Bk | @

~ Extract
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Workflow cont’d:

10. In the Input Data window Set the Image
dimensions of the cubelets to 128 x 128 x
128 samples. Note: to extract 2D images, set
one of the dimensions to 0.

@ Scismic Image Segmentation - 3D o

11. Specify the Inline, Crossline, Time Ranges S
and the corresponding Overlap™ percentages =~ mrmee Spot i
to such that we extract approx. 1000 cubelets . ...conFrEaE=Tm= s
from one half of the input and target volumes Range #images *

s g . Selection 1 100-125 , 300-1250 , 0-1848 1008 X (Ind: 126 crl: 128 22 128)
(see image for specifications).

12. Specify a name for the Output Deep
Learning Example Data (e.g.
Ex_EPS_Faults) and Press Extract

Overlap (Yb)hift 2 images

13. When the Extraction is done, press e ——
Crossdine range 300 4 1250 4] Step 1 2 ST
Proceed Twege(ny 0 Hisa Sswe s [E_JE6 )@
Total number of \mages-_iow
Output Deep Learming BExample Data Bx_EPS_Faults. ~ | Oseclect .. ~
Ocee @

*Overlap: if the number of examples that can be extracted from a given range and overlap does not fit exactly, the last example
is extracted from the boundary backwards.

Example cubelets. Dimensions are: 128 x 128 x 128 samples

Input: EPS < . -

Target: TFL mask (1= fault, 0 = no faulf)
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Workflow cont’d:

14. Specify the Output Deep Learning Model
name (e.g. ML_U-
Net_ EPS2TFL_128x128x128)

15. In the Train tab, Select Keras (tensorflow) =
as Machine learning platform Qrtoa RTwn ol

Input Deep Leaming Example Data Ex_EPS_Faults Oselect.. } QU
Training Type & New J Resuma ) Transfer

16. Select the Parameters tab

Output Desp Leaming Mocel ML_U-Net _EPS2TFL_126x126x128 v OSelect ... [}
- (]
()
@
The machine learning plugin supports two
platforms:
Keras (tensorflow) for deep learning
(convolutional neural networks) and Pytorch.
Supported models and training parameters
are specified in the Parameters tab. O | @

Workflow cont'd:

17. In the Parameters tab Select Type U- Tlp:To changeithentmbsrs intheisllders
Net more precisely, click on the corresponding

slider and use the arrow keys

18. Set Batch Size to 2. A U-Net needs a lot
of GPU memory in the training phase. If mentatior
memory is exceeded, training stops with mif;‘::wDI:D::;”‘VELEMME e B
an error message. You can then try to
rerun with a smaller batch size. Try with
the largest possible batch size as
training performance increases with Outpat Deep Learning Model [ ML_U-Net_EPSZTFL_128x128x128 | (@select...] |}
batch size.

Training Type B New Resume () Transfer

19. Set the number of Epochs to 100 (this is
the number of training cycles through all
examples that are offered in batches of
Batch Size).

500

Epachs 100

Early Stopping: 10
Iitial Leaming Rate (1e). -4

Epach drop (%): 33.33

20. Set Early Stopping to 50. This p—
parameter avoids early stopping when pEe
the error does not decrease after this ——0~
number of Epochs.

ceed) (@ dose | @

21. Go back to the Training tab.
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Workflow cont’d:

22. In the Training tab Press Run

23. The Machine Learning training log M Vi) SRS
. . . Machine learning platform:
window pops up. This window can also Keras (ensafion) .
be started by pressing the )| icon.
Press Reload to refresh. m

- ETA: 1:50 - loss: 0.1290 - accuracy: 0.3462 -
- ETA: 1:48 - loss: 0.1286 - accuracy: 0.3511
- ETA: 1:47 - loss: 0.1286 - accuracy: 0.3556
- ETA: 1:46 - loss: 0.1286 - accuracy: 0.3600
ETA: 1:d4 - loss: 0.1282 - R
ETA: 1:43 - loss: 0.1283 -
ETA: 1:41 - loss: 0.1280 -
ETA: 1:40 - loss: 0.1280 -
ETA: 1:39 - loss: 0.1280 - accuracy: 0.3816
ETA: 1:37 - loss: 0.1280 - accuracy: 0.3856
] - ETA: 1:36 - loss: 0.1279 - accuracy: 0.3897
.] - ETA: 1:35 - loss: 0.1277 - accuracy: 0.3937
]- ETA: 1:33 - loss: 0.1276 - accuracy: 0.3977
] - ETA: 1:32 - loss: 0.1276 - accuracy: 0.4014
]- ETA: 1:31 - loss: 0.1273 - accuracy: 0.4053
] - ETA: 1:29 - loss: 0.1273 - accuracy: 0.4090
] - ETA: 1:28 - loss: 0.1272 - accuracy: 0.4127
] - ETA: 1:26 - loss: 0.1270 - accuracy: 0.4164
] - ETA: 1:25 - loss: 0.1270 - accuracy: 0.4200
] - ETA: 1:24 - loss: 0.1268 - accuracy: 0.4235
]
]
1

- ETA: 1:22 - loss: 0.12686 - accuracy: 0.4269

ETA: 1:21 - loss: 0.1267 - accuracy: 0.4303
- ETA: 1:20 - loss: 0.1267 - accuracy: 0.4337
]- ETA: 1:18 - loss: 0.1266 - accuracy: 0.4370
.| - ETA: 1:17 - loss: 0.1266 - accuracy: 0.4402
.| - ETA: 1116 - loss: 0.1266 - accuracy: 0.4434

=

Workflow cont’d:

24. When training is finished press | @ riocesa >
or select the Apply tab

25. Select the trained model ML_U- s

Net EPS2TFL_128x128x128 and press ™t Bl “h .
Proceed.

Model | ™ ML_2DUnet_sels2salt_0x128x128 ()
= ML_3DUnet_Faults_128x128x128

F ML_U-Net_EPS2TFL_128x128x128 I

Gl @

@ romo: 1 Ut
Type: Seismic
Data Type: Cube
Number of inputs: 1
Gutput: Fault_Mask

3
Wed 31 May 2023, 10:49:46
ed; Wed 3L May 2023, 10:51:1Z

: 100060.85

PS2TFL_128x128x128
age Transformation

Dciose | @
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Workflow cont'd:

26. In the Apply window Select the Input Cube Edge_Preserved_Smoothed.

27. Specify the Output Cube name that will be created by the trained model, e.g. ML_U-
Net_TFL_prediction.

28. Press Run to start processing.

% Apply "ML_U-Net_EPS2TFL_128x128x128" == O X

Input for 'EPS' ‘& [EPS v](©select ...
Apply Overlap (%) inl: 10 5 cl: 10 v z:10 ¢ Merge Mode Blend v
Volume subselection | 100/300-750/1250 (463 samples) | [© select ...
Output 'Fault_Mask' [ ML_UNet_Faults - |(©select ...| @ cavs v

Predict using @ GPU O CPU

@ Execute in Batch |4, Options ...|

[Srn ](©cse | @

Workflow cont'd:

@ Progress Viewer ] X

Starting program: od_desplearn_apply 'D:)\0ODDatal\Demo
Suzveys\F3_Demo_2023_ML\Proc\ML_UNet_Faults.par’'

29. A Progress Viewer window pops up. Applying i o amusase

Process ID: 17364

the trained U-Net is very fast. The resulting gesetjvrRoioeary

Procass: 'Dasp Learning Applier'

fault prediction can be viewed e.g. as overlay  se=wes: mes s vy 2o oisess
on the EPS ofinline 425. o
I AL i

op Learning Appliex’
: Wod 31 May 2023, 11:03:41

End of process: 'Desp Learning Applier’

Tinichod batch processing.

Processing finished successfully.

Inline 500 EPS + TFL mask Inline 500 EPS + U-Net Prediction
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2.6.7 Seismic Image Regression (Unet) - Fill
Seismic Traces

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To fill blank seismic traces using the ‘Seismic Image Regression’ workflow which is part of the
machine learning plugin. The model will have to learn how to recreate an image from example
images containing blank traces. Therefore, we need an input data set in which we have
deliberately blanked some of the traces.

For the purpose of this exercise:

«  We use OpendTect’s attribute engine to
randomly blank +/- 33% of all traces

+  We select examples from one side of the
volume for training the U-Net

+  We apply the trained U-Net to the full
volume, so that we can validate the
interpolation results in the blind test zone

B T

Note: In this exercise we train a 2D Unet but you can equally well train a 3D Unet. The differences between 2D and 3D Unets are
as follows:

1. A 2D model trains much faster (hours vs days)

2. 2D models can be trained on workstations with less GPU / CPU capacity

3. Interpolation results are comparable although 2D interpolation may introduce some striping (like a footprint)

4. Application of a trained 3D model is much faster than a trained 2D model (minutes vs hours)

Randomly blank traces workflow:

To train our 2D Unet regression model we create a data set with 33% randomly blanked traces.
From this cube we extract examples for fraining in a restricted area. The trained model is
applied to the entire volume, whereby the area from which no examples are extracted acts as
blind test area. The real value is of course when we apply the trained model to an area with
real missing traces (which we don’t have in this case). Random blanking (replacing the values
with hard zeros) is done in OpendTect’s Attribute engine and can be done in different ways. In
this case, we will create an attribute set to perform the following tasks:

1. Math attribute with formula: “randg(1)”. This generates random values with a Gaussian
distribution and 1 standard deviation;

2. Apply this attribute to a horizon and save as horizon data;

3. Horizon attribute that retrieves the random values from the saved horizon data. A Horizon
attribute replaces a value at an inline, crossline position with the value extracted from the
given horizon;

4. Math attribute with formula: “abs(value)> 1 ? 0: seis”. We assign the retrieved horizon data
to the variable “value” and the seismic data to “seis”. This attribute assigns values larger
than the absolute value of 1 standard deviation to zero while all other values are given the
value of the seismic data.

5. Additional attributes in the set are used to compare/QC results before and after prediction.
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Randomly blank traces workflow:

Create a new 3D attribute set to randomly blank traces as explained in the following steps.

@ Atibute Set 2D

e
O-wetsEHR Bk

Attritute st <nek saved> <All> - Mathematics SRk AR~
MathFunctions st (Squareroot) ~ | Inset | il |
Formul (like ‘naarstk: + o) * farstk') Set
1. Select the 3D Attributes engine al icon.
2. Create a new 3D attribute set_|
These attributes that will be explained in the
next steps.
3. Save as attribute set @ with the name
‘ML_Random_holes_interpolation’.
i e
T (@] @
Attribute set | wm1._Random_holes_interpolation
random
Retrieve horizon data
Seismic with random missing traces as zeros
difference
Gain_corrected_Filled_Seis_[1425
Gain_corrected seismic
difference between gain corrected seis and ML pred
Randomly blank traces workflow:
4. Create 1¢' attribute with name - e
‘random’ as indicated in the attribute An,,mmfa;m}:mf,’ﬁt"* = e T
set window and Hit ‘Add as new'. - T —— = * W
E random missing | Formula (like ‘nearstk + c0 * farstk’) [randg(1 ) £
difference
5. Set Math attribute with formula: e
“randg(1)”. .
This generates random values with a
Gaussian distribution and 1 standard
deviation:; -
o
Apply this attribute to an horizon and
save as horizon data as indicated in
the next step.
< > Attribute Name |random Addasnew [l
I save on Clase 2]
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Randomly blank traces workflow:

Create a seismic horizon at Z = 1 s. Then apply the random attribute to this horizon and save this
as horizon data. This horizon data will be used in the attribute that does the actual blanking.

6. Create a constant seismic horizon at Z = 1s.

7. Right mouse click on the 3D Horizon < New < With
constant Z.

Output 30 Hoetzon [fire—Ts]

8. Enter Z value (ms)= 1000. Type an Output 3D Horizon e B s
name e.g. Hrz_1s. Hit Create. Dt = -
'Ié rza::' Sel;:l Attribute
9. Display the horizon — attribute ‘random’. Save as D2DU ey
Horizon data. ) e
@ Body = Remove

A B AR PN BT DAL

Randomly blank traces workflow:

Create an horizon attribute that retrieves the random values from the saved horizon data. The
horizon attribute replaces a value at an inline, crossline position with the value extracted from the
given horizon.

10. Create 2" attribute “Retrieve horizon data”
as indicated in the attribute set window and Hit
‘Add as new’.

O st
O sohect ..

11. Select the Input Data that will be blanked ‘4
Dip steered Median filter’.

12. Select the constant horizon “"Hrz_1s” created
in the previous step.

+
L]
E]

13. Select Output “"Horizon Data” and Horizon
Data “random”.

Attt Namme [Retrieve artzon dta Al e [l e
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Randomly blank traces workflow:

Create an attribute that will randomly blank traces as zeros in the input seismic.

14. Create 3" attribute ‘Seismic with random missing
traces as zeros’ as indicated in the attribute set

window and Hit ‘Add as new’. AW VO

Adtribuite set | Random holes. wobin: Basic Mathematics ?

random attewncnons | o (sowsa ooty +| | weert | [ |
15. Set a Math attribute with formula: “abs(value)> 1 s o om0 - 102 =
? 0: seis”. This assign the retrieved horizon data to s bl

the variable “value” and the seismic data to “seis”.
This attribute assigns values larger than the absolute
value of 1 standard deviation to zero while all other
values are given the value of the seismic data.

| =«=

16. Select the previously created attribute ‘Retrieve
Horizon Data’ in the ‘For Horizon to use’'.

it Karme Seisic with random missing traces as zevos | |Ackd o rew (18] e

2 sove on o [Eo=]@

17. Select the seismic you wish to blank in the ‘seis’
(e.g. 4_Dip steered median filter).
Blank traces workflow cont’d: cements color
Seene 1
S; ‘ . Add Default Data
Bl & . AddandSelectData .. N
= . 1 Add at well Location ...
A | Add Color Blended
& Select - o 'S
Select first layer
Filker |*
O Stored f;ﬂuom X .
18. Display the new seismic attribute with S T
blanked traces. Right mouse click on the B [t o

difference between gain corrected seis and ML pred

In-line. Select "Add and Select Data”

19. Select the attribute “Seismic with
random missing traces as zeros” and Hit Ok.

Notice that random traces have been
blanked.
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Blank traces workflow cont’d :

20. Select, "Create a Seismic Output” from the
attribute — Seismic with random missing traces as
ZEeros.

21. In the "Create Single Attribute Volume” window,
keep the default parameters. Type an Output name
(e.g. Seismic with random missing traces as zeros)
and Run.

22. Close the progress window when the processing
finish

23. Display/QC the created seismic

This seismic will be used as input for the next step, ML
Seismic Image Regression prediction.

Processing  Stene View ilites Teraliubis  Help

Create Seismic Ouipt * Attributes b e Single Atribute kD
Create Horizon Output  * D<=>3 ) Muit Attribute Volume ... D |
m =l

s 05 2eros ] |©) Select

Valuine subsedoction [100/300-750/1250 (46: ) © selest ..

‘Quantity to output | Seismi with randam o

Null traces @ Discard Pass
] 5cala values:  Shit
Output Cube |Seismic with random missing traces as zeros - | ) Select .. | CBVS

Balch execution Single rocess {4 Options ...

Grn | Do @

Processing finished sucoessfully.

Exercise objective:

To fill blank seismic traces using the ‘Seismic Image Regression” tool which is part of the machine
learning plugin. The model will have to learn how to recreate an image from example images

containing blank traces.

Workflow:

1. Open the Machine Learning Control Center with the % Ehind H el DL LIS

icon.
2. Click on Seismic.

3. Select the ‘Seismic Image Regression” and Hit Go.

5 Machine Learming Control Center — o *

Survey |F3 Demo 2020

v 0 3D Seismic
LE |§- Wells Harizon-based seismic facies
- > Seismic bodies (supervised 3D)
Seismic Image Segmentation
- Seismic Image Regression
& Selsmic v @@ 2D Seismic
Horizon-based seismic facies
— Seismic bodies (supervised 2D)
?;E Seismic + Seismic Image Segmentation
- LWGUS Seismic Image Regression
~ Pre-trained models
UNet 3D Fault Predictor

Neural

Networks
)

-
]
e
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Workflow cont’d:

4. In the ‘Extract Data’ tab, Press the Select
button. The “Deep Learning Target Seismic
Definition” window pops up.

5. Press the + icon and Select the target

seismic volume (e.g.4 Dip steered median filter).

And OK.

*Note: it is possible to create a Training Set from
examples extracted from multiple surveys. To do this,
press the + icon again and select the target volume to
add to the table below.

6. Press Proceed [Input Data Selection]. The
“Input seismic for prediction” window pops up

Apply

<Input Data> =

Output Deep Learming Example Data O select... | b [

. Dee Laaming Target s Definitien - 0 x
Sesmic Data suvey

x

a

3 1 5 Dciose
£ Selecttarget image - o x
Survey Data Root |C\Surveys O salect ..

Survey |F3_Demo_2020
F3_Demo_2020_20jul21
F3_Demo_2020_oid
My_New_Survey_AL
My_survey_AL

1 Original Seésimics
2 Steering BG Detaled

| 3o D6 Becigroand
3a Steesing PCALLL MF225

Volume subselection (a1

‘Sessmic Data Survey

1 4 Dip steered median fiter 3 Demo 2020 #
=
-
m

[ ot o st o] | @i

* The option to select data from other surveys is available only in commercial projects

Workflow cont’d:

7. Select the input seismic data (i.e. the seismic
with the missing traces as zeros) and Press OK.

8. In the “Input Data” window set the dimensions
of the input features. To minimize processing
time for this exercise, Set the Images dimension
to: 0x128x128, overlap: 0x0x0 and Inline range:
(100 —400).

Note: If the current HW has large amount of GPU and
CPU/computing power, the recommended Image
Dimensions are 128x128x128.

9. Specify the name of the Output Deep
Learning Example Data (e.g.
ML_Ex_FillMissingTraces 0x128x128 ) and
Press Proceed to start the extraction process.

10. When this process is finished Press
Proceed in the “Seismic Image Transformation”
window to continue to the Training tab.

% Input seismics for prediction - current suvey o ox
Input Seismics ® Specify now O Read Saved Setup
- - o
[ Chimney - Confidence: "
[J Fault_Likellhood_Thinned_from_DSMF_seds
[ Foult_Prob_Unet o
[ Filled_Seismic_IL425 7l
Pogaty pregicted M
[ Seismic with random missing traces as 26
I_EV_WH e With random missing traces as 2ercs, ,,

>

=] e
Survey Tnput 1 >
1 F3 Demo 2020 Selsmic with rando -
Images Dimensions Inl: 0 S O 128 32128 3
Inline Range 1003|400 3| Step |1 s Overap (%) 0
Crossline Range 3002|1250 3 Step 1 2| Overap (%) 0
Time Range (ms) |0 (1848 2l sten s =] Overao (%) [0
Output Deep Leaming Examgle Data [ML_Ex_FillMissingTraces_0x128x128 | | © select ...

Quon |~ | @

Toin Aosky
eirost Data O sebet
Ot Dot Lsring Exrol Dk W Ex. FilbirgTraces iuizeatss | @ seoct | (04
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Workflow cont’d:

11. After the training data is selected the
available models are shown. For seismic image
workflows we use Keras (TensorFlow).

12. Check the Parameters tab to see which

models are supported and which parameters can
be changed.

13. Specify a name for the “Output Deep
Learning Model” (e.g.
ML_Unet_FillMissingTraces_0x128x128).

14. Hit Run.

15. Open the processing log file to follow the
progress. When the log file shows “Finished
batch processing”, the Proceed button turns
green. You can press Proceed or Open

the Apply tab.

ExtractData  Train  Apply
Input Deep Learing Example Data ML_Ex_FillMissingTraces_0x128x128 v | © Select. LIRSS

Training Type & New [ Resume [ Transfer

Output Deep Leaming Model ML_Unet_FillMissingTraces_0x126x128 | ~ | © Select ... ]

[

-

400

) 13

Dbroceed >> | E¥Cose @

cose | |4smeont

Workflow cont’d:

16. Once the Training is done, the trained model
can be applied. Select the trained model and
Press Proceed.

17. The Apply window pops up. Here you can
optionally apply to a Volume subselection. Type
an Output name (e.g.
Seismic_ML_Unet_FillMissingTraces_0x128x128)

Note: You can run on GPU or CPU using the Predict using
GPU toggle. Running the application on a GPU is many
times faster than running it on a CPU.

18. Press Run to create the desired output.

19. Close the ‘Progress Viewer’ window when the
processing is finished.

Exract Data_ Train ety
Survey Data Root | €\Surveys O Sefect.

Survey | F3_Doma_1020
F3_Dema_2020 20021
F3_Dermo_2020_okl
y_How,_Surver_AL
My _survey AL

M Unet, Filbissing Traces 0w 280128

Ubiet 7l Missing Traces,

. Aty ML Lnet Filbissnglaces 0128

[EPLTRTERSR| . [ ———— O seet
Apply Overlap (%) [n: 80 30 O 10 30 2010 3

[ — Oselct.

Dracessi firiched successtuly
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Workflow cont’d:

Compare the original seismic data with the Unet predicted
filled seismic results. The line is extracted from the blind test
area.

20. Right Mouse Click on In-line > Add and select Data
> Store. Select the created Filled Seismic
(e.g. ML_Unet_FillMissingTraces_0x128x128), and Hit OK.

21. Type in the Inline field: 425, and Hit Enter.

The same way, add to the display, the original seismic and
seismic with missing fraces .

22. Right-Click on Inline 425 > Add > Afttribute
>Stored. Select the original seismic
(e.g. 4 Dip steered median filter), and Hit OK.
23. Right-Click on Inline 425 > Add > Attribute -
>Stored. Select the seismic with missing traces
(e.g. Seismic with random missing traces as zeros), and =

© Stering

Hit OK.

-

@ za .
2 @ vol  AddstWell Location .. ¥
B Ran  Add Color Blended
& Setect - o x
Select first layer
Filter [+
@ stored Filled_Seismic_L425 "
O Steering Porosity_Predicted_ML_RandomForests
Seismic with random missing traces as zeros
Attributes Seismic with random missing traces s zeros_IL4
Y I Seismic_ML_Unet_FIIMissingT races_0x128x128
PSS ——pe— N
Ous @

=T [l D ¢

-ee scene 1

ements
Scene 1

M W In-line
v [ 425
E] Seismic_ML_Unet_FillMissingTraces_0x128x128
v 4 @ In-line
= » al Auitute | &
H@c Dispiay v W Valume Builder Attribute
Bez Duplicate @ HorizonCube Display
=1 I Reset Manipulation ¥ Systems Tracts Display
T T - o x
Seect Loyer2 Select Loyer 2
Filter |~ il
Douinel Saisnics +® Stored. Fault_Prob_unet L]
T B v
T Ferosey redetes 1. Fandomiorests
7o K1 Cube S0 i [ Sosmic wih randsen wissing traces a5 zerws |
70 A1 Cub tom Horaide & S i randem mizsng aces 5 281,
Do € b [Eel oo @

Workflow cont’d:

24. Compare visually in the blind test
area the:

- Original seismic (4 Dip steered
median filter)

- Randomly blanked traces seismic

(Seismic with random missing

traces as zeros)

- Unet filled seismic
(ML_Unet_FillMissingTraces_0Ox1
28x128)

25. For more accurate comparison,
Set similar colour range for the 3

seismic cubes. Highlight the seismic

cube, Set the colour bar range to (-
8000, 8000).

-so00 [J I3 0D Seismic 1
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Workflow cont’d:

For a better quantitative comparison, create a new attribute ‘difference’ that computes the
difference between the predicted and the original seismic.

@ Aivibuie Sec 30 o x
File

“USYEA WME

26. Select the 3D attribute icon al . Open the s« - Wt 2

A , i Moibiunctiors - st (e o) < Thomt 52 >
attribute set = . Select the attribute set aresinen s ([ e =
“ML_Random_holes_interpolation” T plapla———————=

d¥foronce between gain corol

27. Create a 4" attribute “difference” as
indicated in the attribute set window and Hit
‘Add as new'.

| ==

28. Select the Original seismic (e.g. 4 Dip
steered median filter) for ‘Seis’, and the
predicted seismic (e.g.

Attribute Names dfforence A s e [ e

ML_Unet_FillMissingTraces_0x128x128) for o °
‘pred’
Workflow cont’d:

Display/QC the attribute “difference”. Difference = Original seismic (4 Dip steered median filter) —
Predicted seismic (ML_Unet_FillMissingTraces_0x128x128)

L
Select Layer 2
Filter *
+ o Attibate 5 O Stored | random
* @ Volume Bullder Attribute = Retrieve horizon data
@ HorizonCube Disploy O Steering | seismic with randem missing traces a5 zeros
% Systems Tracts Display @® Attributes

Gain_corrected_Filled_Seis
- Gain_conrected seismic
difference bebween gain corrected seis and M|

@ok | Ocancel @

[N

29. Right-Click on Inline 425 > Add >
Attribute. Select the attribute ‘difference”,
and Hit OK.

Notice the small values of the difference, e e
range (-593, 590). e

30. For more accurate comparison,

Modify the color range to similar range as B 1
the original and predicted seismic [- £ e
8000,8000] oy
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Workflow cont’d (Optional):

For more accurate comparison, apply an RMS gain scaled correction to the original and predicted
seismic, than compute the difference.
Create a new Gain correction attributes to be applied on the original and predicted seismic.

31. Select the 3D attribute icon A% . Open the
attribute set . Select the attribute set
“ML_Random_holes_interpolation”

Ui a Rl -

\L_Random_holes_int <All> Scaling ? &

Inpust Distn | Seismic_ML_Unet_FillMissing Troces (21263128 O et
Type Window.
Gasis RMS

32. Create a 5" attribute
“Gain_corrected_Filled_Seis” as indicated in the

attribute set window and Hit ‘Add as new’ i
33. Select the Input Data -
“Seismic_ML_Unet_FillMissingTraces 0x128x128'

Workflow cont’d (Optional):

For more accurate comparison, apply an RMS gain scaled correction to the original and predicted
seismic, than compute the difference.
Create a new Gain correction attributes to be applied on the original and predicted seismic.

SRR A BAE
34, Select the 3D attribute icon all . Open s = L
the attribute set “®. Select the attribute set

“ML_Random_holes_interpolation”

Input Data [4 Dip steered median fiter © Select ...
Type Window:
Basis RMS

Start ((ms)) Stop ({ms})

Tme Gate 1 0 1848

35. Create a 6 attribute “Gain_corrected e
seismic” as indicated in the attribute set

window and Hit ‘Add as new’ -
B
36. Select the Input Data ‘Gain_corrected
seismic”
< » Adtribute Name Gain_corrected seismic Add as new [l =
e [Eo=]0
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Workflow cont’d (Optional):

Create a new attribute that will compute the difference between the RMS gain corrected original
seismic and ML predicted seismic

37. Select the 3D attribute icon al - e

Open the attribute set = . Select the SR RE A BE
. Attribute set [Random_holes_webind Basic ~  Mathematics. ~| [2]
attnbute Set random MathFunctions | sart (Squareroot) ~  Inset 2% il |
“"ML_Random_holes_interpolation™ ;’fr'mi“"i‘““m‘:‘;m Formd (e et = 0 o) s - e =
- - - e e For‘see’ ues (GolTomctd bl *
Gain_cofrectid seismic For 'pred’ wse Gain_comrected Filled_Seds_IL425

difference between gain cormes

38. Create a 7™ attribute "difference

between gain corrected seis and ML
pred” as indicated in the attribute set
window and Hit ‘Add as new’.

[ SR

39. Select the “Gain_corrected seismic”
as input for ‘seis’ and the
"Gain_corrected_Filled_Seis” as input
for ‘pred’

Attribute Name |difference between gain comected seis and M| Add as new [l =

21 5ave on Close G | @

Workflow cont’d (Optional):

Display the attribute “Gain_corrected_Filled_Seis” (RMS scaled
Seismic_ML_Unet_FillMissingTraces_0x128x128) and the “Gain_corrected seismic”(RMS
scaled 4 Dip steered median filter).

wonlll Wz ] mron st TR R S Y A

40. Right-Click on Inline 425 > Add > Attribute.
Select the atfribute “Gain_corrected_Filled_Seis”,
and Hit OK.

41. Right-Click on Inline 425 > Add > Attribute.
Select the atiribute ‘Gain_corrected seismic”, and
Hit OK.
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Workflow cont’d (Optional):

Compare quantitatively in the blind test area the RMS gain corrected difference between the

original seismic and the predicted seismic.

42. Display the “difference between gain corrected
seis and ML pred” seismic attribute. Right mouse
click on the In-line 425. Select “Add and Select
Data”.

43. Select the attribute "difference between gain
corrected seis and ML pred” and Hit Ok.

Notice the very low values of the “difference
between gain corrected seis and ML pred”. The
range [-0.257, 0.257].

44. For more accurate comparison, display the
difference attribute with similar colour range as the
gain corrected original and predicted seismic.
Highlight the seismic cube, Set the colour bar
range fo [-2, 2].

[Z_ T W= | | 5300 seismic 1 R @R

a00

800, 8O0 1000

i

500
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2.6.8 Seismic Lundin Smoother

Required licenses: OpendTect Pro & Machine Learning

Exercise objective:

To condition data using the Pre-trained models — Lundin GeolLab SimpleDenoise” tool which is
part of the machine leaming plugin. In this exercise, we want to remove incoherent noise while
trying to preserve amplitude ranges.

Seismic data Preparation

Seismic need to be available in the survey. If not, import seismic, preferably a volume not
subject to any previous data conditioning or smoothing

Workflow: e
[N
Project | D:\ODData\Demao Surveys\F3_Demo_2023_ML

1. Open the Machine Learning Control Center with the :

* |§ v wells
i 41 Wells NFHI from RHOB, GR, DT and MD
Icon. »is RHOB from GR, DT and MD
—_— ~ Seismic
g R Lundia Geolab AJAX
) Lundin GeoLab DeSmile

2. Click on “Pre-trained Models”. W‘
s;‘l Seismic + Lundin Geolab SimplsHmult

IS Wells @ UNet VGG19 2D Fault Predictor
3. Select the ‘Lunding GeolLab SimpleDenoise” and Press N e o ey
GO_ o Models ) UNet Supersample Bin Size

.\.Neural @ Pre-trained model information| B & i
«

Use the “Pre-trained Model Information” button to view Vi
parameters, datasets used and model types used in the Otz @ ©
training Of the pre_trained mode| Using Custom Python 3.9.13 environment odmipython-cuda113
Workflow cont’d: = ) R
Input for 'Seismic Data Volume' & | L Original Seismics |(© Select ...
Apply Overlap (%) inl: 10 2 ¢l:10 3 z 10 |3 Merge Mode Blend w

4. The “Apply Lunding GeolLab
SimpleDenoise”
window pops up.

Volume subselection | 100/300-750/1250 (463 samples) B Select ...

Output 'Denoised Volume' | SimpleDenoise_Seismic |(©select .| i cavs

Predict using © GPU CcPy
8 Exacute in Batch |4 Options ...

5. Select Input Cube (e.g. 1 Original

. . (@R | @cioce | @
Seismic).

6. Specify a new name for the “Output

Denoised Volume” (e.g.
SimpleDenoise_Seismic).

7. Press Run. If possible, predict using GPU [Bloa 7
. Staxving program: od_deeplears_apply 'D;\o:?.uf\oeuu i
as this is much faster e B e
dTact U'J,O:J;c'.'?

8. When the processing finish, Press o S R A

button © to close the Progress Viewer APl ying | Dae Toas
window. -

(0.65475) (4m:1ds)
(0.799/3) (2mi2Ss)
9% (0.654/2) (Im:35s)
(0.008/s) (205)

Learning Applier’
Firished: Thu 01 Jun 2023, 12:13:24

End of process: 'Deep Learning Applier’

Finished batch processing.

Processing finished successfully.
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Workflow cont’d:

QC the output fault probability results on the In-line 680.

9. Right Mouse click on In-line > Add and select Data
> Store. Select the seismic that was used as input (1
Criginal Seismic), and then Press OK.

10. Type in the Inline field: 680, and then Press Enter.

11. Right-Click on Inline 680 > Add > Attribute
>Stored. Select the smoothed volume
(e.g. SimpleDenoise_Seismic),
and Press OK.

Tip: Additional seismic attributes can
be added using checkboxes

i Fault
Pnesity_AL
rob Vol AL

QEP Cancsl | | @ Help

B = == ninfleso Flstedt

Tree scene 1 8
Elements Calor
Scene 1
~ B Indine
v [4 680
o
@ sel - o s

Funer [

@ ool | @

Tree scene 1

-}

Elements Color

Scene 1
v ¥ Indine
v (4680
[ Faull Ukelbood Thinned from DFMF _seis M
4 Fault_Prob_Unet_InlE80_AL 5]

Workflow cont’d:

12. Display both and Compare. Note that the
amplitude ranges are preserved in the
smooth volume.

Make a residual display by creating a Mathematics
attribute:  ‘Smooth-Original’. Set the volumes
respectively and add the attribute to the 3D scene.
Note, that you will probably have to manually enter
the amplitude ranges to scale

Smooth Volume

¢

Original Seismic
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